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1. What is Part Planner?

Part Planner allows you to design a plan that details how to manufacture a piece part. The
manufacturing process plan includes a top-level structure of the process needed to manufacture the
part, as well as a detailed design of the individual processes and activities to be included in the plan.
You can create a common process plan for part manufacturing operations, including casting, machining,
heat treatment, finishing, and painting.

As you build the process structure, you can assign resources such as tooling and fixtures to the various
processes, operations, and activities. You can also identify the specific locations (for example, machines
and work cells) within the plant where each operation and activity will be performed. You can create
and classify process and operation templates for later retrieval and reuse.

i
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i Process Design Structure Data Integration
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2. Part planning process example

This portion of a part plan defines a process comprised of five sequential operations.

Operation  Description Characteristic Stored  Type of Requirement
in Operation

Op10 A rough material cut operation. Production

Op20 An NC roughing operation. Finish to £ 0.10 Production

Op30 An inspection operation. Check to +0.10 Inspection

Op40 A finishing operation. Finish to + 0.01 Production

Op50 The final inspection. Check to + 0.01 Inspection

Each operation can contain specific attributes or characteristics that you define.
* Tolerance

* Operator Certification

* User Defined Data Fields

Sequence of Actions Taken in the Operations

* The operations shown are assigned tolerance characteristics.

* Final tolerance is specified at = 0.01.

* To achieve this, the roughing operation is assigned a tolerance of + 0.10 inches. The same
characteristics are then assigned to the related inspection operation.

* Work begins: NC programmer opens Op20, sets up the roughing operation based on the
requirements. The result of Op20 is saved in the operation, including the in-process model generated
by the operation.

* The in-process part is then inspected using the requirements set for Op30.

» After the roughing inspection, the NC programmer finishes the part to meet the requirements set for
Op40 and the in-process model for Op40 in saved. When the part is finished, final inspection uses the
requirements set for Op50.

You can define more specifications by attaching a form to the operation specifying additional data fields
that must be collected. Once you complete the process plan and define the associated workflow, you can
generate the necessary reports and work instructions.
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3. Part Planner general functionality

Displaying information

Displaying information

You can display a variety of information in the primary and secondary views of Part Planner. Many of the
secondary views are only available if you select an object in a primary view that provides valid input. For
example, you can only open the Activities view if you select an operation.

How perspectives and views work

Working with manufacturing perspectives

Teamcenter presents manufacturing data in views, each of which provides its own specific way of
managing or modifying data. The views provide an environment where, for example, you can construct
processes and operations, relate additional relevant information, view different alternatives or studies,
and collaborate with others who are working on the same information.

For common use cases, Teamcenter provides you with several collections of views, organized in
collaboration contexts (CCs), that group the views that you need to perform common tasks. These
CCs behave similarly to the Manufacturing Process Planner perspective.

For all Manufacturing Process Planner CCs, you can:
* Add these perspectives to the rich client navigation pane.

* View all loaded structures in the Open Items list and open structures from this list. If the structure is
part of a collaboration context, the name of that collaboration context is shown in brackets behind
the structure.

* Unload open structures by clicking the Unload All button in the Open Items list, or unload a single
structure by right-clicking it and choosing Unload.

You can switch between perspectives using the " button. When you switch, the same structures are
loaded in each perspective. You can see these structures in the Collaboration Context Tree view.
Teamcenter displays the structures in the primary views of the perspective. If there is no suitable primary
view in the perspective, the structure is listed in the Open Items list and the Collaboration Context
Tree view from which you can activate it.

Secondary views are completely new between perspectives so the state of the secondary views are not
the same when switching perspectives.

When you send an object from another application using the Send To->Manufacturing Process
Planner shortcut menu command, Teamcenter opens the last Manufacturing Process Planner
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_ 3. Part Planner general functionality

perspective that you used. If you have a perspective open in the current session and send a structure
to Manufacturing Process Planner, the structure opens in the current Manufacturing Process Planner
perspective.

Each primary view is assigned a number which represents the view regardless of the Manufacturing
Process Planner perspective. Views with the same number are the same view.

B 000015-Cylinder_Engine X

000015-Cylinder_Engine n
Revision Rule: Latest Working
Effectivity: Today

Wariant Rule: Mot Specified

In Context: Mo Context

I i text: Mo Change
Product #2

In the figure, the view tooltip in every perspective in which item 000015 is open shows Product #2.

By default, you can open 10 views for each type of primary structure view. Your administrator can
change this number in the MEMaxOpenViewsSameType preference. The view remains open as long as
it is open in any of the Manufacturing Process Planner perspectives. As long as there is still one instance
of the view open, when you activate that view, it opens in the same state (for example, expansion
state). After the last instance is closed, activating the view opens the structure, but the expansion state
is lost. However, the data is still loaded, so re-expanding is fast.

Your administrator can add new perspectives to Teamcenter.
Working with manufacturing views

Teamcenter presents manufacturing data in views, each view providing its own specific way of
managing or modifying the data. There are primary views and secondary views. The most commonly
used views in Teamcenterinclude engineering bills of materials (EBOMs), manufacturing BOMS
(MBOMs), plant and product bills of process (product and plant BOPs), and graphic views.

Views provide an environment where you can author manufacturing processes based on additional
information available in Teamcenter. You can construct processes and operations, relate additional
relevant information, and collaborate with others who are working on the same information using
studies and alternatives. There are primary views and secondary views.

* A primary view shows one configurable structure. That structure can contain a base view and several
occurrence groups.

* Asecondary view shows specific types of data related to the primary view with which it is associated.
It can, depending on your needs, change its content if you select a new object in a primary view.
Many of the secondary views are available only if you select an object in a primary view that contains
valid input.
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List of manufacturing views _

In addition to primary and secondary views, you can use the following:
* Collaboration Context Tree view to show all loaded objects.
* Structure Search view that allows you to search for any object regardless of view.

* Graphics view to display any visualization data associated with the structure. The Graphics view is
closely associated with the primary view from which you open it.

You can open multiple views simultaneously. You can undock views and move them to a convenient
position. You can open the same structure multiple times in different views. To assist you in keeping
track of which views are associated, primary views and secondary views are color-coded. Primary and
associated secondary views have the same framed color. In addition, Teamcenter frames the active view
(the one in which you are currently working) in black.

Each view has a toolbar with buttons to execute the common tasks pertaining to that particular view.
The view menu contains additional menu commands pertaining to that view. More complex tasks or
tasks pertaining to several views simultaneously are found on the main application toolbar. The views
have some features in common, such as the ability to change the displayed columns or filtering the
results. You find these features in the view menu.

List of manufacturing views

Teamcenter presents manufacturing data in views, each view providing its own specific way of
managing or modifying the data. The views provide an environment where you can author
manufacturing processes based on information available in Teamcenter. You can construct processes
and operations, relate additional relevant information, view alternatives and isolated studies, and
collaborate with others who are working on the same information.

There are primary views and secondary views. A primary view shows one configurable structure. That
structure can contain a base view and several occurrence groups. A secondary view shows specific data
and, depending on your needs, can change its content if you select a new object in a primary view.

View
Icon Name Description
T 2D Viewer You can have one or many two-dimensional snapshots associated
with a line in your product structure. When you open a selected line in
the 2D Viewer view, Teamcenter displays an attached image dataset.
If there are multiple image datasets attached, you can select any
preferred image.
A&  Accountability Displays the results of an accountability check. This view lists the
Check problem lines in the source and target and provides a list of conflict
details. Lines that are colored in the source and target structures are
also colored in the view. Fully matched lines are not listed.
A Activities Displays all activities to be completed as part of the operation

selected in a process. This view is structure-dependent (it displays
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View
Icon

i

=

g

Name

Activities Gantt

Advanced
Accountability
Check

Attachments

Classification
Properties

Collaboration
Context Tree

Graphics

Description

a tree table). Each listed activity is an expandable folder. Folder
contents may include additional subactivities.

Tip:

You can open many secondary views for activities, including the
PERT or Attachments views.

Provides a visual depiction of the start time and duration for all the
activities scheduled for an operation. The view is available when an
operation is selected in the structure view, or an activity is selected in
the Activities view.

Displays the results of an advanced accountability check. The
Advanced Accountability Check view lets you compare and
propagate multiple types of views/structures, run assessment
comparisons to repair one structure from another, set reporting

and equivalence options, and set partial match criteria for different
types of structures. Many options are available, other than those the
standard accountability check offers.

A structure-dependent data view that is always available when an
object is selected in a structure view, the Attachments view displays
the properties of all components attached to the selected object,
including the base item component and all related subcomponents.

Standard Teamcenter shortcut menu commands are available for any
displayed object. Double-click an attachment on this view to open the
attachment in its appropriate application.

Note:

The process revision is determined by the product structure's
revision rule. This information cannot be specified in this view.

Shows the values that exist in the Classification application for
the object currently selected in the structure view if that object is
classified. This data is informational only and cannot be changed
in this view. You must change the data through the Classification
application.

Contains a list of all structures currently open in the application. You
can use the Collaboration Context (CC) view to load and unload
structures, as well as to save structures as new structure contexts.

The Collaboration Context Tree does not respond to selection in
other views.

Displays any 3D visualization data associated with the selected
structure. The Graphics view is closely associated with the primary
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View
Icon Name Description

view from which you open it. If you close the associated primary view,
Teamcenter closes the Graphics view as well.

] Impact Analysis Identifies which other database components reference and thereby
impact an object currently selected in a structure view, and displays
any assemblies in which the selected object appears.

Note:

You can use the Filter by Item Type command to display all
operations currently associated with, and performed at, the
work area selected in a plant structure.

gy Incremental Allows you to add, edit, or remove incremental changes from a
Change selected line.

- IDC Displays any Intermediate Data Captures (IDCs) associated with the
selected structure. You can switch between captured states of an IDC
by selecting from the Captured State list.

i Manufacturing One of the most important primary structure views, the

BOM (MBOM) Manufacturing BOM (MBOM) is a breakdown of a three-dimensional
product design consisting of part and assembly models, usually
derived from an Engineering BOM (EBOM) or design BOM, that
reflects the needs of manufacturing processes. You must continually
compare and update the EBOM and MBOM, often using an advanced
accountability check, to reflect engineering and manufacturing
changes that occur during the manufacturing process.

i PERT You can open this chart view for a process displayed in a structure
view or for activities displayed in the Activities view. When opened
on a process, the Program Evaluation Review Technique (PERT) view
shows the sequence of the first-level processes or operations that
exist for the selected process.

When opened on a top-level activity, the PERT chart displays the first-
level activities. Each process or operation within the selected process
is represented by a box in this view. Each box contains the name and
ID of the process or operation.

Use this view to arrange the boxes and create a sequential flow of
processes, operations, or activities within the selected object.

NA  Part Planner Displays all activities to be completed as part of the operation
Activities selected in a process. In addition, it displays tool number, start, and
duration times for each of the activities.

Each listed activity is an expandable folder object. The folder contents
may include additional subactivities.

You can open many secondary views for activities, including the PERT
view or the Attachments view.
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Name
Plant

Plant Bill of Process
(BOP)

Process Gantt

Product Manual
Product

Report

Standard Text

Standard Text
Library

Structure

Description

A type of primary structure view that displays the plant, work

areas, work stations, lines, or any physical location where your
manufacturing processes take place. This view is sometimes referred
to as a work area view.

A type of primary structure view that displays resources necessary for
a plant to assemble a product.

Displays processes and operations and the relations between them in
a bar chart that illustrates the work breakdown structure of a project
using a time line, from the start and finish times of the operations

or processes and summary elements (operations or higher level
processes). The Gantt view also shows the dependency (sequence)
of relationships between the elements.

Displays work instructions created and edited using a Product Manual
role.

Displays the product that you want to manufacture in a hierarchical
tree structure.

Supports the creation of reports for all three types of structures:
products, processes (including their operations and activities), and
plants. The generated report is presented through a browser window.

You can create customized style sheets or use other formatting tools
to customize both the data content and the report format.

Enables you to create and manage such as text, data collection
definitions, and symbols that are compiled to create textual work
instructions. The Standard Text view is generally used by the
standard text librarian to manage the elements that the work
instruction author chooses to create work instructions.

Creating work instructions using standard text promotes
standardization and consistency of work instructions throughout the
organization. You can create the elements once, and then reuse them
many times.

Helps you to you use to create standard textual work instructions. A
standard text library is a structure comprised of standard text folders
and standard text elements nested under the folders.

When you open the application, there are three empty structure views
entitled Product, Process, and Plant. These views are placeholders for
structures that you open. When you open a structure, it opens in the
associated structure view and Teamcenter displays the information as
a tree structure. You can open multiple structures at once, including
multiple parts, processes, or plants. Each of these structures is
displayed in a different view. You can configure these structures using
revision rules, variant conditions, and effectivity dates.
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View
Icon Name Description
* If you open a part, the structure view contains the product
hierarchy being manufactured. You can allocate any consumed
parts and workpieces or subsets of workpieces to an operation's
setup.

* If you open a process, the structure view shows the process
hierarchy in the sequence it uses for manufacturing the part.
The process structure contains subprocesses and operations. You
can view the workflow from one process to the next, as well as
see parallel processes. You can also see alternate processes for
creating the target product and allocate work area items, tooling,
and workpieces to a specific process.

 If you open a plant, the structure view displays your factory
environment hierarchy as a tree structure. The root level identifies
the high-level plant structure. Each layer beneath the root level
breaks down the work areas within the plant until the lowest level
in the structure represents individual work areas where specific
operations are performed.

Structure views are primary views for which you can open a

variety of secondary views that provide detail information about the
selected line. Although product, process, and plant are the most
common types of structures that open in a primary view, there are
additional types of structures that open in primary views, including
an Intermediate Data Capture view, a Requirements view (when
working in Systems Engineering), and a Standard Text view.

B Textual Work Helps you to author work instructions by choosing from a library of
Instructions elements. Using this view, you can quickly create or edit textual work
instructions for manufacturing processes or operations.

i Variants Allows you to display and edit variant options, option defaults, and
rule checks currently defined for the product selected in the structure
pane.

o Viewer Displays the content of a dataset that is attached to an item revision
with a Rendering relationship, where possible. For example, if you
select a text dataset, the viewer displays a text editor with the content
of that text dataset. If you select a dataset containing a JT file, the
viewer displays the JT.

o Workarea A type of primary structure view used to display a plant, work area,
work station, or any physical location where your manufacturing
processes take place. This is sometimes referred to as the plant view.

e Work Instruction If your administrator configured the publishing feature for
manufacturing documentation, you may see the . The name of this
view is configurable. Use it to create published pages containing
manufacturing data. You can organize collections of publishing pages
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View
Icon Name Description
into portfolios, which you can view, publish to a Web server or PDF, or
print in My Teamcenter.
Note:

The PS_assume_legacy_transform_units preference determines how Teamcenter interprets the
units of measure for legacy transform data. Teamcenter and NX currently use meters for transform
units of measure; legacy measurements were in inches or millimeters. This preference affects all
data using legacy transforms that have no database-resident indication of the unit measurement
stored with them. The default setting is Unknown. If the preference is left in the default setting,
you may see discrepancies between the model and display units when you view collaboration
context structures in Manufacturing Process Planner.

Behavior of selected objects in active views

If you select an object in the active view, the selections in the other views change as follows. This is
known as selection synchronization.

* Primary views can change their inner selection (highlight) to suit the active selection. The following
situations can cause them not to do so:

* The selection does not correspond to any object in the view.

* The corresponding object is not currently expanded, and the MEExpandToSelection preference is
set to false.

* An expensive search is required to find the corresponding line. In this case, use one of the Find
commands.

» Secondary views can change their inner selection (highlight) to suit the active section when that
selection occurs in a primary view or in another secondary view that is associated to the same primary
view. The following situations can cause them not to do so:

* The selection does not correspond to any object in the view.
* The Disable response to selections button 3 is turned on.
Managing loaded objects with the Collaboration Context Tree view

The Collaboration Context Tree view displays all structures that are loaded in your session. You can use
this view to load or unload structures or to make structures that have moved behind other structures

in the structure view area visible. Additionally, you can use this view to create structure contexts

from loaded structures, to create configuration contexts, and to save contexts into new or existing
collaboration contexts.
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Viewing a process plan in the Custom Process View _

The Collaboration Context Tree view is not a primary or secondary view. It is not associated with other
views and does not respond to selection in other views. You can display this view by clicking the Open
CC Tree button [ in the toolbar.

You can drag a collaboration context from your Home folder into the Collaboration Context Tree view.

Viewing a process plan in the Custom Process View

You can view the process plan in an alternative view called the Custom Process View. This view is
based on configurable style sheets and preferences and can be opened using the Open With command.
The view provides an overview, in tabular form, of all consumed material included in a process plan,
including assigned parts, tools, and features. The view also includes a Used Equipment tab to create or
view support equipment used in each selected object (such as robots and fixtures), and an Attachments
tab to create/view attachments associated with the selected object. Additionally, you can specify which
properties are shown in each table column and modify these properties directly in this view.

The Custom Process View displays data that is relevant to the type of object selected. For example,
when you open a Process Station type, the Custom Process View lists the properties of the station

and the child operations and allows you to assign parts and tools to the operations. When you open a
Process Line type, the Custom Process View lists the properties of the line (which are different than the
station) and the child processes and process areas. There is no requirement to assign parts to stations.

@ PRZ-100027/A;1-STATION Ad0 @)
Item Type: Process Station Date Released: Find No: 40
Item Description: STATION Ad0 Item Revision Owning User: Boes, Paul (boes) °
Content e
Showing 16 lines FBEER
BOM Line ttem Descrip.. Find Mo A

# OPR-100043/4;1-10-ROBO” ROBOTIC UNLD 10
& OPR-100044/4;1-20-ROBO" ROBOT ADMORO1 20
& OPR-100045/A;1-30-ROBO" ROBOT AD30R01 30

Consumed Material 0 Used Equipment 0 Attachments
Showing 2 lines

BOM Line ltem Discrip...  Occurrence Type
f,- RET-100028/A;1-KUKA KRZ KUKA KR210 R31 MEResource
o EQP-100083/A;1-MAA3D1Z MAA3D123L ROE MEResource

Consumed Manufacturing Features o Connected to: 100011-16862 o
O Weld Point | Arc Weld | Datum
Showing 3 lines
Showing 10 lines iR h=Eh|T
. BOM Line ltem Descrip...  Find No.
BOM Line o Weld Type Mumber of Sheets ... Weld i-Value Weld j-Value Weld k-Value ~| % PRO-102191/A:1-PANEL-D# 13221793_014-P) 130

& 100011-16943 100011-16943 Resictance Spot 3 1.00000000000000  0.000000000000000  0.000000000000000 % PRD-101834/A;1-PANEL-D/ PANEL-DA UPR 2230
& 10001116839 100011-16839 Resistance Spot 3 " 0 8.54500000000000 0 0 % PRD-101681/A1-PANEL-D/ PANEL-DA OTR, 2200

|7 g 10001 1- 1686 100611-16862 Resistance Spot 3 1:00000005000060 "~ 0:080000000500000 * 0/000000000000000 "}
é" 100011-16967 100011-16967 Resistance Spot 3 1.00000000000000 0.00000000000000 0.000000000000000
& 100011-17049 100011-17049 Resistance Spot 3 1.00000000000000 0.56460000000000 0.000000000000000
éwommam 100011-16930 Resistance Spot 3 1.00000000000000 0.00000000000000 0.000000000000000
& 10001116992 100011-16992 Resistance Spot 3 ! o o
& 100011-16915 10001116915 Resistance Spot 3 1.00000000000000  0.00000000000000  0.000000000000000
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The top-level structures loaded from a collaboration context or structure appear here. They
may be selected directly to activate them in the Custom Process View.

The top-level structure header specifies the current selected parent process (MEProcess)
structure of the individual BOM Line selected. A toolbar provides access to the property edit
tools. You can use the Edit Rev Description form and click Edit to open the Object Properties
form.

The operation Content tables list child operations for the selected MEProcess and are
arranged in tabular form. You create and edit Operations , Remove Line, and use Column

Management W:ﬁ to view and select properties displayed in the Properties Form.

Note:

Do not manually enter or change values in the Estimated Time column of the Content
pane. Only converted time properties should be used. Manually entered estimated time
values are not saved.

When you double-click an operation in the Content table, an operation editing table opens:

& POT998/A1-Add Parts to Drive Case (View)

Bem Type MEQF Dot Belepiect
I Dag g plivn: Pick pad Plice Reas Dvvot Carte in Chaset B Rrvition Owning Lser

1 a | ¥

The operation header lists the currently selected parent BOM line in the operation table.
You can edit a description or a property. This may be used for updating specific properties
or accessing the property form. This is same type of toolbar used in the top-level structure
header.

This toolbar lists the objects that complete the population of the process/operation.

* The Consumed Material and Used Equipment tabs contain this set of tools when a BOM
line is selected:

e + &

You can cut, copy, open, and remove objects, search classification for resources, and
configure how objects are displayed in the Column Selection.

¢ The Attachments tab contains these tools when available:
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Open the Graphics view _

You can add a dataset or form, open or remove an attachment, and configure how objects
are displayed in the Column Selection.

@ The Consumed Manufacturing Features section contains Weld Point, Arc Weld, and Datum
tabs that display manufacturing features included in the station or operation selected in the
Content section. Results are ordered by find number (sequence).

When you select a feature from any tab's table, parts connected to the selected feature are
displayed in the Consumed Material tab, and resources assigned to the station or operation
are displayed in the Used Equipment tab.

Note:

This section is visible only if an administrator or other person with administrative rights
has set the preference MECustomViewShowMfgFeatures to True.

* The Weld Point tab contains these feature columns: BOM Line, ID, Weld Type, Number of
Sheets Welded, Weld i-Value, Weld j-Value, and Weld k-Value.

* The Arc Weld tab contains these feature columns: BOM Line, ID, Weld Type, parts it is
Connected To, and Weld Length.

* The Datum tab contains these feature columns: ID, Datum Type, Control Direction
(FA=Forel/Aft, CC=Cross Car, UD= Up/Down), and parts that the datums are Connected To.

The Consumed Manufacturing Features section contains the same tools as the Attachments
tab, plus Show/Hide Connected To (see below):

@ The Connected to section is displayed when you select a manufacturing feature and click
Show/Hide Connected To “r in the Consumed Manufacturing Features section (see above).

Whether you select a process station or operation, columns displayed include Item
Description and Find No. You can also add assigned parts, resources, and manufacturing
features columns using Column Management .

Open the Graphics view

The Graphics view is associated with the structure view from which you open it. You cannot change this
association.

* Ina structure view, click .

Teamcenter opens the Graphics view displaying the structure. The Graphics menu is displayed in the
main menu bar if there is at least one Graphics view open.
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* When you close the primary view from which you opened the Graphics view, the Graphics view
closes with it.

* If you unload data from the primary view, the Graphics view remains open, but empty.

* If you load a new structure into the primary view, the Graphics view is available, but the structure
is only loaded when you select a structure to view.

Display configuration information for a primary view
Do one of the following:
* Click i’ in a primary structure view to see configuration information about that structure.

The Configuration Information dialog box displays the following:

@ Configuration Information @

= Configuration Rules
® Revision rule:  Latest Working
' Effectivity: Today

W, Variant rules: Topltern 11221 -
Topltern 1112122

#& Closure rule:  Not Specified

+ Context

Fr“ In context: Mo Context

* Incremental Change

B\ IC edit context:  No Change

Close

e The revision rule.
* The effectivity.

* The variant rule or rules currently in effect.
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Modify the column display _

* Which structure is configuring the current structure.
* In-context information.
* Currently active incremental change.

* Ensure that the MEShowConfigurationHeader preference is set to true. This displays the current
revision rule, effectivity, and variant rule at the top of the structure view. These entries are links that
you can click to open the dialog boxes used to change the configuration.

~ @YY Yw P

T Latest by Alpha Rewision Order E Today W Mot Specified

Process Structure All Maotes

=M000697/8:1-abe (View)

Modify the column display

1. Select aline in the table in which you want to modify the columns to make the table the active one
in the view.

This is important in views that contain multiple tables.

2. Click the Menu button + and choose Columns from the view menu commands located in the
top-right corner of the view.

Teamcenter displays the Column Management dialog box.

3.  Select the desired columns from the Available Properties list and move them to the Displayed
Columns list with the right arrow.

4. (Optional) Modify the order the columns appear in the selected view table using the up and down
arrows.

5. Do one of the following:
* Click Apply to save the current state.

* Click Save and type a name for the column configuration. You can restore a saved column layout
by choosing Apply Column Configuration from the view menu commands and selecting the
saved configuration from the list.
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Find in display

1. Click the Menu button = and choose Find in Display from the view menu commands.
Teamcenter displays the Find in Display dialog box.

2. Click #+ to add a line to the table.

3. Double-click the BOM Line cell of the Property Name column and select the property name by
which to search from the list.

4. Double-click the equal sign to change the operator.

5. Type a value corresponding to the property name, for example, MEOP if you select Item Type as
the property name.

6. Click Find.
Teamcenter displays the number of matches in the bottom left of the dialog box.
7.  Page through the matches using the right and left arrows, or display them all by clicking .
Teamcenter selects the matches in the view.
Sort data in view pane
1. Click the Sort button #1 at the top right of the view, or select Sort from the view menu commands.
Teamcenter displays the Sort dialog box.
2. Do one of the following:
* Sort by default order by selecting Select default order.
* Specify a different sort order.
a. Select Select below criteria.

b. In each of the three boxes, double-click in the box to select from a list of columns available
in the view table.

You can modify the column display by inserting or removing columns from tables.

c.  Select whether to sort the column entries in ascending or descending order.
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Filter search results _

3. Click OK.
Teamcenter sorts the data in the selected table in the order specified.
Filter search results
Several search features allow you to filter search results according to criteria that you specify.

* The ALL option displays properties for all the children of the object currently selected in the
component view.

* You can use the Filter Condition Editor to create condition expressions for filtering the display.

* Expressions cannot be edited after they are listed in the Auto Filter dialog box, but they can be
deleted.

» Teamcenter retains your filter condition expressions until you delete them.
To create conditions, click Add a new search condition -}~ to display the Filter Condition Editor.

* To create an initial condition expression, select a property column value and a logical operator, and
then enter an object value or select one from the list of objects displayed in the table, and then click
Add a new search condition .

Note:

The = = operator tests for an exact match. The = operator tests for a match but is not case
sensitive.

* To expand the expression with additional conditions, use the ADD and OR operators.
* Click Remove the selected condition(s) == to delete the selected condition line.
* Click Clean all the conditions < to delete the entire expression.

* Click ...not meet the condition(s) Y.} to negate the selected condition.

Click OK to add the condition expression to the Auto Filter dialog box.

Saving changes

Teamcenter saves changes to the structure automatically. You do not need to save them manually.
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Caution:

If the same structure is open in Structure Manager and Part Planner, one application can overwrite
the changes made in the other application. To avoid this, close Part Planner before making
changes in Structure Manager.

Comparing structures graphically
About comparing structures graphically

You can compare two structures (BOMs) and view the results to identify differences. The BOMs can
contain different types of objects, such as mechanical parts, electrical parts, routes, and connections.
You can use the graphical comparison capability with released BOMs or with structures that are
configured by effectivity.

You can compare an assembly with an assembly, a part with a part, or two revisions of the same
assembly. If you compare two revisions of an assembly, Teamcenter identifies the following supersedure
information:

e Adds

These are objects that are in the target assembly but not in the source assembly. They have been
added to the assembly.

e Cancels

These are objects that are in the source assembly but not in the target assembly. They have been
removed from the assembly.

e Moves

These are objects that are in different positions in the source assembly and target assembly. Any
object whose transform matrix differs between the source and target is identified as repositioned.

* Reshapes

These are objects that have alternate representations between the source assembly and target
assembly. Any object identified with a UG ALTREP note type is identified as reshaped.

e Common

These are objects that are in both the source assembly and target assembly.
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Compare two BOMs _

Compare two BOMs
1. Apply any revision rules or effectivity needed to configure the structures you want to compare.
2. Choose Tools = Graphical BOM Compare.

Teamcenter displays the Graphical BOM Compare... dialog box listing all loaded structures in both
the First Structure and Second Structure boxes.

3. Select a first and second structure for compare from the lists and click OK.

Teamcenter analyzes the BOMs to identify any differences and displays the Graphical BOM
Compare dialog box containing a visual indication of those differences.

Depending on the type of comparison, you can use the tools and controls in the window to change
the view and examine differences more closely.

If you compare two versions of an assembly under change control (for example, a problem item
and an affected item of an engineering change), Teamcenter displays a list of supersedures.

4. Click Close to close the window on completion.
Set color options

You can change the default colors in which differences and supersedures are displayed in the Graphical
BOM Compare dialog box as follows:

1. Choose Edit - Options.

Teamcenter displays the Options dialog box.
2. Choose Change Management - BOM Tracking from the list of options.

Teamcenter shows the list of current colors assigned to the Graphical BOM Compare dialog box.
3. To change the color assigned to a difference type, double-click the current color assignment.

Teamcenter displays the palette of available colors. Click the required new color and click OK or
Apply to change the color; alternatively, you can click Cancel to exit without changing the color.

View only specific occurrence types

You can use the occurrence type filter to specify which occurrence types to display in the structure. The
occurrence type filter is available on all loadable structures.

1.  Select the desired structure root (product, process, or plant).
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2. Choose Select Occurrence Type Filters from the view menu.
3. Choose the types of occurrences that you want to appear in the selected structure.
4. Click OK.

Only the occurrence types that you selected are shown in the structure.

Note:

You can turn the filter on and off by choosing Apply Occurrence Type Filter from the view
menu or clicking T, in the view toolbar.

Refresh the display of attachments

Generally, when you modify a structure, it is automatically refreshed by Teamcenter. In some cases,
however, the automatic refresh of new attachments is disabled, for example, when adding an
attachment in another application such as My Teamcenter or NX. This is to ensure that performance

is not impaired. Because of this, a new release status does not appear automatically in the Attachments
view. To refresh, you can:

» Select a different line in the structure then select the original one again.
* Use the Refresh Current Structure command.

» Set the MEAttachmentPanelEnableRefreshChildren preference to True. This causes Teamcenter to
automatically refresh the attachments in the Attachments view.

Pasting into a pseudofolder does not refresh the Attachments view. After pasting the design object
under the Represented by pseudofolder in the Attachments view, choose one of the following
solutions to see the pasted object:

* Reload the part object again.
* Send the object from My Teamcenter to Part Planner.
* If the structure has more than one product, move the selection between the children.

The Attachments view is refreshed and you can see the pasted design object.

Expand partially loaded structures

When Teamcenter displays a BOM or manufacturing view containing the results of a search, the siblings
of the node you searched for are hidden so the search results are displayed quickly. Each hidden node is
represented by a ... symbol enclosed in a box. The ancestors of the found node are loaded and visible.
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Pack/Unpack a bill of materials _

The following figure shows how a partly loaded structure displays in the BOM. In this example, three
nodes are hidden and these nodes are siblings of the 000227/A;1-Part4 node found by the search.

‘. 000222-Product X

Ea ze Vi

BOM Line
Uﬂﬂll?.‘fﬁ._l Product (Wiew)

=% 000223/A:1-Sub_Assyl (View)
I 4000227/A,1-Partd

000228/ 8:1-5ub_Assy2 (View)
000231/ 41 -5ub_Assy3 (View)

Partially loaded structure displayed as a result of a search
To expand this structure:
* Click [...

Teamcenter expands the structure showing the siblings of the search result.

roduct

[ Base View 3% IPA 2

BOM Line |

UUUZZZ..‘AI Product (Wiew)
= —‘ 000223/A;1-5ub_Assyl (View)
- % 000224/ 8:1-Partl
—j‘ 000225/4;1-Part2
- 000226/ A1 -Part3
%
B 000228/ A;1-Sub_Assy2 (View)
- % 000231/ A;1-5ub_Assy3 (View)

Expanded structure
Pack/Unpack a bill of materials

* Click one of the following two buttons on the toolbar to group or ungroup multiple, identical
components in one level of the assembly to pack and unpack the BOM.

Part Planner, Teamcenter 2412 3-19
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 Click |_ﬂf to pack.

. CIick[”{n‘ to unpack.

Note:

When lines are packed, one of the packed lines is always designated the master packed line. If
the TCVIS_Selection_From_Viewer preference is set to true, you can select packed objects in the
viewer using the buttons available in the 3D Selection toolbar. However, if you select the master
packed line, all packed lines are selected. If you do not want this behavior, you must unpack the
packed lines before selecting the individual objects in the viewer.

Displaying activities in the Activities view

You display activities associated with an operation in the Activities view. Activities can have associated
objects such as other activities or attachments. You can filter out which types of attachments are
displayed in the Activities view using the MEOperationActivitiesFilteredComponents preference. To
see all attachments, you can open the Attachments view on an activity in the Activities view.

Manage checked-out objects
You manage checked out objects by doing one of the following:
* Check in the object by clicking Check In.

* Return the object to the database without saving any of the changes you made by clicking Cancel
Check Out.

* Transfer the checkout ownership to another user by clicking Transfer Check Out.

* If you have only one object selected, view a listing of previous checkout activity by clicking View
Check Out History.

Note:

You can configure the columns that appear in the Checked Out Objects dialog box and filter its
content.

Load data to Part Planner
Do one of the following:
* Use the Send to menu command in any other application.

* Use the Open By Name buttons.
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* Use the MRU (Most Recently Used Structures) button.
* Use the Quick Search feature.
* Use the Open Items list.

The Open Items section of the navigation pane lists all items that are currently open in the
perspective.

* Use the History list.

The History list in the navigation pane displays links to objects that you opened. Links are displayed in
reverse order; the last object you opened is the first displayed in the list.

¢ Use the Favorites feature.

Drag a collaboration context from your Home folder to the Collaboration Context Tree view.

If you want the related product and plant to open when you load a process, set the
MSE_load_related_product_process_plant preference to true. Also, to enable auto-loading of all
the linked product structures and plant structures to a Bill of Process or Plant Bill of Process, the
MELoadAllLinkedStructures preference should be set to true.

Tip:

Use the Open Items list in the navigation pane to activate a structure that is already loaded but
not currently visible.

Open structure by name

You can search for and open a product, process or operation, work area, collaboration context or
structure context by name or object ID.

1. Inthe toolbar, click Open by Name ™.

2. Click one of the following:

Button To open a

L Product

A Process or operation
C Work area
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Button To open a
-~ .
@:& Collaboration context
" Structure context
b

If a structure is currently open in a structure view, it is listed in the Association to box.

3. Tofind structures associated with the listed structure, select the Association to option and skip to
step 4, otherwise, do one of the following:

* If there is no structure identified or if you want to search for structures associated with a different
structure, select the new structure and click the Set to selected button =+

You can use this option to search for structures that are not associated to loaded root structures.

* Select the Attributes option and type a structure name or ID.

Note:

You can type an asterisk (*) as a wildcard character if you do not know the entire name or
ID.

4. Click Search or press the Enter key.
All structures that match your search criteria are listed in a table in the open structure dialog box.

5. Double-click a structure in the table. It is opened in a structure view.
Opening the most recently used object

You can click the MRU (most recently used) button @ to open any of the last few top-level structures

you opened. This list is saved across sessions and is an easy way to reopen structures you were
previously working on. Click an item revision in the MRU list to open it.

Note:

If the business object display rule for the Item business object is hidden in the Business Modeler
IDE, Service Plan does not show up in the most recently used (MRU) list.

Unload data

e Select the structure in the Collaboration Context Tree view and choose Unload from the shortcut
menu or from the view menu.
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Expand and collapse a structure _

This unloads the selected structure from the perspective.
* In the structure view, choose Unload from the view menu.
This unloads the selected structure from the perspective.

¢ In the Collaboration Context Tree view, choose Unload All from the view menu or File = Unload
All.

This unloads all structures from the perspective.

* In the Open Items section of the navigation pane, right-click the structure you want to unload and
choose Unload.

This unloads the selected structure from the perspective.

* In the Open Items section of the navigation pane, click Unload All to unload all the structures open
in the perspective.

This unloads all structures from the perspective.

Note:

* When you close the primary view without unloading data, the structure is still open. You can
activate it from the Collaboration Context Tree view.

* You can only unload a structure context object separately if you loaded it separately. You can
unload only an entire collaboration context object—not parts of it.

Expand and collapse a structure
1. Select an object in the loaded structure.
2. Do one of the following:

* Choose View - Expand Options = Expand to expand the structure to one level below the
selected line.

* Choose View = Expand Options - Expand Below to expand the entire structure below the
selected line.

Teamcenter expands only to the level of consumed objects. If you want to expand further, your
administrator must define an appropriate closure rule, and then you can expand based on the
closure rule.
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Note:

This can be time-consuming in very large structures.

* Choose View - Expand Options = Expand Below... and select a level to which you want to
expand the structure.

* Choose View - Expand Options = Expand to Type.
Teamcenter displays the Expand to Type dialog box.
a. Inthe Type list, select the type to which you want to expand the structure.

The types listed are dependent on the type of selected object and the
MEExpandToBaseTypes preference. The MEExpandToBaseTypes preference is only
applicable to selected processes.

Selected object type Behavior
Process The list contains subtypes of both Process and
Operation.
Operation The Expand to Type command is unavailable.
Plant The list contains subtypes of Plant.
Product The list contains subtypes of Product.
b.  Click OK.

Teamcenter expands the tree to the selected type.

* If the expand mechanism reaches the given type in a branch, it stops and moves to the
siblings.

* If the expand mechanism does not find an object of the selected type in the tree, it does
not expand the tree.

* If the expand mechanism does not find an object of the selected type in a branch, the
branch remains collapsed.

3. (Optional) Collapse the structure by choosing one of the following:
* View - Collapse Below to collapse the entire structure.

* View - Expand Options - Expand Below... and selecting the Collapse lower level check box.
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Suppress and unsuppress occurrences _

Tip:

Each of these commands are also available from the shortcut menu.

Suppress and unsuppress occurrences

You can hide lines in a structure in the context of another line higher in the structure. This is useful if

a structure contains content that is not pertinent to every user. For example, if you want to send a tool
design package to a tool designer, not every operation that is contained in the package is relevant to the
tool designer’s work. You can hide the nonrelevant lines in a structure as follows:

1. Right-click the line in the structure that is the context of the suppression and choose Set In
Context. For example, if you want to hide some lines in a tool design package, you select the root
process.

2. Select the line you want to hide and choose Edit—>Suppress/Unsuppress Line.

Teamcenter hides the line in the structure. If you export a structure with hidden lines, they are not
included in the PLM XML of the structure and are not exported.

You can display lines that are suppressed as follows:
* In the structure view, click 4 or choose Show Suppressed Occurrences from the view menu.

Teamcenter displays the lines that are suppressed with a symbol %z in front of them. You can display
the Suppressed column to assist you in determining whether a line is suppressed.

BOM Line Suppressed
D’E‘s th Fr-..* 0020394,1-Tap Process (Wiewnd
79 002040/8;1-mr3395 (view) False
et 00204478,1-kined9d False
a1 %D) 002045/8,1-lewig 936 ) True
gt 00204678 1-bou3TTY False
----- T 002041/8;1-]1423 (iew) False
..... =0 b 002042/8:1-al1962 (View) False
..... "0t 002043/8;1-e25223 (View) False

You can unsuppress lines in a structure as follows:

1. Display all suppressed lines by clicking «# or choosing Show Suppressed Occurrences from the
view menu.

2. Select the suppressed lines that you want to show and choose Edit—>Suppress/Unsuppress Line.
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Displaying and hiding structures using the Show Unconfigured buttons

Teamcenter provides you with several buttons or menu commands that show or hide objects in a
structure.

* Show Suppressed Occurrences

Show Unconfigured Variants

Show Unconfigured By Occurrence Effectivity

Show Unconfigured Changes

Show Unconfigured Assigned Occurrences (only applicable to a bill of process)

Apply Occurrence Type Filters

If you have several structures open, the state of these buttons in the various structures affects what

is visible in the structure. It can occur that you try to show unconfigured variants in a composition
structure but are unsuccessful because they are not hidden in the parent structure. For example, you
have the following product structure with Part2 configured out as a result of a variant rule, but with all
variants exposed using the Show Unconfigured Variants button.

% 000215/41-LB_TopPR (View)
- %) 000216/41-11

% 000217/4,1-12

%) 000218/A4:1-13

5 000219/4:1-14

b 000220/ 8:1-15

Additionally, you have a process structure that consumes Part2 from the product structure.

EIEI 000610/ 8:1-Processiread (View) Process Area
=[] 000613/4;1-ProcessLineZl (View)  Process Line
EI 000817/A1-ProcessStation211 ... Process Station
. B g 000623/A;1-0P221 (View) ~ MEOP
LB Des A 000218/A1-3  Item

If, in the process structure, you turn off the Show Unconfigured Assigned Occurrences, you

may expect the assigned part and the owning operation (depending on the settings of the
typeAndRuleForProcessConfiguration preference) to be hidden in the process structure. If, however,
in the product structure, the Show Unconfigured Variants button is turned on, you cannot hide the
assigned occurrences in the plant BOP structure.

The following control only nodes in the process structure (processes and operations) and not assigned
lines:
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Show Suppressed Occurrences

Show Unconfigured Variants

Show Unconfigured By Occurrence Effectivity

Show Unconfigured Changes
The following control assignments being configured in and out:
* Show Unconfigured Assigned Occurrences

* Apply Occurrence Type Filters

Tip:
You can simultaneously show or hide all Show unconfigured options using the Show Hide

Unconfigured All &, « list if your administrator sets the MEShowHideUnconfiguredAll
preference to All.

Set or unset a closure rule

You can limit the expansion of the structure using site-specific criteria to reduce potentially time-
consuming expansions. For example, if a line has a monolithic JT file attached to it, you may not
want to expand the subassembly below it. Similarly, you may not want to expand an assembly if
it is not assigned to the current project. The site administrator specifies the available rules in the
ClosureRulesForBomExpansion preference.

Lines filtered out by a closure rule are not exported.

If lines are hidden by a closure rule, you cannot find them from other views using the Find menu
commands.

Note:

Expanding a structure based on a closure rule can affect the outcome of an accountability check.
Because this type of expansion filters the displayed lines, it can interact with any inclusion rules
you may set for the accountability check.

Select a closure rule before expanding the structure:
1. Choose Tools=>View/Set Closure Rule for Expansion.

Teamcenter displays the View/Set Closure Rule for Expansion dialog box.
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i ?ﬂ&tﬂomnﬁhﬁmﬂﬁm- :
'

Clesure Rules
BUME-pandSk;pByPruﬁu]gnmn
BEOMEspandProcessByProjectiissac
BOMEpandSkipByfternType

BOM| BedtemType
ndSkpByWariablefemn Ty
BOMEpProcessVanasbleltemType

BOMExpandSkpByPartSownce
BOMEspandProcessByPattSource

Description  Skip expansion of BOMLine based on tem type. The qualified BOMLine will be imasible.

Condition Clauses

Condtsonal Clause
SECONDARY object_type=="Svar

Secondar.. Related Pr—  Action Ty...

Sap

Primary Q...

BOMLine Ttern El_itern

" m
Liser Entrves for Conditicnal Clauses

Type (Svmr) ==

Cancel |

Note:

If the closure rules differ from those shown, the site administrator must edit the
ClosureRulesForBomExpansion preference.

2. Select the required closure rule in the Rules list, and then enter any filter attributes necessary for
the selected rule. In the example shown, you must specify at least one project identifier.

Note:

In a conditional clause, evaluation of the left-hand expression must give primitive data types
such as string or integer. If the related property is a typed reference, untyped reference,
relation, or external references, the left-hand expression must evaluate to a primitive data
type that uses the property of the object. You must use the property of the object, rather
than the object itself. For example, instead of using PRIMARY.bl_uom=="kg" in a condition
clause, you should traverse from BOMLine to UnitOfMeasure using bl_uom and then use a
icon property of UnitOfMeasure.

Primary Secondary
object Primary object Secondary Relation  Related Action Conditional
class object class object type property type clause
CLASS BOMLine CLASS UnitOfMeasure Property bl_uom  Skip SECONDARY.
symbol
==%var
Note:

Line breaks are not supported in closure rules with variables.

3.  After you enter the attributes, click OK to set the closure rule.
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Teamcenter applies the closure rule to all future structure expansions until you unset it or set
another rule.

Note:

You can set the SkipClosureRuleEquivalent user preference to determine whether the
closure rule is re-evaluated if you reapply it in the same session and the referenced property
has changed.

To unset the closure rule, select it in the Rules list and then click Unset Rule.

Tip:
You can see the name of the current closure rule in the tooltip on the structure tab or in the
configuration information when you click %i,.

If the action type in the closure rule is SKIP, lines meeting the criteria do not appear. If the action
type is PROCESS, qualified lines appear but are not expanded (they show a + icon). To expand such
a line, unset the closure rule from the window and then repeat the expansion of the subassembly.

Understanding equivalence and in-context ID (IDIC)

Teamcenter has several features that depend on finding parts that are considered equivalent. This
equivalency is often dependent on the in-context ID (IDIC), also known as the absolute occurrence ID.
The in-context ID is a unique identifier, generally alphanumeric, that determines if two parts or processes
are equivalent.

You can view the in-context ID by displaying the ID in Context Top Level column. It is usually
automatically generated, and you should exercise caution in modifying its value.

The following features depend on the in-context ID:
* Finding products in processes that are not yet expanded
* Running an accountability check to verify line equivalence

* Assigning parts to a cloned process structure

Comparing structures to intermediate data captures
An in-context ID is automatically generated in the following situations:
* When you assign a bill of materials (BOM) to a BOM or a bill of process (BOP) to a BOP

* When you assign a BOM to a BOP or enterprise BOP (EBOP) structure if the
MECopyldinContextToAssignedLine preference is set to true
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An in-context ID is not generated when you assign from an EBOP structure to an EBOP structure.

Caution:

If a line has an in-context ID and you cut it and paste the same line back into the structure,
Teamcenter creates a new occurrence without an in-context ID. Therefore, any of the above
comparisons based on the in-context ID no longer work.

Searching for components in other structures
Setting up the search for components in other structures

You can select one or more objects in the following areas of the user interface and search for themin a
different structure.

* Linesin aview

* Consumed parts in a process

* An object in the Navigation pane (Favorites, History, Open Items)
* Objects in the Home folder

* Objects in the My Worklist folder

* Items attached to a Teamcenter mail

* Lines in the Summary view

Objects in the Graphics view

Whether you need to expand a target structure before choosing the Find in All Visible Views menu
command depends on the settings of the following two preferences:

MECopyldinContextToAssignedLine
MECopyldinContextLowerLevels

Note:

Whether you need to expand a structure before a found component can be highlighted within it
depends on the value of the MEExpandToSelection preference. If this preference is set to false,
you must manually expand the target structure to highlight lines found within that structure.

Find components in open structures

1. Right-click one of the following:
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* Linesin aview

* Consumed parts in a process

* An object in the Navigation pane (Favorites, History, Open Items
* Objects in the Home folder

* Objects in the My Worklist folder

* Items attached to a Teamcenter mail

* Lines in the Summary view

* Objects in the Graphics view

Choose one of the following from the shortcut menu.

* Find - Find in all visible views to find the line in all views that are open, not tabbed behind
others, and not minimized.

* Find and select the view in which you want to find the source line.

* If the source structure is an occurrence group, choose Find in Base View to find the selected
structure line in the base view associated with the occurrence group.

Teamcenter searches for the item in the alternate structure and, if successful, highlights it, as
shown in the following figure.
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Individual search result
Recovering a manufacturing session

If you are working in a four-tier environment and a server or network failure or time-out occurs,
Teamcenter reassigns the client session to another server. It also attempts to use the client cache to
reconstruct the run-time configured structure views and minimize loss of information.

If the server connection is lost, Teamcenter displays two dialog boxes:
* Server Reassigned

Informs you that the server connection was lost. Click OK to dismiss the dialog box.
* BOM Session Recovery

Informs you that a BOM recovery session has started. Click OK to dismiss the dialog box.
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Additional error messages may appear, depending on the state of the recovered session.

The primary structure views are recovered and the secondary views have one of the following states:
* Where possible, the view remains open.

* The view stays open, but its content is cleared.

* The view is closed.

The following limitations apply to BOM session recovery:

* BOM sessions are recovered only for the four-tier rich client.

» Teamcenter recovers the BOM session to a usable status, but not necessarily the exact state
before failure or time-out occurred. For example, if you expanded multiple levels of the structure,
Teamcenter recovers only the first-level expansion of the structure.

* The recovery may take an appreciable time to complete, depending on the quantity of data
Teamcenter must process.

* Unsaved changes are lost. For example, if you modified the effectivity date on a revision rule but had
not yet saved the change, the changes are not recovered.

* If you copied BOM lines to the clipboard before the server terminated, Teamcenter removes them.

* If the server terminated after encountering bad data during expansion, the recovery process may
expand the same structure and encounter the same bad data. You must resolve these data issues in
the database manually.

* If the server terminated due to memory shortage when expanding the first level of the structure,
the recovery process may expand the same structure and encounter the same memory shortage. You
must resolve such memory issues separately.

* The Report view is not recovered.

* The knowledge of which variant rule is in effect at the time of the crash is not recovered.
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Part Planner interface

Part Planner interface overview
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1 Structure view

2 Multiple structure views

3 View toolbar

4 Secondary views

5 Docked Attachments view

Displays all the information pertaining to a structure.

Shows each structure that is currently open. Each view can
contain a product, process, or plant. These are referred to
as primary views. You can open multiple views at once,
including multiple products, processes or plants.

Displays command buttons pertaining to one particular
view only. Use this and the menu commands in the view
menu beside these buttons to perform configuration tasks
and other tasks for the current structure.

Multiple views containing detailed information about
different aspects of a primary structure. In this case,

you see the Part Planner Activities view listing activities
pertaining to the selected operation, as well as the Activity
Gantt view, not currently visible, that helps you manage
time information for activities belonging to the selected
operation. These are two of many views available to assist
you in planning parts for manufacture.

You can move views around and dock them in different
positions in the user interface to arrange the work area to
your liking. The Attachments view in the figure is arranged
below the Part Planner Activities view as these are two
common views necessary for part planning.
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List of manufacturing views

Teamcenter presents manufacturing data in views, each view providing its own specific way of
managing or modifying the data. The views provide an environment where you can author
manufacturing processes based on information available in Teamcenter. You can construct processes
and operations, relate additional relevant information, view alternatives and isolated studies, and
collaborate with others who are working on the same information.

There are primary views and secondary views. A primary view shows one configurable structure. That
structure can contain a base view and several occurrence groups. A secondary view shows specific data
and, depending on your needs, can change its content if you select a new object in a primary view.

View
Icon Name Description
T 2D Viewer You can have one or many two-dimensional snapshots associated
with a line in your product structure. When you open a selected line in
the 2D Viewer view, Teamcenter displays an attached image dataset.
If there are multiple image datasets attached, you can select any
preferred image.

A&  Accountability Displays the results of an accountability check. This view lists the
Check problem lines in the source and target and provides a list of conflict
details. Lines that are colored in the source and target structures are
also colored in the view. Fully matched lines are not listed.

A Activities Displays all activities to be completed as part of the operation
selected in a process. This view is structure-dependent (it displays
a tree table). Each listed activity is an expandable folder. Folder
contents may include additional subactivities.

Tip:

You can open many secondary views for activities, including the
PERT or Attachments views.

ik

Activities Gantt Provides a visual depiction of the start time and duration for all the
activities scheduled for an operation. The view is available when an
operation is selected in the structure view, or an activity is selected in
the Activities view.

A= Advanced Displays the results of an advanced accountability check. The
Accountability Advanced Accountability Check view lets you compare and
Check propagate multiple types of views/structures, run assessment
comparisons to repair one structure from another, set reporting
and equivalence options, and set partial match criteria for different
types of structures. Many options are available, other than those the
standard accountability check offers.

i

Attachments A structure-dependent data view that is always available when an
object is selected in a structure view, the Attachments view displays
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View
lcon

2

g

v}

Name

Classification
Properties

Collaboration
Context Tree

Graphics

Impact Analysis

Incremental
Change

IDC

Manufacturing
BOM (MBOM)

Description

the properties of all components attached to the selected object,
including the base item component and all related subcomponents.

Standard Teamcenter shortcut menu commands are available for any
displayed object. Double-click an attachment on this view to open the
attachment in its appropriate application.

Note:

The process revision is determined by the product structure's
revision rule. This information cannot be specified in this view.

Shows the values that exist in the Classification application for
the object currently selected in the structure view if that object is
classified. This data is informational only and cannot be changed
in this view. You must change the data through the Classification
application.

Contains a list of all structures currently open in the application. You
can use the Collaboration Context (CC) view to load and unload
structures, as well as to save structures as new structure contexts.

The Collaboration Context Tree does not respond to selection in
other views.

Displays any 3D visualization data associated with the selected
structure. The Graphics view is closely associated with the primary
view from which you open it. If you close the associated primary view,
Teamcenter closes the Graphics view as well.

Identifies which other database components reference and thereby
impact an object currently selected in a structure view, and displays
any assemblies in which the selected object appears.

Note:

You can use the Filter by Item Type command to display all
operations currently associated with, and performed at, the
work area selected in a plant structure.

Allows you to add, edit, or remove incremental changes from a
selected line.

Displays any Intermediate Data Captures (IDCs) associated with the
selected structure. You can switch between captured states of an IDC
by selecting from the Captured State list.

One of the most important primary structure views, the
Manufacturing BOM (MBOM) is a breakdown of a three-dimensional
product design consisting of part and assembly models, usually
derived from an Engineering BOM (EBOM) or design BOM, that
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View

Icon Name Description
reflects the needs of manufacturing processes. You must continually
compare and update the EBOM and MBOM, often using an advanced
accountability check, to reflect engineering and manufacturing
changes that occur during the manufacturing process.

i PERT You can open this chart view for a process displayed in a structure
view or for activities displayed in the Activities view. When opened
on a process, the Program Evaluation Review Technique (PERT) view
shows the sequence of the first-level processes or operations that
exist for the selected process.

When opened on a top-level activity, the PERT chart displays the first-
level activities. Each process or operation within the selected process
is represented by a box in this view. Each box contains the name and
ID of the process or operation.

Use this view to arrange the boxes and create a sequential flow of
processes, operations, or activities within the selected object.

NA  Part Planner Displays all activities to be completed as part of the operation
Activities selected in a process. In addition, it displays tool number, start, and
duration times for each of the activities.

Each listed activity is an expandable folder object. The folder contents
may include additional subactivities.

You can open many secondary views for activities, including the PERT
view or the Attachments view.

w Plant A type of primary structure view that displays the plant, work
areas, work stations, lines, or any physical location where your
manufacturing processes take place. This view is sometimes referred
to as a work area view.

2 Plant Bill of Process A type of primary structure view that displays resources necessary for
(BOP) a plant to assemble a product.

= Process Gantt Displays processes and operations and the relations between them in
a bar chart that illustrates the work breakdown structure of a project
using a time line, from the start and finish times of the operations

or processes and summary elements (operations or higher level
processes). The Gantt view also shows the dependency (sequence)
of relationships between the elements.

NA  Product Manual Displays work instructions created and edited using a Product Manual
role.
Product Displays the product that you want to manufacture in a hierarchical

tree structure.

NA  Report Supports the creation of reports for all three types of structures:
products, processes (including their operations and activities), and
plants. The generated report is presented through a browser window.

3-37



View
lcon

o
(1

3. Part Planner general functionality

Name

Standard Text

Standard Text
Library

Structure

Description

You can create customized style sheets or use other formatting tools
to customize both the data content and the report format.

Enables you to create and manage such as text, data collection
definitions, and symbols that are compiled to create textual work
instructions. The Standard Text view is generally used by the
standard text librarian to manage the elements that the work
instruction author chooses to create work instructions.

Creating work instructions using standard text promotes
standardization and consistency of work instructions throughout the
organization. You can create the elements once, and then reuse them
many times.

Helps you to you use to create standard textual work instructions. A
standard text library is a structure comprised of standard text folders
and standard text elements nested under the folders.

When you open the application, there are three empty structure views
entitled Product, Process, and Plant. These views are placeholders for
structures that you open. When you open a structure, it opens in the
associated structure view and Teamcenter displays the information as
a tree structure. You can open multiple structures at once, including
multiple parts, processes, or plants. Each of these structures is
displayed in a different view. You can configure these structures using
revision rules, variant conditions, and effectivity dates.

* If you open a part, the structure view contains the product
hierarchy being manufactured. You can allocate any consumed
parts and workpieces or subsets of workpieces to an operation's
setup.

* If you open a process, the structure view shows the process
hierarchy in the sequence it uses for manufacturing the part.
The process structure contains subprocesses and operations. You
can view the workflow from one process to the next, as well as
see parallel processes. You can also see alternate processes for
creating the target product and allocate work area items, tooling,
and workpieces to a specific process.

* If you open a plant, the structure view displays your factory
environment hierarchy as a tree structure. The root level identifies
the high-level plant structure. Each layer beneath the root level
breaks down the work areas within the plant until the lowest level
in the structure represents individual work areas where specific
operations are performed.

Structure views are primary views for which you can open a
variety of secondary views that provide detail information about the
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View

Icon Name Description
selected line. Although product, process, and plant are the most
common types of structures that open in a primary view, there are
additional types of structures that open in primary views, including
an Intermediate Data Capture view, a Requirements view (when
working in Systems Engineering), and a Standard Text view.

Textual Work Helps you to author work instructions by choosing from a library of
Instructions elements. Using this view, you can quickly create or edit textual work
instructions for manufacturing processes or operations.

@  Variants Allows you to display and edit variant options, option defaults, and
rule checks currently defined for the product selected in the structure
pane.

), Viewer Displays the content of a dataset that is attached to an item revision
with a Rendering relationship, where possible. For example, if you
select a text dataset, the viewer displays a text editor with the content
of that text dataset. If you select a dataset containing a JT file, the
viewer displays the JT.

" Workarea A type of primary structure view used to display a plant, work area,
work station, or any physical location where your manufacturing
processes take place. This is sometimes referred to as the plant view.

B Work Instruction If your administrator configured the publishing feature for
manufacturing documentation, you may see the . The name of this
view is configurable. Use it to create published pages containing
manufacturing data. You can organize collections of publishing pages
into portfolios, which you can view, publish to a Web server or PDF, or
print in My Teamcenter.

Note:

The PS_assume_legacy_transform_units preference determines how Teamcenter interprets the
units of measure for legacy transform data. Teamcenter and NX currently use meters for transform
units of measure; legacy measurements were in inches or millimeters. This preference affects all
data using legacy transforms that have no database-resident indication of the unit measurement
stored with them. The default setting is Unknown. If the preference is left in the default setting,
you may see discrepancies between the model and display units when you view collaboration
context structures in Manufacturing Process Planner.
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Menu command

File=»New-Process

File*New-Operation

File->New=Activity

File=>New—->Workarea

File-»New-From Template-Process
From Template

File->New->From
Template2>Operation From Template

File->New-From
Template->Workarea From Template

File->New->From Template-=Iltem
From Template

File-»New-From Template>Activity
From Template

File»New-Standard Text->Standard
Text Library

File»New-Standard Text->Standard
Text Folder

File-»New=Standard Text->Standard
Text Element

File®>New=Item

File=>New=Part

File®>New->Form

3. Part Planner general functionality

Purpose

Creates a new process under the selected line in the
structure pane or as a new root process.

Inserts a new operation under the selected line in the
process structure.

Creates an activity under the selected item in the process
structure.

Adds a work area to the plant structure.

Creates a new process from an existing one.

Creates a new operation from an existing one.

Creates a new work area from an existing one.

Creates a new item from an existing one.

Creates a new activity from an existing one. This command
is only available if you have an activity selected in the
Activities view, or in the Activities section of the Time
view.

Creates a standard text library that you can use to manage
text and symbol building blocks to create textual work
instructions. A standard text library is a structure comprised
of standard text folders and standard text elements nested
under the folders.

Creates a standard text folder that helps you manage the
structure of a standard text library.

Creates a standard text element that is one of the building
blocks used to create textual work instructions. Standard
text elements are stored in a standard text library.

Creates a new item under the selected item in the product
structure or as a new root product.

Creates a new part.

Attaches a form to an object in the structure context. This
menu command is available only if the attachments pane is
open.
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File>New->Folder

File»New-Dataset
File»New->BOM View Revision

File->New=Item Element

File»New=Connection-
Non-Revisable

File-»New=>Connection-
Revisable

File®>New=Collaboration Context
File=>New-Structure Context
File-»New-Configuration Context

File=>New-=>Workflow Process

File®>New->URL

File*New-Envelope

File=Save As=Item(Revision)
File=Save As->BOM View(Revision)
File->Open

File->Open With

File>Revise

File->Open By Name

File->Most Recently Used Structures

Part Planner menus

Purpose

Attaches a folder to an object in the structure context. This
menu command is available only if the attachments pane is
open.

Attaches a dataset to an object in the structure.
Creates a new BOM view revision for the selected line.

Creates objects to represent design or manufacturing
features that are not defined as part of the physical structure
in the BOM. Features are implemented as item elements,
sometimes called general design elements (GDEs).

Creates a new nonrevisable Tc Link connection (for
example, connection or datum point connection).

Creates a new revisable Tc Link connection (for example,
connection or datum point connection).

Creates an empty collaboration context.
Creates an empty structure context.
Creates an empty configuration context.

Creates a new workflow process with attachments, an
associated process template and the ability to assign tasks
to specific users.

Attaches a URL to an object in the structure context. This
menu command is available only if the attachments pane is
open.

Allows you to attach an envelope to an object in the
structure context. This menu command is available only if
the attachments pane is open.

Creates a new item revision of the selected line.

Creates a new BOM view revision of the selected item.
Opens the selected object.

Allows you to select with which tool an object is opened.
Revises the selected item.

Open a product, process, work area, collaboration context,
or structure context by name or ID.

Displays a list of structures that you recently closed. Use this
as a way to quickly open desired structures.
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Menu command

File=Print

File->Print...

File->Define Configuring Structures

File=>Close
File=>Unload All

File>Exit

Edit->Cut (Ctrl+X)

Edit->Copy (Ctrl+C)

Edit>Paste (Ctrl+V)

Edit->Paste Substitute

Edit->Paste Special

Edit->Replace

Edit2>Replace...

Edit->Split Occurrence

Edit=>Insert Level

Edit->Delete

3. Part Planner general functionality

Purpose

Views, prints, or saves information about the currently
selected structure.

Views, prints or saves properties, textual information,
graphics or information associated with the selected item.

Enables you to specify which open structure configures a
process structure.

Closes the current application, in this case, Part Planner.

Removes all structures from the collaboration pane and
structure panes.

Ends your session.

Marks the selected lines for removal and copies their
contents to the clipboard. Cut lines are only removed once
pasted elsewhere in the product structure.

Copies the selected lines to the clipboard.

Pastes item revisions from the clipboard as components of
the selected lines.

Pastes item revisions from the clipboard as substitutes of the
selected (assembly) lines.

Pastes components on the clipboard to the selected
assembly (line).

Replaces the selected line with the item revision or item
element on the clipboard.

Opens a dialog box where you can type the item identifier of
the component to replace the selected line.

Splits a line that represents several occurrences into two
branches. The new branch and the original (changed)
branch initially have the same notes, variant conditions,
and other data, but you can subsequently modify them
independently.

Creates an item and inserts it in the current structure as a
new level below the selected line. The number of relative
occurrences of the children is preserved.

Deletes a single item or an item and all its children.
Optionally, you can also remove any associated referenced
objects. This command permanently removes any selected
item from the structure and the database.
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Menu command

Edit>Remove

Edit->Notes
Edit>Properties

Edit2>Purge

Edit->Latest

Edit->Change Ownership

Edit>User Setting

Edit->Options

Edit>Assign Resource
Edit->Variant Condition
Edit2>Toggle Precise/lmprecise
View->Refresh Window

View-Refresh Current Structure

View-Show Connected Lines

View—>Access

View->Named References

Part Planner menus

Purpose

Removes the selected lines from the structure. The lines
removed by this method are not placed on the clipboard.

Views and edits all occurrence notes for the selected line.
Views and edits all properties of the selected line.

Permanently removes old versions of a dataset from the
database. You can select whether to purge all old versions or
specific versions of a dataset.

Displays the latest versions of all datasets in a selected
folder. The Latest menu command updates all version-0
datasets to reference the latest saved version in the
database. This feature is useful in a network environment
when multiple users are working on the same dataset.

Changes ownership of one or more objects. Using the

Explore Selected Components option, you can select
component objects and attachments, such as datasets,
forms, and part files for ownership change.

Changes your group, role or volume assignments, also your
application logging and journaling options.

Changes user interface settings that affect all applications.
Assigns resources to a selected process or operation.
Creates a variant condition on the selected line.

Changes the precision of the selected assembly (line).

Reads information from the database and updates the
information displayed in the application.

Updates information in the currently open and active
structure. If you add datasets to an object in a different
application (for example, My Teamcenter), use this menu
command to update the Attachments view.

Shows or hides all lines that are connected by the selected
connection.

Views, changes, and/or applies access permissions for a
selected object.

Views, opens, imports, or exports the named references
of a selected dataset. You can use the function buttons in
the dialog box to cut or copy a selected reference to the
clipboard and paste references from the clipboard.
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Menu command
View-File

View=Pack/Unpack-Pack

View->Pack/Unpack->Pack All

View=Pack/Unpack->Unpack

View-»Pack/Unpack-»Unpack All

View->Expand Options->Expand

View-Expand Options->Expand
Below

View->Expand Options->Expand
Below...

View-Expand Options->Expand to
Type

View=Collapse Below

Tools=>Check-In/Out=
Check-Out

Tools=>Check-In/Out=Check-In

Tools=>Check-In/Out-»Cancel Check-
Out

Tools=>Check-In/Out->Transfer Check-

Out

Tools=>Check-In/Out=
Notification List

Tools=->Check-In/Out=>
Check-Out History

Tools=1D Display Rule=View/Set
Current

Tools->ID Display Rule->Modify
Current

3. Part Planner general functionality

Purpose
Shows the audit file for the selected structure or assembly.

Packs the selected lines so that all lines with the same item
revision and find number are displayed as a single line. The
actual quantity of lines is appended to the node.

Packs all packable lines in the displayed structure.

Unpacks the selected packed lines so that they are displayed
as separate lines, one for each occurrence.

Unpacks all lines in the displayed structure.

Expands the substructure immediately below the selected
lines.

Expands the complete substructure below the selected lines.

Expands the substructure below the selected lines to a
user-selected level. You can also collapse an expanded
substructure when you choose this command (hide certain
child lines).

Expands the substructure below the selected lines to a user-
selected type.

Collapses the complete substructure below the selected
lines (hide all child lines).

Checks a selected component out of the database.

Checks a selected component into the database.

Reverts checkout procedure.

Transfers a selected, checked-out component to another
user.

Views or edits the list of users who are informed if the
selected component is checked in or checked out.

Views the history of check out actions for the selected
component.

Views the ID display rule currently applied to the selected
structure or set a different ID display rule.

Modifies the ID display rule currently applied to the selected
structure.
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Menu command Purpose

Tools=1D Display Rule=Create/Edit Creates a new ID display rule or modify an existing ID rule.

Tools=Project->Assign Assigns the selected structure to a predefined project.

Tools=Project->Remove Removes the selected structure from a project to which it is
assigned.

Tools=Revision Rule=View/Set Views or sets the revision rule for the currently displayed

Current structure.

Tools=Revision Rule-Set Date/ Sets the date, unit number, or end item to configure the

Unit/End Item structure, if the current rule allows.

Tools2Revision Rule=Set Override Sets an override folder to override item revisions that would

folder otherwise be selected by other criteria.

Tools=Revision Rule*Modify Current Modifies the current revision rule and apply the modified
rule to the current structure. You can save the change if you
have write access to the original rule.

Tools—>Revision Rule->Create/Edit Creates or edits a revision rule.
Tools—-Effectivity->Occurrence Views, edits, creates, or copies occurrence date effectivity
Effectivity data for the occurrence of the selected line, or for multiple

lines. You must have the appropriate permissions to create
or edit effectivity data.

Tools > Effectivity2Revision Allows you to view, edit, create, or copy effectivity data for
Effectivity the item revision of the selected line. You must have the
appropriate permissions to create or edit effectivity data.

Tools = Effectivity 2 Effectivity Allows you to view, edit, create, or copy effectivity mapping
Mapping for an end item. Effectivity mappings are needed if you
implement nested effectivity.

Tools=Variants->Configure Variants  Configures or edits a variant structure for the selected top-
level module.

Tools=Variants->0nly Configure Root When on, displays options only for the top-level module,
regardless of the line selected. Set to off to configure the
structure for a lower level module.

Tools—>Variants—>Search Searches for an existing variant item.
Tools=Variants->Count Modules Counts the modules defined for the selected variant
structure.

Tools—»Variants?Unlink Variant Item  Unlinks a variant item from the generic module item to
make changes.

Tools=Variants-»Update Variant Manually updates variant items. If you make structural
Items changes to a generic item and create a new item revision,
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Menu command

Purpose

Teamcenter does not automatically propagate such changes
to each associated variant item. You must make such
changes manually.

Note:

The Incremental Change menu commands only appear if you set the
Incremental_Change_Management preference to true.

Tools—>Incremental Change->Display
Icons

Tools=Incremental Change->Add

Tools=>Incremental Change->Remove

Tools=Incremental Change->Delete
on Object

Tools—Incremental Change->Create
on Object

Tools=Incremental Change->Remove
Changes

Tools=Incremental
Change-»Incremental Change
Baseline

Tools=Incremental Change-Edit
Attachment

Tools->Incremental Change-Split

Tools=Accountability Check->Check

Tools=2>Accountability Check->Clear
Display

Tools=Accountability Check-Select
Unused

Customizes how incremental change icons are displayed and
the contexts in which you want to see icons.

Retrospectively creates an add change and attaches it to the
active incremental change.

Retrospectively creates a remove change and attaches it to
the active incremental change.

Establishes a delete change to the attachment.

Establishes a create change to the attachment.

Removes (undoes) changes on the active incremental
change.

Revises the parent assembly to create an incremental
change baseline.

Edits an attachment (dataset or form) and track the changes
with the active incremental change.

Splits some of the changes from the active incremental
change into another existing incremental change.

Allows you to compare two structures and view the
differences (that is, how one structure uses objects
compared to the other structure). This submenu is active
when two structure panes are visible.

Removes color highlights created by the accountability
check.

Runs the accountability check and shows all occurrences in
the source pane that do not match an occurrence in the
target pane in an occurrence group.
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Menu command Purpose

Tools=Accountability Check-Select  Runs the accountability check and shows all occurrences in
Completely Used the source pane that match more than one occurrence in
the target pane in an occurrence group.

Tools=2>Accountability Check->Select  Runs the accountability check and shows all occurrences in
Overused the source pane that match a corresponding occurrence in
the target pane in an occurrence group.

Tools=Accountability Check=Partial  Displays all properties that were included in the partial
Compare Results compare criteria that you set in the Partial Match Options
pane when running an accountability check.

Tools->Repair Broken Links Identifies broken links and searches for possible repair
candidates.
Tools->Multi-Site Collaboration Controls the data shared with participating sites in a

distributed network. Multi-Site Collaboration allows you to
publish and unpublish objects.

Tools->Graphical BOM Compare Compares two revisions of a part or assembly and examine
the difference in the Viewer pane.

Tools>Resequence structure Reorders the process to reflect a change in the process step
numbers.
Tools-»Update Flows Updates PERT flows according to the find number of the

selected component's children, or in the case of multiple
selections, of the selected components.

Tools=Import->Objects Imports objects into the database using various import
formats.

Tools=Import->From PLMXML Imports a PLM XML file into the database.

Tools=Import->Remote Imports a structure from a remote site in a Multi-Site

Collaboration environment. Search for the remote object in
My Teamcenter.

Tools=>Export-Objects Exports the selected structure and its attachments in PLM
XML format to a selected export directory. You must choose
the appropriate transfer mode for the destination system.

Tools-Export->To PLMXML Exports the selected structure and its attachments in PLM
XML format to a selected export directory. You must choose
the appropriate transfer mode for the destination system.

Tools>MES —->Release to MES Creates a work package to send to an external
manufacturing execution system (MES).
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Menu command

Tools—>MES—Validate for MES

Tools>MES-Launch MES Web Page

Tools=Send Data To

Tools->Send Additional Data To

Tools->Address List

Tools=->List Substitutes

Tools->Manage Global Alternates

Tools=Intermediate Data Capture

Tools-Baseline

Tools->Generate 3D PDF Report

Tools=Link/Associate=Link To
Manufacturing Process

Tools=>Link/Associate-Link As
Required

3. Part Planner general functionality

Purpose

By default, checks that all data has a released status. You
can add custom validation checks to suit your business
needs.

Opens the Teamcenter Web Browser that displays MES
information.

Sends selected data to an external application using an
application interface object. Your Teamcenter administrator
uses the Business Modeler IDE application to create

new application interface types associated with a specific
application. Each of these types are available in the Send
Data To dialog box.

Sends additional data to a running session of the application
launched using the Send Data To menu command.

Displays lists of users who participate in workflow processes.

Adds or removes substitute components or set the preferred
substitute.

Shows a list of the global alternates available for the
selected line. The preferred global alternate is indicated by
an asterisk (*).

Saves the current structure configuration to a PLM XML
format that you can browse and compare against existing
structures.

Copies work-in-progress (WIP) item revisions. During the
development of a product design, you may need to share
such copies of your working design with other users at the
same or different sites. You can also save your design for
future reference.

Creates an interactive 3D documentation report that derives
directly from process data stored in the database. The report
is in PDF format and contains process information and 3D
data.

Enables you to share an operations across top levels to two
process plans.

Links product items that are required to carry out an
operation. This menu command is available only on
operations. The Link as Required relationship does not add
an occurrence below the operation, unlike when you assign
a product item as MEConsumed.
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Menu command Purpose
Tools->Link/Associate- Associates a product to a process so that when opening one,
Associate Product As Target the other opens automatically.

You can turn this behavior off using the
MSE_load_related_product_process_plant preference.

Tools=Link/Associate—> Associates a work area to a process so that when opening
Associate Workarea one, the other opens automatically.

You can turn this behavior off using the
MSE_load_related_product_process_plant preference.

Advanced-=Connect Connects two selected lines with a revisable or nonrevisable
connection.
Advanced-Disconnect Disconnects the currently selected line with a revisable or

nonrevisable connection to another line.
Advanced - Generate Portfolio Creates a portfolio to hold manufacturing documentation.

Advanced-Organization Displays your Teamcenter organizational structure including
the groups in your enterprise, the roles in each group, and
the users assigned to each role. Organization Management
Using Groups, Roles, and Users explains how a user
with dba privileges creates and manages the information
displayed in the organization chart.

Note:

The Graphics menu appears only if you open the Graphics view.

Graphics=Selection-Select All Selects all the objects displayed in the viewer.

GraphicsSelection->Select None Clears any objects currently selected in the viewer.

Graphics=Selection-Reverse Selects all objects not selected in the viewer, while

Selection simultaneously unselecting any objects currently selected in
the viewer.

Graphics=2Selection->Define Sets the object and/or occurrence types you want to hide

Selection Filter from display in the Graphics view.

Graphics=Selection->Apply Selection Filters the objects and occurrence types that you specified
Filter in the Visualization Filter dialog box from view in the
Graphics view.

Graphics-Visibility->View Selected Blanks and unblanks objects loaded in the viewer.
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Menu command

Graphics=Visibility->Blank Selected
Graphics-Visibility->Blank All
Graphics=Visibility=>Unblank All

Graphics—-Visibility->Reverse Blank
All

Graphics=Visibility->Unload Selected

Graphics-Visibility->Define
Visualization Filter

Graphics=Visibility=>Apply
Visualization Filter

Graphics-Visibility->Blank All By
Type->

Graphics=Visibility->Display All By
Type

Graphics=2Edit Color/Translucency

Graphics=Insert

Graphics=Insert-Insert from File

Graphics=Insert=Insert from
Clipboard

Purpose

Note:

The term loaded refers to an object whose JT file
has been loaded in the viewer. A loaded object may
or may not be visible, depending on whether it is
blanked or unblanked.

Makes any objects selected in the viewer invisible.
Makes all objects in the viewer invisible.
Makes all objects loaded in the viewer visible.

Makes any currently visible objects invisible, while
simultaneously making visible any loaded objects that are
currently invisible.

Unloads any objects selected in the viewer.

Allows you to select object types to permanently hide from
display in the viewer.

Turns on the visibility filter that you specified using the
Graphics=Visibility->Define Visualization Filter menu
command.

Hides objects in the viewer based on their types.

Displays objects in the viewer based on their types.

Modifies the color, transparency, and shine of selected
objects in the viewer. These settings only apply to the
currently loaded objects. The next time the edited object
is loaded, the settings revert to the default color and
translucency.

Allows you to insert JT, stereolithography (.stl) and VRML
(.wrl) files as reference graphics.

Inserts a reference graphic from the operating system, using
the Open by Name dialog box.

Inserts a reference graphics object from the clipboard.
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Menu command

Graphics=2Views-View Control

Graphics=Draw Children

Graphics=Show Subcomponents

Graphics2Hide Subcomponents

Graphics=2Export 3D File

Graphics2Replace JT File

Graphics=2Clearance-
Preferences

Graphics=2Clearance-
Toggle Results Window

Graphics=2Transformation-
Temporary Transformation

Graphics=2Transformation->
Persistent Transformation

Graphics=Preferences

Graphics=2Performance

Purpose

Note:

Only item revisions (not items) can be displayed as
reference graphics.

Creates, edits, and displays standard views, using the Rotate
and Standard Views dialog boxes.

Displays the components of a subassembly. You can also
access this command if you right-click in the BOM.

Breaks down solids in the corresponding monolithic JT files
and make the subcomponents independently controllable.
This function is only available for only leaf and unpacked
BOM line nodes.

Removes all merged subcomponents and the one-level tree
from the tree. You can load or unload the monolithic JT file
related to this structure line node in the normal way.

Exports the current visible objects to a STEP or VRML file.

Replaces the JT file that represents an item revision. You can
choose a replacement file from one of the JT files associated
with the current structure line item.

Sets clearance analysis and preferences.

Shows clearance results in a separate window.

Repositions or scales objects in the viewer. These
transformations are not saved in the database.

Repositions objects in the viewer window and saves the
transformations in the database.

Sets clearance analysis and general viewer preferences.

Sets rendering, culling, and general performance
preferences.

The following menu commands are shown in the view menu of the primary structure views.

Menu command

Show Graphics

Purpose

Opens the Graphics view that displays visualization data
associated with the selected structure. The Graphics view
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Menu command

Show Information

Revision Rule

Variant Rule

Set Date/Unit/End Item

Find in Display

Search by ID in context

Apply Occurrence Type Filter

Select Occurrence Type Filters

Show Unconfigured Variants

Show Unconfigured Changes

Show Unconfigured by Occurrence

Effectivity

Show Unconfigured Assigned
Occurrences

Define Configuring Structures

Save as New Structure Context

Set In Context

3. Part Planner general functionality

Purpose

remains associated with the primary view from which it is
opened.

Displays configuration information about the open
structure.

Views or sets the revision rule on the currently selected line.

Views, sets, saves, and loads the variant option values for
the selected line.

Sets the date, unit number, or end item to configure the
structure, if the current rule allows.

Searches for an object in the currently displayed structure.

Searches for absolute occurrences using the identifier
assigned in the ID In Context column of the property table.

Adjusts the display to show only the objects that you select
using the Select Occurrence Type Filters command. This
gives you a more compact and tidy view of very large
structures.

Chooses which objects are visible in the structure. Select the
object types that you want to see.

Shows lines that are hidden because they are configured out
using variants and options.

Shows lines that are configured out because an incremental
change associated has an effectivity on it and the lines are
not currently effective.

Shows lines that are configured out because they have an
occurrence effectivity associated with them and the lines are
not currently effective.

Shows lines that are configured out because they are
assigned occurrences that are configured out for any reason
in the original structure.

Enables you to specify which open structure configures a
process structure.

Saves the selected structure as a new structure context.

Enables you to set the currently selected structure as the
context for additional information set on child objects. For
example, you can add an occurrence note to a child line
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Menu command Purpose

in the structure that is only pertinent in the context of the
currently selected structure line.

Unload Unloads the current structure.

Part Planner buttons

Button Purpose

) Triggers a soft abort to the current operation.

w Cuts the selected lines from the structure and places them on the clipboard.

e Copies the selected lines in the structure and places them on the clipboard.

IE Pastes the components from the clipboard as children of the currently selected
(assembly) line in the structure or into NX.

* Deletes the selected lines from the structure and does not place them on the
clipboard.

= Removes the selected lines from the structure completely and does not place them

on the clipboard.

=) Creates a new process under the selected line in the process structure view. If
nothing is selected, this command creates a new root process.

Inserts a new operation under the selected line in the process structure view.

W Creates a new item under the selected item in the process structure view. If no item
is selected, this command creates a new root product.

L9 Adds a work area to the plant structure. You should only do this in the plant structure
view.
i Creates a holder for a collection of occurrences and absolute occurrences in the

BOM. An occurrence group typically represents an assembly.
a7 Reorders the process to reflect a change in the process step numbers.

Unpacks the selected packed lines so that they are displayed as separate lines, one
for each occurrence.

; Packs the selected lines so that all lines with the same item revision and find number
are displayed as a single line. The actual quantity of lines appended to the node.

0 Adds or edits the occurrence notes of the selected line.

N Opens the Graphical Compare dialog box, allows you to visually compare two
revisions of the same structure.
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Button

=

Purpose

Opens the Collaboration Context Tree view that displays all the open structures.
You can use this view to make structures visible in the structure pane or to unload
structures.

Opens the Classification Search Dialog that you can use to assign a specific resource
to a selected line in your structure.

Browses for and opens a specific structure by name or ID. Click the arrow beside this
button to open various types of structures such as a product, process, work area,
collaboration context, or structure context.

Shows a list of your most recently accessed structures. If you select an entry from the
list, Teamcenter loads the structure into the structure pane. You can configure the
number of entries shown in the MRU list by right-clicking the button and moving the
slider to the desired number.

Adds or removes substitute components or set the preferred substitute.

This button is enabled if the selected line may have substitutes, otherwise it is
disabled.

Shows a list of the global alternates available for the selected line. The preferred
global alternate is indicated by an asterisk (*).

The following toolbar buttons are only available if you enable incremental change.

1]

I WY

o

g

Creates a new incremental change object.

Searches for a specific incremental change object.

Displays a list of the most recently used incremental change objects.
Displays information about the incremental change object.

Turns off incremental change tracking.

Sends an incremental change object to My Teamcenter.

The following buttons are found in most views:

[

@

-
-

L&

Associates the secondary view to the currently selected primary view or to the view
that you select when you click the arrow beside this button.

Locks the secondary view to the currently selected primary view. The secondary view
then does not change its view association if you select a different primary view.

Changes the association of the secondary view to the currently selected view, even if
you have disabled the response to selection.

The following buttons are located in the Collaboration Context Tree view.
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Part Planner buttons _

Purpose

In the Collaboration Context Tree view, makes the structure that you select visible
and active in the structure view.

In the Collaboration Context Tree view, unloads the open structures from all views.
The empty views remain open.

In the Collaboration Context Tree view, unloads all structures from all views. The
empty views remain open.

The following buttons are located in the structure views.

Opens the Graphics view to display visualization data associated with the structure.

Shows lines that are hidden because they are configured out using variants and
options.

In a process structure view, shows lines that are configured out because they are
assigned occurrences that are configured out for any reason in the original structure.

Shows lines that are configured out because an incremental change associated has
an effectivity on it and the lines are not currently effective.

Shows lines that are configured out because they have an occurrence effectivity
associated with them and the lines are not currently effective.

Displays configuration information about the open structure.

Enables you to show or hide any related occurrence groups.

The following buttons are located in the Accountability Check view.

Displays configuration information about the source and target structures.
Sorts the check results in an order you specify in the dialog box.

Filters the results by category. Using the filter, you can choose to show all categories
or only a selection.

The following buttons are located in the Process Gantt view.

Scales the chart up or down to accommodate the entire process flow.

Scales the chart up to show the currently selected time element placed in the middle
of chart and taking up most approximately two thirds of the chart.

Reduces the scale of the chart by a factor of two.
Enlarges the scale of the chart by a factor of two.
Copies the calculated duration to the allocated time field in the selected element.

Unlocks the edit mode enabling you to changes activity duration times by dragging
the time bar.
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Button Purpose

- Shows the calculated duration time. Teamcenter draws a bar across the top of each
time element displaying the calculated duration path of the children of this time
element.

= Displays the critical path.

Displays the duration of the critical path.

Deletes the flow between elements in the Gantt chart.

Mok G

Creates a flow between elements in the Gantt chart. The flow represents a
chronological relationship between two elements.

The following buttons are located in the PERT view.

[3 Activates default select mode. You can make single/multiple selection by clicking or
by using a rubber band selection, or relocate objects using drag-and-drop.

= Activates draw mode to create single or multiple flows continuously.

& If activated, shows information about assigned parts, resources, and features

assigned to the object. If you hover with the mouse over the object, Teamcenter
provides more information about the assigned objects.

i Reassigns the find number of all processes currently visible in the PERT chart
according to the flow defined. You must define a start number and an increment.

b4 Removes flows from the PERT chart.

) Searches for a pattern within PERT node texts.

et Finds the next occurrence of the pattern.

O Enlarges PERT graphics.

S Makes PERT graphics smaller.

[ Fits all the selected PERT boxes into the PERT chart window. If you do not make a
selection, the command fits all boxes into the PERT chart window.

S Adjusts PERT graphics so that one pixel equals one point.

e Zooms into a selected area in the PERT graphics by using a rubber band selection.

Changes the layout of the PERT chart to one of the following:
* Hierarchical—Top to bottom &,
* Hierarchical—Right to left J}=

* Hierarchical—Left to right =
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Button Purpose

* Hierarchical—Bottom to top =
* Hierarchical—Incremental =,
* Circular &

* Orthographic =

* QOrganic =

2 E Aligns selected PERT nodes to the desired position. You can align to the following
- positions:

o Left &

Center i@

Right g

Top T

Middle sge

Bottom s

Distribute horizontally oge

Distribute vertically 2
a Moves to the parent of the selected node and displays its children in the PERT chart.

¥ Displays the children of the selected node in the PERT chart.

To format rich text, use the following buttons that are available in the Drafting Symbols tab and the
GDT Symbols tab.

Symbol Description

El Manually refreshes the editing box.

Adds a frame around the selected characters.
ﬂ Bolds the selected text.

3-57



_ 3. Part Planner general functionality

Symbol Description

ﬂ Italicizes the selected text.

E Underlines the selected text.

él Sets the color of the selected text.

—A—l Decreases the size of the selected text.
A Increases the size of the selected text.

Subscripts the selected text.

Aligns the selected text.

Center aligns the selected text.

x|
ﬁ Superscripts the selected text.

Right aligns the selected text.

é—( Inserts the text you entered in the two boxes to the left of this button.

Inserts a control frame around the selected characters.

Integrating with a manufacturing execution system

A manufacturing execution system (MES) is designed to help companies more effectively and efficiently
execute manufacturing operations from the product order through each step of the manufacturing
process to its final point of delivery. Equally important, an MES is a dynamic information system that is
key to collaborative manufacturing strategies by providing mission-critical information about production
activities to managers across an organization and its supply chain.

The integration between the definition process in product lifecycle management (PLM) and the control
and execution process in an MES generates tremendous value for both processes. As part of the PLM
process, the bills of process (BOPs) can be fully simulated in digital replications of the factory. These
BOPs can be created, tuned, potentially optimized, validated, and then sent as a technical work package
to an MES that automatically generates a work plan for the shopfloor. The MES also controls and
monitors the execution of this work plan on the factory floor. Therefore, the interoperability between
the MES and PLM is critical in closing the gap between simulation in the engineering environment and
reality on the factory floor. As production ramps up, information collected by the MES is essential in
adjusting the bills of process. This information is fed back to engineering to improve their knowledge of
the actual BOPs needed to produce desired results. Continuous improvement initiatives can benefit from
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the collection of data when the MES is monitoring and reporting what actually occurred on the physical
factory floor.

The Manufacturing Execution System Integration collects the bill of process, the bill of materials, and
any relevant work instructions into a work package that is released to the MES. The operator can use this
information to machine the desired product. If there is a problem with the data, the planner can modify
the contents of the work package and release it again.
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Creating product structures

About product structures

A part structure is a hierarchy of each of the component items arranged in parent-child relationships,
and is the basis for the process definitions. The part may contain manufacturing features such as holes,
pockets, and weld points to be manufactured using manufacturing processes.

A structure can have various configurations, also known as revisions, to capture the variations in a part.

Part Planner opens each product as a separate structure view. You can also view product structures using
Structure Manager.

If the product structure contains an item that is owned by another site, it is initially labeled as REMOTE
OBJECT (this is sometimes called a stub). To import the associated CAD data and attachments, select
the assembly and choose the Tools=Import-Import Remote menu command. If the import request

is successful, you see the full properties and attachments of the assembly, rather than the stub. You

can import individual components and part family members in this way. To configure the import of

part family members, choose the Tools=Import->Import Remote Options option and click the NX Part
Families tab.

You can create product structures with CAD systems within Part Planner or Structure Manager.
Restructuring the product structure

Restructuring and editing the product structure

You can restructure a representation, including a BOM view, occurrence group, structure context, or
composition. You must revise a frozen product structure before restructuring. Restructuring edits the
product structure in downstream views (for example, manufacturing) while preserving the derived
occurrence structure and data related to specific occurrences of parts and assemblies. Restructuring is
disabled for product structures that contain CAD designs because it can make the CAD data invalid.

During restructuring operations, Teamcenter maintains the integrity of incremental changes, classic
or modular variants, and structure relationships. Teamcenter displays warnings when it encounters
absolute occurrences attributes and data.

If you have edits pending to a product structure, you must save the edits before you open the structure
in another application.

In addition to restructuring, you can edit individual properties on any line, subject to the following
limitations:
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Restructuring is not permitted on lines that have pending edits.

Property edits are associated with a relative occurrence and are marked as pending until they are
saved to the database.

Property edits are highlighted only if you use the column editor. If you use other methods of changing
properties (for example, the Properties dialog box), these edits are not visually highlighted in the
properties table. However, Teamcenter still retains the details of such edits until you save or revert
them.

Use the PS_structure_change_condition preference to specify actions as structure edits. For
example, by default, changing a reference designator is not considered as a structure edit, but you
can add this action to the preference. NX requires reference designator changes to be considered as
structure edits.

If any note in the list of notes is edited, the All Notes field shows a ... icon with a red strike-through. It
does not show the exact original value.

Edits to the absolute or relative transformation matrix are not highlighted.
You cannot edit the first property column (BOM Line).

If you cut more than one BOM line to the clipboard and then modify the BOM lines on the clipboard,

this action changes the ownership of the remaining BOM lines. For example, if you cut two BOM lines
and then remove one of these lines from the clipboard, the status of the remaining line changes from
pending cut to pending copy. If you want to modify the BOM lines that are the subject of a cut action,
repeat the cut action on the required BOM lines, rather than modifying the contents of the clipboard.

If you remove a line that contains one or more unsaved changes to its substructure, the system does
not automatically save those changes.

By default, if you cut or copy a line and then paste it to a new location, incremental change elements
(ICEs) are not copied. This may necessitate significant manual recreation of data if you are cutting

or copying many lines together. To automatically copy ICEs, the administrator must set two Business
Modeler IDE constants:

* FndOEnablelceCarryOver business object constant

When moving, copying, or assigning a line from one location to another, this constant determines if
the ICEs are carried forward. You must set this constant to true on both the source location’s parent
and the target location’s parent.

* FndOAttrICEsToExclude property constant

Defines the occurrence attributes that Teamcenter does not copy to the target location for
occurrence attribute changes.
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These settings apply to in-context changes made to structure lines, their attachments, and their

occurrence attributes.

Note:

Restructuring primitive actions include:

* Removing a level (removing a line and keeping child lines)

Splitting an occurrence

Replacing data in context

existing absolute occurrence data.

* Inserting a level (including pasting a line as a parent of selected lines)

Moving a line to a new location (for example, cut and paste actions)

Only the last two actions make copies of the absolute occurrence data; the other actions share the

In certain cases, restructuring may cause valid reports of broken links, as shown in the following

examples:
Example 1:
A
S B
e C (APNL in context of A)
S D

The link to Cis lost. This is correctly reported as a broken link.

Example 2:
A
e E
e B
AR E TR C
e D(APNL i n context of B)
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If you move D to E, it is outside of the context of B and APN1 is lost. This is correctly reported as a
broken link.

Example 3:
A
e B
| A C
| Fome - D(APN2 in context of A)
e B
| A C
| e D(APNL in context of A)
e D
e D

If you move C to D, the system cannot determine which D to move the APN to without user interaction.
It skips the APN and logs an error message.

Example 4:
A
S B
Fom e e - C
o D(APNL in context of B)

The link to D is lost. This is correctly reported as a broken link.
Insert a level in the structure

You can create an item and insert it in the current structure as a new level below the selected line. The
number of relative occurrences of the children is preserved. If you select more than one line, they must
share the same parent.

1.  Select the parent line of the new level and choose Edit->Insert Level.
Teamcenter displays the Insert Level dialog box.

2. Enter the item identifier and other attributes of the new item. If the inserted item is new, you must
insert it with a quantity of 1.

3. On completion, click OK or Apply.
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Teamcenter creates the new item and inserts it as a new level. The selected branches become
children of the inserted level, while the inserted level becomes a branch of the original parent. All
existing variant conditions, notes, absolute occurrences, and other data is moved down with the
selected branches. The default quantity of the new level is 1, meaning that no quantity change
occurs.

Note:

You can only insert a level if the line represents a standard business object type. If the line
represents a custom type, copy it to the clipboard and choose Paste Special. Teamcenter pastes it
as a new level above the currently selected line.

Remove a level from the structure
1. Select the affected line and choose Edit-»Remove or click Remove =&.

Teamcenter displays the Remove dialog box.

2. Click Yes to confirm removal of the line. The total number of instances is preserved at the end of
this action. Any options of the removed lines are moved up and variant conditions are merged.

If you try to remove a level that would result in option definitions becoming inconsistent (for example,
options that are referenced by a parent line), Teamcenter displays an error message.

Move a node to another branch

You can move a selected node from one branch to another. All substructure and occurrence data moves
with the node.

1. Move a node using any of the following methods:
* Cut and paste using the Edit->Cut and Edit-»Paste menu commands.
* Cut and paste using the Ctrl+X and Ctrl+V shortcut keys.

Caution:

Do not try to move a node by dragging the line to its new position. Teamcenter performs a
copy action when you drag a line.

Teamcenter displays the Paste dialog box.
2. Do one or more of the following:

* Change the item ID and revision ID.
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* Change the view type, if applicable.

 Select if the line should be pasted as a component of the selected assembly line, as a substitute
for the selected line, or as a new level above the selected line.

» Specify the number of occurrences, quantity per occurrence, and find number.
3. Click OK or Apply to complete moving the line.

Caution:

If you cut a line and edit tracking is enabled, the line is displayed in red with a strike-through
until you commit the edits. Do not attempt to edit or work with this line, or you may obtain
unpredictable results. If you want to edit or work with a line that is marked as cut, revert changes
to the line by choosing Edit->Revert Edit first.

Similarly, do not edit or work with a marked line in another structure editor such as Multi-Structure
Manager. Always complete and save your work on the structure before you open it in another
structure editor.

Replace a node

You can replace an item representing a node in the structure with another item. All data associated with
the original node is preserved.

Note:

Your system administrator sets the PS_replace_with_substructure preference to determine if
any substructure below the node is replaced. If this preference is true, the node and its entire
substructure (if any) are replaced without prompting. If it is false, Teamcenter displays an error
message and does not complete the replacement action.

You cannot use the Replace feature on any type of process or consumed line in manufacturing
structures.

1. Select the line to replace and choose Edit->Replace Node or click &=.

Teamcenter displays the Replace Node dialog box.
2. Enter the item identifier and other attributes of the item that replaces the existing item.
3. Click OK or Apply.

Teamcenter replaces the existing item.

If you have edit highlighting turned on, the number of the original part is shown in red, strike-
through text.
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Split an occurrence

You can split a line that represents several occurrences into two branches. The new branch and the
original (changed) branch initially have the same notes, variant conditions, and other data, but you can
subsequently modify them independently. The quantity on the original line before the split must be
greater than 1.

1.  Select the occurrence line and choose Edit=>Split Occurrence.
Teamcenter displays the Split Occurrence dialog box.

2.  Enter the quantity for the new line that results from the split and click OK or Apply.
Working with global alternates

Global alternates overview

A global alternate part is interchangeable with another part in all circumstances, regardless of where
the other part is used in the product structure. A global alternate applies to any revision of the part and
is independent of any views.

Note:

If the parts are interchangeable only in specific products or assemblies, use substitutes rather than
global alternates.

Parts and their global alternates are related only in a single direction. For example, if part A has three
global alternates (parts B, C, and D), then B, C, and D are each a global alternate of A. However, part Ais
not an alternate of B, C, or D, as shown next.
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la MOT a Global .
Aftermate of

Part B

. la a Global
Alternate of

la NOT a Global
Alernate of

Part A Part C

|z a Global

o Alternate of

la NOT a Glcbal
Alernate of

Part D

la a Global
" Alternate of

Global alternates - single direction

One part can be a global alternate of more than one other part. For example, part B may be a global
alternate of parts E and F, as well as a global alternate of part A, as shown next.

' s MOT a Global
la MOT a Global Alte mate of
Alternate of » Part E
Part A lsaGlobal
- la a Global Ahernate of
Al mate of
Part B
" |z NOT a Global
Alternate of
Part F
|z a Gilcbal »
Alternate of

Global alternates — multiple alternates

Global alternate relationships are not shared. For example, part C is not a global alternate of part B, even
though they are both global alternates of part A, as shown next.
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la NOT a Global »
Alternate of
Part B
. Iz a Global
Alternate of
Part A la NOT a Global
Alternate of
Iz NOT a Global
Alternate of .
Part C
- |z a Glcbal
Alternate of

Global alternates — nonsharing

Likewise, global alternate relationships are not chained. For example, if part B is a global alternate of
part A, and part Cis a global alternate of part B, part Cis not a global alternate of part A, as shown next.

|z NOT a Global . |l NOT a Global
Ale rnate of Al mate of e
Part B Part C
. |z a Global . |z a Global
Part ﬁ Alternate of Alernate of
|z MOT a Global
e Altarnate of

Global alternates - chaining
List global alternates
1. Select a line in the product structure. If it has global alternates, this is indicated by the g icon.
2. Click Global Alternates ¢ :.

Teamcenter displays the Global Alternate dialog box, which lists all the global alternatives of the
selected item. The preferred global alternate (if any) is marked with a check mark.

Note:

You can also list global alternates in My Teamcenter.

Add global alternates

1. List the global alternates (if any) of the item for which you want to add one or more global
alternates.

2. Inthe Global Alternate dialog box, click Open .
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Teamcenter displays the Open by Name dialog box.
3. Search for the item that you want to define as a global alternate of the selected item.

4. If you want to define more than one global alternate of the selected item, repeat the previous step
for each global alternate.

Note:

You cannot add the same item as the global alternate more than once. Teamcenter displays a
Cannot create duplicate alternates of same item message if you attempt this action.

Remove global alternates
1.  List the global alternates of the item from which you want to remove one or more global alternates.

2. Inthe Global Alternate dialog box, select one or more global alternates to remove and click
Remove.

Teamcenter removes the selected global alternates from the list.

Note:

If you remove all the global alternates from an item, the corresponding line in the product
structure no longer shows the ¢ icon.

Set or unset preferred global alternate
1.  List the global alternates of the item from which you want to remove one or more global alternates.
2. Inthe Manage Global Alternates dialog box, select a global alternate and click Prefer.

Teamcenter designates the selected global alternate as preferred and places a check mark next to it
in the list.

To remove the preferred designation from a global alternate, select it and click Prefer again. Teamcenter
removes the check mark next to it in the list of global alternates.

Open an existing part revision

When you open a part, the first BOM view revision (BVR) of that part opens by default. Your
administrator can set the MEManufacturingDefaultBVR preference at your site to open another BVR
if necessary.

Use one of the following methods to open a part:
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* Find the part item in My Teamcenter. Using the mouse, drag the item or its revision to the Part
PlannerManufacturing Process Planner application button in the navigation pane.

* Find the partitem in My Teamcenter. Choose Send To-»Part Planner from the shortcut menu.

* Open a process revision in Part Planner. The part revision that has been most recently assigned as a
target item by this process is opened by default.

* Open a part revision in Part Planner using the Open Product dialog box.

Create a new structure using Part Planner
1. Choose File->New=Item, or click Create New Item = ..

2. Inthe New Item dialog box, select one of the item types from the list.
3. Click Next.

4. Enter the ID number to be assigned to this new part. If this new part is a revision of an existing one,
type the ID of the existing part. You can assign a unique revision number in the Revision field.

To let the system automatically assign a unique ID, click Assign.
5. Type a name for the new part. Make it unique so you can search the database using this term.

6. Select Show as new root to specify that the newly created item is opened as a root object. It is not
pasted to the selected item. If you do not select this option, the new item is pasted as a child of the
selected item.

If the Show as new root option is selected but unavailable, Teamcenter does not allow you to
create a new object under the selected object, for example, if you try to create a work area under a
process.

7.  Type a part description.
At this point, you have all the information required to create a new item.
8. (Optional) Select a unit of measure from the Unit of Measure list.

9. (Optional) Click Next to add optional information, such as filling out the item's forms, or checking
the item out.

10. (Optional) Click Define Options to specify the following:
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* Select Use item identifier as default display or Use revision identifier as default display if
you created an alternate identifier for the item and want to use it as the default display object.

* Select Check Out Item Revision on Create to check the newly created item out of the database
immediately upon creation.

11. Click Finish to create the new part.

12. Click Close to close the New Item dialog box.

Creating a new structure using a CAD system

Importing the part from a CAD system is the primary method for populating the database with a new
product. The CAD system lets you design the structure and the detailed geometry of the part before you
bring the structure into Part Planner.

Authoring MBOM

Reasons for creating an MBOM

When working in the manufacturing environment, Siemens Digital Industries Software recommends
that you create a manufacturing bill of materials (MBOM) from your engineering bill of materials
(EBOM). There are several reasons for this:

* Generally, manufacturing engineers do not have write privileges on the EBOM and cannot modify it.
For example, a design engineer may specify that a part is going to be purchased and sets a property
value to buy. Subsequently, the manufacturing department determines that it is more economical for
them to make this part. They want to change that property to make but do not have the privilege to
do so.

* Assembling a part requires a structure that is different from the EBOM structure. For example, in
the BOM, the exhaust manifold is part of the engine compartment. During assembly, however, the
exhaust manifold must be added after the body is built onto the chassis as the exhaust pipe must be
put through the bumper. This type of regrouping and adding of manufacturing-specific parts is most
efficiently performed in a separate manufacturing BOM structure.

» Especially for final assembly, companies often have manufacturing parts that they consume in
different MBOMs. These can only be created in a structure to which you have write access.

* There may be changes to an EBOM that should not immediately be reflected in the process structure.
For example, you may want to continue manufacturing using the current parts to use up existing
inventory. By using an MBOM, the manufacturing engineers have control over when the changes to
the EBOM are reflected in the manufacturing process.

* Some companies do not author the EBOM in Teamcenter. It is imported from another system so that
the EBOM in Teamcenter is a replication of the status of the EBOM in another system. Using an MBOM
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provides you with a buffer for these changes so that you can monitor and process them in a controlled
manner.

Note:

You cannot open an MBOM in Siemens Digital Industries Software NX.

Automatically creating an MBOM from an EBOM

Teamcenter provides you with several automatic methods to create a manufacturing bill of materials
(MBOM) from an EBOM (engineering bill of materials).

* Create an MBOM from a recipe

Create an MBOM from a template that contains a recipe for searching the EBOM for required parts.
The recipe can contain a variety of search attributes such as an attribute search, spatial search, ID
search, or combinations of search criteria.

This type of creation mechanism works well for make to shelf industries where the products are
standardized such as the automotive or home appliance industries.

* Use the me_create_mbom utility

The me_create_mbom utility creates an MBOM based on a specific EBOM but replaces make parts or
phantom levels in the EBOM with manufacturing-specific parts and directly copies over buy parts.

Your administrator can take advantage of user exits in this utility that allow you to embed your own
logic into the utility.

Your administrator can take advantage of user exits in this utility that allow you to embed your own
logic into the utility that specify:

* What constitutes a make part using the USER_create_or_ref_item user exit (exposed in Business
Modeler IDE using the BMF_ITEM_create_or_ref_id operation on an Item object).

* How to synchronize equivalent lines and align properties using the USER_synch_item user exit
(exposed in Business Modeler IDE using the BMF_ITEM_sync operation on an Item object).

* What constitutes equivalent lines if there is no in-context ID or occurrence thread using
the USER_item_find_equivalent_line user exit (exposed in Business Modeler IDE using the
BMF_ITEM_find_eqv_line operation on an Item object).

* Which action to take on a released MBOM Item Revision object during update using
the USER_item_action_on_release user exit (exposed in Business Modeler IDE using the
BMF_ITEM_action_on_release operation on an Item object).
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For more information, see Integration Toolkit Function Reference.

Your administrator can create a workflow to run this utility using the ME-create-mirror-AH and the
ME-update-mirror-mbom-A action handlers.

This type of MBOM creation method works well for configure to order customers such as heavy
machinery.

Note:
Neither of the methods to create MBOMSs supports part replacement through propagation.
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Create an MBOM from a recipe

You can automatically create an MBOM based on a recipe. A recipe consists of search criteria saved on
each node of an MBOM template that define the parts to assign to that specific node.

MBOM template

. Toap layal

Regipe &

Recipe B

DUPLICATE

—.‘. Aecipe C

EBOM MBOM

Too leve . Top leve
. Create MBOM atthis level for the entire

structure —b’
7 e

Execute recipe

W

W

W
Z
m
3
=
=
m

@

W
3
2
o

Beginning with an MBOM template that contains phantom levels, you define a recipe for each part that
is to be manufactured. When you run the search, Teamcenter searches in the specified EBOM for parts
that fulfill the criteria and assigns them to the MBOM.

Unless a cloning rule is set up to ignore MBOM recipes, wWhen you clone an MBOM that contains
recipes, Teamcenter clones the recipes as well.

1. Open the MBOM template on which you want to save recipes.

This MBOM must already be linked to an EBOM structure.
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Right-click a node on which you want to save a search criteria and choose Open With->BOM
Recipes.

In the BOM Recipes view, click Create/Update Recipe .

In the BOM Recipe Details view, enter a name for the search and the search criteria that describe
the parts that you want to add to the MBOM at the selected node.

What you enter as search criteria is company-specific but may include usage address, position
designator, or a function-based numbering scheme making up the ID.

¥, M_000202-M_CAR MBOM 17 =0 y r@|E Tt =0
SR e[V R =
"%\ Latest Working ‘¥ Today ™' Not Spedfied *» Not 5;

80M Line |usage 1
, 000202/A;1-CAR EBOM (View) % M_0DD202/A;1-M_CAR MBOM (View)
%% 000203/A;1-Body (View) &% 000203/A;1-Body [View) Buy
&% DD0Z14/A; 1-Chassis (View) 5% 000214/A; 1-Chassis (View) Buy

= % 000224/ A; 1-Powertrain (View)
= % D00225/A;1-Transmission (View)
% 000226/A;3-Drive Gears

- % 000215/A;1-Frame (View)
- % DD0219/A; 1-Suspension (View)
4 % M_DD0225/A;1-M_Transmission (View) Phanton

% 000227/A;3-Motor # M_000224/A;1-M_Powertrain (View) Phantan
% 000228/A;3-Reducer Gears & % DDD246/A; 1-Steer and Control (View) Buy
=% 000229/B;1-rear_drive_asm (Vi
% 000230/A;2-rear_ade
% 000231/A;2-rear_drive_hous
% 000232/A;2-main_drve_gea 1] | |
% 000251/A;1-rear_ade_type_Mf @000 = i
% 000233/A;3-power pack case (F7B0M Reche Detak &1 I A=
% 000235/A;3-rowr servo remote ¢
#- % D00236/A;1-Power Source (View) M_000224/A;1-M_Powertrain (View)
# % 000238/A;2-Wheel and Tire Asm (\ R .
B % DD0246/A;1-Steer and Control (View) Recpe Name:* [ Transmesion -
% D00247/A;2-steering pinion
% 000248/A;2-Rack Item ID: [ 2
Ttem name: | Transmission 2
Item attrbutes: | Name = Transmission; j A
Classfication: [ ool I
Occurrence notes: | _—I ;I
Spatial fiter: | |
Form attrbutes: | ool I
Usage Address: | ;I
Position Designator I o
Query Type:
|Genera =]

You can add multiple criteria to one search box by separating them with a semicolon.
Click Validate BOM Recipe « .

Teamcenter runs the search on the EBOM and lists the parts that fulfill the search criteria in the
BOM Recipe Validation Results view. Use this step to verify that you have entered the correct
criteria.

In the BOM Recipe Details view, click Create New Recipe #.

Teamcenter lists the new recipe in the BOM Recipes view. You can save multiple recipes on an
MBOM node.

Do one of the following:
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* To resolve one node of the MBOM template, select the recipe in the BOM Recipes view and click
Resolve BOM Recipe "j.

* To resolve multiple nodes of the MBOM template, select a node in the MBOM template and
choose Tools—»>Resolve BOM Recipe.

8. Inthe Resolve BOM Recipe dialog box, select whether to remove the previously assigned parts

and click OK. If you open the dialog box from the Tools menu, you can choose to resolve all nodes
underneath the selected node by selecting Resolve recipe recursively.

Teamcenter adds the parts from the EBOM that fulfill the search criteria to the MBOM.

& 000248/A;1-CAR. x

e PR

}}4 { e | E

® Latest Working "®' Today ™' Not Specified % Not Specifiec

BOM Line /

| Qual

% 3605/B;2-5pring

4

-5 000254/A;1-Chassis (View)
' % 000255/A;1-Suspension (View)

& s 000256/A;1-Powertrain (View)
% 000257/A;1-Transmission (View)

‘ i Sl 100258/ 4;1-Power Source [View)
-

s 3522/A;2-battery pack
2% 000259/A;2-Wheel and Tire Asm (View)

[

Additionally, the resolved parts are listed under the recipe in the BOM Recipes view.

A v E|lEv|aye¥ =0

000258/A; 1-Power Source (View)

«|

BOM Line Item Type Ttem Description =
=[] BatteryPack
# 3522/A;2-battery pack Item battery pack

I i

You cannot directly copy a BOM recipe. You can, however, select a recipe in the BOM Recipes view, and
then select a different node in the MBOM. The search criteria are still visible in the BOM Recipe Details
view where you can save them as a new recipe on a different MBOM node.
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Creating an MBOM using the me_create_mbom utility

The me_create_mbom utility creates an MBOM based on a specific EBOM, but replaces make parts or
y copies over buy parts.

phantom levels in the EBOM with manufacturing-specific parts and directl

Except in specific cases (see preferences below), do not use this utility to update the MBOM. To update

“ 000202/A;1-CAR EBOM 3 % i 02 [ [or[% R 75, M_000202-M_CAR EBOM & e Bl
& Latest Working *' Today ' Not Speciied ** Not Specfied &7 N¢| &\ Latest Working €' Today ' Not Specfied #* Not Speciied €
BOM Line [ usage_Makec BOM Line [usage_Makeo...
“ 000202/A;1-CAR EBOM (View) % M_000202/A;1-M_CAR EBOM (View)
-5 000203/A;1-Body (View) Buy &% 000203/A;1-Body (View) Buy
- 000214/A;1-Chassis (View Bu &% 000214/A;1-Chassis (View) Buy
B, DUUZNIA'I-inartriln [\.'l)ew) Ph:mnm £ % M_000224/A;1-M_Powertrain (Viev) Fhantam
T » : = %5 M_000225/A;1-M_Transmission (View] Phantom
- % 000225/A;1-Transmission (View) Phantom A Gwi lew) i
@ % 000236/A;1-Power Source (View) Phantom 5 M_000227/A51-M_Mator Meke
&% 000238/A;2-Wheel and Tire Asm (View) Buy 8 W_0OD220/A LM Raducer Geors. Make
#1- % 000246/A;1-Steer and Control (View) Buy @ % M_000229/A;1-M_rear_drive_asm (V... Make
% M_000233/A;1-M_poweer pack case  Make
% 000235/A;3-rovr servo remote control  Buy
# M_000236/A;1-M_Power Source (View)  Phantom
®- % 000238/A;2-Wheel and Tire Asm (View)  Buy
®- % 000246/A; 1-Steer and Control (View) Buy

an MBOM, use an accountability check or an advanced accountability check.

You can create a manufacturing bill of materials (MBOM) from an engineering bill of materials (EBOM)
automatically using the me_create_mbom utility. This utility creates a new MBOM root node, and then

either:

» Copies over engineering parts that are designated as Buy or Phantom.

* Replaces the parts designated as Make with new manufacturing parts containing the same in-context

ID (IDIC) as the engineering part for future comparison.

Example:

me_create_nbom -u=kj -p=kj -g=Engi neering
-key="item i d=000159, obj ect type=ltent -revrul e="Lat
-nrevrul e="Latest Working" -1og=D:\workdir\create3.c

est Wor ki ng"
sv -usenfk

Caution:

Log off any interactive session that uses the same structures as the structures you update with the
utility before you use the utility to avoid failures due to locking of objects in that user session.

The utility is affected by the values of these preferences:

* MEMBOM_Mirror_MakeRules

This preference specifies a BOM Line property, such as bl_item_object_type, and property value pair
that serve as input for the decision as to whether to create a manufacturing-specific part.

There are two ways to view defined BOM Line property names:

4-18




Creating an MBOM using the me_create_mbom utility _

1. Inthe BMIDE, you can check the properties defined for the object BOM Line.

2. In Structure Manager, if you right-click on the column title line and choose Insert Column(s)...,
you get a list of the defined BOM Line properties.

Note:
This preference accepts only a string value.

If you require a boolean or other attribute, you should write your own Business Modeler
Framework extension to control a make or buy decision.

Preference syntax
KEY:<BOMLinePropertylnternalName>,VALUE:<PropertyValue>,ACTION:<ActionValue>

* <BOMLinePropertylnternalName> is the property on which the value criterion will apply (e.g. "GCS
CP").

* <PropertyValue> is the value used by the criterion.
e <ActionValue> is the action to undertake on the BOM node.

Valid values are PartLink (links a Design node to Part node) and PartAssign (links and assigns a
Design node Under a Part node).

Note:

ACTION is only meant for Design/Part like structures. If more than one value for a

given property can determine the action, the operator OR ('|') can be used as follows:
"KEY:<BOMLinePropertylnternalName>,VALUE:<PropertyValue1>,ACTION:<ActionValue1>|
VALUE:<PropertyValue2>,ACTION:< ActionValue2>" (e.g. "KEY:GCS CP,VALUE:Make|
VALUE:MakePart,ACTION:PartAssign|VALUE:MakeLink,ACTION:PartLink"). If there is no
preference value, the item is shared between Engineering BOM (EBOM) and
Manufacturing BOM (MBOM) structures.

A common criteria may be, for example, whether you make or buy a part. Any parts designated as
Make or Phantom (for organizational purposes) in the EBOM are replaced by manufacturing-specific
parts in the MBOM. In this case, the value of this preference may look like this:

KEY: Usage_MakeOr Pur chase, VALUE: Make| VALUE: Phant om

You can use a custom property in this preference. If you do not assign any value, the utility carries
over the parts from the EBOM directly.
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Note:

You should write your own Business Modeler Framework extension to control a make or buy
decision.

* MEMBOM_Mirror_TypePrefixSuffix

This preference specifies the item type for the new manufacturing-specific item and any prefix or suffix
to add to the item ID of the part in the EBOM that is being replaced by a new part in the MBOM.

If you use custom manufacturing business object types, you can add this type to the value of this
preference.

The default value of - usenf k is false. If true, and only the object type is present in
MEMBOM_Mirror_TypePrefixSuffix, use that type and the ebom item id for MFK value. If you set
the command line option - usenf k to t r ue and specify only the item type, you can enter multifield
keys.

If your company uses naming rules for new items, you must ensure that the prefix that you assign

in this preference corresponds to the naming rules for the manufacturing item. Alternatively, you can
remove all naming rules for manufacturing items. A conflict with item naming rules leads to this error
message:

ERROR on line:250 creating mbom
T4006: Ualid pattern is aannnnnn. creating mbom

THOOT: Supplied item_id value "M_gp130410" is invalid. creating mbom
7007: Invalid Tag - the requested object does not exist creating mbom

* MEMBOM_Mirror_ReplaceMakeOnChange

This preference specifies the behavior when, after creation of an MBOM, you change a make/buy
property value from Make to Buy. At update, by default, Teamcenter simply appends the buy part to
the existing structure without removing the make part already in the MBOM. If you set this preference
to TRUE, at update, Teamcenter replaces the make part in the MBOM with the buy part from the
EBOM, avoiding duplication of parts.

* MEMBOM_Mirror_RemoveLineWithIDIC

This preference is applicable to updating an MBOM with the utility. It specifies that if the in-context ID
(IDIC) of a line in the MBOM is not found in the EBOM, or if a line in the MBOM has no IDIC, it is not
removed at update if it is already stamped with an IDIC.

* MEMBOM_Mirror_IDICOnChildren
This preference determines whether the IDIC is retained on a make part in the MBOM when updating

it using the utility after changing a make part to a buy part in the EBOM. When updating, if the
MEMBOM_Mirror_ReplaceMakeOnChange preference is set to FALSE, both the original make part
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and the buy part exist in the MBOM after updating. This causes the accountability check to display
multiple matches. Removing the IDIC on the make part ensures that there is only one match in an

accountability check. If the MEMBOM_Mirror_ReplaceMakeOnChange preference is set to TRUE,
the make line is replaced with the buy line from the EBOM so this preference is irrelevant.

* MEMBOM_Mirror_lgnoreRules

This preference uses the keyword ACTION to skip an EBOM node or to traverse below an EBOM node
while ignoring that EBOM node. The children of the traversed EBOM node become the children of the
corresponding MBOM parent.

* MEMBOM_Mirror_AlignProperties

This preference controls which properties and attachments are copied from the EBOM to the MBOM
by enabling the alignment of properties on Make items and revisions. The Make nodes are of
different types than the original EBOM nodes.

The following examples of running the utility demonstrate its use and the differences in output caused
by changing the utility arguments. The initial values of the preferences are as follows.

MEMBOM MakeRul es=KEY: Usage_Product, VALUE: Make| VALUE: Phant om
MEMBOM RenpveLi neW t hl DI C=FALSE

MEMBOM TypePr ef i xSuf fi x=Conpany, ,

Note:

No prefix is used in this course due to the naming rule conflict.

Creating an MBOM

For the following EBOM:
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(002028 1-CAR. EBOM

't Latest Working '*' Today

Not Speciied #» Not Spedfied €= Not Spec

% 000202/A;1-CAR EBOM {View) .
- % 000203/A;1-Body (View) Buy
B 000214/A; 1-Chassis (View) Buy
- 000224/ A; 1-Powertrain (View) Fhantom
=% 000225/A;1-Transmission (View) Fhantom
% 000226/A;3-Drive Gears Make
% 000227/A; 3-Makor Make
L% D00228/A;3-Reducer Gears Make
B %% 000229/A;2-rear_drive_asm (View) Make
4 000230/A;2-rear_axde Buy
4 000231/4;2-rear_drive_housing Make
% 000232/A; 2-main_drive_gear Buy
% 000233/4;3-power pack case Make
A 000235/A; 3-rovr servo remote control Buy
=] -"; 000236/A; 1-Power Source [View) Fhantom
% 000237/A;2-battary pack Buy
- % 000238/A;2-Wheel and Tire Asm (View) Buy
- % D00246/4; 1-Steer and Contral (View) Bury

Run the utility:

nme_cr eat e_nbom - u=user-name - p=password - g=group -ebonr oot =000202
-revrul e="Lat est Working" -nrevrul e="Latest Working"

Produces the following MBOM:

(%, M_000202-M_CAR EBOM 53 ™ e Dl
! Latest Working %' Today ™ Not Speciied * Mot Speciied €

BOM Line | usage_Make0...
5 M_D00202/A;1-M_CAR EBOM (View)
&% 000203/A;1-Body (View) By
& & D00214/4;1-Chassis (View) Buy
B8 M_000224/4;1-M_Powertrain (View) Phantom
= m_nnazzsm 1-M_Transmission {View) Fhantom
5 M_000226/A; 1-M_Drive Gears Make
5 M_000227/A; 1-M_Motor Make

s M_D00228/A; 1-M_Reducer Gears Make
[ % M_000229/A; 1-M_rear_drive_asm (V... Make
5 M_D00233/A; 1-M_power pack case Make

% 000235/A;3-rovr servo remote control  Buy

".a M_000236/A;1-M_Power Source (View)  Phantom
B % 000238/A;2-Wheel and Tire Asm (View) Buy
% D00246/A;1-Steer and Contral (View) Buy

Note the following:
* The top-level node is replaced with a manufacturing-specific part.

* The make and phantom parts are replaced with new manufacturing-specific parts.

Part Planner, Teamcenter 2412
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* The buy parts of the EBOM are directly copied over to the MBOM.

* An IDIC is generated for all parts except for those below a buy part.

* The in-context ID (IDIC) of the new parts is the same as the original part in the EBOM. This is true if
the IDIC is already present in the EBOM part.

* When you right-click the top node of the EBOM or MBOM and choose Link/Associate—>Link
Structures, you can see that the utility has linked the two structures.

Creating the MBOM to a specific level

For the following EBOM:

Run the utility:

% 000202/A;1-CAR EBOM 53

B2 elvvTRYE

""" Latest Working ‘% Today = Not Specfied £ Not Speciied €= Not Spe

BOM Line

| usage_MakeOrPurc.

% 000202/A;1-CAR EBOM (View)

% 000203/A;1-Body (View)

% 000214/A;1-Chassis (View)

%4 000224/A;1-Powertrain (View)

% 000225/A;1-Transmission (View)

s 000236/ A;1-Power Source (View)

% 000238/A;2-Wheel and Tire Asm (View)
-5 000246/A;1-Steer and Control (View)

{3

B8

Buy
Buy
Fhantom
Phantom
Fhantom

Buy
Buy

nme_cr eat e_nbom - u=user-name - p=password - g=group - ebonr oot =000202
-revrul e="Latest Working" -nrevrul e="Latest Wrking" -depth=2

Produces the following MBOM:

B M_000202-M_CAR EBOM X

it CIPIEaL

& Latest Working ¢! Today ™ Not Specified #* Not Specfied €= Not Spec

BOM Line

| usage_MakeorPurc..

5 M_000202/A;1-M_CAR EBOM (View)
3 < 000203/A;1-Body (View)
-4 000214/A; 1-Chassis (View)
5 M_000224/A;1-M_Powertrain (View)
% M_000225/A;1-M_Transmission (View)
% M_D00236/A;1-M_Fower Source (View)
B 000238/4;2-Wheel and Tire Asm (View)
4 000246/A;1-Steer and Control (View)

B

i

&

Buy
Buy
Fhantom
Phantom
Fhantom
Buy
Buy
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Note that the new MBOM contains only two levels of structure. The remaining levels in the EBOM are

Updating the MBOM from a specific line

You now update the MBOM above, but only for the M_000225 line and down, requiring the following

utility command:

nme_creat e_nbom - u=your-user-name - p=your-password - g=your-group
- ebonr oot =000202 - scopei d=000225 -revrul e="Lat est Wbr ki ng"
- mbonr oot =M 000202 - nrevrul e="Lat est Wbrki ng"

The utility creates the following MBOM:

B M_0

WL02-M_CAR EBOM X

U P e v TR

* Latest Working ¢ Today ™' Not Specfied #» Not Specified €= Not Specified

BOM Line

| usage_makeo...| I In Context (Top L...|

% M_000202/A;1-M_CAR EBOM [View)

&% 000203/A; 1-Body (View) Buy OMOZNj7SMAQDSD
#-% 000214/A; 1-Chassis (View) Buy tECRV_0WMAQpgB
= M_I:}DI:IZZ-HA‘L M_Fowertrain Wew] Fhantom crsanummqm
BM unnzzﬁm 1= M_Drm Gears Make W.ZBHQME'Td‘tﬂHD
5 M_000227/A;1-M_Motor Make yaTBNgMSYdinHD
& M_000228/A; 1-M_Reducer Gears Make YYXBNgMSYdinHD
£ M_000226/A;1-M_rear_drive_asm (Vie... Make isdENgMaY dinHD
5 000230/A;2-rear_axle Buy nxnbwu2 BMAQSdA
% M_D00231/A; 1-M_rear_drive_housing Make WVSbLLTSMAwWn(C
4 000232/A;2-main_drive_gear Buy DY gKSEIMAwWDID
5 M_000233/A:1-M_power pack case Make YEVBNgMIYdtaHD
5 D00235/A;3-rowr servo remote control  Buy yKRBNQMIYdtnHD
B M_D00236/A;1-M_Power Source [View) FPhantom 2BrvS3diMagdyB
H- 4% 000238/A;2-Wheel and Tire Asm [View) Buy AFtdPeVHMAwWSoD
-4 000246/A;1-Steer and Control (Wiew) Buy 2Z941zpbMAwgmD

Changing Make to Buy and Buy to Make in the EBOM

For the following EBOM and MBOM:

% v 5] % [ 2% B T = O (3, M_000202-M_CAR EBOM 23 B0 elvw R0
Lat'estWoﬁhg“Today“ Not Spediied ** Not Spedfied €= Not Spedified ¥ Latest Working ' Today ¥ Not Spedied ™ Not Speciied € Not Spechied
BOM Line | usage_Makeo...| ID In Context (Top Level) BOM Line | usage_Makeo...| ID In Context
4 000202/4;1-CAR EBOM (View) & M_0D00202/A;1-M_CAR EBOM (View)
&% 000203/A;1-Body (View) Buy OMOZNJ7SMAQDSD &% 000203/A;1-Body (View) Buy OMOZNJ7SMAQDSD
B % 000214/A;1-Chassis (View) Buy ECRV_0WMAQpgS &% 000214/A;1-Chassis (View) Buy TECRV_OWMAQpPIR
000224/A;1-Powertrain (View) Fhantom gCfRB37bMAAQYD -5 M_000224/A;1-M_Powertrain (View) Fhantom gCfBB37BMAAQYD
% 000236/A;1-Power Source (View) Phantom 28rvS3dfMagdyB B % M_000225/A;1-M_Transmission (View) Phantom 2KLGeelMAQZC
=% 000225/A;1-Transmission (V.ew) Fhantom ZIKLGce:lMAQuzC % M_000226/A;1-M_Drive Gears Make YUZBNgMIYdINHD

Make W e M_D00227/A;1-M_Motor Make yoTBNgMSYdinHD
£ nunzzs;n 3-Reducer Gears Make y‘{XBHgMB\'ﬂmHﬂ ¥ M_D00228/A;1-M_Reducer Gears Make YYXBNgMIYdnHD
5 000227/A;3-Motor Make YATENgMIYdinHD (-8 M_D00229/A; 1-M_rear_drive_asm (Vi... Make IsdBNgMIYdtnHD
% 000233/A;3- ok w—.sz MOV HD L M_000233/A;1-M_power pack case  Make YVBNGMIYdtnHD
00¢ e ) % 000235/A;3-rovr servo remote control  Buy YKRENGMIYdtnHD
&% 000229/A; 2-rear_drive_asm [\llewj lstNgMQ“!’deﬂ % M_000236/A;1-M_Power Source (View)  Fhantom 2BrvS3diMAgdyB
- < 000238/A;2-Wheel and Tire Asm (View) Buy AFtdPeVHMAWS0D %% 000238/A;2-Wheel and Tire Asm (View) Buy AFtdPeVHMAWSEOD
- % D00246/A;1-Steer and Control (View) Buy ZZ941zpbMAWgmMD &% 000246/A;1-Steer and Control (View) Buy ZZ94LzpbMAwgmD
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You change the Make value to Buy for the drive gears and change the Buy value to Make for the rcvr
remote control in the EBOM and run the utility as follows:

me_cr eat e_nbom - u=user-name - p=password - g=group - ebonr oot =000202
-scopei d=000225 -revrul e="Latest Working" -mnbonroot=M 000202
-nrevrul e="Lat est Wrking" -update

The results are as follows:

(7 000202/A;1-CAR EBOM £1 513 elv[v% =0 PER “M_CAR EBOM x S 1% ev[vRT=0
! Latest Working ¢\ Today ¥ Not Spediied ** Not Speciied €= Not Specfied ¢ Latest Working ¢ Today ¥ Not Specfied * Not Speciied £ Not Specified
BOM Line / [usage_makeo...| D In Context (Top Level) BOM Line [ usage_makeo...] I In Context
“ 000202/A;1-CAR EBOM (View) % M_000202/A;1-M_CAR EBOM (View)
&% 000203/A;1-Body (View) Buy OMOZHj7SMAQDSD &% 000203/A; 1-Body (View) Buy OMOZN{75MAQDSD
=% 000214/A;1-Chassis (View) Buy ECRV_0WMAQpgE 000214/A;1-Chassis (View) Buy HECRV_OWMAQpgB
=1 % 000224/A;1-Powertrain (View) Phantom gCreB37bMAAQYD M_000224/A;1-M_Powartrain (View) Phantom gCfB837bMAAQYD
=% 000225/A;1-Transmission (View) Phantom 2IKLGee1MAQIZC = Tran fiewi) Phantom 2|KLGce1MAQIZC
4 000226/A;3-Drive Gears Buy YUZBNGMIYdinHD — 000226/A;3-Drive Gears Buy YUZENgMSYdtnHD
% 000227/ A;3-Motor Make YgTBNgMIYdtnHD 5 M_000226/A;1-M_Drive Gears Make YUZBNgMSYdtnHD
% 000228/A;3-Reducer Gears Make YYXBNgMIYdtnHD B M_000227/A;1-M_Motor Make ygTENgMIYdtnHD
B4 000229/A; 2-rear_drive_asm (View) Make ISdBNgMSYdtnHD 5 M_000228/A;1-M_Reducer Gears Make YYXBNGMSYdtnHD
4 D00233/A; 3-power pack case Make YCVBNgMSYdtnHD H -5 M_000229/A;1-M_rear_drive_asm (Vi... Make isdBNgMaYdtnHD
# 000235/A; 3-rovr serve remote control - Make ykRENGMOYdtnHD —— % M_000233/A;1-M_power pack case Make YEVENgMOYdtnHD
®- % 000236/A;1-Power Source (View) Phantom 2BrvS3dfMAgdyB | % M_000235/A;1-M_rovr servo remote ... Make ‘ YKRBNgMSYdtnHD
® % 000238/A;2-Wheel and Tire Asm (View)  Buy AFtdPeVHMAWSOD % M_000236/A; 1-M_Power Source (View)  Phantom 2BrvS3diMAgdys
%% 000246/A;1-Steer and Control (View) Buy 2Z9412pbMAWgmMD % 000238/A;2-Wheel and Tire Asm (View) Buy AFtdPeVHMAWSOD
#- % 000246/A; 1-Steer and Control (View) Buy 27941zpbMAWGmMD

When the rcvr remote control part is changed from a Buy to a Make, the utility replaces the buy partin
the MBOM during update. Buy to make behavior is not affected by preference settings. For the make to
buy change (the drive gears), the behavior depends on two preferences:

* The MEMBOM_Mirror_ReplaceMakeOnChange preference is set to FALSE. The make part is not
removed from the MBOM. The buy part is added to the structure.

The IDIC values on the make part are determined by the MEMBOM_M irror_IDICOnChildren
preference.

* [f MEMBOM_Mirror_IDICONnChildren is set to FALSE (or does not exist), the IDIC on the make part
in the MBOM is retained. Performing an accountability check between the EBOM and MBOM results
in multiple matches as the MBOM contains both a make and a buy part with the same IDIC.

* [f MEMBOM_Mirror_IDICONnChildren is set to TRUE, the IDIC on the make part in the MBOM is
deleted and an accountability check displays the make part as missing in source.

Caution:

You must exercise caution when removing an IDIC on any part. This can cause problems in
other areas, for example, if the part is consumed in an process structure, you lose the link to
that line.

* The MEMBOM_Mirror_ReplaceMakeOnChange preference is set to TRUE.

The buy part (drive gears) replaces the make part. The result of the MBOM after update is as follows:
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%, 000202/A; 1-CAR EBOM £3 ™, % 52w elw% % 20 DK ¥ M X S hle v R0
! Latest Working "¢ Today ' Mot Speciied *~ Not Specfied €2 Not Speciied ¢! Latest Working ¥ Today ' Mot Specied ¥* Not Specfied €2 Not Speciied
BOM Line / |usage_makeo...| ID In Context (Top Level) BOM Line | usage_makeo...| 1D In Context
% 000202/A;1-CAR EBOM (View) # M_000202/A;1-M_CAR EBOM (View)
B 000203/A; 1-Body (View) Buy OMO2Nj75MAQDSD OMO2ZNj75MAQDSD
=% 000214/A;1-Chassis (View) Buy ECRV_0WMAQpgB LECRV_0WMAQpgB
B 000224/A;1-Fowertrain (View) Phantom gCfBB37bMAAQYD gCf8837bMAAGYD
=¥ 000225/A;1-Transmission (View) Phantom 2IKLGce1MAQIZC
< 000226/A;3-Drive Gears Buy YUZBNgMIYdtnHD % 000226/A;3-Drive Gears YUZBNgMIYdtnHD
“ 000227/A;3-Motor Make ygTENgMSYdtnHD 5 M_000227/A;1-M_Motor Make ygTBNgMSYdtnHD
% 000228/A;3-Reducer Gears Make YYXBNgMIYdtnHD & M_000228(A;1-M_Reducer Gears Make ¥YHBNgMIYdtnHD
#- % 000229/ A;2-rear_drive_asm (View) Make IsdBNgMIYdtnHD -5 M_000229/A; 1-M_rear_drive_asm (Vi... Make isdBNgMSYdtnHD
5 000233/A;3-power pack case Make YCVBNgMSYdtnHD ¥ M_000233/A;1-M_power pack case Make YEVBNgMSYEtNHD
% 000235/A; 3-rovr servo remote control  Make ykRBNgMSYdtnHD | - H M_000235/A;1-M_rovr servo remate ... Make YKRBNgMOYStnHD
® % 000236/A;1-Power Source (View) Phantom 2BrvS3dfMAgdy8 % M_000236/A; 1-M_Power Source (View)  Phantom 28rvS3dfMAgdyl
&% 000238/A;2-Wheel and Tire Asm (View) Buy AFtdPeVHMAWS0D - 000238/A;2-Wheel and Tire Asm (View)  Buy AFtdPeVHMAWSOD
- % 000246/A;1-Steer and Control (View) Buy 22941zpbMAvwgmD &% 000246/A; 1-Steer and Control (View) Buy 2Z941zpbMAvegmD

In summary, the behavior of the preferences is as follows:

MEMBOM_Mirror_ReplaceMakeOnChange FALSE The buy part is added to MBOM and
the previous make part is kept in the

MEMBOM_Mirror_IDICOnChildren TRUE structure but its IDIC is removed.

MEMBOM_Mirror_ReplaceMakeOnChange FALSE The buy part is added to MBOM and

. . the previous make part is kept in the
MEMBOM_Mirror_IDICOnChildren FALSE structure but its IDIC is not removed.

MEMBOM_Mirror_ReplaceMakeOnChange TRUE The buy part is added to

MBOM and the previous make

part is removed in the structure,
irrespective of the value of
MEMBOM_Mirror_IDICONnChildren.

MEMBOM_Mirror_IDICOnChildren TRUE/FALSE

Updating a released node in the MBOM

In the following EBOM and MBOM, M_000229/A;1-M_rear_drive_asm is released and then the
make/buy property on its child, 000230/A;2-rear_axle, is changed from Buy to Make.

& 000202/A;1-CAR EBOM x % W 2% e w9 % T = 0O (% M_000202-M_CAR EBOM 53 S [elv[v R0

¥ Latest Working " Today % Not Specfied #* Not Specfied €= Not Spectied ¥ Latest Working "¢ Today ™ Not Specfied ¥ Not Specified €2 Not Spectied
BOM Line / [usage_Mateo...] Rem Rev Status [ID In Context (Top L... BOM Line [usage_makeo...| Rem Rev status [

% 000202/A;1-CAR EBOM (View) % M_000202/A;1-M_CAR EBOM (View)

B4 000203/A;1-Body (View) Buy OMOZN]7SMAQDSD &% 000203/A;1-Body (View) Buy or
- % 000214/A;1-Chassis (View) Buy tECRV_0WMAQpgE &% 000214/A;1-Chassis (View) Buy tE
- % 000224/A;1-Powertrain {View) Fhantom gCfBB37bMAAQYD = M_000224/A;1-M_Powertrain (View) Phantom gt
=% 000225/A;1-Transmission (View) Phantom 2IKLGeelMAQIZC =¥ M_D00225/A;1-M_Transmission (View)  Phantom 2l
% 000226/A;3-Drive Gears Buy YUZBNgMOYdtnHD % 000226/A;3-Drive Gears Buy ¥
YGTBNGMSYdtnHD % M_000226/A; 1-M_Drive Gears Make i
YYXBNgMYdtnHD % M_000227/A;1-M_Motor Make ¥
isdBNgMOYdtnHD #: M_000228/A; 1-M_Reducer Gears Make ¥
nonMwu2BMAQSdA =% M_000229/A;1-M_rear_drive_asm (... Make TCMReleased i
WVSBLLTSMAWNIC % 000230/A;2-rear_ade Buy [
% 000232/A;2-main_drive_gear Buy DYqKSBxIMAWDID 5 M_000231/A;1-M_rear_drive_ho... Make w
< 000233/A;3-power pack case Make YCVENgMEYdtnHD % 000232/A;2-main_drive_gear Buy [
% 000235/A;3-rovr servo remote control Make YKRENGMOYdtnHD % M_000233/A;1-M_power pack case  Make ¥y
B4 000236/A;1-Power Source (View) Phantom 2BrvS3dfMAgdyB “ 000235/A;3-rovr servo ramote control Make ¥k
B % 000238/A;2-Wheel and Tire Asm (View) Buy AFtdPeVHMAWEOD % M_D00235/A;1-M_rovr servo remote... Make vk
B %% 000246/A;1-Steer and Control (View) Buy zZ941zpbMAvgmD 5 M_000236/A;1-M_Powver Source (View) Phantom 2F
&% 000238/A;2-Wheel and Tire Asm (View) Buy Al
&% 000246/A;1-Steer and Control (View) Buy i

You revise the MBOM part so you have write access and run the update utility.
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You run the utility with the -actiononrelease argument set to 2.

nme_cr eat e_nbom - u=your-user-name - p=your-password - g=your-group
- ebonTr oot =000202 - scopei d=000225 -revrul e="Latest Wrking"
- mbont oot =M 000202 -nrevrul e="Lat est Wrking" -actiononrel ease=2 -update

The results are as follows:

% w3 % e w5 R0
% Latest Working ‘& Today ' Not Specfied = Not Specified €2 Not Speciied

BOM Line | usage_MakeQ...| Tem Rev Status | ID In Context
% M_000202/A;1-M_CAR EBOM (View)
B % 000203/A; 1-Body (View) Buy OMOZNj75SMA

& M_000202-M_CAR EBOM X

B % 000214/A;1-Chassis (View) Buy tECRV_0WM:2
Bl M_D00224/A;1-M_Powertrain (View) Fhantom gCfaBI7hMAL
=% M_D00225A:1-M_Transmission (View) Phantom 2KLGeal MAG
& 000226/A;3-Drive Gears Bary YUZBNgMOYdl
o M_000226/A;1-M_Drive Gears Make yUZBNgMOYd
% M_000227/4;1-M_Motor Make yaTENgMIYdi

% M_000228/A;1-M_Re

ducer Gears

= 5 r_drive_a

. 1= B,

% M_000231/A;1-M_rear_drive_ho... WVSBLLTSM;

< 000232/A;2-main_drive_gear Buy DvgKSEadmA

S M_000233/A;1-M_power pack case  Make yoWVENgMaYdt

5 D00235/A;3-rovr servo remote control Make ykRENgMOYdt

% M_D00235/A;1-M_rovr servo remote... Make ykRENgMIYdt

5 M_000236/A;1-M_Power Source (View) Fhantom 2BrvS3dfMAg

- 000238 A; 2-Wheel and Tire Asm (View) Buy AFtdPeVvHMA

B % 000246/4;1-5teer and Control (View) By 2704 TzpbMAw

The utility revises the part and replaces the old revision with the new one.
Changing properties in the EBOM

To detect property changes in the EBOM, run an accountability check between the EBOM and MBOM.
You can propagate any property differences using the accountability check mechanism.

Attachments

Attachments are always synchronized as the attachment is created as a reference on the new make part.
Any changes to the attachments on the EBOM side are automatically reflected in the MBOM. If you add a
new attachment to the EBOM, you must run the update to see it in the MBOM part.

In-context authoring
Cloning, copying, and replacing in-context assemblies

When you edit an assembly in context, you can modify occurrence properties of the lines beneath the
top selected line in the context of that line only. No matter how many places the in-context lines occur
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under other top structures, the changes will only affect this line. For more information on in-context
editing, see Performing in-context editing.

If you have an assembly with in-context edits that is almost identical to another required assembly—for
example, you have a parent with a specific occurrence effectivity and you need to create a new parent
with different effectivity—you can save time by using one assembly as a template for another. In MBOM
Product or Workarea views, you can:

* Use the Clone Assembly in Context to split an MBOM structure into two structures by cloning it
within the same MBOM. You can also copy, reference, or exclude attachments from the structure
being cloned and change the occurrence effectivities of both the items being cloned and the cloned
structure.

* Copy an assembly with in-context edits and paste it elsewhere in the same MBOM using the Paste
Assembly in Context command. This command creates a new absolute occurrence of the assembly
while retaining in-context edits and attachments. Standard Teamcenter copy and paste commands do
not retain any edits made in the assembly in the context of the parent lines above the line you are
copying and pasting, so without this capability, you would have to remake these missing in-context
edits.

To define different item types for different manufacturing nodes or simply change the item type of a
manufacturing node because your manufacturing plan has changed, use the Replace Assembly with
Any Item Type command. This command replaces the top item of an assembly with an item of a
different item type and retains the original item's in-context edits. Using this command, you can also
copy, reference, or exclude attachments from the original item.

Clone an in-context assembly

You can clone an assembly with in-context edits from a line in an MBOM to a different line in the same
MBOM. This command:

* Retains all in-context edits in the cloned assembly.
* Lets you copy, reference, or exclude in-context attachments from the structure being cloned.

* Optionally splits occurrence effectivity dates or ranges between the assembly being cloned and the
cloned assembly.

Note:

» Existing BOM lines are not changed, only direct attachments that are on new items that are
cloned. This command can also control in-context attachments in the cloned structure.

* Cloning rules are defined by your administrator using the
MECopyAssemblylnContextTemplates preference. This preference points to the
Item.ltem.CopyAssemblylnContext preference, which lists the cloning rules for the case in
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which the source is the first item and the target is the second item. By default, all items are
cloned. Your results may not follow the same rules as those in this example.

If you are editing in context, hide in-context editing mode.

In the MBOM Product or Workarea view, select the line to be cloned.

| BOM Line | Find Mao. | Occurrence Effectivity | Absolute Transformation Matrix |
| %5 DDMGL/AL-TopLline (View) 1000010000100001
| = 002462/ 4:1-c1 (View) 1000010000100001

SRR 002482/ Al =) (View) 1-20 (002461) 1000010000100001

5% po2483/4141 %12 1000010000100001

%% 0024847812 0 %2 1000010000100201
= ¥ 002551041 -Plan (Wiew) 40 1000010000100001
% 002552/A:1- €1 (View) 10 1000010000100001

Choose Edit—In Context—>Clone Assembly in Context.
In the Clone Assembly In Context dialog box, the selected line is displayed in the Copy Of box.

In the same MBOM, select the equivalent line to which you want to clone the assembly, and next to
the Paste To box, click »=".

Click Next.

(Optional) In the Assign information section, in the ID box, type an ID or click Assign, and
optionally, in the Name box, type a name for the cloned assembly.

If you do not type a name, the assembly inherits the name of the structure you selected in step 2.
Click Next.

For each attached object, in the Define Attached Objects section, from the Copy Option column,
select how the attachments should be handled.

* Copy Reference creates a reference to the object attached to the structure that you are cloning.
* Copy Object copies the object to the cloned structure.
* No Copy creates neither a reference or copy of the object in the cloned structure.

Click Next.
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10. (Optional) In the Related Objects Information section, expand the related structure items being
cloned, type or assign new item revision IDs or related object names, and modify any user data as
needed.

If you do not change the revision IDs, they are automatically assigned. If you do not change the
related object names, they retain the names of the structures being cloned.

11. Click Next.
12. (Optional) In the Occurrence Effectivity Cutback section, set occurrence effectivity.
a. Toseta new effectivity for:
* The structure being cloned, click &, next to the original assembly.
* The cloned assembly, click @&, next to the cloned assembly.

b. Inthe Occurrence Effectivity dialog box, define the appropriate effectivity for the structure
being cloned or the cloned assembly.

13. Click Finish.

The assembly is cloned with all in-context edits intact.

"*. Latest Working ‘£ Today ™% Mot Specified £% Not Specified
| BOM Line ] Find No. | Occurrence Effectivity | Absolute Transformation hatr: |}

. A, D0MGL/AL-Tapline (Wiew) 1000010000100001
=B 002462/ 8:1-c1 (View) 10 1000010000100001
= W 002482/ AcL-J (View) 10 1-20 (D02461) 1000010000100001
%0 002483741k %12 1000010000100001

L% 002484/ 8.1 -jik2 i %5 1000010000100201
= «‘JIJDESL'A-,L-PIM{I.'EMJ 40 1000010000100001
S0 2552/ Al -c1 (View] 1000010000100001
(=% 00256278 1-k (View] 10 1000010000100001
4% 003 Al-d %o 12 1000010000100001

| A0 nomBa/At k2 20 T 1000010000100201

Copy and paste an in-context assembly

You can copy an assembly with in-context edits and paste it elsewhere in the same MBOM. This
command creates a new absolute occurrence of the assembly while retaining in-context edits and
attachments.
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Note:

Cloning rules are defined by your administrator using the combined
MEDuplicateAssemblylnContextTemplates and Item.ltem.DuplicateAssemblylnContext
preferences. Your rules may not match the rules in this example.

1. If you are editing in context, hide in-context editing mode.

2. In the MBOM Product or Workarea view, right-click the line to be copied and choose Copy.
3. Inthe same MBOM, right-click the equivalent line to which you want to paste the assembly.
4. Choose Edit->In Context—>Paste Assembly in Context.

A new instance of the assembly is created with all in-context edits and attachments as specified in the
cloning rules intact.

Replace an in-context line or assembly with a new item type

You can replace a manufacturing bill of materials (MBOM) or bill of equipment (BOE) line or assembly
with a new item that has a new item type and retain the original line's or assembly's in-context edits.
The procedure is similar to the File->New item command, but lets you retain in-context edits and also
copy, reference, or exclude attachments from its original structure.

Since by default you cannot copy and paste items from the plant structure to the process structure as
anything other than the type item, you can use the Replace Assembly with Any Item Type command
to create a new item of a different item type and that type becomes the default paste option. For
example, you could use the command to replace the item type as a resource (MEResource occurrence
type) and the system lets you copy and paste items as resource by default.

Note:

Cloning rules are defined by your administrator using the combined
MEReplaceAssemblylnContextTemplates and Item.Iltem.ReplaceAssemblylnContext
preferences. Your rules may not match the rules in this example.

1. If you are editing in context, hide in-context editing mode.

2. Inthe MBOM or BOE Product or Workarea view, select the in-context line/assembly for which you
want to change the item type.
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A Warkares #1

DR e
L Latest Warking 'E. Today ™' Mot Specified #% Mot Specified
Fer 000204/8:1-bom (View)
BOM Line | Quantity | Item Description
| 000294781 -bam (View)
El-# 000298/8:1-assemblies (View)
& 10030872 1-parts
% 00030942 1-parts
B9 00031/AL-newhode (Viewd
SRR 00707 /28 1-assernblies (View) S
5% 000304/8:1-parts x5 0§
4 00030574 1-parts
A 0003064 1-parts
g IR B e

3. Choose Edit—>In Context—->Replace Assembly with Any Item Type.
4. Inthe New Item dialog box, select the new item type and click Next.
5. Inthe ID and Revision boxes, type an ID and revision or click Assign.
6. Inthe Name box, type a name for the new item and click Next.

Properties from the in-context line or assembly for which you want to change the item type, such
as name, description, and unit of measure, are prepopulated. Your administrator can map common
item and revision properties between item types, and define custom item types and properties,
using the MEReplaceAssemblylnContextAlignProperties preference.

If you click Next, the remaining prompts are similar to those in any New Item dialog box. You may
click Finish at any time to accept defaults. Some attributes are prepopulated with the attributes of
the original in-context line/assembly. Clicking Next lets you modify the defaults.

7.  Click Finish.

The selected line is replaced with the new item type, ID, revision, and name, with all in-context edits
intact.

Now when you use the Copy, Paste, Copy As, or Paste As commands, the new item type is the default
when you paste.
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PRI (O & 1707t x N IRE]

5 & I
1 Latest"ﬂ"url:mg ® Tnday bl Nut"Spe.r.;.lfled #a Mot Spetlﬁed
Fr 000294/8;1-bora (View)
' BOM Line | Quantity | Ttem Description
% 000294/8:1-bam (View)
[=1- %% 000298/2:1-assemblies (Wisn)
& D00308/8:1-parts

% 000308/8;1-parts
[=1- %% 000310 8 -newiMode (Wiew)
SRR o) S TINOTE-000006/2 1., pueat desceiption
5% 00030478 1-parts x5 W S
< DOO305/2:1-parts
5 000306/2:1- parts
= UL SUDFAL- PANTS

Creating process structures

About process structures

A process structure describes how an assembly or part is manufactured. Processes are structured in
hierarchical parent-child relationships. Sequence relationships can also exist between child processes.

These relationships let you specify both sequential and parallel processes, as shown in the following
figure.

77 000217 /4; 1-process1 (View)

=0 000218/4;1-prl (Yiew)

E+ @ 00022174, 1-0p1 (View)

I HE= A 00022974, 1-pd
.= i}}@@ 1

= g 000222/4;1-0p2 (View)
e 00022848103
e 0002268, 1-wad (View)
= g 000223/8; 1-0p3 (View)

----- HE= A 000227 /6,102

..... i:}@@. 1

----- ‘tg== 000225/4;1-wa3 (View)
----- - Dl:ll:lzlgm 1-

ﬁ@@ |:u:u:|224m = WIEW}

Defining process structures

A process is referred to as a composition structure because its configuration is affected by the
configuration of its assigned structures. Although a process is a distinct entity and is revised and
controlled independent of the part or product, lines in the process structure can configure out
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depending on the configuration of the assigned structure. You can specify which open structure
configures the process structure using the Define Configuring Structures menu command.

When you assign a product or part to a process, certain properties of the part are copied over to the
process. You can specify which properties in the MEAssignProperties preference.

By default, when you assign a part to a process, Teamcenter assigns the part using the MEConsumed
type. Your administrator can change the controllingOccsForProcessConfiguration preference to
specify another occurrence type to use for assignment at your site. If this preference is blank, the
configuration of consumed items does not affect the configuration of operations.

Also, by default, if an occurrence type is defined for a BOM line, and you assign the BOM line to a process
or operation, Teamcenter assigns the BOM line using the same occurrence type. However, if your

administrator sets the MEAssignCustomizedOccurrenceType preference, you can specify a different
occurrence type during the assignment.

Create a new process structure

Create a process as a new root object or as a child of another process by selecting the parent process
before you open the New Process dialog box.

1. Choose File->New—Process or click Create a New Process “H.
2. Inthe New Process dialog box, select one of the process types from the list.
3. Click Next.

4.  Enter the ID number to be assigned to this new process. If this new process is a revision of an
existing one, type the ID of the existing process. You can assign a unique revision number in the
Revision box.

To let the system automatically assign a unique ID, click Assign.
5. Type a name for the new process. Make it unique so you can search the database using this term.

6. Select Show as new root to specify that the newly created process is opened as a root object. It is
not pasted to the selected process. If you do not select this option, the new process is pasted as a
child of the selected process.

If the Show as new root option is selected but unavailable, Teamcenter does not allow you to
create a new object under the selected object, for example, if you try to create a work area under a
process.

7. Type a process description.

At this point, you have all the information required to create a new process.
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8.  (Optional) Click Next to add optional information, such as filling out the item's forms, or checking
the process item out of the database.

9. (Optional) Select Define Options to specify the following:

* Select Use item identifier as default display or Use revision identifier as default display if
you created an alternate identifier for the item and want to use it as the default display object.

* Select Check Out Process Revision on Create to check the newly created process out of the
database immediately upon creation.

10. Click Finish to create the new process.

11. Click Close to close the New Process dialog box.

Open an existing process structure
Do one of the following
* Open a process revision in the Part Planner using the Open Process dialog box.

* Find the process revision item in My Teamcenter. Using the mouse, drag it to Part Planner in the
navigation pane, or use the shortcut menu and choose Send To to send the item to Part Planner.

* Open a part revision in Part Planner.

All processes and work areas associated as target to this part open by default if the
MSE_load_related_product_process_plant preference is set to true. However, to enable auto-
loading of all the linked product structures and plant structures to a Bill of Process or Plant Bill of
Process, the MELoadAllLinkedStructures preference should also be set to true.

Process structure example

The following example of a crankshaft rod and piston assembly shows a process structure that involves
both assembly and machining processes, which together describe a manufacturing process.

* Crankshaft assembly — the main process
* Rod and piston — a subprocess
m Assembly — assembly process to assemble the rod and piston
m Rod — subprocess to capture the rod's manufacturing process

¢ Raw material — operation to cut the raw material
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¢ NC machining rough — machining operation to rough the material

¢ Heat treatment — operation to send the rough part through heat treatment to release stresses
¢ NC machining finish — operation to machine the part to its final dimensions

¢ Inspection — operation to inspect the part

m End caps — subprocess to manufacture the end caps. It contains individual operations as shown
in the example above.

m Piston — subprocess to manufacture the piston. It contains individual operations as shown in the
example above.

With the benefit of experience, standard process structures may be developed for your plant.
Templates can be made from these processes to speed the workflow through your organization.

Importing structures using the tcexcel_import utility
Creating structures by importing from Excel
There are two ways to import structures using Microsoft Excel:

* You can populate structures in Teamcenter based on definitions in a Microsoft Excel spreadsheet using
the tcexcel_import utility. The main purpose of this utility is to import process structures, such as
build sequences or process plans, but the utility can also import any type of product, process, plant,
and resource information. Additionally, the utility supports:

* Linking between multiple structures.

* Assigning relations (consumed, required, work area, and resources).
* Attaching forms and filling out attribute values.

* Modifying ownership.

* Defining activities (with time information).

* Attaching variant information.

Remember: The tcexcel_import utility is designed for data creation only. You can set the description
on items and revisions during creation. Once you create an item, you can only update the item
description.
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Note:

Importing an item that already exists in the database can result in BOM duplications or new
revisions. To avoid this problem, set -o (option) = off to update the database item using the
information in the Excel spreadsheet.

Example:

tcexcel_import -u=username -p=password -o=off -i=<file_name>.txt

* You can use Microsoft Excel to import structures from an external source, for example, from a design
contractor that does not have Teamcenter. The structure is defined in an Excel spreadsheet that
Teamcenter validates against a predefined control file to ensure all the necessary data is present. If
the structure subsequently changes, you can reimport the same spreadsheet and update the latest
working data in Teamcenter. You must have Teamcenter Client for Microsoft Office installed to import
or update structures in this way.

Note:

You can only import imprecise structures in this way. Also, the import process does not
configure the structure (for example, by defining revision rules) or set the view, nor does it
support absolute occurrences or incremental changes.

* You can import structures from an Excel file that was exported from Teamcenter using the Work
Offline and Import option in the Export to Excel dialog box. With this option, the control file data is
generated automatically on a separate tabbed sheet in the export file. The control file does not have to
be predefined manually.

Import a spreadsheet into the database

1. Create a Microsoft Excel file with specific headings. The import utility recognizes specific headings
and formats in the Excel file and translates them into Teamcenter structures.

Sample Excel file:
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A B c D E
1 Headerlt Item Item Item Description
2 Header2 Item Item Item
3 Headerd Item Item Item
E Title Root Sub1 Sub?2 Descr
5 Product Root New product for next year
6 Sub Assy 1 Structure Packaging
7 Comp11 Box
8 Comp12 Manual
| Comp13 Package material
10 Sub Assy 2 Structure Engineering
11 Comp21 Product Component 1
12 Comp22 Product Component 2
13 Comp23 Product Component 3
14 Comp24 Product Component 4
15 Comp25 Product Component 5

2. Save the Excel file as a text file.
a. In Excel, click File=>Save to save the Excel file.
b. Choose File->Save as.
c. Inthe Save as type box, select Text (Tab delimited)(*.txt).

Sample .txt file saved from the sample Excel file:

Headerl Item Item Item Description
Header2 Item Item Item
Header3 ILtem Item Item
Title Root Subl Sub2 Descr
Product Root New product for next year
Sub Assy 1 Structure Packaging
Compll Box

Compl2 Manual

Compl3 Package material
Sub Assy 2 Structure Engineering

Comp21l Product Component 1

Comp22 Product Component

Comp23  Product Component

Comp24 Product Component

Comp25 Product Component

[ SRS

d. If you are updating the text file, you are asked if you want to replace the existing file. Click Yes.
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Excel displays a message stating that certain features in your file may not conform to a
tab-delimited text file.

e. Click Yes.

f.  Click File—>Close to close the Excel text file. If a dialog appears requesting that you save the
text file, click No.

The text file is saved in the same directory as the Excel file. This is the input for the import
utility.

Note:

The pipe character (| ) is not permitted within the Excel file. It causes an error in the
import routine.

The structures from the Excel file are imported into the database and you can open them in
Part Planner.

3. Call the tcexcel_import utility to import the Excel file into the Teamcenter database.
a. Open a Teamcenter shell (Teamcenter command prompt).
b.  Change to the import directory where the Microsoft Excel file is stored.
c. Call:
tcexcel_import -u=user_name -p=password -g=group_name -i=my_excel_file.txt

Sample structure created from the .txt file that was saved from the sample Excel file:

o PdeUC’[] & F'rnn::ess] - F'Iant]

[;BOM Line ltern Description
WP 00017074 Product Root (view) Mewr product for next year

EI ’DDD*I?“IIA Sub Assy 1 (view)  Structure Packaging

P e & 00017 2/A-Camp11 Baox
----- & 000173/A-Camp12 Manual

- & 00017 4/A-Camp13 Fackage materal

EI & 000175/A-Sub Assy 2 (view)  Structure Engineering
----- & 000176/A-Camp21 Froduct Component 1
----- & 000177 /A-Campz2 Froduct Component 2
----- & 000178/A-CampZ3 Froduct Component 3
----- & 000179/A-Camp24 Froduct Component 4
----- & 000180/A-Camp2a Froduct Component &
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Creating a simple structure

The import utility recognizes specific row headings along with keywords found in those columns. The
following is a very simple Microsoft Excel input file that creates a process containing a subprocess.

Header1 Item Item Description
Header2 Process Process
Header3 Process Process
Process-Root New Process
sub process1 New Sub-process1
Note:

You can copy the content of HTML tables and paste them into an Excel file to use them as
examples.

The keyword Item results in an item being created with the name listed in the Item column (for
example, Process-Root or sub-process1). Because there are two columns with the header Item, the
utility creates a nested structure—an item inside an item. The Process entries signify the types and
subtypes of the item to be created. This results in the following structure.

Process Structure I term Description I e Type ]

A, 001147/A-Process-Root Mewy Process MEProcess
?‘?, Mew Sub-process MEProcess

A more involved structure is shown in the following example.

Header1 Item Item Item Description
Header2 Process Process OP
Header3 Process Process NCMachining
Tile  Root  Root  Patno.  Descripton
Process-Root New Process
sub_process1 New Sub-process1
OPO1 Read
OP02 Get and place cable
OPO3 Record lot control
OP04 Get from printer and place on carrier
sub_process2 New Sub-process2
OPO05 Get sign and place on carrier
OP06 Set model switch
OPO7 Remove beam from cart
sub_process3 New Sub-process3
OPO08 Lock both sides and latch in place
4-40 Part Planner, Teamcenter 2412
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sub_process4 New Sub-process4
OP09 Get wire harness and position

In this file:

Header1, Header2, and Header3 are mandatory row headings.

The Item columns designate the number of levels in the structure you import. In the example, the
imported structure has three levels, as seen by the three Item columns.

The strings in the Item columns represent the names that are assigned to the newly created items (for
example, sub-process3 or OP08).

The entries in the columns of the Header2 row represent the types of the objects that you create.
The entries in the columns of the Header3 row represent the subtypes. In the example, the third Item
column contains an operation of type OP that uses the NCMachining subtype.

The Description column contains the description for each object you create.
The utility ignores all entries in the row containing the Title heading.

The utility looks for the first entry in the row following the Title row and uses this as the name of

the root object for your structure. In the example, that is the Process-Root entry. You can insert any
number of rows between the row containing Title and the last Header row before it to help organize
your data, but they are ignored by the utility.

If you want to stop the import at a certain point in the Excel file, insert END-OF-PROCESS (case
sensitive) at the desired point in the first column of the spreadsheet. The utility stops importing when
it hits that row.

Converting these Excel file creates the following structure.

Process Structure | ftem Type I ftem Description

Mewy Process

Messy Sub-process

Read

Get and place cable

Record lot cortral

Get from printer and place on carrier
Mewy Sub-process?

Get sign and place on carrier

et model switch

Remaove beam from cart

Mewy Sub-processd

Lock bath zides and latch in place
Mewy Sub-processd

Get wire harness and position

Part Planner, Teamcenter 2412 4-41
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By default the item IDs are assigned automatically. You can also specify item IDs or item revision IDs.

All of this information holds true for other types of structures. The following example shows a product
structure that is imported by the utility.

Header1 Item Item Item Description
Header2 Item Item Item
Header3 Item Item Item
Tidle Rt Name  Name.  Descripton
Product New Product
Sub_Assy1 New_Sub_Assy1
Part1 Desc of Part1
Part2 Desc of Part2
Part3 Desc of Part3
Part4 Desc of Part4
Sub_Assy2 New_Sub_Assy2
Part5 Desc of Part5
Part6 Desc of Part6
Part7 Desc of Part7
Sub_Assy3 New_Sub_Assy3
Part8 Desc of Part8

This results in the following structure.

List of keywords

Header1 Header2 Header3 Data value Remark
Item item_type item_subtype item_name The BOM line values define the item
name.
Item MEActivity MEActivity activity_name Adds an activity to an operation.
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Header1 Header2 Header3 Data value Remark

Activity Description - description Specifies the activity description.

Activity Time - time Specifies the activity duration.

Activity Unittime - number Specifies the activity unit time.

Activity Frequency - number Specifies the activity frequency.

Activity Category - VA, NVA, NVABR Specifies the activity category.

ActivityForm form_name form_attribute_ attribute_value Adds a form to the activity and enters
name the attribute value.

ItemID - - item_ID Autogenerates an ID if the item ID

value is empty.

ItemID - - M:store_marker Creates a new item and autogenerates
the ID. Stores new ID and revision in a
text file.

ItemID - - L:use_marker Creates a new item and uses ID stored

as marker in the text file.

ItemRev - - revision Assigns an item revision if the item
revision value is empty.

Description - - description Specifies the item description.

Type - - item_subtype Allows you to overwrite the item
subtype from the Header3 Item
column.

Attribute form_name form_attribute_ attribute_value Adds a form to the current item

name revision and enters the attribute
values.

Attribute ItemRevision form_attribute_ attribute_value Enters attribute value in the

Master name corresponding revision master form.

Attribute Item Master form_attribute_ attribute_value Enters an attribute value in the

name corresponding item master form.

Occurrence Note occ_note_name occ_note_value Adds occurrence note to the BOM line.

Occurrence AbsOccurrence AbsOccurrence occ_ID _value Adds absolute occurrence ID to the
BOM line.

Quantity - - number Adds a quantity to a BOM line.

NumOccs - - number Adds a number of occurrences to a
BOM line.

Sequence - - number Adds a sequence (find number) to a
BOM line.

Status - - status Adds a release status to an item
revision.

Owner - - person;group For the root node, specifies the default

owner for the entire structure.
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Header1 Header2
Owner -
Variants item_IDI
item_revision
Relation Consumed
Relation Consumed
Relation Workarea
Relation Workarea
Relation Resource
Relation Resource
Relation Resource
Specifying type

Header3

occurrence_type

occurrence_type

occurrence_type

occurrence_type

occurrence_type

occurrence_type

occurrence_type

Data value

person

variant_conditions

product_root_ID

consumed_item

plant_root_ID

workarea_ID

resource_ID

resource_ID~

occurrence_type

resource_ID
[;resource_ID]

Remark

For each item, specifies the owner for
this item or item revision.

Specifies the item to which the variant
options are assigned.

Specifies the relation that links the
process root to the product root to link
the two structures.

Specifies one or multiple consumed
items (separated by a ;) for all nodes
other than the root node.

Specifies the relation that links the
process root to the plant root to link
the two structures.

Specifies one or multiple work areas
(separated by a ;) for all nodes other
than the root node.

Assigns a resource to an operation.
The occurrence type from the
Header3 column is used.

Assigns a resource to an operation
using the specified occurrence (not the
one found in the Header3 column).

Assigns multiple resources to an
operation using the occurrence type
specified in the Header3 column.

You can use the Type column to overwrite the item subtype that you specified in the Header3 column
for the corresponding item.

Header1 Item Item

Header2 Process OP

Header3 Process OP

Tile  Pocess  Operaon

CAM_Setup1

Material procurement
Rough milling
Washing
Machine Pocket
Inspection
Drilling
Heat Treatment

Type

NCMachining

NCMachining

NCMachining
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Part Probing
Final Inspection

This produces the following output.

: ®O ¢* 000039-CaM_Setupl) |
T Latest YWorking "B Mot Specified W Mot Specified
BOM Line Item Type
=) 000039/, 1-CAM_Setupl (view) MEFrocess
------ g 00004044 ; 1-Material procurement MEQP
------ , j}, 000041 /4 ;1-Fough milling MEMCMachining
------ & 00004244 ; 1-\Washing MEQF
------ , j}, 000043/ 1-Machine Pocket MEMCMachining
------ & 000044 /4 1-TNspection MECP
------ i 000045/4;1-Drilling MEMCMaChining
------ & 000046/4;1-Heat Treatrment MEOP
------ & 000047 /4 ;1-Part Probing MECP
------ & 00004344 ;1-Final Inspection MECF

Specifying IDs

By default, IDs are created automatically (based on the same rules that are applied by the business
modeler). You can specify IDs in a ItemID column in the Microsoft Excel sheet that are assigned to the
objects during import. If you specify an ID that already exists in the database, it is updated using the
information from the Excel sheet.

Optionally, you can specify the item revision using an ItemRev column.

Header1 Item Item Description ItemID ItemRev

Header2 Item Item

Header3 Item Item

______

Assy Assembly PAR_as-00
Comp10 CheckBox PAR cn-10 A
Comp20 RadioButton PAR_cn-20 001
Comp30 ListBox PAR cn-30
Comp40 Staticlmage PAR_cn-40 B
Comp50 Menultem PAR_cn-50 002
Comp60 DropDownlList PAR_cn-60 A
Comp70 Spacer PAR_cn-70
Note:

You can also use the ID column to automatically generate IDs and store them in a text file for
future reference.
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Adding activities

You can add activities to an operation by adding rows in the Microsoft Excel sheet for these activities. In
addition, you can add a Time column to enter the duration time for each activity.

Act-Process

><¥ 8R >@

><® >

OP10 Operation10

0OP20 Operation20
Act1 activity 1 6
Act2 activity 2 10
Act3 activity 3 3

OP30 Operation30

OP40 Operation40
Act4 activity 4 2
Act5 activity 5 4

OP50 Operation50

OP60 Operation60

OP70 Operation70
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You must place activities on separate rows. These activities then appear in Manufacturing Process
Planner as follows.

°g 000177-A 3% m

Description Activity Description | Durati...

EEL b Activity Root Object  Activity Root Object .
A T Ty
F9 000177/A1-Act-Process (vid || - A activity 1 activity 1 0
LT 000178 /A1-0P10 -l At activity 3 activity 3 0
| ' bl At activity 2 activity 2 0

-1

& 000180/4:1-0P30
gy 000181/4,1-0P40
by 000182/4:1-0P50
gy 000183/4,1-0P60
- gy D00184/8:1-0P70

Creating the PERT sequence on import

During import, the tcexcel_import utility can create the PERT sequence on the structures. The sequence
is based on the hierarchy as listed in the template.

Example:

Create the following in the import template.

Item Item
MEOP MEActivity
MEOP MEActivity

INSTALL FROMNT LH OO0R STRIKER

GET DOOR STRIKER KIT
WALK TONVEHICLE
LOAD PILOT LOCE

After importing, the following PERT sequence is created.

GET DOOR STRIKER KIT —— WALK TO VEHICLE ——— LOAD PILOT LOCK

Importing the frequency of an activity

When importing plant structures, the tcexcel_import utility can also populate the frequency.
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Line | Frequency | Category |
1A OPR-100447/A 1 MA A

ot

‘he colurnns to be displayed and either save the modified list as a new column

1EW,

Displayed Columns I}

L] | CfghctivityLine.al_activity_time_system_frequency

Note:

The frequencies are numeric values.

Importing the category of an activity

When importing plant structures, the tcexcel_import utility can also populate the category.

m

Line | Frequency | Category | Unit Time (sec) /
= A" OPR-100615/A 1 MA 0
Sl | o 2d Pilot Lock 1 VA I=| B
Value Description
o A Mot assigned
""" MNVA Mon value added
o NYABR Mon value added but requir...

Note:

The category values are based on an existing (OOTB) LOV.

Importing the unit time of an activity

You can also use the tcexcel_import utility to populate the unit time of the imported plant structure, as
shown in the Activities view above.

To do so, create the following in the import template.
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Header1 Activity
Header2 Unittime

Note:

The unit times are numeric values.

Importing multiple structures

You can import multiple items on a single Microsoft Excel spreadsheet by adding the required item IDs to
the Item column as follows.

Header1 Item Item Description
Header2 Item Item
Header3 Item Item
Tde Rt  swo 0 Dec
ltem1 Assembly 1
Comp11 Component 11
Comp12 Component 12
Comp13 Component 13
[tem2 Assembly 2
Comp21 Component 21
Comp22 Component 22
Item3 Item 3
ltem4 Item 4
Item5 Assembly 5
Comp51 Component 51

You can see the results of importing these structures in My Teamcenter.

& Home % 2 w Viewer| * Impact Analysis| %
&= Multiple_ltems
Search Text L e | =
4 &k Home Object Type
8 Mailbox L #, 000193 -Tternl Ttermn
4 5 Newstuff . 000197-Fem?2 Trem
| 4 |3 Multiple_Iterns (%, 000200-Fem3 Itern
b L% 000193-Temi £, 000201 -Temd Ttem
i [Py 000197-Ttem2 (%, 000202-Ttem5 Ttem
i L% 000200-Fem3
i L% 000201-Femd
Py 000202-TtemS
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Describing multiple BOM lines in one row

You can expand the types of definitions you assign to the imported objects by adding another header
row to the Microsoft Excel file. This allows you to create, for example, several objects in one row and
overwrite values that already exist with new values.

Header1 Item Item Item Description Description
Header2 Process Process oP
Header3 Process Process NCMachining
Header4 Root Proc Op ALL Op
Tile  Root  ProcName  Op.Name  Description  Overwrite Description
Process-Root New Process
sub_process1 OPO1 New Sub-process1 Read
OP02 Get and place cable
OPO03 Record lot control
OP04 Get from printer and place
on carrier
sub_process2 OPO05 New Sub-process2 Get sign and place on
carrier
OP06 Set model switch
OPO7 Remove beam from cart
sub_process3 OP08 New Sub-process3 Lock both sides and latch in
place
sub_process4 OP09 New Sub-process4 Get wire harness and
position

The Header4 row allows you to overwrite values for columns that exist twice. In the example, there
are two Description columns. But if you look at the row containing sub_process1, you see that there
are also two objects in the same row (sub_process1 and OP01). The utility sees that there are two
description columns. It assigns the description contained in the ALL column (this is a case-sensitive
keyword) to everything except for that which is contained in the Op column (this is a reference to the
first column named Op). The utility assigns the description in the first column (the one designated by
ALL) to every object that it imports. It then looks at the second column and sees that this is a special
description for all objects contained in the Op column. Importing the Excel file results in the following
structure.
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Process Structure ftem Type tem Description
Mewr Process
MEFrocess Mew Sub-processt
MEMCRaChining Read
MEMNCHachining Get and place cable

MENChaCchining
MERChachining

MEFrocess

MEMChachinirg
MEMChachining
MEMC Rz hindrg
MEFrocess

MENChachining
MEFrocess

MENChachining

Record lot cortral

Get from printer and place on carrier
Mew Sub-process?

Get sign and place on carrier

Set model switch

Remove beamn from cart

Mew Sub-process3

Lock both sides and latch in place
Mewr Sub-processd

Get wire harness and posttion

You can now specify two different descriptions for two different objects in one line of the Microsoft Excel

file.

Overwriting data in columns

Similar to overwriting descriptions, you can use the overwrite mechanism to overwrite other data in the
structure. The following is an example of creating different values for the cost_estimate attribute in an
Impact Analysis form in the same line in the Excel file.

Header1 Item Item Item Item Attribute Attribute Attribute
Header2 Item Item Item Item ImpactAnalysis Form ImpactAnalysis Form ImpactAnalysis Form
Header3 Item Item Item Item cost_estimate cost_estimate cost_estimate

Header4 Levell Level2 Level3 Level4 ALL _—
-----——_

Product-
Root
P1 P1.1 P1.1.1 1.00 100.50 111
P1.1.2 112
P1.1.3 113
P1.2 P1.2.1 123.45 121
P1.2.2 122
P2 P2.1 P2.1.1 2.00 90.00 211
P2.1 P2.1.2 212
P2.2 P2.2.1 200.00 221
P2.3 P2.3.1 222.88 231

The resulting output shows the cost_estimate attribute set to 2.00. This is specified by the Header4
entry for the Attribute column that contains the keyword ALL (shown in white in the spreadsheet).
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BOM Line | Item Mame |4t | Wiork Instructions @ Variants L0 Attachments
; DDDD&G,{A 1-Product-Root {(view) Product-Root Line Description _r
% 000067/ 1-P1 fview) Fi %, 000075/A:1-F2
4 000068/4;1-PL1 (view) Pl1 -5 view Collecti
P111 o 000075 A-view BOM ¥
Pll.e (& 00o07s/a Itern M.
gi;3 {4 Impactanalysis Form Description Specific
F1.2.1 .
» 000074/4,;1-P1.2.2 F1.2.2 @'{ ImpactAnalyﬂs von
B-% DDDD?E;‘A 1-P2 {wiew) F2 oo
B-% 000076/4;1F2.1 (view) P21 B Impacthn:
% 000077 fa;1-P2.1.1 F2.1.1 )
% oooo7e/ejiFala P22 cost_estimate: N |
7% DDDD?Q;‘A 1122 (view) P22 < m
% 000081/8;1-F2.3 (view) P23 %

The Header4 entry for the next Attribute column, Level3 (shown in red), specifies that the

cost_estimate value for P2.1 is set to 90.00. This overwrites the value 2.00 that was set by the ALL

entry in the previous figure.

BOM Line | Itiem Mame : t | Wark Instructions | & variarits o Attachments
% * 000066/A; 1-Product-Root (view)  Product-Root Line | Descrigtion
- 000067 /4, 1-P1 {view) F1 % 000076/ 1P2.1
1 ! ’ '
E DDDD&S}A 1-P1.1 (wiew) PL1 -. @ Viewr callecti
5 0000694;1-P1.1.1 F1.1.1 FI-[E 000076/4-¥igw BOM i
1212 EH; [ 000076/4 Thern M
. P e “o| A Impactanalysis Form Description Specifit
- 000072/4;1-P1.2 (view) P12 1 . | " a
% 000073/4;1-P1.2.1 Fl1.2.1
Y O0007478:1-F1.22  PL2Z ¥ ImpactAnalysis Form
B 00007574 1-P2 (view) P2
=% D00076/4;1-P2.1 (view)  F2.1
: £ 000077 /8, 1-P2. 1.1 Fz2.1.1
Y 000078/4;1-P2.1.2  P2.1.2 cost_estirmate: |
; 00007944, 1-P2.2 (view) P22 < o
% 000081/4;1-F2.3 (view) P23 u_ ——

The Header4 entry for the next Attribute column, Level4 (shown in cyan), specifies that the

cost_estimate value for P2.1.1 is set to 211. This overwrites the value 2.00 that was set by the ALL

entry and the 90.00 set by the Level3 entry in the previous column.
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BOM Line I Iterm Name f t | Work Instructions | @ wariants o Attachments
‘, 000066,/4; 1-Product-Root (view) Product-Root i Line | Description
-7 000067 /4, 1-P1 (view) P1

U , & 000077/8,1-P2,1.1
- E7h000068/4;1-P1.1 (view) P11 L[ 000077 4 Ttem M

i’ DO0062/4;1-P1.1.1 P1.11 [ Impactanalysis Form Description Specific
5 0007044 1-F1.1.2 P1.1.2 [ﬁ View collecti
<% 000071/4;1-P1.1.3 PL.1.2
E-%5 000072/4;1-P1.2 (wienn) PlL2

00007348;1-PL2.1 PL2.1
% 000074/4,1-P1.22  PL22

% ImpactAnalysis Form

=% 000075/8;1-F2 (view) P2 B ImOaCTAN o
B 000076/8;1-P2.1 (view)  P2.1 A Ui SEIC-Ar Tl e

% 000077 /4;1-P2.1.1 F2.1.1

% 000078/8;1P2.12 P12 cost_estimate: b
% 000079/4;1P2.2 (view) F2.2 - =
B D0008144;1-P2.3 (view) P23 i

Attaching forms

You can add forms to your structure, and fill out attributes within these forms. The following Microsoft
Excel sheet shows an example of this.

Header1 Item Item Item Description Attribute
Header2 Item Item Item ItemRevision Master
Header3 Item Item Item project_id
Title  Root  Proc.Name Op.Name  Descripfon  lemProjectid
Product New Product Project xyz
Sub_Assy1 New_Sub_Assy1 Project 1
Part1 Desc of Part1 Project 1
Part2 Desc of Part2 Project 1
Part3 Desc of Part3 Project 1
Part4 Desc of Part4 Project 1
Sub_Assy?2 New_Sub_Assy2 Project2
Part5 Desc of Part5 Project2
Part6 Desc of Part6 Project2
Sub_Assy3 New_Sub_Assy3 Project3
Part7 Desc of Part7 Project3

Item Master and ItemRevision Master are keywords that signify that the values in those columns
should be inserted into the master form or the revision master form, respectively, of the type specified in
the Header2 row. The entry in the Header3 row specifies the attribute to be filled in by the given values.
This must be in the internal format specified in the Business Modeler IDE application (for example, in

the previous example, the Project ID string is shown in the user interface, but the string shown in the
Business Modeler IDE application is project_id).
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Project I | Project sovx

You can also add a form of your choice to the structure. In the following example, in addition to entering
a value in the revision master form for program ID, you add the ImpactAnalysis form to the operations
and fill in the cost estimate field with the given values.

Header1 Item Item Description Attribute Attribute
Header2  Process oP ItemRevision Master ImpactAnalysis Form
Header3 Process program_id cost_estimate
__-___
Attribute_Test F4711 0815

OP10 Description for OP10 F4711 0816 100.50

OP20 Description for OP20 F4711 0817 123.45

OP30 Description for OP30 F4711 0818

OP40 Description for OP40 F4711 0819 200.00

OP50 Description for OP50 F4711 0820 222.88

OP60 Description for OP60 F4711 0821

OP70 Description for OP70 F4711 0822 90.00

This results in the following structure.

Process Struchure | them Typs l:katnmims | Altackments | E" Report al ¢
] WEProcess Line I Description

Jte DODESALL-OP10 Description for 0910
[ 0006E4/L I,

FECE

BB PREB

cost_estimate: | 100,50 |
weiht_estimate: | |
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Specifying the date attribute for forms

You can specify a date field in a form that you import using Microsoft Excel. The format for the date
depends on the value for the DefaultDateFormat key defined in the timelocal_locale.xml file. This file
is located in the following directory:

TC-root-directory\lang\textserver\en_US
If, for example, the following format for the date is specified in the timelocal_locale.xml file:
%d-%b-%Y %H:%M

You must enter the date and time as 15-Aug-2013 18:30 in the Excel input value. The date format is as
follows:

%d Day of the month (0-31)
%b Abbreviated month name
%Y Year with century (1970-2069)

%H Hour (24-hour clock 00-23)
%M Minute (00-59)

The following spreadsheet shows how to add a date attribute value to the form.

Header1 Item Attribute Attribute

Header2 Item Item Master Item Master

Header3 Item fndODate user_data_3
Test 19-Aug-2013 18:30 check

This example imports an item called Test and the two attributes on the Item Master form, fndODate
and user_data_3, are updated with the values 19-Aug-2013 18:30 and check, respectively.

Note:

The fndODate attribute is added on the Item Master form for illustration purposes only. This
attribute is not available by default in Teamcenter.

Attaching multiple forms of the same type to an activity

You can create multiple forms of the same type when creating operation activities. The header definition
for creating forms does not change. You specify the data for multiple forms in the value fields separated
by the ~ character, for example, V41~V42~V43. The number of entries in the Attribute column defines
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the number of forms that are created. The attribute values are written into the forms in the order that
they appear in the cell. The first entry is written into the first form, the second entry is written into the
second, and so on, until there are no more attribute values in the cell.

The following spreadsheet shows how to add multiple forms to activities.

Header1 Item Item Item Description Activity Activity  ActivityForm ActivityForm
Header2 Process OP  Activity Description Time BVRSyncInfo BVRSyncInfo
Header3 Process OP  Activity appl_data view_type

Act-Process

OP10 READ
INPANEL
SHEET
Act1 Get Cable 20 appl_datal1~appl_data V11~V12~V13
12
Act2 Place to 38 appl_data21~appl_data V21~V22
Inpane 22
~appl_data23
Act3 Fix Retainer 12 appl_data31 V31~V32~V33
firmly
Act4 Adjust 23 appl_data41~appl_data V41~V42
settings 42
~appl_data43
Act5 Inspection 10 appl_data51 V51

In this example, in the row containing Act4, three forms are created because the cell in the appl_data
attribute column contains three entries.

The Excel input produces the following output.
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Ttem Name | Ttem Type 4 2o Assambly Viewer B wiork Irstructions @ varlants Attachments &' Report ' Cperation Acthities = activities (010
2 Act-Pracess MEProcess Line / | activity Descripton [ Startr. [ourat. [ start ¢calc) [ourston @ca. |
7 Hn A 00D306/A Activity Root Coject 0 [} a 48
= ACE2] Get Cable o el 1] el
[#r BvRSyncinfol
[# BvRSyncinfo2
L& BvRSyncinfud
5 W A2 Place t Inpang| 0 B 0 =
[ BVRSYNCInfol
[ BvRSyncinfo2
[ BvRSyrcinfiod
= A3 Fbe Retainer firmly 1] 12 o 12
[ BvRSyreInfol
[ BVRSYrCInfo2

st s . ;T o s
vt s it
View Type:! |w_1 \

st
Wiew Type: | vaz |
appl_data; rppl_dataﬂ

Wiew Type: | |
appl_data: rpp|_|1a{aqz

appl_data: rpp\_da‘taﬂ
< | > < |

| » < | »
8
| cancelcheckout | | Closa | | cancel checkaut | | Close ] [ cancelcesout | [ Close |

ai Eag|

Assign resources

You can assign resources to operations in a process structure or to work areas in a plant structure.

1. If necessary, import the resources into the database.
Header1 Item Item ItemID
Header2 Item Item
Header3 Item

Item
Milling Tool Assembly res_tool_mill_001
Holder
Cutter

Insert
Twist Drilling Tool res_tool_drill_001
Holder HSK63
Twist Drill
Spot Drilling Tool res_tool_drill_002
Machine Adapter
Spot Drill
EcoMill 350 Siemens 802C res_machine_001
2.  Create a Microsoft Excel spreadsheet that includes a column with the following keywords:

* Add the Relation keyword to the Header1 row.

Part Planner, Teamcenter 2412
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* Add the Resource keyword to the Header2 row.
* In the Header3 row, type the occurrence type of the resource, for example, Tool or Resource.

3. Assign these resources operations in the process structure as follows.

Header1 Item Item Description Relation
Header2 Process OoP Resource
Header3 Process Tool
_—_——
Proc_Root
OP10 Rough Milling res_tool_mill_001
OP20 Heat Treatment
OP30 Finishing MachineTool~
res_machine_001
OP40 Washing
OP50 Drilling res_tool_drill_001;
res_tool_drill_002
OP50 Inspection

Importing this sheet results in the following structure.

* D00040-Proc_Root  (Latest Working Effectivity: Mot Specified)

Process Structure | Item Description Occurrence Type
"9, 00004074, 1-Proc_Root (view)
=gy 0000418, 1-0P10 (view) Raough *illing
= res_tool_mill_D01/4;1-Milling Toal Azsembly (view) METool

'.u 00003374, 1-Holder
5 000034 4 1-Cutter
% 00003544 1-Tnsert

.', 00004274, 1-0P=20 Heat Treatment
ER DDDD43;’A 1-0P30 fuiew) Finishing
%8 res_machine_D01/a;1-EcoMill 350 Siermens 8020 MEMachineTool
gy 000044 £ 1-0P40 W ashing
= gy OO0D45/4;1-0PS0 (wiew) Drilling
= res_tool_drill_001/8;1-Twist Drilling Tool (view) METoo

% 000036 /4 1-Holder HSKES

% 000037 M4 1-Twist Drill

_".-. res_tool_drill_002/4;1-Spot Drilling Tool (view) MET oo
% 00003874 ; 1-Machine Adapter

% D00039/4 ; 1-Spat Drill

.', 000046544, 1-0Pa0 Inspection

There are several points to note about this structure:
¢ The Relation column must contain the item IDs (not the names) of the resources or work areas.

* Resources that are classified in the database are indicated as such in the structure by the
classified symbol ' —. The import utility can assign both classified and nonclassified resources.
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* The resources must already exist in the database.
* You can assign multiple resources to a single BOM line by separating them with a semicolon.

* You can specify an occurrence type in Header3 of the Relation column that is then used for
all the relations. If, however, you enter an occurrence type in the cells of the relation column
(designated by occurrence type~item ID), this occurrence type is used instead of the one in
Header3. In the preceding example, for res_machine_001, the MachineTool occurrence type is
used instead of the default Tool.

Importing quantity and number of occurrences

You can add the quantity or number of occurrences to the process structure by adding a Quantity or
NumOccs column to the Header1 row. You can also add both simultaneously.

Header1 Item Item Description Q
w
F (]
0
o
ic
1
y

Header2 Item Item

Header3 Item Item

wNo o QoO=OSMmEYER

Quantity_Test

Iltem10 Description 10 1
Iltem20 Use 2 of Item20 2
Iltem30 Description 30 1
Iltem40 Add 4 of Item40 2
Item50 Description 50 3
Item60 Description 60 1
Iltem70 Description 70 2
This produces the following output.
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O00017-Cuantity_Test  (Latest Waorking Effectivity: Mot Specified)

BOM Line Quantity Pack Count
4. 000017 44, 1-Quantity_Test (view)
------ 00001874, 1-Thermll x 1
------ A 000019/4;1-Tkem20 x 2
------ 00002074 ;1-Ttem30
------ 00002174, 1-Termd0 x 8
------ 00002274, 1-Tkems0 x 3
------ 00002374, 1-Tkerme x 1
------ 00002474, 1-Tkerm70 x 4

|

fo= o
| ISR TR 6 R SRR S AT

If you unpack this, you see the following.

O00017-Cuantity_Test  (Latest Working Effectivity: Not Specified)

BOM Line Quantity Pack Count
4 000017 /4, 1-Quantity_Test {view)
------ % 00001844, 1-Ttem10 % 1
------ % 000019/4;1-Ttem20 % 2 2
------ % 00002074, 1-Ttem30
------ % 000021/4;1-Ttem40 ¥ 4
------ % 000021/4;1-Ttem40 ¥ 4 4
------ % 00002244, 1-Tkems0
------ % 00002244, 1-Tkems0
------ % 00002244, 1-Tkems0

s

N
N sl T = = =

------ % 000023/4;1-Tkerman x 1 1
------ % 000024/4;1-Ttem70 x 2 2
------ 0000244, 1-Ttem70 x 2 2

Importing release status

You can add the release status to the process structure by adding a Status column to the Header1 row
and assigning an existing release status to an item or item revision.

Header1 Item Item Description Status
Header2 Item Item
Header3 Item Item

Status_Test

ltem10 Description of ltem10
Iltem20 Description of Item20
Iltem30 Description of ltem30
Iltem40 Item-Rev with status TCM Released
Item50 Description of ltem50
Iltem60 Description of ltem60
ltem70 Description of ltem70
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This produces the following results.

. (D0D009-Status Test) |
EDDDDDQ—Status_Test {Latest Working Effectivity: Mot Spec

BOM Line Item Rev Status

- 000009/4;1-Status_Test (view)

% 00001044 1-Them10

% 00001144 1-Tem=20

% 00001244 1-Them30

% 00001344 1-Ttem40 TCH Released
% 00001444 1-Thems0

% 00001544 1-Thema0

% 00001644 1-Them70

Assigning find numbers

You can use the Sequence heading to help you assign find numbers to the structure you are importing.

Header1 Item Item Description Sequence
Header2 Process OoP
Header3 Process OP

Process_with_Sequence

OP10 READ INPANEL SHEET 100
OP10 GET AND PLACE CABLE 110
OP10 RECORD LOT CONTROL 120
OP10 GET INPANEL BUILD SHEET 130
OP10 GET STRAGGLER SIGN 140

This results in the following output:

“O {* D00075-Process with Sequence) |

* D0007S-Process_with_Sequence  (Latest Warking Effectivity: Mot Specified)
Process Structure Iterm Description Item Type Find ko,

:H‘ 00007544, 1-Process_with_Sequence... MEProcess

------ g 00007644 1-CP10 READ IMPAMEL SHEET MECP 100

------ g OO0077 f41-0P20 GET AMD PLACE CABLE MECP 110

------ g 00007244 1-0P30 RECORD LOT COMTROL MECP 120

------ g 00007944 1-0P40 GET IMPAMEL BUILD SHEET MECP 130

ey 000004, 1-0PS0 GET STRAGGLER SIGH MECP 140

Attaching notes

You can use the Occurrence header to help you attach notes to the structure you are importing.
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Header1 Item
Header2 Process
Header3 Process

This results in the following structure.

Item Description

OoP

Occurrence

Note

ResourcelD

OCC-Note-Test

Part1 Read OCN1
Part2 Get and place OCN2
Part3 Record OCN3
Part4 Get from printer OCN4
Part5 Get and place OCN5
Part6 Set Switch OCN6
Part7 Remove beam OCN7
Part8 Lock sides OCN8
Part9 Place Beam OCN9
Part10 Route OCN10

egeeeesesesd

Importing transformation data

Process Structure

et and place
Recard

et from printer
et and place
Set switch
Remove bearm
Lock zides
Place Beam

Route

MEResourcell:
MEResourcell:
MEResourcell:
MEResourcell:
MEResourcell:
MEResourcell:
MERezourcell:
MERezourcell:
MERezourcell;
MEResourcell:

QA
CCh2
CCMS
CiCMe
CICMS
CICME
CICMT
CICME
CIZMe
CCr10

You can import transformation matrix data by specifying the data in the Matrix column of the Excel

spreadsheet.

Header1 Item
Header2 Item
Header3 Item

Item
Item
Item

Description

Matrix

Transformation_Text

Iltem10
Iltem20
Iltem30
Iltem40

Description 10
Description 20
Description 30
Description 40

1000010000100001
1001010400110001
1001010700110001
10010101000110001
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Item50 Description 50 10010101300110001
ltem60 Description 60 1007010400110001
Iltem70 Description 70 1007010700110001

You can see the transformation data in the Absolute Transformation Matrix column in Teamcenter.
Assigning absolute occurrence IDs

You can use the Occurrence column to help you assign absolute occurrence IDs.

Header1 Item Item Item Description Occurrence
Header2 Process Process oP AbsOccurrence
Header3 Process Process AbsOccurrence

Process-Root

Sub10
F02211 READ SHEET AbsOcclD-F02211
FO1760 GET AND PLACE CABLE REEL AbsOcclD-FO1760
FO1459 RECORD LOT CONTROL AbsOccID-FO1459
F00269 GET SHEET FROM PRINTER  AbsOcclD-F00269
Sub20
F00270 PLACE ON INPANEL AbsOccID-F00270
FO1206 SET MODEL SWITCH AbsOcclD-FO1206
F00271 REMOVE BEAM COMP AbsOcclD-F00271
Sub30
F00272 LOCK BOTH SIDES OF LATCH AbsOcclD-F00272
F00273 INSTALL HARNESS AbsOcclD-F00273
F00279 ROUTE BEAM AbsOccID-F00279

This produces the following output.

®g (* 000097-Proc-Root) |

W Latest Working €L Mot Specified T Mot Specifisd
BOM Line | Item Description Item Mame | Item Type | ID In Context {Top Level)l
Dr_t,!, 000097 /A ; 1-Proc-Root {view) Proc-Root MEFroCess
=58 00009874 ; 1-5ub10 (rigw) Sub10 MEProcess
------ ¢ 00009974 ;1-FO2211 RE&AD SHEET FOz211 MECP absOcocID-FO2211
------ ¢ 000100/4;1-FO1760 GET &MD FLACE CABLE REEL FO1760 MECP AbsOccID-FOL1760
------ & 000101/4;1-FO1459 RECORD LOT COMTROL FO1459 MECP AbsOcocID-FO1459
------ & 00010274 1-FO0269 GET SHEET FROM PRIMTER.  FOO2G69 MECP AbsOccID-FO0269
=78 00010374 ;1-5ub20 (vigw) Subz0 MEProcess
------ ¢ 000104 /4;1-FO0270 PLACE OM IMPANEL Fao27a MECP AbsOccID-FO0270
------ & 000105/4;1-FO1206 SET MODEL SWITCH FO1206 MECP AbsOocID-FO1206
------ & 00010674 ;1-FO0271 REMOYVE BEAM COMP FOo271 MECP AbsOccID-FO027 1
=58 000107 /4 ; 1-5ub30 (rigw) Sub30 MEProcess
------ & 00010874 ;1-FO0272 LOCk BOTH SIDES OF LATCH FOO272 MECP AbsOccID-FO0272
------ & 00010974 ;1-FO0273 INSTALL HARMESS FOO2732 MECP AbsOccID-FO0273
------ & 00011074 ;1-FO0279 ROLUITE BEAM Fao279 MECP AbsOccID-FO0279
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Assigning ownership to objects

You can change the ownership of objects you import into the database by using an Owner column. The
first entry in this column after the title row (that is, the root entry) defines the global owner and group. If
you leave any of the subsequent owner cells empty, the object's ownership is changed to the root owner
and root group. In the following example, this is Person 1 belonging to the Mfg group.

Tip:
Make the Owning user column visible in Teamcenter to verify that the owner is imported
correctly.
Header1 Item Item Item Item Description Owner
Header2 Process Process Process oP
Header3 Process Process Process
_______
Owner-Test Info: usera Person 1;Mfg
Proc1 Info: usera
Subproc11 Info: usera
OP111 Info: userb Person 2
OP112 Info: userc Person 3
Subproc12 Info: userb Person 2
OP121 Info: usera
OP122 Info: userc Person 3
OP123 Info: usera
Subproc13 Info: usera Person 1
OP131 Info: userd Person 4
Proc2 Info: usera
Subproc21 Info: userc Person 3
OP211 Info: usera
Subproc22 Info: userd Person 4
OP212 Info: usera
0OP222 Info: userc Person 3
Proc3 Info: userb Person 2
Subproc31 Info: userd Person 4

Importing this spreadsheet results in the following structure in the database.
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Process Structure Item Description | tem Revision Owning User | Item Revision Owhing Group

N000045/4; 1-Cwner-Test (view) sera Person 1 (usera)
=5, DO0046/4;1-Proct (view) Info: usera Person 1 {usera) 1fig
B“H, 000047 /4;1-Subprocll dview) Info: usera Person 1 {usera) 1fig
. g 000048/4;1-0P111 Info: userb Person 2 (userh) rifg
. g 000049/4;1-0P112 Info: userc Person 3 (userc) 1fig
B“H, 000050/4;1-Subprocl2 fview) Info: userh Person 2 {userh) 1fig
| g 0000S1/4,;1-0P121 Info: usera Person 1 (usera) mifig
-y 000052/4;1-0P122 Info: userc Person 3 (userc) rfg
. g 0000S3/4;1-0P123 Info: usera Person 1 {usera) 1fig
B“H, 000054/4;1-Subprocl3 fview) Info: usera Person 1 {usera) 1fig
e gy 000055 /4, 1-0P131 Info: userd Person 4 {userd) 1fig
=58 D000S6/4;1-Proc2 (view) Info: usera Person 1 {usera) rfg
B“H, 000057 /4;1-Subproc2l fview) Info: Lserc Person 3 (userc) 1fig
. g 0000S58/4;1-0P211 Info: usera Person 1 (usera) mifig
B“H, 000059/4; 1-Subprocz22 (view) Info: userd Person 4 {userd) 1fig
- 0000B0/A;1-0P212 Info: usera Person 1 {usera) rfg
gy 000G 14 1-0P222 Info: userc Person 3 {userc) rfg
=55, DO00G2/4;1-Proc3 (view) Info: userb Person 2 {userb) rfg
-8 0000634 1-Subproc3t Info: userd Person 4 {userd) 1fig

Linking multiple structures
Linking multiple structures—overview

To link product to process, or plant to process, you must link the structures in the Microsoft Excel files to
each other.

In the first Excel file, you specify some BOM lines that you want to link to in another Excel file. This is
done in the column with Header1; ItemlID using the syntax M:my_marker.

In the second Excel file, you specify a link to this marker (again in the ItemID column). Instead of
creating a new item for the BOM line, the system uses the existing item that is specified using the syntax
L:my marker.

You can specify a specific item 1D in the ItemID column. If you do this, the system uses an existing item
with this ID. If this item ID does not exist in the database, it generates a new item with ID. If temID is
not specified, the system always generates a new item and assigns the item ID automatically.

If you specify M:any-marker-label, the system generates a new item and assigns the item ID
automatically. Additionally, the newly-generated ID and revision are stored in a text file with the name
marker.txt. In Example A, the following marker.txt is generated:

M op20_mar ker 024528 A
M op40_mar ker 024530 A

Note:

Markers (specified using <M:marker> and <L:marker>) must be unique.

For each M: entry, the system writes one line to the marker.txt file with the actual ID and revision. If
you now load the second Excel file, you must specify the additional marker.txt parameter . The system
checks for L: entries in the ItemID column and replaces this label with the correct item ID from the
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marker.txt file causing the system to reuse the previously generated item, instead of creating a new

one.

Example A

This example links operations between two structures. You can link any process step between multiple
structures. Note the M: and L: entries for OP20 and OP40.

Header1 Item Item Description ItemID
Header2 Process OP
Header3 Process

Sequence

Process-1-Root

OP10 Read 100
OP20 Get and place cable 'M:op20_marker 110
OP30 Record lot control 120
OP40 Get from printer and M:op40_marker 130
place on carrier
OP50 New Sub-process2 140
OP60 Get sign and place 150
on carrier
Header1 Item Item Description ItemID Sequence
Header2 Process oP
Header3 Process
Root  Root Descripion  Usemarkers
- Process-2—Root - -
PSO5 Set switch 200
PS10 Remove beam 210
PS15 Place carrier 220
OP20 Get and place cable L:op20_marker 230
PS25 Lock 240
OP40 Get from printer and place on carrier L:op40_marker 250
PS35 Get wire 260
As a result, you get the following two linked structures.
| mem Type | Rem Description

S mwibch
Remove basm
Flace carrier

God and place cably

Lgck

Gt from prirder and plete on SAiar

Gl wire
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When OP20 and OP40 are used in Process-2-Root, they are the same operations that are used in
Process-1-Root (items 000752 and 000754).

Example B

You can also link related objects such as consumed/required parts, work areas, or resources. In this
example, you link plant information (Workarea) to a process structure.

Header1 Item Item Description ItemID Sequence
Header2 WorkArea WorkArea
Header3 Plant Station
Tile  Root  Station  Description Storemarkers Seq.No.
Plant—Root M:proot
OP10 Station 1 M:op10 100
OP20 Station2  M:op20 110
OP30 Station 3 M:op30 120
OP40 Station 4 M:op40 130
OP50 Station 5 M:op50 140
Header1 Item Item Description Relation Sequence
Header2 Process OP Workarea
Header3 Process OP
Tile  Root  Oper Description Link tomarkers Seq. No.
Process—Root - L:proot
OP10 Read L:op10 100
OP20 Get L:op20 110
OP30 Record L:op30 120
OP40 Save L:op40 130
OP50 Send L:op50 140

As a result, you get the following two linked structures.
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BECOM Line | Item Descripkion
"-’-j 00015714, 1-Plank—Rook (i)
o 000158(A;1-0P10 wuew} Station 1
0001594, 1-0P2 Skation £
o 000190)4;1-0P30 wuew} Station 3
L 000191 A; 1-0P40 {View) Station 4
LT 000192148, 1-0PS0 (Yiew) Station 5
Process Struckure | Item Tvpe Occurrence Tvpe Item Description
EH 00019314, 1-Process—Raat (view) MEProcess
o gy OO0194/A; 1-0P 10 {View) MECP Read
LGl s =2 000188/04; 1-0P10 (Wiew) MESkakion MEWorkarea Skakian 1
= [ IIIEII:II'.:JE,I'F'. 1- OF'EEI ('-.-'|ew]| MEDP ek
[t MESkakion MEWorkarea Stakion 2
o 4, DO0196/A:1-0P30 (wuew} MECP Record
L.l s =2 000190/ 4; 1-0P30 (Wiew) MEStakion MEWarkarea Skation 3
(= unmg?,mn-omn {Wiew) MECP Save
== 000191 /4; 1-0P40 (View) MEStakion MEWarkarea Skation 4
= g O00198/8;1-0PS0 (iew) MECP Send
== 000192/4; 1-0PS0 (Yiew) MEStakion MEWarkarea Skation 5

The plant objects are linked to the process structure using the specified WorkArea occurrence type.
Link two structures

1.  Save the two Microsoft Excel files as (Tab delimited)(*.txt) text files.

2. Import the first file (containing the M: markers):

tcexcel_import -u=user_name -p=password -g=group_name -i=Link-Process_structure-1.txt
-m=my_marker_file.txt

Note:

If you do not specify a name for the marker file using the -m parameter, Teamcenter outputs
a file named marker.txt

3. Import the second file (containing the L: markers) with the parameter my_marker_file.txt:

tcexcel_import -u=user_name -p=password -g=group_name -i=Link-Process_structure-2.txt
-m=my_marker_file.txt

Caution:

If you want to repeat this procedure using the same two input files, you must delete the
my_marker_file.txt by hand before doing so.
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Attaching variant data

If you want to load variants, an item must exist in your database containing all the variant options. For
the next example, the item revision (v_item/A) has the following options.

Motor Engine Engine V10 V12
Transmission TRN THX4 TCX7 TJS8 TDT9
Air Conditioning System AC Y N
Entertainment System E_TAPE Y N
E_CD Y N
E_NAVI Y N

The variant item revision is specified in the Variants column in the Header2 row as shown in the
following example.

Header1 Item Item Variants
Header2 Process OP V_item/A
Header3 Process OP
Tile  Root  Sub  VarantDefinitions
Proc_Root
Comp1
Comp?2 AC==N
Comp3 AC==Y AND E_NAVI==
Comp4
Comp5 Engine==V8 OR Engine==V10
Comp6 Engine==V10 AND (TRN==TCX7 OR TRN==TJS8)
Comp7 (Engine==V12 OR TRN==THX4) AND (AC==Y AND (E_TAPE==Y OR E_CD==Y))
Comp8 Engine==V8 OR TRN==TJS8 OR AC==Y OR E_NAVI==Y

Importing this sheet results in the following structure.

BEOM Line | Variant Conditions ™
3 010083/A:1-Proc_Root (View)
----- %@ 010091/A1-Comp8  Engine = V8 OR TRN = TIS8 OR AC = Y ORE_NAVI = ¥
""" & ® 010088/41-Comp5  Engine = V& OR Engine = V10
""" ;@ 010089/ A 1-Compb Engine = V10 AND (TRM = TCX7 OR TRM = TJ58)
----- %@ 010086/A1-Comp3  AC =Y AND E_NAVI= Y
----- & 010085/A1-Comp2  AC=N
""" P 010090/ 4:1- Comp?  (Engine = V12 OR TRM = THX4) AND {(AC = ¥ AND (E TAPE =Y ORE_CD =¥}
----- & 010084/4:1-Compl
----- & 010087/A:1-Compd
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Load a variant item into the database
1. Copy the following four lines into a file named variant_options.pim:
#COL | evel itemrev nanme descr type option
#DELI M TER #
#ALT_DELI M TER ;
O#v_item#A#Vari ant s1#Vari ants Option
Def i ni ti ons#l t en#Engi ne; V8; V10; V12; - ;
TRN; THX4; TCX7; TIS8; TDT9; -; AC, Y; N; -; E TAPE; Y; N, -; E CD; Y; N, -; E_NAVI; Y; N
2. Change to the directory containing the variant_options.pim file.
3. Create v_item/A by using the following command to import variant_options.pim:

tcexcel_import.exe -u=user_name -p=password -g=group_name -psfile -i=variant_options.pim

The variant options for v_item/A appear as follows.

w_itern/A;1-Variantsl
=-Options
AC

-3 item,/A:1-Variantsl

----- Option Defaults
----- Rule Checks

Option
Marme: Descrip
"TRN !

Allowed Values

TCHT
TOT9
THX4
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Importing standard text library structures from a legacy system

If you have a standard text library structure in a system other than Teamcenter, you can re-create this
structure in Teamcenter using the tcexcel_import utility. You define the full library structure containing
folders and standard text elements in a Microsoft Excel spreadsheet and save it to a tab-delineated file.
This file is then used as input for the tcexcel_import utility that creates the structure and attaches
documents to the standard text elements. In the spreadsheet, you specify the paths to the documents
that are to be attached to the standard text elements. The textual content for each of the standard text
elements can come from:

* TXT files containing only rich text.
* DOCKX files containing tables, images, formatting, header and footer content.

After import, a standard text librarian can modify the library structure and an author can modify the
documents and save the modifications.

The following is an example of an input file with a simple library structure. The first four columns
represent the structure of the standard text library. The last column, the StxFilePath column, contains
the path to the document that will be attached to the standard text element.

Header1 Item Item Item StxFilePath
Header2 MesOMESTXLibrar MesOMESTXFolder MesOMESTXElement
y
Header3 MesOMESTXLibrar MesOMESTXFolder MesOMESTXElement
y
Tile  Reot skl sb2 se3
Library
Safety instructions
STX1 D:\templ\goggles.docx
STX2 D:\temp\boots.docx
STX3 D:\temp\helmet.docx
Folder2
STX4 D:\temp\magnet.docx
STX5 D:\templtable_example.docx
STX6 D:\templrich_text_example.docx
STX7 D:\temp\helmet.docx
STX8 D:\temp\helmet.docx

Note:
This example imports only DOCX files, but both DOCX and TXT files are supported.

You can import this structure into Teamcenter by saving the Microsoft Excel spreadsheet as a text file and
import that file into Teamcenter using the following tcexcel_import utility call:
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tcexcel_import -u=username -p=password -g=dba -i=path-to-txt-file

The resulting structure appears as follows in Teamcenter.

& 104229-Labrary "-_. S0 ([ Storndard Text £1 e

W ST % © Rl 1 N e | 12
BOM Line | Is Randord Tez I\ [ 004244/08,0-5T3
& 004240/8: 1-Library (view) -
5 0424 148:1-Folder] (View)
(B 004242/8:1-5T1 True
[ nosz43/81-5T02 True
-_“ ﬂnuwﬂ;j-m3 True WP FITNANG T FICLC. 0T T O R W PRSI 1500 T SCEC T FOLCTON.

in

L7 004245/8:1-Folder? (View)

Y 004246/,1-574 True
[l 004247 /81-5T08 True

(M 0004248481 5TE True
[y n04249/8,1-5TX7 True
[ 004250/8,1-5T8 True

Note that the standard text elements have documents attached. You can modify these documents, save
them, and continue to work with them in the customary fashion.

Note:

You can only use the tcexcel_import utility to create new library structures. You cannot use it to
update structures.

Sequence processes without the process flow viewer

When you add an object to a process or plant structure, you often need to add it between existing
objects. You can do this by giving the new object a find number that falls between the existing objects.
When the existing objects have no number space between them, you need to resequence the structure.
For example, you have the existing numbers 11,12,13 and must change these to 10,20,30. If you do not
use PERT flows, or intend to use them later in the process, you can resequence the structure as follows:

1.  Select the parent object of the structure that you want to resequence.
2. Choose Tools=2Re-Sequence Structure.

Teamcenter displays the Re-sequence dialog box.
3. Type a start number and increment.

4. Clear the Consider flows check box.
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The default state of this check box is stored in the MEConsiderFlowsOnReSequence preference.
After the first time you open the dialog box, the check box state is stored in a cookie.

5.  Click OK.
Sequencing processes with the PERT view

Sequencing processes and operations with the PERT view

The PERT view displays a graphical representation of process flow in PERT chart format. You can edit
and manipulate the process flow in the graphical environment. You can also assign parts, resources, or
manufacturing features directly in the PERT view.

The PERT view is used in different contexts, for example:
* When you select a process.
The PERT view displays the flow of operations and processes directly under the selected process.
* When you select a work area object.
The PERT view displays the physical flow on the plant floor.
* When you select an activity in the Activities view.
The PERT view displays the flows of activities directly under the selected activity.

When you create a process, Teamcenter creates a default process flow that includes all the children
(subprocesses and operations) of the process. The default flow appears in the structure view, starting at
the top left and continuing down in a tree-like fashion, and in the PERT chart.

4-73



_ 4. Designing process structure

.4 PERT X
Scope: 000135/A;1-assemble_fishing_reel (View)

"% 000136/A
assemble_drag_assembly

i1

v

79 000137/A

assemble_handle_assembly
Bl

v

"3 000138/A
assemble_spool_assembly

il

, v
72 000139/A

assemble_rotor_assembly
1 Wl

v

23 000140/A
assemble_body_assembly

You can additionally add nodes to the PERT chart from siblings of the selected process.

You can additionally create flows to and from a node that is not a direct child of the selected parent node
that you open as scope in the PERT chart. These types of flows are called scope flows and are displayed
with a gray (configurable) background color.
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L‘—JDH, qpl39947/4;1-assemble_drag_assembly (View)
79 qp139952/A:1-process_1 (View)

139953/ 4:1-process_2 (View) 2 qp139953/A

! qp P ‘

79, qp139949/A

- A - ; rocess_2
o3 qpl39954/A:1-process 3 (View) P o oo

- gpl30956/4:1-process_4 (View)
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Dﬂ qpl39948/A:1-assemble_handle_assembly (View) ‘_,_,—/
Dﬂ qpl39949/4;1-assemble_spool_assembly (View) Dﬂ qpl39954/A
DH, qpl39950/A;1-assemble_rotor_assembly (View) process_3

DH qpl39951/A;:1-assemnble_body_assembly (View])

H

79, gp139956/A
process_4

If the Show Assignments button is turned on, the PERT nodes provide you with information about
assigned parts, resources, and features assigned to the object. If you place the mouse over the object,
Teamcenter provides more information about the assigned objects. Additionally, Teamcenter displays the
@) symbol if a process has any variant information associated, as well as incremental change icons, if
applicable.

Teamcenter occasionally creates implicit flows to retain necessary dependencies between objects. This
can happen, for example, when you begin with process A->process B->process C, and then configure
process B out of the structure using variants. Teamcenter creates an implicit flow between process A and
process C. Teamcenter displays these flows in a different color, and you cannot modify or delete them.

You can configure the attributes that determine how each process, operation, or root activity node is
displayed. You can override some of these configuration settings individually.

When you select a node in the PERT chart, Teamcenter selects the equivalent line in the structure view,
and vice versa. If you remove a node in the PERT chart, Teamcenter removes the equivalent line from the
structure.

Draw flows

1. Click the Draw Flow button =, on the PERT toolbar. The draw flow mode is activated and the cursor
changes to %

2. Draw flows as required by clicking the origin node, then the target node.

3. Exit the draw flow mode using one of the following methods:

a. Press the Esc key.
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b.  Click the Select button [; on the PERT toolbar.
If you select an incorrect source or target while drawing a flow, the PERT chart:
* Does not create any arrows.
* Does not display an error message.
* Remains in draw flow mode.
Create flows to and from external processes or operations

You can add processes or operations to a PERT chart that are not immediate children of the process on
which you open the PERT chart. Any flows you create to and from these external processes or operations
are called scope flows. This is useful when you model fishbone structures of sublines merging or leaving
a main line.

You can create scope flows between the following structures:

Processes

Processes and operations

Process areas

All types of process areas

1. With a process open in the PERT chart, select an external node in the same process structure. This
node can be a sibling of the process that you send to the PERT or it can be any child of a sibling.

2. Click Add External Nodes i=*.

Teamcenter adds the process or operation to the PERT chart with a gray background.
3. Create a flow to or from the external node.
4. (Optional) Select an external node and click ¥ to remove the node.

When you revise a part, any existing scope flows are copied. If you then delete the copied flow, the
scope flow between the original parts still exists. This behavior means that different revisions of parts
can participate in different scope flows.
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Scope flows after revise Scope flows after deleting new scope flow
External node/A External node/B External node/A External node/B
Part /A Part /A

Select objects in the PERT view

Do one of the following:

 Select a single node or flow by clicking it.

* Select multiple nodes by dragging a rectangle around them with the cursor.

* Select a mixture of flows and nodes by keeping the Ctrl key pressed and clicking them.

* Select all nodes by right-clicking in an empty area of the PERT view and selecting Select PERT Nodes.
* Select all flows by right-clicking in an empty area of the PERT view and selecting Select Flows.

» Select all flows and all PERT nodes by right-clicking in an empty area of the PERT view and selecting
Select All or by pressing Ctrl+A.

Delete flows
1.  Select the flow or flows you want to delete.
2. Perform one of these delete actions:
* Click the Delete button X on the PERT toolbar.
* Press Delete on the keyboard.
Deleting flows disconnects the PERT nodes from each other.
Remove PERT nodes in a process PERT view
1. Select the node or nodes that you want to remove.

2. Do one of the following:

* Click Remove a Line =& in the main toolbar.
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¢ Press Ctrl+R.
Teamcenter removes all selected occurrences from the current structure.

Processes and operations are BOM lines so you cannot delete them from the database, only remove
them from a structure.

Delete nodes in an activity PERT view.
1.  Select the activity node or nodes that you want to delete.
2. Click the Delete button ¥ on the PERT toolbar.
Activities are not BOM lines and Teamcenter can, therefore, delete them from the database.
Resequence a process in the PERT chart

The sequence of processes in the process structure are represented by find numbers. Find numbers are
assigned according to the predecessor relationships between the children. Children with no predecessor
are all assigned the same starting find number. Children with the same predecessor are all assigned

the same number—the number of the predecessor plus a defined increment. Children with multiple
predecessors are assigned the highest predecessor's find number plus the defined increment.

Note:

To see the find numbers in the user interface, add the Find No. column.

1. Do one of the following:
* Click g}i on the PERT toolbar.

* Choose Tools—»>Re-Sequence Structure.
Teamcenter displays the Re-Sequence Structure dialog box.
2. Type a start number and increment, then click OK.

Teamcenter changes the line find numbers and the order of the children in the structure pane
according to your entries.

3. Toresequence the child processes, operations, and activities of the current structure, select Include
Descendants.

4. To resequence the lines in the structure without taking the flows into consideration using the
process flow viewer, clear the Consider flows check box.
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Note:

The resequence action does not work in the case of cyclical links.

The resequence feature is applicable only to the process or work area PERT chart. If you open the PERT
view on an activity, the resequence button on the toolbar is unavailable.

Resequencing by drag-and-drop on a flow

You can drag-and-drop a PERT node onto a flow to change the node order and put the dragged node in
between the two nodes previously connected by the flow. For example:

A Z F
D

B
¥
E

Dragging the node D on to the flow between A and B results in the following order:

* The dragged node is disconnected from its old predecessors and successors.

* New flows are created between all predecessors of the dragged node to all successors of the dragged
node.
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* |If the dragged node has either predecessors or successors, but not both (meaning if it was either the
first node in a chain or the last node in a chain), no substitute flow is created.

* The dragged node is connected to its new predecessor and successor. The only predecessor of the
dragged node is the source of the flow on to which it was dragged. The only successor of the dragged
node is the target of the flow on to which it was dragged.

When dragging the node over a flow, the target flow is selected to indicate that it is the target for the
drop.

Process3

ProcessS

Analyzing circular structures

When sequencing processes with the PERT chart, you may end up with a circular structures. For
example:

4-80



Analyzing circular structures _

= X ()% | B 3w

B Line
79, 000824/A:1-Top (View)
-3 000825/A:1-process 1 (View)
':',q 000827 /8,1-process 1-1 (Vi)
-3 000826/A:1-process 2 (View)
78 000828/ 4:1-process 2-1 (View)

ERAPENR=ARY By

9 000828/A

process 2-1

In large structures, these can be difficult to find. Using the Circular Flow view, you can quickly find the
problem areas and rectify them.

Right-click a process and choose Open With—Circular Flow.

Regardless of which process you select in a structure, Teamcenter considers the entire structure
when searching for circular flows. The view displays one circular flow at a time.
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% PERT

000828/ A1 -process 2-1 (...

L J

000827 /41 -process1-1 (...

2. Correct the circular flow in the PERT chart.

3. Open the process repeatedly in the Circular Flow view, repairing the problems in the PERT chart,
until Teamcenter does not find any more circular flows.

Reassign flows by drag-and-drop

You can modify flow source/target nodes by dragging the origin or end point of one of the flows to
another target. For example, if node A is connected to node B and you want to modify this relation to go
from A to C:

1.  Select the end point of the flow.
2. Move the end point from B to C.

If you move the edge of the flow to a nonvalid area, the flow remains connected to the original source
and target nodes.

Find objects in the PERT view
1. Click Find % in the PERT view toolbar.

Teamcenter displays the Find dialog box.
2. Type the desired string and click OK.

Teamcenter highlights the first instance of the string in the PERT chart.

3. Keep clicking Find again f;ﬁ' to find the next instances of the string.
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Displaying assignments in the PERT chart

If the Show Assignments button 5 is turned on, the PERT nodes provide you with information about
assigned parts, resources, and features assigned to the object. If you place the mouse over the object,
Teamcenter provides more information about the assigned objects.

The following preferences control the display of assignments:

MERelationTypeFeature
Specifies which types of manufacturing features are counted when showing the number of features.
MERelationTypePartsConsumed

Specifies which types of assigned objects are counted when showing the number of consumed
objects.

MERelationTypeUsedEquipment

Specifies which types of resources are counted when showing the number of assigned resources.
Show or hide assignments
1. In the PERT view, click the Show Assignments button Ep.

Each process, operation, activity, or work area node lists the consumed parts =, resources &, or
manufacturing features ™, and their occurrence types.

2. Move the cursor over the symbol of the part, resource, or feature in the PERT chart to view more
detailed information.

Notice that the part, resource, or feature symbol turns into a button when you hover over it with
the cursor. You can use this to unassign consumed parts, resources, or features.

3. (Optional) Hide the assignments by clicking the Show Assignments button again.

Note:

Teamcenter remembers the state of the Show Assignments button when you close the PERT
view.

Assign parts in the PERT chart
Do one of the following:

* Drag a part from a product, process, or work area structure to a process, operation, or activity PERT
node.
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» Copy a part from a product, process, or work area structure. Right-click a PERT node and select Paste.

If the Show Assignments button is selected, the PERT node immediately displays the assignments. If the
button is not selected, Teamcenter performs the assignments, but nothing is shown in the PERT node.

Assign a part with a specific occurrence type
1. Inthe structure view containing the part that you want to assign, copy the part.

2. Inthe associated PERT chart, right-click the node to which you want to assign the part and choose
Paste As and select the appropriate occurrence type.

Unassign consumed parts, resources, or features

1. Move the cursor over the symbol of the part, resource, or feature in the PERT chart.

¥
3, 000139/A
assemble_rotor_assembly
@i
+ AR
I Equipment:
000140/A
DH' mh{e_bud g—“’, rack_drill_2010_014/4:1 -Twist Drill (View) - MEResource

Double click to select and unassign objects

Notice that the part, resource, or feature symbol turns into a button when you place the mouse
over it.

2.  Double-click the part, resource, or feature button.
Teamcenter displays a dialog box listing the assigned objects.
3. Select one or multiple objects and click Unassign.
Teamcenter removes the objects from the structure.
Assign resources using the Classification Search Dialog
1.  Select a process or operation PERT node.
2. Choose Edit=>Assign Resource, or click the Assign Resource button & on the toolbar.
3. Expand the Classification Root folder entry in the Classification Search Dialog.

4. Search the various classes and subclasses to locate and select the appropriate resource.
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5. If necessary, change the occurrence type of the resource by selecting from the Occurrence Type
list.

Your administrator can modify the occurrence types that are displayed by default in the
MEAssignCustomizedOccurrenceType preference.

6. Click OK to close the Classification Search Dialog.
Teamcenter assigns the resource to the selected node in the PERT chart.
Zoom in and out

You can view the entire process flow or only selected operations by zooming in or out of the PERT chart
as follows:

Click To

*, Zoom In Increase the magnification by 25 percent and view a
correspondingly smaller area.

=, Zoom Out Decrease the magnification by 25 percent and view a
correspondingly larger area.

ff]l Zoom to Fit Set the PERT chart's zoom ratio to fit all the selected PERT
boxes into the PERT chart window. If you do not select
anything, the command fits all boxes into the PERT chart

window.
5+ Actual Size Display the chart in its original, as-designed size.
‘i Zoom Window Drag a box around an area in the PERT chart to which you

want to zoom.

Press Esc or click Select [; to exit the Zoom Window mode.

Resize nodes in the PERT chart

If the Auto Size Pert Boxes option is turned off in the manufacturing options, you can re-size one or
many PERT nodes.

* To resize nodes manually, select one or more nodes and drag them to the desired size.

Note:

You cannot drag a node larger than the size specified by the PertChart.BoxAutoSizeMaxWidth
preference.

* To resize nodes automatically, do one of the following:
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e To resize one or several PERT nodes, select the nodes and choose Autosize from the shortcut menu.
* To resize all PERT nodes, right-click the background of the PERT chart and choose Autosize.

Teamcenter resizes the nodes to 138 x 50 pixels, or to the size specified in the
PertChart.BoxDefaultWidth and PertChart.BoxDefaultHeight preferences, if they are set.

Change the layout of PERT nodes

* Click Apply Layout Algorithm =, and select one of the following:

Hierarchical 2., Top-to-Bottom Highlights the main direction of a graph, beginning with a
top node and flowing to the bottom.

Hierarchical 2 }= Right-to-Left Highlights the main direction of a graph, beginning with
node at the right and flowing to the left.

Hierarchical 2=[_ Left-to-Right Highlights the main direction of a graph, beginning with a
node at the left and flowing to the right.

Hierarchical 2= Bottom-to-Top Highlights the main direction of a graph, beginning with a
node at the bottom and flowing to the top.

Hierarchical 2., Incremental Displays only the changes to a particular section of the
graph.

&z Circular Displays group and tree structures within a network in a

ring and star pattern.

= Orthographic Creates compact graphs with no overlaps, few crossings,
and few bends. Most appropriate for medium-sized sparse
graphs.

£ Organic Creates a layout with the nodes spaced as far away from

each other as possible, still while minimizing this distance.
Most appropriate for undirected, complex graphs.

Align process steps

You can drag one or more selected process boxes to a different position.Teamcenter remembers the new
position without the need to save changes.

To help align the process steps:

1. Switch on a grid in the process flow viewer by clicking Grid Mode #i. The grid is displayed in the
background of the PERT chart. When it is visible, each box snaps to the grid coordinates

2. Select the boxes that you want to align and do one of the following:
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* Click Shape Alignment E and choose one of the following alignment options:

o Left |2
* Center @
* Right g
* Top oE
* Middle sgs
e Bottom mle
* Distribute horizontally of=
* Distribute vertically &
Drill up and down in a structure
Do one of the following:
* To drill down, select a node and click & or double-click the node.
Teamcenter displays the children of the selected node in the PERT view.
* To drill up one level, click a.

Teamcenter changes the scope to the parent of the previously displayed scope and displays the
parent’s children.

Print a PERT chart

1. With a PERT chart open in the PERT view, choose Print from the view menu.
2. Select a printer and click Print.

Teamcenter prints the PERT chart.

Export a PERT chart

1. From the view menu, choose Export.

2. Choose a file type to export. You can choose from JPG, PNG, or BMP.

4-87



_ 4. Designing process structure

3. Specify an export directory.
Change the appearance of the PERT chart background
* From the view menu, choose Change Grid Style.

Teamcenter changes the background. The background cycles from dotted, to line grid, to an empty
background each time you select the menu command.

Show and hide PERT chart overview pane
1.  From the view menu, choose Show Overview to turn on the menu button.

Teamcenter shows the overview pane at the left of the PERT chart that helps you located your
position within the PERT chart. You can change the size of the overview pane to suit your needs by
dragging the pane divider to the left or right.

2. From the view menu, choose Show Overview again to turn off the menu button.
Teamcenter closes the overview pane.

Teamcenter saves the status of this command for the next session.

View the properties of a step

1. Click the box of the process, activity, or work area in the PERT chart.

2.  Click Launch Teamcenter line properties [=.

Update PERT flows

Use this feature to update pert flows according to the find number of the selected line’s children, orin
the case of multiple selections, of the selected lines. This is necessary if you change the find numbers of
processes or operations in a structure.

1.  Select the scope.
* If the PERT view is open, ensure that the scope selected for the PERT view is the desired one.
Teamcenter uses the PERT view's scope as the scope to update the flows.
* If the PERT view is not open, select one or more lines in a process structure.

2. Choose Tools=Update Flows.
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3. Select Include Structure Sub-Hierarchies to update all sub-hierarchy flows except for activity
flows.

4.  Click OK. This command works only for processes with children. If you make multiple selections,
the command works only for processes with the same parent and of the same type.

Teamcenter removes all the flows of the selected process and creates new flows according to the
find numbers.

5. (Optional) Reapply a layout algorithm to clean up the PERT chart.
Configure the PERT chart

You can configure the behavior of the PERT chart in the Manufacturing options, as well as by using
some preferences.

1. In the Manufacturing Process Planner perspective, choose Edit—>Options and select
Manufacturing from the Options list.

2. Click the Pert tab.

E} Cptions @
¥ Options
J Options - : .
||| General | Pert | Tirne | Gantt | Graphics
..... ] AIE | | | | | P |
----- 1 ARM Transaction bMonitor Auta Size Pert Baxes
""" ] Content Managerment
----- 1 Cross Prabing Configure Pert Node Text
""" T Dataset [ Ohject Type ][ Pert Mode Text Pattern ]
..... % IGI:M tion ForL-d 3 MAELctivity [rme_cl_ohject_narme]
----- ntegration For I-deas
_____ 0O List%f\-"alues MEDP [bl_itern_itern_id]/Thl_rev_iterm_revision_id][bl_rew_object_narne] |
hAEPlant [bl_itern_itern_id]/Thl_rew_item_revision_id][bl_rev_object_narne]
MEProcess [bl_itern_itern_id]/Thl_rew_item_revision_id][bl_rev_object_narne]

3. If you want Teamcenter to automatically fit the size of a new PERT node to the text it contains,
select Auto Size Pert Boxes. If you do not select this, Teamcenter creates each new node the same
size.

4. Configure the text that Teamcenter displays in each PERT node using the Configure Pert Node
Text table. You can specify the contents of a PERT node that depends on which type of object is
displayed.
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Configure Pert Mode Text

[ Object Type ][ Pert Mode Text Pattern ]
MEActivity [rne_cl_object_narme]
MEOP [bl_itern_item_id]/[bl_rev_itern_rewvision_id][bl_rew_...| [
MEPlant [bl_itern_item_id]/[bl_rev_itern_revision_id][bl_rew_...
MEProcess [bl_itern_item_id]/[bl_rev_itern_revision_id][bl_rew_...

Add a new object type to the Object Type list by clicking =+ .
Teamcenter displays a new line in the table.

Select an object type by clicking in the Object Type cell.
Click in the Pert Node Text Pattern cell.

Type the property names that you want to appear in the PERT node. These must have the
following format:

free-text[bl_item_item_id]/[bl_rev_item_revision_id][bl_rev_object name]
where:

free-text Any text except for square brackets [ ]. HTML is not supported.

[property_name] A valid property name for the property type that must be wrapped in
square brackets, for example: [bl_rev_object_name].

Putting text on a new line displays the text on a new line in the PERT node.

For the process PERT chart and the station flowchart, the fields that comprise the formula may
be selected from the BOM line properties or occurrence notes of the object. For the activities
flowchart, the fields may be selected from the activity attributes.

For example, if you enter the following for an OP object type:
Revision: [bl_bomview_rev] Class: [bl_line_object_class]

Teamcenter displays the following operation in the PERT node:

ta Revision: 0000c609 Class:
MEOPRevision

and if you enter the following for an Activity object type:

Name: [me_cl_display_string]
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Desc: [me_cl_object_desc]

Teamcenter displays the following activity PERT node:

* Mame: Activity_01
Desc: Description for
Activity 01

Note:

These values are also stored in the PertChart.Object_Type.Text preference.

Note:

If you customized text in the PERT nodes prior to Teamcenter 9.0, you must remove the HTML
tagging and use plain text.

On the Gantt tab of the manufacturing options, change the implicit flow color.
This implicit flow color is used in the PERT view as well.

Change other pertinent preferences. Some of the preferences listed do not exist in the database;
you must create them manually.

Preference Usage

PertChart.NodeDefault.Text

Configures the default text for all types derived from operation/process and work
area class.

PertChart.ActivityDefault.Text
Configures the default text for all types derived from activity class.

PertChart.BoxDefaultWidth
PertChart.BoxDefaultHeight

Configures the default width/height to be used when new PERT nodes are
created in the preference file (per site, group or user). The values of width and
height are any positive integers and specify the number of pixels used for the
width and height of newly created PERT nodes. If the BoxDefaultWidth and/or
BoxDefaultHeight entry do not exist, 138/ 50 is used as default. Those values
are common for all PERT chart types. Once they are defined in the process PERT
chart, the activity and station flowcharts use these values to define the size of
newly created PERT nodes.

PertChart.AutoSizeMode
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Preference Usage

Turns autosize on or off. When autosize is off, the size of the all newly created
PERT nodes is uniform. When autosize is on, the size of the newly created PERT
nodes is automatically fitted to the displayed text, including allowing for multiple
lines. This preference is applied to all PERT chart types (process, activity, and plant
PERT charts). If the entry is not defined in the preference file, nonautosize mode is
used as default.

PertChart.BoxAutoSizeMaxWidth

If the autosize mode is on, configures the maximum width in

pixels to be used when new PERT nodes are created. For example,
PertChart.BoxAutoSizeMaxWidth=150 causes the following text to be split into
multiple lines:

D’E 000296/ AProcess name is
much too long

If this preference is not set, Teamcenter uses a default value of 170.

PertChart.Object Type.BGColor

Defines a background color for a specific object type. For example,
PertChart.OP.BGColor=40,100,240 displays the following operation node:

Defines the background color for nodes in the process and station flow PERT chart
that do not have an explicit background color definition.

PertChart.NodeDefault.BGColor

PertChart. ActivityDefault.BGColor

Defines the background color for nodes in the activity PERT chart that do not have
an explicit background color definition.

PertChartCreationLayout

Defines where newly created nodes are placed in the PERT chart. If the value is
Horizontal, all newly created nodes are put at the top right corner.

7.  Close the PERT view and reopen it to see the changes.
Filter the process structure

You can select only certain occurrence types to display in the process structure.
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1. Choose Select Occurrence Type Filters from the View Menu list.
Part Planner displays a dialog box that allows you to define the occurrence types that are displayed.

2. Move each occurrence type that you want to include in the process structure display to the Shown
Types column in the dialog box. When the required types are selected, click OK to implement the
selections and close the dialog box, or click Apply to implement the selections without closing the
dialog box.

3. Choose Apply Occurrence Type Filter from the View Menu list to turn on the defined filter.

Creating operations and activities

Operation types

Each process structure contains individual process operations. These operations describe one step in the
manufacturing process of a part. Each operation is executed at a specific work area on the shop floor.

There are many different types of operations that can be included in a manufacturing process model.
Examples of operation types include:

* Machining (NC CAM) Operations
* Painting

* Quality Control

* Heat Treatment

* Assembly

* Welding

Each operation is revision controlled independently, and can be shared by several process plans.

Each operation type is associated with different types of data. In general, this data can be classified as
follows:

Data type Description

Input data Results from a previous operation or activity, such as an in-process
model that was generated in the previous step.

Work instruction data Contains all information necessary to execute the work. This may
include information about tooling and setup and necessary action
to execute the operation. If the work area is not explicitly defined,
the requirements for the work area are specified as part of the work
instructions.

Output data Generated when work instructions are applied to the input data. An
example includes a resulting in-process model and any instructions
to be used in the next operation or activity.
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Data type Description

Analysis data Derived from work instructions used to perform analysis across
different process operations. This may include cost and time.

Product data Associated with one or more parts in the part structure.
Work area data Associated with one work area.
Resource data References resources used during completion, such as standard

equipment of the work area or additional items needed.

Note:

By default, classify immediately is disabled for a root item in Manufacturing Process Planner.

Create a new operation

After you create a top-level manufacturing process, create the individual operations completed as part of
the process.

Note:

You may also want to create stand-alone operations that are not part of a process structure so you
can save these operations as templates and clone their structures.

1. Ina process structure view, select the process to which you want to add an operation.
If the new operation is not to be associated with a process, skip this step.

2. Choose File->New—->Operation, or click Create New Operation ..~ on the toolbar.
The New Operation dialog box is displayed.

3. Select one of the operation types from the list.

4. Click Next.

5. Enter the ID number to be assigned to this new operation. If this new operation is a revision of an
existing one, type the ID of the existing operation. You can assign a unique revision number in the
Revision field.

To let the system automatically assign a unique ID, click Assign.

6. Type a name for the new operation. Make it unique so you can search the database using this term.
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7.  Select Show as new root to specify that the newly created operation is opened as a root object. It
is not pasted to the selected object. If you do not select this option, the new operation is pasted as
a child of the selected process.

If the Show as new root option is selected but unavailable, Teamcenter does not allow you to
create a new object under the selected object, for example, if you try to create an operation under
a part.

8. Type an operation description.
At this point, you have all the information required to create a new operation.

9. (Optional) Click Next to add optional information, such as filling out the operation's forms, or
checking the operation out of the database.

10. Enter logical designator information.

A logical designator is an expression associated with a process, operation or partition that captures
commonality between them. This step appears only if you are creating an operation under a
generic BOM, and only if your administrator has defined a logical designator class for the operation.
This form may include mandatory fields. You cannot proceed until these are filled. If you create
multiple operations, the information you enter in this form is passed to each logical designator in
each new operation.

11. (Optional) Select Define Options to specify the following:

* Select Use item identifier as default display or Use revision identifier as default display if
you created an alternate identifier for the item and want to use it as the default display object.

* Select Check Out Operation Revision on Create to check the newly created operation out of
the database immediately upon creation.

12. Click Finish to create the new operation.
13. Click Close to close the New Operation dialog box.

After the operations are created, create the individual activities that are to be performed as part of this
operation.

Open an existing operation

Do one of the following:

» Expand the process hierarchy in the structure view and open an existing process structure.
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* Open an operation structure by name in the Part Planner using the Open Process or Operation dialog
box.

* Use the My Teamcenter application to search for operations and then send them to the Part Planner
application.

Create operation activities using the Activities view

Each operation can have individual activities that break down the operation into steps describing in
detail what is done as part of that operation. For example, a material procurement operation may
include an activity to unload the material and another activity to move the material to a storage area.
The activities are created as children of the operation.

Each activity is defined by its type, description, start time, and duration. An activity can also reference
Teamcenter objects. This enables you to attach any forms to the activity that represent features and their
associated tooling and instructions.

Note:

You cannot create revisions of activities.

The cumulative time of all activities is recorded and charted on the Activities Gantt view.
1. Inthe process structure view, select the operation to which you want to add an activity.
2. Choose Open With=Activities.

Teamcenter opens the Activities view displaying all the activities belonging to the selected
operation.

3. Select the parent activity for the new activity.
4.  Click the Create New Activity button .4 on the view toolbar.
The New Activity dialog box is displayed.

5. Select the activity type. If there are many types to choose from, you can type a search filter to
narrow your choices.

6. Click Next.

7.  Enter the required information in the activity form. The information you enter here is dependent on
your business needs. Mandatory fields are designated by a red star.

8. Click Finish to add the activity.
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Sequence operation activities

(Optional) After adding the activities, specify the desired sequence operation activity.

To create an activity from a template:

1.

In the structure view, select the operation to which you want to add an activity.
Choose Open With=Activities from the shortcut menu.

Select the parent object for the activity in the Operation Activities pane.
Choose File=*New->From Template->Activity from Template.

Click the Find Template tab to search for an existing template, or select a template from the
Favorite Templates pane.

Sequence operation activities

After you create the individual activities to be completed as part of an operation, you can modify the
sequence in which these activities are performed. This sequence is called the activity flow.

As you sequence the activity flow, identify:

* Preceding activities (those that must be completed before others can be started)

* Parallel activities (those that can be completed at the same time as others)

To sequence operation activities:

Select an operation in the structure view.

2. Choose Open With—=Activities from the shortcut menu.
3. Inthe Activities view, select the root activity.
4. Choose Open With=PERT from the shortcut menu.
Teamcenter opens a PERT view with the selected activity as scope.
5.  Sequence activities with the PERT view.
Note:

You can also use the Activities Gantt Chart tab to sequence an activity.
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Understanding setup structure

The setup structure describes the structure containing operations to be performed. This structure
contains the tooling, resources, parts, and workpieces and their position in the work process.

The following figure shows an example of the operation's setup as it inherits the process setup and all
the elements that make up the setup structure. The setup structure mainly consists of the following:

» Operation's specific resources

* Factory resources linked to plant occurrences

* Consumed parts linked to the product occurrences
» Workpiece

* Inherited process setup structure.

Parts to operations processes

A process structure can be created to describe the flow of processes. Each process may be a container
for all operations performed in one work area. In this case, all the common work area elements from
the factory and the common tooling can be defined at the process level and any specific tooling and
consumed item can be defined at the operation level.

The operation setup structure inherits the elements in its loaded parent process. You must ensure that
the components of the process setup structure and the operation structure are positioned correctly.
Because an operation can be shared across many processes, the inheriting setup is shown only if the
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operation is shown in the context of its parent process. If only the operation is loaded, the process setup
is not shown.

Operation setup may include additional toolings that are specific for performing the operation,
consumed parts, and workpieces. When dealing with large assemblies, not all parts of the workpiece are
of interest to the operation. In this case, you can define a subset of the workpiece that is of interest for
details planning. This subset is another occurrence group that is assigned to the operation. Keep in mind
the following:

* The operation setup includes its parent process setup.

* You can allocate consumed items from any of the manufacturing views.

Create an operation setup structure
1. Create the structure.
2. View the structure and make any necessary changes.

3. Allocate workpieces to the setup structure from any product view. Each element in the setup
structure can be assigned a type. A workpiece has the type MEWorkpiece.

4.  Allocate work area elements as resources.

5. Allocate resources from the resource library.
Assign consumed items to operations

As you create a process plan, indicate the materials that will be consumed during the execution of each
process operation. Consumed items can include parts and components as well as materials such as
grease and gloves.

Use the following steps to specify the items in the part structure to be consumed by the operations in
your plan.

1. Expand the relevant sections of the product and process structures.
2. Inthe product structure view, select the component to be used by the operation.
3. Do one of the following:

* With both product and process structure views visible, drag the selected component to the
operation.
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* Choose Copy from the shortcut menu and paste the copied component to the operation. By
default, objects are assigned using an MEConsumed occurrence type. To specify a different
occurrence, use the Paste As menu command.

4. Repeat this process for each operation to consume an item from the structure.

Note:

By default, an occurrence of the MEConsumed type may be assigned to a process. Your
administrator can change the controllingOccsForProcessConfiguration preference to specify
another occurrence type as valid for assignment at your site. If this preference is blank, the
configuration of consumed items does not affect the configuration of operations.

To identify components that are already consumed and components that are not yet consumed,
do a BOM comparison between the product and the process.

Assign work areas

After you create a process operation and its activities, identify where in the plant the operations
take place. To do this, establish a relationship between the operation and the work area where the
production occurs.

1. Expand the relevant sections of the work area and process structures.

2. Inthe work area structure view, select the work area or station where the operation is to be
performed.

3. Do one of the following:

* With both work area and process structure views visible, drag the selected work area or station to
the operation.

* Select Copy from the shortcut menu and paste the copied work area to the operation.
By default, objects are assigned using an WorkArea occurrence type. To specify a different
occurrence, use the Paste As command.

4. Repeat this process for each operation to consume an item from the structure.

U

Repeat these steps for each process and operation you create.

By default, an occurrence of the WorkArea type may be assigned to a process. Your administrator can
change the controllingOccsForProcessConfiguration preference to specify another occurrence type as
valid for assignment at your site. If this preference is blank, the configuration of consumed items does
not affect the configuration of operations.
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Assign classified resources to an operation
Do one of the following:
* For rough planning, choose Window->Show View—Classification or click ..
Teamcenter displays the Classification view from which you can drag resources directly to a structure.

If you need to paste the same resource into a structure multiple times, copy the resource and use the
Paste Duplicate command to ensure that each resource is a separate resource with a new item ID.
This allows you to position a resource without repositioning other instances of the same resource.

* For more detailed planning, open the Classification Search Dialog.

1. Select an operation from an expanded process hierarchy in the structure view and select the
top-level operation to which you want to attach resources.

2. Choose Edit2>Assign Resource, or click the Assign Resource button & on the toolbar.
The Classification Search Dialog is displayed.

3. Expand the Root folder entry on the Classification Search Dialog.

4. Search the various classes and subclasses to locate and select the appropriate resource.

5. If necessary, change the occurrence type of the resource by selecting from the Occurrence Type
list.

Your administrator can modify the occurrence types that are displayed by default in the
MEAssignCustomizedOccurrenceType preference.

6. Click OK to close the Classification Search Dialog.
Assign unclassified resources to an operation

Assign unclassified resources (such as tools) to an operation as follows:

1. Open the My Teamcenter application and find the resource to be assigned to the operation.

2. Select the object and click the Copy button |- on the toolbar.

3. Open the Part Planner application.

4. Select the operation in the process structure.
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Choose Edit-»Paste Special.

Teamcenter displays the Paste Special dialog box.

Select as component of selected assembly.

Enter the number of occurrences, quantity, and find number.
Select MEResource from the Occurrence Type list.

Click OK.

Note:

You did not make a copy of actual data when you performed the copy and paste functions. You
merely copied an object that points to the data in the database.

Assign resources to activities

As you create operations in your process plan, you create individual activities to be executed as part of
the operation. If any of the activities require that a resource be used during its execution, assign the
resource to the activity.

Expand the process hierarchy in the structure view and select an operation.
Choose Open with=Activities view.

Select an activity.

Click g on the Activities view toolbar.

The Activity Assignments dialog box is displayed.

Only resources previously assigned to the operation to which this activity belongs are listed. You
can use one of the resources already assigned to the operation, or assign a new resource from the
Classification application.

Select the resource using one of the following:
* To assign a resource already used in the top-level operation:

a. Inthe Occurrences on Operation list, choose the resource to be assigned to the activity.
Repeat this function until all necessary resources are selected.

b.  Close the Activity Assignments dialog box.
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* To assign a resource from the Classification application:

a. Click the Assign New Resource From Library button & in the Activity Assignments
dialog box.

The Classification Search Dialog is displayed.
b.  Expand the classification tree if it is compressed.

c.  Search the various classes and subclasses to locate and assign the appropriate resource to
the activity.

d. If necessary, change the occurrence type of the resource by selecting from the Occurrence
Type list.

Your administrator can modify the occurrence types that are displayed by default in the
MEAssignCustomizedOccurrenceType preference.

e. Click OK to close the Classification Search Dialog.

bl

Click OK to close the Activity Assignments dialog box.
Creating plant structures

About plant structures

A plant structure is a hierarchy of work areas, as illustrated in the Sample plant structure. The work
areas describe the locations existing in a plant in which manufacturing operations are performed. The
hierarchy of the work areas can be very different from one plant to another.
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Sample plant structure

Plant
F 4
— Work Area & Operation 1

Rezource A1 C
Resource A2
Fesource A2
Wiark Area B . T— D
| Azzembly M

Resource B
Resource B2

Wark Area C ]
| Dye Stemping , Operation 3

N

Resource C1
Resource C2

Plant architecture example

A The plant structure can represent the entire plant.

B The plant structure can also represent work areas, sections, line cells, or stations within
the plant.

C Each work area can include resources that are permanently positioned at the work area.

D

Individual process operations used to manufacture a product are assigned to the work
areas in which they are performed.
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E Each work area is typically configured with standard equipment but also can be specially
configured with any equipment necessary to execute a specific operation.

F If special resources are needed, create work instructions that explain how to configure
the work area to meet an operation's special needs. If appropriate, create a workflow
process to release the work instructions.

For example, if a process operation requires tools that are not already at the assigned
work area (such as those that are part of work area C), work instructions are generated
to identify which tools need to be available and installed when the process operation is
executed.

Note:

You cannot create a plant in a plant structure. The plant structure represents the plant itself.

Plant layout tools such as FactoryCAD are generally used to populate the work area structure within your
plant. Using a plant layout tool lets you create detailed designs of each work area.

Create a new work area structure

The physical layout of equipment in each work area and the relative locations of these areas throughout
the plant are the scope of the work area structure definitions. Standard equipment is organized
hierarchically into work areas depending on their location on the shop floor.

1. Open a plant structure in a structure view.

2. Choose File->New->Work Area, or click Create Work Area .53.

3. Inthe New Work Area dialog box, select one of the work area types from the list.
4.  Click Next.

5. Enter the ID number to be assigned to this new work area. If this new work area is a revision of an
existing one, type the ID of the existing work area. You can assign a unique revision number in the
Revision field.

To let the system automatically assign a unique ID, click Assign.
6. Type a name for the new work area. Make it unique so you can search the database using this term.

7. Select Show as new root to specify that the newly created work area is opened as a root object. It
is not pasted to the selected work area. If you do not select this option, the new work area is pasted
as a child of the selected work area.
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10.

11.

12.

13.

If the Show as new root option is selected but unavailable, Teamcenter does not allow you to
create a new object under the selected object, for example, if you try to create a work area under a
process.

Type a work area description.
At this point, you have all the information required to create a new process.
(Optional) Select a unit of measure from the Unit of Measure list.

(Optional) Click Next to add optional information, such as filling out the work area item's forms, or
checking the work area item out of the database.

(Optional) Click Define Options to specify the following:

» Select Use item identifier as default display or Use revision identifier as default display if
you created an alternate identifier for the item and want to use it as the default display object.

* Select Check Out Workarea Revision on Create to check the newly created work area out of the
database immediately upon creation.

Click Finish to create the new work area.

Click Close to close the New Work Area dialog box.

Open an existing work area structure

Do one of the following:

* Open a work area revision in Part Planner using the Open Work Area dialog box.

* Find the work area revision item in My Teamcenter. Using the mouse, drag it to the Part Planner
button in the navigation pane; or use the shortcut menu and choose Send To to send it to the Part
Planner application.

* Open a process revision in Part Planner. The work area most recently assigned as a target by the
process is opened by default.

The process revision most recently assigned as a target item by this part opens by default if the
MSE_load_related_product_process_plant preference is set to true.

Sequence the work area flow

The work area sequence represents the line of work areas a product passes through during the

manufacturing process. As you develop your work area structure, you may need to modify the sequence
of the individual work areas in your plant. Set both parallel and linear sequences as necessary using the
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PERT view. While this sequence is independent of any process flow, it does impose constraints on the
process flow through the plant.

Managing collaboration contexts

About collaboration contexts

A collaboration context is used to save groups of data in a specific configuration. It is a Teamcenter
object that holds a collection of data contained in structure and configuration contexts. This data allows
you to capture multiple different Teamcenter structures in one container. You can open a collaboration
context in the Multi-Structure Manager application, in Manufacturing Process Planner, in Multi-BOM
Management, or in Part Planner. You can use the Collaboration Context Tree view to manipulate the
object within collaboration contexts.

A collaboration context consists of any number of structure contexts and one configuration context. A
structure context can contain any BOM or assembly structures. It holds occurrence groups, items, and
item revisions. A configuration context holds the revision rule, variant rules, and closure rule applicable
to the collaboration context, as well as the current state of various buttons that affect the objects seen in
the structure tree and view, such as Show Unconfigured Variants or Show Unconfigured Changes.

You can also use a collaboration context to collect data to share with a third-party application.

You can specify which type of object is pasted under the structure context using the
MESaveAsSC_PasteType preference.

Note:

The PS_assume_legacy_transform_units preference determines how Teamcenter interprets the
units of measure for legacy transform data. Teamcenter and NX currently use meters for transform
units of measure; legacy measurements were in inches or millimeters. This preference affects all
data using legacy transforms that have no database-resident indication of the unit measurement
stored with them. The default setting is Unknown. If the preference is left in the default setting,
you may see discrepancies between the model and display units when you view collaboration
context structures in Manufacturing Process Planner.

Overview of creating a collaboration context
There are two methods used to create a collaboration context:
* Top down:
1. Create an empty collaboration context.
2. Create empty structure contexts within the collaboration context.

3.  Fill up the content of the new structure context by inserting items.
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* Bottom up:
1. Open desired objects.
2. Save these objects as structure contexts.

3. Save all structure contexts in the session to a new collaboration context or move structure
contexts into an existing collaboration context.

You can create a collaboration context for each instance of a collaboration between applications within
Teamcenter or between Teamcenter and an external application. For example, if your Teamcenter
system connects to a Tecnomatix system, you must define a single collaboration context to allow the
two systems to share data.

Create a new collaboration context

How you create collaboration contexts depends on the method you use to build your collaboration
context structure.

* If you use a top down method:
1. Choose File-*New-Collaboration Context.
Teamcenter displays the New Collaboration Context dialog box.
2. Choose a collaboration context type from the list.

* Your administrator can create additional types as necessary with the Business Modeler IDE
administration application.

» Teamcenter places the types of collaboration context you previously created in the Most
Recently Used list.

3. (Optional) Select Open on Create.

If you select this option, Teamcenter opens the new collaboration context in the application
directly after creation.

Tip:

If you do not select this option, you can find the new collaboration context in the Newstuff
folder in My Teamcenter.

4. Click Next.

5. Type a name in the Name box.
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Mandatory parameters are marked by a red asterisk.
6. (Optional) Type a description of the collaboration context.

7.  Click Finish.

Note:

You can create a collaboration context in Multi-Structure Manager, Manufacturing Process
Planner, Part Planner, Multi-BOM Management, and My Teamcenter.

If you selected Open on create, Teamcenter displays the context as a top-level line.
Teamcenter always stores the new collaboration context in the Newstuff folder in My Teamcenter.

* If you use a bottom-up approach to creating collaboration contexts, you can also create a new
collaboration context that contains an existing structure context.

¢ Choose Save as New Collaboration Context from the Collaboration Context Tree view menu.
Save objects as collaboration contexts

You can save loaded structures, including studies, to a new collaboration context. Teamcenter creates
a structure context from each loaded structure that you include in the collaboration context if is not
already contained in a structure context.

1. Select a root line of an object in the collaboration pane and choose File-»Save as->Save as New
Collaboration Context.

Teamcenter displays the Save as New Collaboration Context dialog box.

2. Type a name and description for the new collaboration context in the Name and Description
boxes.

3. Select a type of context from the list. Click More to see a complete list of structure context types.

Your administrator can create new collaboration context business objects (types) in the Business
Modeler IDE.

4.  For each structure in the list on the left that you want to save, enter the following
information. Your administrator can change the existing defaults for this information in the
Default_StructureContext_Type preference.

¢ Name of the structure context

* (Optional) Description
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* Type of the structure context
* Type of the configuration context to be created for this structure context

If the structure is already a part of a structure context, you can see this information when you
select the structure in the structure list. Even if a structure is already part of a structure context,
Teamcenter creates a new structure context for the structure that is based on the existing one and
includes any modifications made to the current structure.

(Optional) If you want to save loaded structures to a new collaboration context that captures linked
released studies or all studies, review the Include Studies list and select the studies to include.

(Optional) Select the Open On Create option to open the new collaboration context.

Teamcenter opens the new collaboration context. The participating structures appear twice: once
in their previous location (as a root structure or as part of another collaboration context object)
and once under the new collaboration context. Additionally, each participating structure is now
displayed in two structure views—one displaying the original structure and one displaying the
newly created structure context.

If you do not choose this option, you can find the new collaboration context in the NewStuff folder
in My Teamcenter.

Click OK.

Teamcenter collects all of these structure contexts into the new collaboration context. In addition,
it creates a configuration context within the structure context containing the revision and variant
rules currently applied to the object. It clones or references the revision and variant rules of the
existing structure, according to the following rules:

* If the current revision rule is saved as public, it creates a reference to it.

¢ If the current revision rule is modified and not saved, it clones the modified rule to create a
private revision rule for the configuration context.

* If the current variant rule is saved as public, it creates a reference to it.

* If the current variant rule is modified and not saved, it clones the modified rule to create a private
variant rule for the configuration context. If the variant rule is cloned, it is not linked to the top
line item in the structure.

¢ |t does not define a closure rule.

Each new structure context refers to all of the occurrence groups that have manufacturing views
(visible tabs) when you save it.
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Note:

If you try to save a structure that is configured by multiple variant rules, you must set the
DisableSaveSOS preference to true.

Save objects as structure contexts
1. Select the object in the Collaboration Context Tree view or ensure the structure view is in focus.
2. Choose Save as New Structure Context from:
* The view menu of the Collaboration Context Tree view or the structure view.
* The Collaboration Context menu command in the File menu.
* The shortcut menu of the Collaboration Context Tree view.
3. Choose a structure context type from the list and click Next.

* Your administrator can create additional types as necessary with the Business Modeler IDE
administration application.

* Teamcenter places the types of structure context you previously created in the Most Recently
Used list.

4. Type a name in the Name box.

Mandatory parameters are marked by a red asterisk.
5. (Optional) Type a description of the structure context.
6. Click Finish.

Teamcenter creates the new structure context and displays it in the Collaboration Context Tree view.
It moves the original structure into the new structure context in the view. In addition, the name of the
structure displayed on the tab in the structure view changes to the name of the new structure context.

Opening a collaboration or structure context

When you open a collaboration context in Part Planner, each structure context within the collaboration
context appears in a separate view. The collaboration context is listed in the Collaboration Context Tree
view.
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Saving a collaboration context

Teamcenter saves any changes you make to the collaboration context automatically, except
for configuration changes. You must save these using the File->Collaboration Context—>Save
Configuration menu command or choosing Save Configuration from the view menu in the
Collaboration Context Tree view.

Manipulate objects in a collaboration context

You can move structure contexts in and out of a collaboration context in the Collaboration Context
Tree view.

e Move a structure context into a collaboration context.
1.  Select a structure context.

The structure context that you select here must be open as a root structure (must show as a root
structure in the Collaboration Context Tree view) and not as part of a collaboration context.

2. Choose Move Structure Context into CC Object from the view menu or choose
File—>Collaboration Context->Move Structure Context into CC Object.

Teamcenter displays the Move Structure Context into CC Object dialog box. The CC Object list
displays all open collaboration contexts.

3. From the CC Object list, select a collaboration context and click OK.

Teamcenter adds the structure context to the specified collaboration context.
* Remove a structure context from a collaboration context.

1.  Select a structure context in a collaboration context.

2. Choose Remove Structure Context from CC Object from the view menu or choose
File—>Collaboration Context->Remove Structure Context from CC Object.

Teamcenter removes the structure context from the collaboration context and displays it as a root
structure in the Collaboration Context Tree view.

Find collaboration contexts containing a selected line
1. Right-click a line in a structure and choose Tools—>Find Affected Collaboration Contexts.

Teamcenter displays a list of any collaboration contexts in the database that contain the selected
line except for structure contexts that consist of occurrence groups, generic BOPs, or plant BOPs.
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2. Right-click the desired collaboration context and choose Send To—>Part Planner or double-click the
collaboration context to open it in Part Planner.

Manage configuration contexts

You can save a specific configuration to a configuration context. You can apply this configuration to a
structure context at a later point. In this way, you can easily change between various configurations to
see their effect on a structure.

Tip:

You can see the currently active configuration in the Configuration Information dialog box or in
the configuration header of the structure view. If the configuration header is not visible, set the
MEShowConfigurationHeader preference to true.

Do any of the following:
* Create a new configuration context.
1. With a collaboration context selected, choose File->New—Configuration Context.
2. Select a type of configuration context from the list and click OK.
3. Type a name for the configuration context and, optionally, a description.
4. (Optional) Specify the revision rule to save in the configuration context.
5. (Optional) Specify the closure rule to save in the configuration context.
6. (Optional) Save the state of the Show unconfigured buttons.
7.  Click Finish.
Teamcenter saves the configuration context object in the Newstuff folder in My Teamcenter.

Caution:

If you create a new configuration context while you have a collaboration context selected,
the new collaboration context replaces the existing collaboration context.

* Save the configuration of an open structure to a configuration context.

1. Select the structure with the configuration you want to save. You can select a root structure or a
structure context.
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2. Choose Save as New Configuration Context from the Collaboration Context Tree view menu
or choose File=»Configuration Context->Save as New Configuration Context.

3. Select a type of configuration context from the list.

4. If you selected a structure context in step 1, select Paste to Structure if you want the new
configuration context to replace the one currently belonging to the structure context.

5. Click Next.
6. Type a name for the configuration context and, optionally, a description.
7.  Click Finish.
* Apply a saved configuration to an open structure.
1. Select a structure context or an open structure.

2. Choose Apply Configuration Context from the Collaboration Context Tree view menu or
choose File=Configuration Context2>Apply Configuration Context.

Note:

When applying a configuration context that contains the Preference-Driven entry for the
Show Unconfigured buttons, Teamcenter respects the settings of the structure to which
the configuration context is being applied and does not change the state of the buttons to
reflect the MEShowUnconfigured... preferences.

3. Search for a configuration context by clicking Open an object by name 4.

Teamcenter displays the configuration contained in the selected configuration context in the
Apply Configuration Context dialog box. These entries are for informational purposes only. You
cannot change them.

4. Click OK.
Teamcenter applies the new configuration to the open structure.

* Restore a configuration to the one saved in the loaded configuration context.
1. Select the structure context.

2. Choose Restore Configuration from the Collaboration Context Tree view menu or choose
File-Configuration Context->Restore Configuration.
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Teamcenter applies the configuration contained in the existing configuration context to the
structure view.

Note:

When applying a configuration context that contains the Preference-Driven entry for the
Show Unconfigured buttons, Teamcenter respects the settings of the structure to which
the configuration context is being applied and does not change the state of the buttons to
reflect the MEShowUnconfigured... preferences.

* Save an existing configuration.

* Select a structure and choose Save Configuration from the Collaboration Context Tree view
menu or choose File=»Configuration Context->Save Configuration.

If you select This happens
A structure context that has a The configuration context is updated to reflect the
configuration context current configuration.

A structure context that does not have A dialog box opens where you can choose the name,

a configuration context type, and description for the new configuration context.
The new configuration context reflects the current
configuration.

A collaboration context For each structure context under the collaboration
context:

m If the structure context has a configuration context,
the configuration context is updated to reflect the
current configuration.

m If the structure context does not have a configuration
context, a configuration context is not created and
a message lists the structure contexts for which a
configuration was not saved.

Saving the state of the Show Unconfigured ... buttons

Teamcenter provides you with several buttons or menu options that show or hide objects in the
structure and in the Graphics view. These are:

* Show Suppressed Occurrences
* Show Unconfigured Variants

* Show Unconfigured By Occurrence Effectivity
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Show Unconfigured Changes

Show Unconfigured Assigned Occurrences (only applicable to process assemblies)

Show GCS Connection Points

Apply Occurrence Type Filters

Whether these buttons are turned on or off affects what is shown in the Graphics view, and, therefore,
affects any product view snapshots created in that view. Teamcenter saves the state of these buttons so
that when a product view is restored, the same objects are displayed in the Graphics view as when the
snapshot was created. The state of these buttons is stored in a configuration context.

When you create a new configuration context or save an existing configuration to a configuration
context, you can specify the state of the first four of these buttons (On or Off), or you can specify that
the state is Preference-driven. The following preferences specify the state of these Show Unconfigured
buttons:

* MEShowSuppressedOccsDefaultState

* MEShowUnconfiguredVariantsDefaultState

* MEShowUnconfiguredOccurrencesEffectivityDefaultState
* MEShowUnconfiguredChangesDefaultState

* MEShowUnconfiguredAssignedOccurrencesDefaultState

You can also view or change the state of all options in the configuration context properties.

Occurrence Type Filters: |MEFeatureAssign &
MEMachineTool
MULL
‘ b
Show Guided Component Search Connection Points: |
Show Suppressed Occurrences: |
Show Unconfigured Assigned Occurrences: |preference-driven
Show Unconfigured By Occurrence Effectivity: |
Show Unconfigured Changes: |,
Show Unconfigured Variants: | o5
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Note:

When applying or restoring a configuration context that contains the Preference-Driven entry for
the Show Unconfigured buttons, Teamcenter respects the settings of the structure to which the
configuration context is being applied or for which the configuration context is being restored

and does not change the state of the buttons to reflect the MEShowUnconfigured... preferences.
This retains the behavior of configuration contexts that were created prior to Teamcenter 10.0,
when the configuration context did not save the state of the buttons. When you open a structure
or collaboration context containing a configuration context where all values are set to Preference-
Driven, the structure view opens with the states of the Show Unconfigured buttons reflecting the
values of the preferences.

Pasting under a collaboration context object

When pasting a structure context to a collaboration context or a configuration context to a structure
context object, Teamcenter pastes it with an IMAN_CCContext relation. Do not use the Paste As
command to change this relation when pasting collaboration context objects. If you change the relation,
the associated contexts will no longer load when loading the collaboration context.

Creating structures from templates

About cloning structures

When creating structures, it can be convenient to create a structure identical to another one. This may
be because, over time, you may design standard products, processes, operations, and activities that
act as templates that can be reused to manufacture typical products. Or, it may simply be the most
convenient way to quickly generate another structure.

You can clone structures in one of two ways:

* Use the Paste Duplicate command to quickly clone a structure from another structure that is visible
or easily available in the user interface.

* Use the File->New—->From Template menu commands to create a structure that is based on another
structure that is not currently open. You also use this method to clone structures when you want to
select configuration options for the cloning process.

You can clone a process, product, or plant structure. Your administrator specifies cloning rules that
determine the actions taken when you clone a structure, as follows:

* Clone
The new structure includes a copy of the object that is referenced by the source structure.

e Reference
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The new structure references the same object that is included in the source structure.
Ignore

The new structure does not include or reference the object.

Map

The system maps the template to a replacement structure. For example, this allows you to create a
process structure from an existing process or from a process template. Optionally, this rule may be
allowed by a second (default) action: Reference or Ignore.

You can use the cloning mechanism to create a new process structure that consumes the same parts as
an existing structure. This action is based on in-context IDs.

Note:

Cloning is a core capability and is used in various functions, such as, create alternate, create from
template, process synchronize, and isolated study. It is very recursive and database I/O intensive.
To help reduce the number of database commits to the minimum needed, your Teamcenter
administrator can create a preference named ME_defer_save_in_clone and set it to true.

IMPORTANT: The value of this preference should be made true only after running cloning
usecases in a test environment. This is required as cloning may fail in specific data conditions
when the preference is set to true.

Create a structure from a template

Note:

Ensure that the necessary Product.Template, Process.Template, and Plant.Template cloning
preferences are defined. These preferences contain the rules that determine how the objects in the
template are mapped to the objects in the new plant structure.

Choose File->New—>From Template and the type of structure that you want to create.
Click the Choose Template tab.

In the Template ID box, enter the ID of the structure that you want to use as a template and press
Enter.

You can also browse to the template you want to clone using Resource Manager, either by name or
by searching for a template in the Classification Search Dialog if it is classified.

Teamcenter assigns a new ID in the Process ID box.

(Optional) Rename the new structure in the Name box.
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5.  Click the Configuration tab.
6. Select a revision rule from the Revision Rule list.
7. Select an effectivity by clicking Set Date/Unit/End Item.
8. Do one of the following:
* Click Process all variants to traverse the structure considering all unconfigured variants.

* Click Process configured to only process the configured structure. You must specify a variant
rule when you choose this option. The structure is configured using the variant rule and
unconfigured variants are not considered during cloning.

9. From the Cloning Rule list, select a rule.
10. If you are creating a process from a template,

* Choose the product to which you want to map the consumed products by selecting it in the
Product Reference Structure list.

* Choose the work area to which you want to map the consumed work areas by selecting it in the
Plant Reference Structure list.

This allows you to clone a process and map the consumed objects to different structures from the
one chosen in the prototype.

11. (Optional) Select Carry over future incremental changes.

If you select this option, you must set the date in the cloning dialog. If you do not select this option,
cloning copies the configured structure only.

12. (Optional) Select Show as new root to create the cloned structure as a top-level object.
13. Click OK or Apply to create the new structure from the template you choose.

At the end of any cloning operation, if new incremental changes are created as part of cloning
process, Teamcenter displays a dialog box listing the new incremental changes.

Attaching variants as cloned structures

When a template is used, the structure it represents is duplicated to create a cloned structure. The
cloned structure includes the manufacturing processes, operations, activities, and parts of the structures
associated with them. Any variant options attached to template objects are cloned and attached to the
matching clone objects. Load If variant conditions, Set If option defaults, and Error If rule checks in
template structure occurrences are duplicated in the clone structure.
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Variant expressions referring to variant options attached to template objects are matched to the options
attached to the corresponding clone objects. For example, consider a part that includes Item 001 -
Mounting Thread. This item has a variant option called Dimension, which can have a value of either
Metric or Imperial. The part (Item 001) includes an occurrence of Item 002, thread insert with a variant
condition stating Load if Item 001's Dimension = Metric.

When this part is used as a template, two items are cloned:

* Item 001-Mounting Thread is cloned to Item 101-Mounting Thread. It has an option called
Dimension, which can equal Metric or Imperial.

* Item 002-Thread Insert is cloned to Item 102-Thread Insert. It has a variant condition stating Load
if Item 101's Mounting Thread = Metric.

Note:

This only works with classic variants.

Consuming products in cloned processes

Set a cloned process structure to consume products from a cloned product structure

A process structure consumes products from a product structure. By default, a cloned process structure
consumes products from the same product structure as the original process structure. If you want a
cloned process structure to consume products from a cloned product structure, you must set up this type
of cloning when you create the cloned process structure.

In this example, the original process structure is called Process Structure 1. The original product
structure is called Product Structure 1 and the clone of Product Structure 1 is called Product Structure
2.

1. Make sure that the in-context IDs in Product Structure 2 are the same as those in Product
Structure 1. This is the case when you clone Product Structure 2 from Product Structure 1.

2. Make sure Product Structure 2 is loaded when you clone the process structure.
3. Inthe New Process from Template dialog box:

a. Select Process Structure 1 as the template.

b.  Click the Configuration tab.

c.  Select Product Structure 2 from the Product Reference Structure list.

d.  Click OK.
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The newly cloned Process Structure 2 now consumes a part in Product Structure 2 for each
part in Product Structure 1 that is consumed by the Process Structure 1 template process.

Consuming parts in a cloned process using smart in-context IDs

You can use smart in-context IDs (IDICs) to consume parts with the same usage into cloned process
structures. Your administrator can set up the in-context ID to be based on other BOM line properties
such as usage address or reference designator so that they are independent of the top line.

For example, you have a product structure (Model A) which is consumed in a process (Process A).
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You also have a new product, Model B, with the same part usages. You then clone Process A to create
the new process to manufacture Model B and call it Process B. Ideally, you want all the parts that are

consumed in Process A to be automatically consumed in their counterparts in Process B, based on the
same pat usage.

Your administrator has configured the in-context ID to consist of the property or properties that
represent the part usage (for example, usage address). The parts in Model A are stamped with these
in-context IDs which are carried with the parts when they are assigned to Process A.

When Process A is cloned to fetch consumed parts from Model B (cloned with the option to map

consumed from a reference product), Process B is created with the appropriate consumed parts from
Model B.
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Apply revision rules to templates

1. Onthe New Process from Template or New Operation from Template dialog box, click the
Configuration tab.

2. Click Revision Rule to select a revision rule for the template. The box lists all revision rules that are
defined in the database.

_Or_

Click Cloning Rule to select a cloning rule for the template. The box lists all cloning rules that are
defined in the database.

Save template favorites

Save commonly used templates to a favorites palette so they can be quickly accessed and used.

1. Open the New Process from Template, New Operation from Template, or New Activity dialog
box.

2. Select the template using one of the following methods:

* For processes and operations, type a Template ID value on the Choose Template tab. The
template ID is the process ID or operation ID of the process or operation being cloned.

* For activities, specify an Operation ID value for the operation where the activity occurs on the
Find Template tab, then select the Operation Revision and Activity as a basis for the template.

Note:

You may also use the Find by Name or Find by Class buttons to find the template in the
database.

3. Click Add to Favorites.
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Select a process or operation template

Any template previously saved as a favorite is displayed by name on the Choose Template tab.
Templates not saved as favorites may be accessed from the database.

To select template that is saved as a favorite:
1. Open the New Process from Template or New Operation from Template dialog box.

2. Onthe Choose Template tab, click the favorite template you want to use. Use the scroll bars on
the right of the tab if the list is extensive.

* The Template ID text box is automatically updated with the template ID of the selected favorite
template.

* The Item Details section in the dialog box is automatically completed with the process or
operation ID, revision, and name upon which the template is based.

3. If necessary, click the Configuration tab and set a revision rule for the template.

4. Select Show as new root to open this new process or operation as the root process or operation in
a structure view.

5. Click OK.
The new process or operation is created.

To select a template from the database:

1. Open the New Process from Template or New Operation from Template dialog box.

2. On the Choose Template tab, use one of the following methods to search for the template.
* In the Template ID box, type the ID of the process or operation to be used as a template.

* Click the Find Template by Name button and search for the template using its name or ID. Use
wildcard characters in your search, if necessary.

* Click the Find Template by Class button to open the Classification Search Dialog and search for a
classified template.

The Item Details section is completed with the information for the template you have selected.
3. If necessary, click the Configuration tab and set a revision rule for the template.

4. Select Show as new root to open the template as the new root process or operation.
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5. Click OK.

Select an activity template

Any templates previously saved as favorites display by name on the Favorite Templates tab in the dialog
box. Templates not saved as favorites can be accessed from the database.

To select a template that is saved as a favorite:
1. Inthe New Activity dialog box, click the Favorite Templates tab.
All activities previously saved as favorites are listed.
2. Click the favorite template to be used.
3. Click OK.
To select a template from the database:
1. In the New Activity dialog box, click the Find Template tab.
2. Use one of the following methods to specify the template ID:
* In the Operation ID box, type the ID of the parent operation for the activity to be used.

* Click the Find Operation by Name button ©., and search for the parent operation using its name
or ID. Use wildcard characters in your search, if necessary.

* Click the Find Operation by Class button - to open the Classification Search Dialog and search
for a classified activity template.

3. After you specify an operation ID, click the Operation Revision button “ to open the Revision
Selection dialog box.

4. In the Revision Selection dialog box, use Revision Display Filter to filter revision types for the
selected operation. Use the additional filter buttons to clarify the filter further for only released,
in-process, or working revisions.

5. Double-click the appropriate revision.

The revision is displayed in the New Activity dialog box. All activities that exist as part of the
operation revision are loaded into the Activity list.

6. Select an activity.

7.  Click OK.
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Remove a favorite template

1. Open the New Process from Template, New Workarea from Template, New Operation from
Template, or New Activity dialog box.

2. From the Choose Template (processes and operations) or Favorite Templates (activity) tab in the
Template pane, choose the template to be removed.

3.  From the shortcut menu, choose Remove from Favorites.

The template is removed.

Note:

To remove a database template that is not saved as a favorite, use the same process you would use
to remove any other database item.

Carrying over future incremental change when cloning

When cloning, you have the option to carry over future effective incremental changes. If you are using
date effectivity, future is anything falling after the date set in cloning dialog box. If you are using

unit effectivity, future is anything after the unit number set in the cloning dialog box. Incremental
changes that are currently effective are merged with the currently set incremental change. Those that
are effective in the future are carried forward to the new cloned structure or re-created under new
incremental change revisions. Any incremental changes whose effectivities are in the past are dropped
from the cloned incremental change.

Note:

» Specify the release status type that is assigned to any newly created incremental change
revisions during cloning in the Clone_Pending_Release_Status preference.

* Specify the release status type that should be considered as secure in the
Clone_Secured_Release_Status preference.

In the following figure, the vertical line represents the point of cloning.
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Cloning with incremental changes

1 IC1 Incremental change 1 whose effectivity lies in the past.
2 IC2 Incremental change 2 that is secure and configured.
3 IC3 Incremental change 3 is the current IC (set at the bottom of the pane) that is

configured and pending. This is the target IC.

4 IC4 Incremental change 4 is pending and unconfigured.

After cloning, Teamcenter:
* Disregards IC1.

* Clones IC2 to a new IC5 and the change elements in IC2 (that is, add or remove) that are associated
with the cloned object are cloned and added to IC5. IC5 then has a pending status.

* |C4 is left alone and the new change elements are added to it. This is not cloned because the status is
pending and the out effectivity does not match the currently set IC revision (IC3).

Override copy action rules

To override the template copy action for any object found in a structure, add a template action
occurrence note to the object in the cloned structure as follows:
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1. From the Edit menu, choose Notes, or click the Notes button [ ] on the toolbar.
2. Inthe Create list, choose TEMPLATE ACTION.
3. Enterlgnore, Reference, or Clone in the Description box.

4. Click OK.
Associating product and process structures

Creating a relationship between product and process structures

After you define all operations and activities that comprise a manufacturing process, establish a
relationship between the process and the part it manufactures. To do this, associate the part as a target
item of the process.

You can also assign product parts to the process structure with a specific occurrence type. The following
table lists some of the available occurrence types.

Occurrence type Use

ME Assign Used when assigning parts to processes.

MEConsumed Used by the operation that takes a part out of the bin.

METool Used to assign tools to processes and operations.

MEResource Used to assign equipment to processes and operations.

ME Assemble Used by the operation that attaches the part to the product.

ME Disassemble Used by operations when they disassemble a part.

ME Handle Used when all other relationships to an operation do not
apply.

ME Feature Assign Used when assigning manufacturing features to operations.

METarget and MEOther Used for other types of assignments that do not involve

consuming, handling, assembling, or disassembling for
operations and assignment for processes.

Associate a product as target

When you associate a product as the target, you create a relationship between the product structure and
the process. You can link a product and a process several times if the process is repeated.

1. Right-click the process line and choose Link/Associate—>Associate Product as Target.
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Teamcenter opens the Associate Product as Target dialog box with the process listed in the
Process box.

< D01363-dT8efo9 T 001371-d78ef00 - assy X
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@ Sssociate Product as Target @

Process:

001371A81-dT3efaY - assy (Wiew)

Targets:

o

2. Inthe product structure view, select the product line that you want to associate as the target and
click the Set/add current selection button =t in the Associate Product as Target dialog box.

Teamcenter enters the name of the part in the Targets box.
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Click OK.

This attaches the part structure as the target to the setup structure of the process. You have
established the relationship between the part and top-level process used to manufacture that part.
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You typically choose this option for a part of the METarget occurrence type that is defined in the
NX CAM Integration.

Note:

When you save an MENCMachining operation in the NX CAM Integration, the associated
part is automatically assigned as the target in Manufacturing Process Management.
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Assign a part to a process
Do one of the following:
* Use the Copy and Paste commands.

1. Right-click a part revision in a structure view and choose Copy, or click the Copy button % on
the toolbar.

2. Inthe process pane, select the appropriate process and choose Paste.
* Drag the part to the appropriate process.

By default, if an occurrence type is defined for a BOM line and you assign the BOM line to a process

or operation, Teamcenter uses the same occurrence type. However, if your administrator sets the
MEAssignCustomizedOccurrenceType preference, you can specify a different occurrence type during
the assignment.

You can specify the properties that are copied over from part to process during the assignment process
using the MEAssignProperties preference.

Assign a product with a specific occurrence type
Do one of the following:
* Assign using Copy and Paste As.

1. Right-click a part revision in a structure view and choose Copy, or click the Copy button % on
the toolbar.

2. Inthe process pane, select the top-level process to be assigned to the part selected in the
product pane and choose Paste As and one of the occurrence types listed, depending on the
purpose of your assignment.

If you assign as MEConsumed, Teamcenter establishes the link between a part and the process
when the part is consumed in an assembly operation. A consumed item is required during a
manufacturing process or operation.

If you assign as MEWorkpiece, Teamcenter establishes the link between the workpiece and a
process or operation. A workpiece can represent an intermediate state of the product during the
manufacturing process.
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Note:

The occurrence types available to you are determined by your administrator using the
MEDisplayOccurrenceType preference.

* Change the occurrence type in the Occurrence Type column.

Share an operation across process plans

You can share an operation across top levels of two process plans.

S ;
| SubAssembly 1 | Sub Assembly A
| |
I —>[_Farl ] . —>[_PL |
: —>{ Pz |~ :
| \ |
| S |
| \. \ |
| - |
I 1| I
I —>[Process Plan 1 !}. I —>[Process Plan 2
Cpll ——— "
Y
—Es kS

€-> Associate product to process
—> Assign parts to process
N Share an operation

Link to manufacturing process

Note:

You cannot use this method to share operations within the same process plan.

1. Copy the operation that you want to share to the clipboard.
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2. Load the second top-level plan with which the operation is to be shared.
3. Expand the process plan to the required subprocess.
4. Paste the operation to the subprocess.

Teamcenter does not create a new operation with a unique ID.

5. Expand the subprocess to the required items that are consumed in the shared operation for this top
level.

6. Select the consumed item in the process and choose Link/Associate->Link to Manufacturing
Process from the shortcut menu.

Teamcenter displays the Link to Manufacturing Process dialog box.

7. Select the desired part from the Source parts list or select the part in the product structure and
click Set/Add current selection i=.

8. Click OK.
Reconciling broken links

About broken links

Changes to the product or plant structure are not automatically updated in the process tree where the
occurrence is referenced. This results in a broken link. With this feature, you can identify broken links
and search for the possible occurrence that was originally defined, for example, as a consumed part.

When you expand a process to display linked items, each link line includes a symbol indicating the state
of the reference:

Symbol Description

== Occurrence is linked to a product or plant structure.

&5 Link is broken.

=53] Occurrence is linked to a product or plant structure that

is not currently loaded, or a product or plant structure is
loaded but not currently configuring the process structure.

Note:

Teamcenter retrieves the status of a link from a run-time property, MfgOLinkState.
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When performing the search for broken links, Teamcenter searches through process structures that you
specify and looks for broken links. It then looks through product or plant structures that you specify

for likely candidates to repair these links. The search is based on criteria that you can specify in the
MPP_DefaultCandidateSearchCriteria preference. Once found, you can have Teamcenter repair these
links automatically, or you can choose to select candidates manually from the candidates list.

Your administrator can save search criteria for you to use. You can further modify these criteria and save
your modifications to the saved criteria.

When there are many broken links and each broken link has many candidates, a large amount of
memory is required for high-speed processing. If the total number of broken links and candidates is too
large, for example, 32,000 lines, the memory usage may be a concern if you are performing the search
on an underpowered computer. To speed up the search, divide the search scope into smaller pieces to
reduce memory usage; for example, select subnodes instead of the root node.
If you see the white link symbol == for a line, it means that the occurrence is linked to a product or plant
structure that is not currently configuring the process structure. Select Define Configuring Structures
from the view menu to specify the product or plant that should configure the process.
The following properties are supported in a search for broken links:
* Aselection of BOM line properties:

Item Id

Find number

Quantity

Usage Address

Reference Designator
Position Designator

* All types of occurrence notes

* Any extended or custom properties your administrator creates

* Properties found on the weld attribute form

Identify broken links

1. Open the process in which you want to search for broken links.

2. Choose Tools—>Repair Broken Links or choose Repair Broken Links from the shortcut menu.
Teamcenter displays the Repair Broken Links dialog box.

3. Modify the scope for the broken link candidate search by adding or removing product structure
lines. Do this by selecting them in the product structure and clicking Set/Add current selection =.
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4. (Optional) Modify the search criteria.
5. To set a revision rule, click Alternative Revision Rule.
You can choose to view or set the revision rule, enter the end unit/date, or set an override folder.

6. Choose whether you want to perform a quick or a more thorough search in the Structures
Traversal section.

Click To

Visible Structure Search through the launched, loaded structure (all the
currently expanded and visible lines). The quick search does
not include nodes that have never been expanded (that is,
nodes that are not loaded) or are hidden due to effectivity or
variant conditions.

Full Structure Search through the complete tree in the launched structures,
loading as necessary. The search expands collapsed
(unloaded) nodes; it does not include nodes hidden due to
effectivity or variant conditions.

7.  To search for broken links only, and not perform the more time-consuming candidate search, clear
Include Candidates.

8. To have Teamcenter repair the links automatically, select Automatic Repair.

Teamcenter searches for eligible candidates in the product or plant structure and, if only one
candidate is found, automatically creates a relationship of the same type as the broken link
between the process line and the lone candidate.

9. Click Search.

Teamcenter searches for all broken links from the selected process node down to the leaf nodes
and displays them in the Broken Links list. If you select Include Candidates, it also searches for all
candidates that fulfill the search criteria and displays them in the Candidates list.

If you select a line in the process structure on which to perform the search with multiple broken
links in the substructure, and Automatic Repair is active, all broken links for which Teamcenter
finds a unique candidate are repaired.

Repair broken links
1. Search for broken links.

2.  Select the broken link that you want to repair from the Broken Links list.
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3. (Optional) Click Show in Tree to see the line containing the broken link highlighted in the process
structure.

4. Select the candidate to which you want to relink the process line in the Candidates list.

5. (Optional) Click Show in Tree to see the candidate for repair highlighted in the product or plant
structure.

6. Click Repair.
Teamcenter relinks the process line to the product or plant line and the symbol is updated in the
Broken Links list to show the link is no longer broken. You can select multiple pairs of broken links/

candidates before clicking the Repair button. Teamcenter remembers your choices and processes
all the pairs that you select.

Modify search criteria

By default, when searching for candidates to repair broken links, Teamcenter examines the properties
listed in the search criteria that you select from the Stored Criteria list. If the criteria of a perspective
candidate match the values in the search criteria, the candidate is proposed as a replacement.

1.  Select a search criteria from the Stored Criteria list.
The choices shown are saved by your administrator.

2.  Click Edit beside the Stored Criteria box and add BOM line properties by clicking the Add +
button.

Teamcenter adds new properties to the criteria list in the order in which they are displayed in the
columns of the process view. To display more properties, you must first add new columns with the
desired properties to the process view.

Note:

If a property is added by a preference, its name is displayed as the internal property name.

3. Designate whether the properties should be considered as mandatory or optional by clicking in the
cell and selecting a value.

4. Enter a property value.
You can use the * wildcard symbol or a space between characters.

5. (Optional) Save the modified search criteria by clicking Save Criteria.
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You can only modify search criteria that were saved by your administrator. You cannot modify the

MPP_DefaultCandidateSearchCriteria search criteria.

Break associations

To break an association between a part and a process or a work area and a process, do the following:

1. Right-click the process root and choose Link/Associate->Associate Product as Target or Link/
Associate—->Associate Workarea, depending on which association you want to break.

Teamcenter displays a dialog box listing the existing associations.

2. Select the undesired association and click Remove selected object —.

Teamcenter removes the association between the part and process or work area and process.

Consuming an assembly with in-context information

In the following example, an assembly part is consumed below a process structure. If a child item in the
product structure contains in-context information that was edited for a part above the consumed part,
you cannot see the in-context information in the process structure. In the following example, it6 has a
variant condition in the context of it_top. Therefore, you see the variant symbol and the target symbol

in the product structure.

000%39/4; 1-pri (VYiew)
B e A 00092414; 1-t1 (View)
5 000937 /A 1-it6

Process Structure

Item Typ
MEFrocess
Ikem
Ikem

it top

. __ 1275911693 _Private_3 (Modified) '\ Date -"Now" ') it_top

BOM Line /

Ttem T 4

2, honozaja; 1-it_top (Yiew)

=& % 000924/4;1-t1 (View)
4 ®%) 000937/4;1-it6

Kl |

Item
Item
Item

>

i

If the in-context information is added in the context of the consumed line or below it, it is visible. In the
following example, the variant condition of it7 is edited in the context of it1, which is the consumed

line. Therefore, the in-context information is available in the process structure.
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Prn-c;.m Structure Ttem Typ
';: »ﬁﬁ-a num24_m; -1 (View) Item
1 % 000940/, 1-t6 (View) tem
3% 000941/4; 1-it7 Item
4| |
—

_ ietop |

"8\ __1275911693_Private_3 (Modified) %! Date - "Now" N\ it_top

iN CONTEXT: [« GOBSZAIISEL (Hew) «
BOM Line / tem T "
u!- r:lnn??m {-it_top (Yiew) T

E [JDEI'B‘!IJ,I'P. 1-ikE (Wiew)
‘A% 000941/4;1-t7 Il:f:m

4 | o

Link unconsumed items as required

You can add items to a process plan that are used by a process but not consumed by it, such as glue or
heat treatment. You link these using a MERequired relation.

1. Open the process structure and the product structure that contains the item you want to link.
2. Right-click the appropriate operation in the process structure and choose Link->Link As Required.
Teamcenter displays the Link as Required dialog box.

3. Select the item in the product structure that you want to link to the operation and click ¥=* in the
Link as Required dialog box.

4. Click OK.
5. Right-click the operation and choose Open With->Required Items.

Teamcenter displays the Required Items view showing the item that is linked.
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.4, 011229-preduct 23\[-} Wulkalea} = O |= Required ltems 53 = " Y =8

% w R
BOM Line
] O_llZB/A;l—product View)
% 011231 /AL -item2

“ n 2
=0 A—24 Required#1 011230-iteml— ¢, (TRl 0Bl B e ale)
% @ B EEEE

Process Structure |

011232/41-process top (View)
PR 011234/4:1-operation

6. (Optional) Reopen the Link as Required dialog box as described in steps 1 and 2.

Teamcenter displays the linked item in the list.

Q Link as Required @
Operation:

011234781 -operation
Required parts:

%5 011230-item1

| ok || cancel

Visualizing structures

Ways to visualize structures

You can visualize a structure in several ways.

4-138 Part Planner, Teamcenter 2412
© 2025 Siemens



Display images in the Graphics view _

* The Graphics view available in the manufacturing applications allows you to visualize the product,
process, or plant structure. You open the Graphics view, sometimes referred to as the embedded
viewer, by clicking % in the structure view toolbar.

When the Graphics view is open, many of the secondary views exhibit boxes in front of the nodes in
the hierarchy structure that you can use to turn graphics display on and off.

* The rich client Lifecycle Viewer application provides you with nearly all of the visualization tools
offered by the stand-alone viewer, many of which are not available in the embedded viewer
within Teamcenter applications. You open the rich client Lifecycle Viewer application by clicking the

Lifecycle Viewer application icon%.

 Stand-alone Lifecycle Visualization provides you with all the functionality of a viewer view or the
Lifecycle Viewer but with support for optional software modules such as Concept, Visualization
lllustration, Quality Producer, and Variation Analysis. Stand-alone Lifecycle Visualization is integrated
with Teamcenter, so you can send data from Teamcenter applications into the stand-alone viewer,
perform analysis, and then save your work back to the database.

Display images in the Graphics view

If an image is associated with the object selected in a structure view, opening the associated Graphics
view displays that image.

The following image types are available in this view:
* DirectModel

Imported .jt files or .jt files created by the translators. These datasets containing these files must be
attached to the item or item revision with a Rendering relation.

* DirectModelMarkup
Captured image of a DirectModel dataset.
* DrawingSheets and Markup
Imported .cgm files.
* Image
Imported .tif, .gif, .jpeg and similar file types.
When you open an image in the Graphics view, the Graphics menu is displayed in the menu bar.

1. Right-click a line in the structure view and click % in the view toolbar.
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Teamcenter opens the Graphics view associated with the structure view from which you open it.

Note:

Do not confuse this assembly viewer with the viewers that you can open using the Open
With shortcut menu command. The assembly viewer has more features that you can use to
view and manipulate 3D assemblies.

2. Select the check boxes next to the components in the tree that you want to display in the Graphics
view. If you select the root item, the entire structure is displayed.

BM Line

S 0002758; 1 (View)
LV D003030A;1

- 000279081 (Miew)
B 00028008; 1 (View)
B 000281)8;1 (View)
B 000252081 (View)
B 000283081 (View)
B 000254 8;1 (View)
B 000272081 (Miew)
B 000286081 (Wiew)
B 000313081 (View)
B 000314081 (View)
B 000315081 (View)

When you open the Graphics view, other views that display the hierarchy also display the check
boxes that you can use to blank and display graphics. These check boxes are slightly different.

The following states exist for the check boxes.

Check box State

v The part or assembly is fully loaded and visible.

v The assembly component is fully loaded but only partly visible. This can be
because a part is turned off or because geometry does not exist for one or
more parts.

~ The assembly component is partially loaded and only partially visible.

v All available geometry is visible, but geometry does not exist for every part.

I The part or assembly is loaded but not visible.

- No geometry exists for the selected part, or if this is a parent structure, it is

not fully loaded and not visible.
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Tip:

If you want to display a single component in a large structure, additionally use the Viewer view
that you open using the Open With shortcut menu command.

Toolbars available in the Graphics view

Use this toolbar To

3D Alignment Move individual parts or groups of parts and align them to other parts
in the viewer.

3D Appearance Work with advanced appearance attributes.

3D CAE Viewing View Computer Aided Engineering (CAE) Finite Element Analysis (FEA)
results.

3D Clearance Check the clearance of parts in your model.

3D Comparison Compare the geometry of two sets of parts.

3D Coordinate System Create and manage coordinate systems. You can also align parts or

your view to a coordinate system.

3D Display Modes Control the display mode of geometry in the viewer. You can display
geometry as shaded, tessellated lines, feature lines, or any combination
of these. Tessellation or feature lines hidden by other geometry can be
viewed as normal, semi-transparent, or invisible.

3D GDT Markup Insert GD&T markups on your 3D models.

3D Markup Add text or graphical elements on your 3D model in the viewer.

3D Measurement Measure your 3D model.

3D Movie Capture Capture the contents of the viewer as you move the camera around,

show or hide parts, transform parts, play animation sequences, and
play VFM motion files associated with your model.

3D Navigation Manipulate the 3D view.
3D PMI Display and control Product and Manufacturing Information (PMI) in
your model.
Note:

PMI functionality is available only when PMI is enabled on your
system. If PMI is enabled, you can right-click a part and choose
one of the following commands:
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Use this toolbar

3D Part Manipulation
3D Part Transformation
3D Section

3D Selection

3D Standard Views

3D Thrustline Editor
3D Visibility

Create Markup

Print

To

e Show PMI

Shows all effective PMI on the selected part or subassembly
and its children.

* Toggle in PMI Tree

Adds PMI from the selected part or subassembly and

its children to the PMI tree. Alternatively, if the part or
subassembly is already in the PMI tree, Teamcenter removes
it.

Manipulate parts by dragging.

Translate, rotate, and scale parts in your model.
Work with cross sections of your 3D model.

Pick part entities.

Examine your model from different views.

Create and manipulate thrustlines.

Hide obscuring parts and clip areas of your model.

Create product views, capture an image of the current geometry or
show or hide the 3D PMI tree.

Print an image or display a print preview.

Displaying images in views other than the Graphics view

When you open the Graphics view, other views that display the hierarchy also display the check boxes
that you can use to blank and display graphics. These slightly different check boxes are displayed in the

following views:

e Gantt view

* Manufacturing Features view

» Structure Search Criteria view (in the Current Scopes section)

e Structure Search Results view

* Accountability Check view

* Assignments view
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= Search Result
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The following states exist for the check boxes.

Check box State

g The node is displayed in the Graphics view. If it is a leaf node (no children), it has
geometric data. If it has children, all the children are currently visible.

= The node has children, and only some of them are currently displayed.

| The node is not displayed in the Graphics view for one of the following reasons:

* The user has chosen to hide it.
* There is no geometric data attached to it.

* The geometric data of the node is not yet loaded, so it is uncertain whether
the node has geometric data.

= The node is a leaf node and has no geometric data.

Isolate parts for viewing

You can remove unwanted parts from the viewer, isolating the part of interest:
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1. Select one or more the parts you want to see in the viewer and deselect unwanted parts.

2. Choose Graphics=Visibility=2>View Selected and Teamcenter blanks all unwanted visible parts
and shows only the selected parts. Alternatively, you can right-click required parts in the viewer and
choose View Selected.

Selecting packed objects for display

When lines are packed, one of the packed lines is always designated the master packed line. If the
TCVIS_Selection_From_Viewer preference is set to true, you can select packed objects in the viewer
using the buttons available in the 3D Selection toolbar. However, if you select the master packed line,
all packed lines are selected. If you do not want this behavior, you must unpack the packed lines before
selecting the individual objects in the viewer.

Manipulate graphics
You can use transformation tools to graphically manipulate parts or assemblies in the structure.

You can perform two types of manipulations:

* Choose Graphics=2Transformation->Temporary Transformation to temporarily translate, rotate, or
scale parts or assemblies. You cannot save temporary transformations, but you can capture images of
them.

* Choose Graphics=2Transformation—Persistent Transformation to edit the structure by permanently
translating and rotating parts or assemblies. (Scale option is not available.)

Note:

If there are arrangements in the structure, by default persistent transformations are applied
to all of them. To limit persistent transformations to the active arrangement, set the
TCVIS_reposition_all_arrangements preference to False.

The differences between performing a temporary transformation and editing the structure are listed in
the following table.
Functionality Temporary Transformation Persistent Transformation (editing the structure)

Permanence All changes are temporary.  Changes are permanent.
Teamcenter removes the
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Functionality Temporary Transformation Persistent Transformation (editing the structure)

modifications when you
close the window.

Repositioning All options are permitted. All options are permitted except scaling.

options

Occurrences Occurrences are not Occurrences are repositioned, potentially updating
repositioning repositioned. multiple BOM lines.

The Temporary Transformation dialog box provides the same options as the Lifecycle Viewer Part
Transformation dialog box. The Permanent Transformation dialog box provides the same options,
except for scaling.

Displaying objects by type
Overview of displaying objects by type

You can display or blank objects in the Graphics view based on their type, occurrence type, or a
combination of both. For example, you may want to blank all weld points or display only the parts
consumed by a process. In addition, a visualization filter allows you to set the object and/or occurrence
types you want to hide from the display on a more permanent basis.

The types of objects you can blank or display depend on the type of structure on which you are working.
For a process structure, you can display or blank:

* Item types such as Item, WeldPoint, or Workarea. All item types that derive from Item, Workarea,
and PSConnection (including WeldPoint) are supported.

 All available occurrence types such as MEConsumed or ME Weld Point.

* Any combination of these item and occurrence types.

For a product structure, you can display all types that derive from:

* |tem

* PSConnection

For a plant structure, you can select all types that derive from the Workarea item type.

The object types to be blanked or displayed in the structure must exactly match the selected types.
Selecting an item does not select every object derived from the Item type.

To reduce the size of this potentially long list of candidates, you can store the commonly used item list in
the MEBlankDisplayTypes preference.
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Display/blank objects by type
1. With a structure open in the Graphics view, do one of the following:
* Choose Graphics=Visibility->Display/Blank Selected by Type—2>0Object/Occurrence Type
* Right-click in the viewer pane and choose Display/Blank Selected by Type.
* Right-click a subassembly in the structure tree and choose Display/Blank Selected by Type.
2. Choose the type of object or occurrence type that you want to blank or display.
The entries in this list are dictated by the value in the MEBlankDisplayTypes preference.
The object types that you select are displayed or blanked in the viewer.
Display/blank multiple object types
1. Choose Graphics=Visibility->Display/Blank Selected by Type—>Advanced.

2. Select all the object types that you want to display. If you open the dialog box with a process
displayed in the viewer, you can also select occurrence types.

3. (Optional) Select Display only selected types to blank all types other than those selected in the
dialog box.

4. Click OK.
Set the visualization filter

Use the visualization filter to set the object and/or occurrence types you want to permanently hide from
the display.

1. With a structure open in the Graphics view, choose Graphics—Visibility>Define Visualization
Filter, or click the Define Visualization Filter button [ in the toolbar.

2. Choose the object or occurrence types that you want to hide permanently from the display.
3. (Optional) Select Apply visualization filter to activate the filter as soon as you close the dialog box.
4. Click OK.

5. (Optional) If you did not activate the filter in step 3, activate it by choosing
Graphics=Visibility->Apply Visualization Filter or clicking the Apply Visualization Filter button
./ in the toolbar.
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Working with product views
About product views

You can save data in the assembly viewer, including current items, zoom factor, rotation angle, and

pan displacements. You can retrieve a saved product view (sometimes called a 3D snapshot or snapshot
view) during a subsequent session or share it with other users. You can only save or retrieve product
views when a base view structure is displayed in the viewer. You cannot create product views of
occurrence groups.

You can create product views that contain one or more of the following:
* Collaboration contexts

* Structure contexts

» Configurator contexts

* |tem revisions (structure lines)

* 2D and 3D NX CAD and Lifecycle Visualization files

e Motion (VFM) files

* Published documents, including work instructions

Each product view is stored in a dataset containing a thumbnail image file, a PLM XML session file, 3D
markup layers, and the top-level item of the view.

You can configure the structure with revision rules, effectivity, variant rules, and similar techniques. If
appropriate, you can use several Show Unconfigured menu commands to hide unconfigured objects in
the structure and in the viewer. When product views are captured, these view selections are taken into
account; otherwise, potentially unbuildable combinations of parts may be displayed when the view is
restored. You can retrieve the original state of the menu commands and consequently the original state
of the view.

If the product view is attached to a structure and the structure is cloned, the product view functions
correctly in the new (clone) structure. Likewise, product views may be attached to a structure that is
shared with Multi-Site Collaboration.

You can also update product views in the Lifecycle Viewer or stand-alone Lifecycle Visualization. You
send a dynamic product view to one of these applications, and then create a new product view or
update and replace the existing one. When you send the updated product view back to Teamcenter, you
can open it in the assembly viewer.
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Your Teamcenter administrator sets the size and presentation of the product views with system
properties and preferences..

Note:

In Teamcenter 8.0, the file format of 3D product views changed. If you open a file that was created
in an earlier Teamcenter version, it is automatically converted to the new format.

Create and save a product view

Adjust the content of the viewer window using the pan, rotate, eyeball, and zoom buttons to create
the necessary scene.

Select an object in the structure base view window.
If necessary, right-click in the viewer menu bar and choose Create Markup.

Teamcenter displays the Create Markup toolbar.
Click Create 3D Product Views = on the Create Markup toolbar in the assembly viewer.

Teamcenter displays the Product View Gallery dialog box, which contains thumbnails of any
previously saved product views that are associated with the selected object.

Do one of the following:
* Click New Product View [=I.
* Right-click in the window and choose Create New Product View.

You are prompted to enter a name for the product view if the Vis_PV_Show_Name_Dialog user
preference is set to True. If it set to False, Teamcenter generates a name automatically.

Teamcenter saves the product view and its configuration in a dataset. It also adds a thumbnail of
the view to the Product Views dialog box.

Note:

Thumbnails of all product views are not visible at all times, only for those items related to the
selected end item (the top entry in the structure window).

Configure and manage product views

1.

Choose Options—Visualization—>Product View.
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Teamcenter displays the Product View Creation Preferences pane.

Set the following preferences as required:

Preference

Geometry Asset

Show Product View name dialog

View Toggle Warning Level

View Toggles to consider

Image Capture

Image Format: Image Resolution,
Width of image, and Height of
image

Thumbnail: Width, Height, and
Quality

Description

Determines whether a geometry asset file is added when
a product view is created. This file is required if you want
to export a PLM XML file of the product view. This option
is equivalent to the Vis_PV_Geometry_Asset preference.

If selected, you are prompted for a name each

time you create a product view. If not selected,
Teamcenter generates the name automatically. This
option is equivalent to the Vis_PV_Show_Name_Dialog
preference.

If selected, Teamcenter displays a warning or prevents
you from continuing if you try to create a product view
when one or more of the View menu commands to show
unconfigured data is selected. This option is equivalent to
the Vis_PV_InvalidConfigWarnLevel preference.

Select the View menu commands to show unconfigured
data that are considered if the View Toggle Warning
Level option is selected. This option is equivalent to the
VisPVBlockingViewToggles preference.

Determines if Teamcenter saves a preview image of

the 3D product view when it is created. If you choose
Perform Image Capture (Using Image Export Dialog),
you are prompted for the settings to use. If you choose,
Perform Image Capture (with preferences), it uses
values set in preferences. This option is equivalent to the
Vis_PV_ImageCapture preference.

Depending on the setting of the Image Capture

option, these options may determine the file format,
resolution, and size of the preview image. If

Perform Image Capture (Using Image Export Dialog)
is set, these options are disabled. These options

are equivalent to the Vis_PV_ImageCaptureType,
Vis_PV_ImageCaptureResolution,
Vis_PV_ImageCaptureWidth, and
Vis_PV_ImageCaptureHeight preferences, respectively.

Determine the size and resolution of the
thumbnail image created for each product
view. These options are equivalent to the
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3.

Preference Description

Vis_PV_ThumbnailWidth, Vis_PV_ThumbnailHeight,
and Vis_PV_ThumbnailQuality preferences, respectively.

Play motion in current view If selected, any motion (VFM) file in the current product
view plays when the view is selected. This option is
equivalent to the Vis_PV_Play_Motion preference.

Configuration rule to use Offers you two choices:

* Use configuration from the current BOM ignores
stored rules and preserves the configuration that was
active before you applied the product view.

* Use configuration from product view considers any
arrangements, effectivity, variant rules, and revision
rules stored with the product view when you apply it.

This option is equivalent to the
Vis_PV_HowTo_Configure_BOM preference.

Note:

Your administrator may configure these preferences with SITE or GROUP protection scope,
rather than USER protection scope. If so, you may be able to view but not change the current
settings.

Right-click a selected product view thumbnail in the Product View Gallery dialog box.

Teamcenter displays a shortcut menu.

Note:

You can identify the currently selected product view by the green border (if checked out) or
red border (if not checked out) around its thumbnail.

Choose one of the following.

Command Description

New Tab Creates a new tab for the element currently selected in
the structure. This tab is unavailable if no element is
selected in the structure base view window.

Refresh Tab Refreshes the currently selected tab in the product view
gallery to reflect structure configuration changes.
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Command
Remove Tab

Refresh All Tabs

Remove All Tabs

Add =
Apply
Delete &

Update [

Rename

Enable Multiple Selection

Options

Create product view preview manually _

Description
Removes the current tab from the dialog box.

Refreshes all the tabs in the product view gallery to
reflect structure configuration changes.

Removes all tabs from the dialog box.

Creates a new product view from the current contents of
the viewer.

Applies the configuration of the selected product view to
the viewer.

Deletes the selected product view.

Refreshes the stored product view with changes made in
the viewer. This command is enabled only if you check
out the product view dataset.

Displays a dialog box that allows you to change the name
and description of the selected product view. A product
view name appears below each button; the description
appears when the cursor is placed over the button.

If you rename a product view, the order in which
thumbnails are displayed in the Product View Gallery
dialog box changes. Teamcenter generates the default
name of a view from the date and time it was initially
created. It lists available views in alphanumeric order.
You can choose an appropriate new name to move the
view up or down the list.

Allows you to select more than one product view.

Displays the Product View Creation Preferences pane.

Note:

the product view are unavailable.

If you right-click any part of the Product View Gallery dialog box (except one of the buttons)
and no product view is selected, the menu commands to apply, update, rename, and delete

Create product view preview manually

Note:

The menu commands described in this procedure are available only if the Image Capture option
is set to Perform Image Capture (using Image Export dialog). If you do not select this option,
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you cannot manually adjust the size, resolution and file format each time you create or update a
product view.

1. Right-click a product view or the Product View Gallery tab and select Image Capture.

Teamcenter enables the capture of 2D images, as indicated by a check mark next to the menu
command.

2.  Create or modify the product view.

If you selected Perform Image Capture (using Image Export dialog) previously, Teamcenter
displays the Image Export dialog box.

3. Change the size and file format of the image if necessary, then click OK.
Teamcenter creates the product view using the parameters you entered.
Manage unconfigured data in a product view

You can use several menu commands to show or hide unconfigured objects in the structure and in the
viewer, as follows:

* Show Unconfigured Variants

Show Unconfigured By Occurrence Effectivity

Show Unconfigured Changes

Show Unconfigured Assigned Occurrences

Show GCS Connection Points

Apply Occurrence Type Filters

When product views are captured and restored, these view selections are preserved; otherwise,
potentially unbuildable combinations of parts may be displayed when the view is restored. If you choose
to update the configuration from the product view when you reopen it, the saved view selections are
retrieved; if you choose to use the current configuration, the saved view selections are ignored.

To evaluate the configuration of an existing product view, right-click a product view in the Product View
Gallery and choose Show Configuration.

Teamcenter displays a dialog box that shows the assembly configuration when the product view was
created. The name of the product view is shown in the title bar of the dialog box. The dialog box

also lists any Show Unconfigured menu commands that were active at the time the product view was
created.
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If you show the configuration for product views created on a composite structure (such as a process),
the results are displayed in tabular form with each member structure occupying a line in the table. If any
Show Unconfigured ... command was set to Off for all the assemblies contained in the structure, the
corresponding column is not displayed. In the following figure, the Show Unconfigured Changes and
Show Unconfigured by Occurrence Effectivity commands were turned off when the product view was
created and those entries do not appear as columns.

o Configuration
- 20120510-145048

=7

Title ®  Revision Rule ®  Show Unconfigur.. [ Show Guided Co... S} Show Unconfigur...
000770-al_assemble_base_plate Latest Working X 0On X On X On
000763-al_base_plate Latest Working ¥ On ¥ On Preference-driven

Close

Retrieve and open an existing product view

* Open the product view in Teamcenter:

1. Select an object in the structure base view window and open the assembly viewer.

2. Click the Create 3D Product Views button on the viewer toolbar.

Teamcenter displays the Product View Gallery dialog box containing thumbnails of available
product views of the selected structure. Only product datasets associated with the currently

selected end item are visible.

3. Right-click below the image area in the Product View Gallery dialog box and select the
configuration that you want to use for the product view.

Command

Options—>Configuration rule to
use->Use configuration from
Current BOM

Options—>Configuration rule to
use—->Use configuration from
product view

4. Do one of the following:

Description

Applies the product structure configuration that is
currently set to the product view that you are loading.

Adopts the configuration that was set at the time the
product view being loaded was created.
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* Select the thumbnail of the product view you want to open and click Apply.

Teamcenter opens the product view and retrieves the saved configuration for the structure
window and viewer. You can then click Cancel to close the dialog box without opening the
product view.

* Select the thumbnail of the product view you want to open and click OK.
Teamcenter opens the product view as before and closes the dialog box immediately.

5. If the product view contains a motion file, replay it by right-clicking the product view and
choosing Load Motion File(s). If Play motion in current view is selected, the motion file is
played against the current structure; otherwise, it is played against the original structure.

* Open the product view in stand-alone Teamcenter lifecycle visualization:

1.  Select one or more product view datasets in the Attachments tab.
. . . . . Hq-\
2. Click the Send to Lifecycle Visualization & button.

Checking product views in and out

After you create a product view (3D snapshot), you can check it into the Teamcenter database to make
it available to other users. To refresh or delete an existing product view, you must first check it out to
prevent other users from inadvertently overwriting your changes.

You can identify a checked out product view by a green frame around the thumbnail image in the
Product View Gallery dialog box. Similarly, you can identify a checked in product view by a red frame
around the thumbnail.

Check out product view dataset
Select a product view and choose Tools->Check-In/Out->Check-Out.

Teamcenter applies a checkout lock to the dataset, allowing you to refresh or delete the product view.
Other users cannot refresh or delete the product view while you have checked it out.

Note:

If you close the Product View Gallery dialog box while you still have datasets checked out,
Teamcenter displays a request for confirmation that you want to continue. If you do, all active
checkout locks are canceled.

The Check-Out command is enabled only if you select a product view that is not checked out by
another user.
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Check in product view dataset
Select the product view you checked out and choose Tools->Check-In/Out->Check-In.

Teamcenter removes the checkout lock from the dataset, allowing other users to update or delete the
product view.

Cancel checkout of product view dataset
Select the checked out product view and choose Tools=Check-In/Out->Cancel Check-Out.

Teamcenter removes the checkout lock from the dataset, allowing other users to update or delete the
product view.

Refresh a product view

You can refresh a saved product view of the current structure at any time with changes you make during
the current session in one of the following ways:

* Right-click the product view gallery and choose Refresh Tab to update the 3D snapshot in the
selected tab to reflect any structure configuration changes.

* Right-click the product view gallery and choose Refresh All Tabs to update the 3D snapshots in all
tabs to reflect any structure configuration changes.

* Right-click the product view and click the refresh product view button, which is the center graphical
button in the middle row of buttons.

* Right-click the product view and choose Apply.

Note:

The Apply command and refresh button are only enabled if you check out the product view.

Send a product view to an external viewer

Select one or more product views in the structure tree and choose File->Open in TcVis or right-click and
choose Send to-Lifecycle Viewer.

The selected viewer opens the product view with a configured structure. If you already have a 3D
document active, Teamcenter allows you to open your product view or merge it into the active
document, if the formats are compatible.
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Note:

This method is not available if an incremental change is applied to the structure.

Note:

You can also select multiple product views in the product view gallery and send them to the
Lifecycle Viewer or stand-alone Lifecycle Visualization. The product views open one at a time and
any configuration of the original structure is retained.

Delete a product view
1. Click the floppy disk button on the Viewer toolbar.
Teamcenter displays the Product Views dialog box.

2. Select the thumbnail of the product view you want to delete and click the delete product view
button, which is the right graphical button in the middle row of buttons. Alternatively, you can
right-click in the window and choose Delete.

Teamcenter deletes the product view and its associated dataset.
Working with markups

Adding and deleting markups

When an image is loaded in the viewer, you can add markup layers to the image. You can mark up JT
files that are attached to DirectModel datasets or schematic geometries. You can also view images in
JPEG or BMP formats that are attached to a schematic geometry. To view and mark up schematics, your
administrator must set the TC_Schematic_BOMView_Types preference to on.

Markups are text or graphical elements that you draw in the viewer with your model or schematic. 3D
markups display on 3D layers.

Markups may include lines, rectangles, polygons, ellipses, inset images, and text.
Anchored text markups can include part information and metadata attributes.

To create or modify markups, display the relevant toolbar by right-clicking the Lifecycle Visualization
base toolbar and choose the appropriate command from the shortcut menu.
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Note:

If you are working with schematics, only a limited set of functions are available. The following
options do not apply to schematics: edit color/translucency, insert, view control, export 3D,
reposition, rotate, PMI, clearance, cross-section, navigation, and visibility.

Working with 3D and schematic markups
Create a 3D markup dataset

You need to create a DirectModel3DMarkup dataset to store 3D markups of structures or assemblies.

Note:

You MUST HAVE at least the Teamcenter lifecycle visualization standard configuration installed to
work with 3D markups.

1. Load the structure or assembly (DirectModel dataset) in the viewer.
Teamcenter displays the model and the Lifecycle Visualization toolbar.
2. Click the Create Markup & button.
Teamcenter displays the Create Markup3D Dataset dialog box.
3. Inthe dialog box, type a name for the dataset in the Dataset Name box.
4. (Optional) Type a description of the dataset.
5.  Click OK.

Teamcenter creates the DirectModel3DMarkup dataset and attaches it to the DirectModel
dataset.

You can create multiple DirectModel3DMarkup datasets under a single structure or assembly. Each
DirectModel3DMarkup dataset can contain multiple markup layers.

Note:

Markup layers are stored as VPL files.

Draw 3D markups

Perform the following steps to draw markups on structures, assemblies, or schematics:
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On the 3D Markup toolbar, click Enable Markup El

(Optional) To change colors, fill styles, line and edge styles and sizes, and font styles and sizes, click
Preferences & |.

(Optional) To draw a filled ellipse, polygon, rectangle, or text markup, click Fill il

(Optional) To attach the markup to a point on the model or schematic click Anchor _|

Anchored markups display, hide, and move with their attached parts. Anchored text markups are
attached to parts with leader lines.

(Optional) Create or select a layer for the markup. If you do not have a markup layer, one is created
when you add the first markup.

Specify the markup type by clicking the corresponding button on the 3D Markup toolbar.
Teamcenter changes the cursor to indicate the type of markup.

Place the markup in one of these ways:

To place this markup Perform these actions

Line a. (Foran anchored markup) Select a point on the model
or schematic.

b. Inthe viewer, drag the mouse pointer to draw a line.

c. (Optional) To draw a horizontal or vertical line, press
and hold the shift key as you drag.

Polyline a. (Foran anchored markup) Select a point on the model
or schematic.

b.  Inthe viewer, click to place one endpoint.

c.  (Optional) To draw horizontal or vertical polyline
segments, press and hold the shift key.

d. Click to place each vertex.

e. Double-click to place the last vertex.
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Freehand line a. (Foran anchored markup) Select a point on the model
or schematic.

b. Inthe viewer, drag the mouse pointer to draw.

Rectangle a. (Forananchored markup) Select a point on the model
or schematic.

b. In the viewer, click to place one corner.

c. Drag the mouse pointer, and then release to place the
opposite corner.

d. (Optional) To draw a square, press and hold the shift key
as you drag.

Polygon a. (For an anchored markup) Select a point on the model
or schematic.

b. Inthe viewer, click to place each vertex.

c.  (Optional) To draw horizontal or vertical segments,
press and hold the shift key as click.

d. Double-click to place the last vertex.

Ellipse a. (Foran anchored markup) Select a point on the model
or schematic.

b. Inthe viewer, drag the mouse pointer to draw.

c. (Optional) To draw a circle, press and hold the shift key
as you drag the mouse pointer.

Inset image a. Inthe Open dialog box, select the image dataset and
click Open.

b.  (For an anchored markup) Select a point on the model
or schematic.

c. Inthe viewer, drag the mouse pointer to place and size
the image.
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To place this markup

Text

URL

Perform these actions

(For an anchored text markup) Select a point on the
model or schematic. Teamcenter displays the Markup
Text dialog box.

(Optional for an anchored text markup) In the Markup
Text dialog box, click Advanced to add part information
or metadata attributes.

(For a floating text markup) Click a point in the viewer to
place the text markup. Teamcenter displays the Markup
Text dialog box.

(Optional) Change the font, size, and style of the text.
(Optional) To change the shape in which the text
appears, from the Bounding shape list, choose the
None, Rectangle, or Circle.

Type the text of the markup in the Text box.

Click OK.

Place a text or inset image markup.

Right-click the markup, and choose Properties.

In the Properties dialog box, click the Hyperlink tab.

In the Link Specification box, type the URL, or click
Browse and browse to the appropriate file path. You can
link to any type of file. The application that is associated
with the file type opens and displays the file.

Click OK.

To navigate to the URL or launch the referenced file,
double-click the link.

Note:

When you open a URL for an animation (VAN) file, the
animation plays automatically.

To create a URL markup that opens the default E-mail
program and addresses a message, type mailto: in the
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To place this markup Perform these actions

Address box. When you double-click the link, the E-mail
program is launched and a message is addressed to the
specified address.

The markup appears in the viewer, with a list of markups under the selected markup layer. If Teamcenter
displays an asterisk (*) before the markup layer name, changes were made to the markup layer since it
was last saved.

Note:

If you open a 3D model that includes an anchored text markup that is anchored to an item that has
been removed from the current 3D model or moved to a different structure in the same 3D model,
when the 3D model file opens, the leader line does not appear and the text of the 3D markup
appears in red.

Create a 3D markup layer

Create a 3D markup layer using one of the following methods:

Initial markup layer

1. Ensure a 3D markup is visible.

2. Click the Save Layers (&) button on the Lifecycle Visualization base toolbar.
The system displays the Save Layer dialog box.

3. Type a name for the new layer in the Name box and click OK.

Teamcenter displays the new layer in the Markup Layers list.

Note:

The Markup Layers list does not display until you create a 3D layer.

Additional markup layers
1. Right-click in the Markup Layers list and choose New Layer from the shortcut menu.
Teamcenter displays the Save Layer dialog box.

2. Type a name for the new layer in the Name box and click OK.
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Teamcenter displays the new layer in the Markup Layers list.

Note:

The Markup Layers list does not appear until you create a 3D layer.

Open 3D markup layers
* Select a 3D Markup dataset.

Teamcenter opens the Markup Layers list containing the saved layers for the dataset.
Save 3D markup layers

When you create or edit a 3D layer, an asterisk (*) appears before the name of the layer in the Markup
Layers list until you save the layer. When you save the layer, the asterisk disappears until the layer is
edited again.

Save 3D layers together or separately. Perform the following steps to save layers:
1. From the Markup Layers list, select the layer that you want to save.
2. Right-click and choose Save Layer from the shortcut menu.
Teamcenter removes the asterisk next to the layer name in the list.
Delete 3D markup layers
1. Right-click the DirectModel3DMarkup dataset in the tree.
Teamcenter displays the Dataset Object menu.
2. Choose Named References.
Teamcenter displays the Named References dialog box.

3. Inthe named reference table, select the markup layer that you want to delete.
4. Click the Cut ﬂ button.

Teamcenter removes the layer from the named reference list.
5.  Click the Close button.

Teamcenter closes the Named References dialog box.
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Control the display of 3D markup layers

To Perform these actions

Display or hide 3D layers Select or clear the state indicator to the left of the layer name in the
Markup Layers list.

Save all layers Save all the 3D layers, separately, with their current file names.
Save layer Save the selected 3D layer.

Save layer as Save the selected 3D layer with a new file name.

Capture view Capture the orientation of the model and markup as seen in the

viewer for the selected layer.
Apply view Restore the captured view for the layer selected.

Hide view Hide the captured view for the layer selected.

Working with 2D markups

View 2D images

1.  Select the DirectModel dataset in the navigation tree or Properties table and click the Viewer tab.

Note:

To view a named reference of the DirectModel dataset, right-click the dataset in the tree,
choose Visualize Named Reference from the Dataset Object menu, and choose the named
reference file that you want to view.

Teamcenter displays a message indicating that you are about to view a JT assembly and verifying
that you want to download all the components of the assembly.

2. Click OK to download the components.

3. Click the Image Capture & | button in the viewer pane. The Create Markup Layer dialog

box appears, allowing you to create a DirectModelMarkup dataset and attach it to the original
DirectModel dataset as a markup relationship. The Viewer pane now contains a Markup Layers
tree to the left of the graphical display.

Compare 2D image layers

You can compare image layers when you want to:
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Display common areas and differences.

Display the common areas of both layers, one of the comparison layers, or all of the comparison
layers.

Change the colors of one or both image layers in your comparison.

1. Choose two 2D image datasets in the navigation tree.

2. Choose Compare 2D Images from the View menu.

Teamcenter displays the images in the Viewer tab and displays the 2D Compare toolbar.

3. Perform one of the following tasks:

To Perform these actions

Display only the compare layer Click the Display Compare Layer button [m| on the 2D

(common areas of both layers) Compare toolbar. Only the compare layer is displayed in

the Viewer tab. The information that is common to both
layers is drawn in black.
Display one layer and not the other Click the Display 1st Layer button | or the Display

2nd Layer button &g|.

Display all comparison layers Click the Display All Layers button Hj|. All the

comparison layers are displayed. Unless you have
changed the color preferences, the first layer is green;
the second layer is red; the comparison layer is black.

Create 2D markups

—_

Select the 3D format (DirectModel) of the object that you want to revise.
2. Click the 2D Markup button & in the viewer pane.

Teamcenter displays the Create Markup Layer dialog box.
3. Type the name of the markup layer that you are creating in the Name box.
4. Select the type of file from the File Type list.

5. Type a brief explanation of the markup layer's purpose and content in the Description box and click
OK.
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The new markup layer can be found in the Properties table, or by expanding the DirectModel
object in the tree.

Create 2D markup layers

You can use DirectModelMarkup and Markup datasets to create a new markup layer for a 2D format
image, as follows:

1. Inthe navigation tree, select a DirectModelMarkup or Markup dataset for the object that you
want to revise and click the Graphics view.

2. Mark up the 2D image using the markup toolbar.
3. Save the markup layer in the new dataset component.
4.  Click the Save 2D Markup button .
Teamcenter displays the Save Layer dialog box.
5. Type the name of the layer that you are creating in the Name box and click OK.

Teamcenter generates a 2D file, stores it in the current dataset and displays it in the Markup
Layers tree. If multiple markup layers are created in the same session, they can all be saved
simultaneously. Teamcenter displays a separate Save Layer dialog box for each saved layer.

Working with drafting symbols and GD&T symbols

Your administrator may permit the use of drafting symbols and geometric dimensioning and tolerance
(GD&T) symbols in any of the fields of a form.

To add or edit symbols in a form, display the form in the Viewer view and click the Edit button.
Teamcenter displays the Change GD&T Symbols dialog box.

To add or edit drafting symbols, click the Drafting Symbols tab and click one or more of the predefined
symbol buttons. To add or edit GD&T symbols, click the GDT Symbols tab and click one or more of the
predefined symbol buttons.

To format rich text, use the following buttons that are available in the Drafting Symbols tab and the
GDT Symbols tab:

El Manually refresh the editing box.
Add a frame around the selected characters.
ﬂ Bold the selected text.
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Italicize the selected text.

Underline the selected text.

Set the color of the selected text.
Decrease the size of the selected text.
Increase the size of the selected text.
Subscript the selected text.
Superscript the selected text.

Align the selected text.
Center align the selected text.
Right align the selected text.

Insert the text you typed in the two boxes to the left of this button.

Insert a control frame around the selected characters.

Additions and changes are reflected in the editing box of Change GD&T Symbols dialog box. To save
changes and exit, click the Edit button again.
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Modifying process plan data

Create item revisions

Use item revisions to manage changes or revisions to part, process, and work area items. When you
create a new item, Teamcenter automatically creates the first item revision. You can then add additional
revisions as necessary.

Note:

There is always only one working revision at any one time.

1. Open a process or part.
2. Select the object that you want to revise.
3. Choose File=Revise.
The Revise dialog box is displayed. The item ID is preselected so it mirrors the original item.
4. Type a new revision ID.
5. Give the revision a new name, if necessary.
6. Click OK.

The new item revision is displayed in the structure view.

Creating variant configurations

Variant configuration allows you to create options (such as manufacturing locations) and allowed values
(such as a specific plant within the company) and associate these options with an item revision. This is
usually done at the top-level but can be implemented anywhere in the BOM.

You can use the Show Unconfigured Variants menu command to show any BOM lines that are
configured out by variant rules. However, if you create compositions (for example, a process) where

the items are assigned from another top line (for example, a product or work area), the configuration

is controlled by the configuration of the original BOM line. You can configure out the original BOM line
(for example, the consumed items in the product) by effectivity, incremental change or variants, and the
corresponding BOM line in the composition is configured out. Thus, the line in the composition is hidden
or shown if it was assigned from another top line, irrespective of the cause of its configuration in the
original BOM. Such lines are also configured out if the original BOM is not loaded while you open the
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composition. You can show assigned objects in the structure using the Show Unconfigured Assigned
Occurrences menu command.

You can specify which loaded BOM structure configures a process structure.
Perform where-used searches
1. Right-click an object in a structure view and choose Open with=>Impact Analysis.
2. Set the Where box to Used.
3. Set the Depth box as required:

* One Level to report immediate parent objects only

* All Levels to report all objects up to the top-level product

* Top Level to report final objects only
4. In the Where Used Options area, set the Rule box as required:

* Click All to report all revisions.

» Select the required revision rule from those listed to report only the configured revisions.
5.  Select what object is shown in the tree nodes from the Display list.
6. Inthe viewer pane, double-click the object for the search.

The results of the search display graphically.
7. Double-click any of the resulting objects to continue the where-used search.
Perform where-referenced searches
1. Right-click an object in a structure view and choose Open with=Impact Analysis.
2. Setthe Where box to Referenced.
3. Set the Depth box as required:

* One Level to report immediate parent objects only

* All Levels to report all objects up to the top-level product
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* Top Level to report final objects only
4. Double-click the object for the search.
The results display in the viewer pane.
5. Double-click any of the resulting objects to continue the where-referenced search.
Create duplicate items
1. Open the appropriate process, part, or work area.
2. Choose File=Save As.
The Save As dialog box is displayed.
3. Type anew ID and revision for the new item.
4. Click OK.

The new item opens in My Teamcenter.

Cutting, copying, pasting multiple processes and operations

When you cut or copy and paste multiple processes or operations in Part Planner, the predecessor and
sequence information is moved with the processes or operations. For example, if you copy multiple
operations or processes from one source process and paste them to one target process:

» Teamcenter keeps the relative find numbers of operations or processes. For example, copying
10,20,20,30 results in X, X+10, X+10, X+20, where X is the next available find number (with
increment of 10).

* Flows between the copied operations or processes are also copied.

* Anew flow is not created between the last process/operation/work area and the new one. Use the
Update Pert Flows command to achieve this.

Use Edit->Paste Special to designate the behavior of the copied lines. You can specify
the occurrence type to use when pasting, assigning, or using drag-and-drop in the
MEAssignCustomizedOccurrenceType preference.
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Add, edit, and delete text notes

You can add text notes to the various objects in your process plan that can be viewed by others in your
organization as they work with the plan. These notes can also be edited and deleted, and can be printed
with the Report Generator application.

To open the Notes dialog box:
1. Select an object using one of the following:
* Select an object from the tree hierarchy in a structure view.

¢ Click one of the boxes in the PERT view.
2.  From the Edit menu, choose Notes, or click the Notes button D on the toolbar.

The Notes dialog box is displayed.

3. Perform one of the following:

Action Steps
Add a new note a. From the Create list, choose the type of note to be
created.

b.  Type the text of the note.

c. Click OK.

Edit a note a. From the Existing Notes list, choose the type of
note to be edited.

b. Change the text, as necessary, in the description
area. When you are done, click OK.

Delete a note a. From the Existing Notes list, choose the type of
note to be deleted.

b. Click Remove.

Attaching objects to the process plan
Overview of attaching objects to the process plan

Each process, operation, activity, and work area can have objects associated with it. These objects can
include items such as detailed work instructions, drawing sheets, and NC programs.
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The following types of objects can be attached:

Object type Purpose

Datasets Application-specific objects used to manage data files created by other
software applications. When you double-click a dataset in a BOM, the
system launches the software application (tool) associated with the

dataset.
Folders Containers for objects and can reference any object type.
Forms Objects you define that are managed by the application as a form

type. The form holds any additional data you want to associate with a
process, operation, or work area.

Other objects Objects can be associated with manufacturing processes, operations,
activities, and work areas by specific relationship types. These
relationship types are set by your system administrator.

You can view attached objects in the Attachments view. If you attach datasets in another application
(for example, My Teamcenter), you can use the Refresh Window and Refresh Current Structure menu
commands to display them in the Attachments view.

Attach new datasets
1. Select an item revision:

* For activities, select the activity in the Activities view.

* For parts, processes, operations, or work areas, select the object in the structure view.
2. On the File menu, choose New->Dataset.

The New Dataset dialog box is displayed.

3. From the pane on the left side of the New Dataset dialog box, click the dataset type to be
attached.

Click More if the list does not contain the dataset type you need.
4. Type a name for the attachment.
5. (Optional) Type a description of the attachment.
6. Click the Browse button ... to import a file.

The File Import dialog box is displayed.
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7.

10.

Search for and select the file to be attached, then click Import.
Select the relation type with which the dataset is attached to the item in the Relation list.

To open the attachment in the application window after import, check the Open on Create check
box. Otherwise, leave this check box unselected.

Click one of the following buttons:
* OK to add the dataset and close the New Dataset dialog box.

* Apply to add the dataset and redisplay the New Dataset dialog box.

Attach existing datasets

1.

Find the object to be attached using the My Teamcenter application.

Select the object and click the Copy button | on the toolbar.

Open Part Planner.

Select the object where you wish to attach the dataset.

Click the Paste button T_J on the toolbar.

Attach new forms

A form is a user-defined object managed in the database as a form type.

Note:

Forms cannot be attached to operation activities.

—_

In the Attachments view, select the item where you want to attach the form:

In the File menu, choose New->Form.

The New Form dialog box is displayed.

From the pane on the left side of the New Form dialog box, click the form type you want to attach.
Type a name for the form.

Optionally, type a description of the form.
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6. To open the form in the application window upon import of the file, check the Open on Create
check box. Otherwise, leave this check box unchecked.

7.  Click one of the following buttons:

* OK to attach the form and close the New Form dialog box.

* Apply to attach the form and redisplay the New Form dialog box.
Attach existing forms

1. In My Teamcenter, find the form you want to attach.

2. Select the form and click the Copy button | ™ on the toolbar.

3. Open Part Planner.

4. Select the object where you want to attach the form.

5. Click the Paste button -|:.J on the toolbar.

Remove objects and attachments

As you design and create revisions of your part, process, and work area structures, you may need to
remove objects and object attachments from the structure tree.

When you remove an object or attachment, it is removed from the current structure but not deleted
from the database.

To remove an object from the structure view:

1. Select the object in the structure view.
2.  Click the Remove a Line button {=& on the toolbar.

Teamcenter removes the line from the structure.
To remove an attachment:

1. Right-click the object containing the attachment in the structure view and choose Open
with->Attachments.

2. In the Attachments view, select one of the attachments.
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3. Choose Edit->Cut or click the Cut button g_.-‘flf’ on the toolbar.

Delete objects and attachments

Before you can delete an object from the database, you must first remove all but one reference to it. This
is usually done by:

1. Performing a where-referenced search on the object using the Impact Analysis view.

2. Removing all of the objects but one using Cut. Choosing Cut does not delete the object from the
database.

Note:

In order to delete an object, you must have read, write, and delete privilege on that object.

To delete an object:

1. Select the object from the Product, Process, or Plant structure view.
2. Click the Remove a Line button {=& on the toolbar.

3. Open the My Teamcenter application and locate the object.

4. Select the item and click Delete % on the toolbar.

To delete an attachment:

1. Select the object in the Attachments view.

2. Choose Edit=Delete or click Delete ¥ on the toolbar.

Creating substitute occurrences

As in the Teamcenter applications, the Part Planner application allows you to create substitute
components in your part, process, and work area structures. The substitutes you create are specific
to a single occurrence.

Some key points for using substitutes include:
* One of the substitutes is the preferred substitute and is always displayed in the BOM.

* You can change the preferred substitute.
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* You can add any number of substitute components for a particular line in the BOM.

» Substitutes are unique to the BOM. For example, if you were to identify a substitute station in
the current work area structure, only the current work area structure is impacted. Other work area
structures are not affected.

* To view the substitute components for a part, process, or work area, select the component in the
structure view. Then click the "% button.

Modify object properties
1. Do one of the following

* Double-click the property form in the Attachments view.

* Right-click the property form in the Attachments view and choose Open with->Viewer.
2. Check out the property form and edit the required properties.

3. Check the form back in.

Understand the Gantt

The Process Gantt view displays processes and operations and the relations between them in a chart. A
process Gantt chart is a bar chart that illustrates the work breakdown structure of a project. It illustrates
the start and finish times of the operations or processes, or the relationships between those start and
finish times if they overlap, as well as summary elements (operations or higher level processes) of the
project using a time line. The Gantt chart also shows the dependency (sequence) relationships between
the elements.
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= 5, 000136/4;1-P1 (View) | 1 000136/8;1-P1 {Yiew)

B 59 000137/8;1-P2 {View) I 1 o00137/4; P2 (View)
3 00014018;1-PS (View) V_M
3 00014 /i8;1-P6 (Views) I 000141/8;1-P6 (View)
B 59 000135/8;1-F3 {View) ¥ H 000138/4;1-P3 (View)
0, 000142/8;1-P7 {View) ’—m‘l PT (View)
B 59 000143)4;1-F8 {View) 000143/4;1-P8 (¥iew)
9, 00014518, 1-P10 (View) | ooo14s/a;1-P10 (View)
3, 000144/8;1-P3 {View) P ooota4/a;1-P2 (view)
o7 000139/4;1-P4 (View) F— 000139/8; 1-P4 (Yiew)

Using the Process Gantt view, you can:

* Configure the view using preferences.
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* Change the time duration of elements.
* Reset the scope (structural selection) of the Gantt view, or otherwise modify the view.
¢ Create and delete flows.

» Show and hide the critical path (sequence of processes/operations that defines the longest path of the
project).

* Expand and collapse structures within the chart.

* Set the calculated duration time (the overall time it takes to execute a process's or operation's direct
children) in the chart, and propagate the allocated (allowed) time from the calculated (perceived)
duration.

* Set cycle time and display time units as red lines in the chart.

* Use wrapped cycle time to show that even though a task exceeds its assigned cycle time, it can still be
completed in time for the next task to begin.

» Set custom colors to better identify resources assigned to processes in the chart.
Note the following about the Process Gantt view.

* The duration of an element in the Gantt chart represents its allocated time. You can also set the
allocated time in the Time view.

* You cannot set start times manually in the Process Gantt view. Start times are calculated based on
previous processes or operations.

* To help you avoid making inadvertent changes to activity durations, the Process Gantt view is locked
in edit mode when you first open it. You must unlock this mode by clicking + before you can modify
duration times by dragging the time bar.

* If objects are configured out in the initiating process structure, the Gantt chart ignores them.

* You can drop a process into the Gantt chart; the behavior is identical to dropping it in the same
position in the structure view.

* When you select a process or time element in the Process Gantt view, the same process is selected in
the structure view.

* You cannot delete a process that has flows attached to it.
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Open the Process Gantt view
1.  Select a process or operation in the structure view.
2. Choose Window-Show View—-Process Gantt.

Teamcenter displays the Process Gantt view. The selected process or operation is the root node of the
process tree. The pane on the right displays the start time and duration time for each line of the process
structure. You can open multiple Process Gantt views for comparison purposes.

Note:

You cannot manipulate start times in the Process Gantt view.

Change duration times

Do one of the following:

1. Make sure that the Lock editing button  is off.

2. Move the cursor over the end of the time bar until it changes to a double-ended arrow .
3. Drag the end of the bar to the desired duration time.

-or-

1. Right-click the time bar and choose Show property dialog.

2. Type anew end time and click OK.

Teamcenter changes the length of the time element to reflect the new time.

Tip:

Teamcenter displays the duration time in a tool tip for the process or operation, as well as in the
allocated_time column of the view navigation pane.

Reset the scope
1. Select a process or operation in the structure view.
2. Click ¥7.

Teamcenter removes the current process or operation from the Process Gantt view and replaces it with
the selected one.
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Modify the view

Do one of the following.

Click To

[ Scale the chart up or down to accommodate the entire
process flow.

i Scale the chart up to show the currently selected time
element placed in the middle of chart and taking up most
approximately two thirds of the chart.

= Reduce the scale of the chart by a factor of two.
& Enlarge the scale of the chart by a factor of two.
Tip:

Use the Ctrl key to help you draw a box around a group of time elements to select multiple objects.

You can also use the following shortcut menu commands to help you modify the view:

Menu command Description

Collapse element Collapses the tree structure under the selected line. It also
collapse the corresponding time elements.

Expand element Expands the tree structure to one level under the selected
line. It also expands the corresponding time elements.

Create a flow

You can only create flows between processes or operations at the same level in a structure that have the
same parent (sibling lines).

Do one of the following:

* Create a flow between elements by selecting at least two bars in the Gantt chart and click ™%_.
Teamcenter creates a flow between the elements in the order that you selected them.

» Create a flow by dragging one bar to another in the representation pane.

If, for example, you drag Process 1 to Process 2, Teamcenter creates a flow from Process 1 to Process
2.
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* Select the desired nodes in the tree structure in the navigation pane and click ™.

Teamcenter creates a flow between the elements in the order that the nodes appear in the tree.

Tip:

Teamcenter displays the names of the source and target elements in a tool tip on the flow.

Delete a flow

Select the flow by clicking the line and do one of the following:
* Click =x.

* Choose Delete flow from the shortcut menu.

* Press the Delete key.

Show/hide the critical path

The critical path is the sequence of processes/operations that defines the longest path of the project. The
project cannot be executed in a shorter time than the critical path. A project might have more than one
critical path. In the case of a single critical path, if you make a modification that shortens the duration of
any of the elements, you shorten the overall duration of the project.

1.  Click the Mark Critical Path button -ll to display or hide the critical path.

If there is more than one critical path in the Gantt chart or some alternative paths have the same
critical path length, Teamcenter shows all the critical paths.

2. (Optional) Click Tﬁi to view the duration of the critical path.

Teamcenter displays the read-only Critical Path Length dialog box.
Expanding and collapsing structures

When expanding and collapsing structures in the navigation pane of the Process Gantt view, the
behavior differs from the expand/collapse behavior in the navigation pane of the application. In the
Process Gantt view, if a structure that includes expanded children is collapsed, the children are also
collapsed.

In the navigation pane of the application, if you collapse the selected line, and then expand it again, you
see the same structure.
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8 001338/A;1-001 (view)
Shw- 1001342/, 1-002 (view)

o 001402/4;1-003
& 001401/4;1-002
=58 001365/4;1-004 (view)
9 001397/A;1-321 (view)
+-78 001395/A;1-666 (view)

In the navigation pane of the Process Gantt view, if you collapse the selected line, and then expand it
again, you see the following.

8 001338/A;1-001 {view)
=9
- g 001402/4;1-003
& 001401/A;1-002
-5 001365/A;1-004 (view)
+-5 001395/4;1-666 (view)

Understanding the calculated duration time

Duration of an element is the overall time it takes to execute its direct children. If all the children are
parallel (no flows between them), it is the length of the longest child. In the case where there are flows
between the children, it is the overall time it takes to execute the children according to the order (flows)
between them. Calculated duration of upper levels is based on the calculated duration of lower levels.
If the lower level has no children (for example, a process that has no processes or operations below), its
calculated duration is equal to its duration.

* For a process with only child operations, the calculated duration is the length of the longest path of
operations. If the operations have flows between them, it is the overall time it takes to execute them
according to the flows.

» For a process with child processes, Teamcenter first calculates the calculated duration of each child
process containing only child operations, and then calculates the longest process duration of the
processes based on the calculated duration time of the subprocesses and operations.

If there are, for example, four operations with the same parent, having duration times of one second,
two seconds, three seconds, and four seconds, the calculated time for the parent process is four
seconds. If, however, the second operation must be completed before the third, the calculated duration
time is 5 seconds for the parent process.

Use the Show calc duration button 5" to show or hide the calculated duration time. Teamcenter shows
a bar across the top of each time element displaying the calculated duration path of the children of this
time element.
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Calculating start times based on calculated duration _

Calculating start times based on calculated duration

When the calculated duration mode is turned on, the calculation of start times is based on the calculated
duration of the predecessors. If calculated duration is off, the start times are calculated based on the
duration of the predecessors.

Teamcenter always turns off the critical path mode when you change the calculated duration mode
because the critical path most likely changes after the calculated duration mode is switched.

Propagate allocated time from the calculated duration

Propagating allocated time from the calculated duration copies the calculated duration to the allocated
time field in the selected element.

1. Select the line you want to have as the top line of the populate action.

The line you select is the starting point for counting the traversal of parent-child relationships when
propagating calculated duration.

TR
2. Click i

Teamcenter displays the Propagate Calculated Duration dialog box.
3. (Optional) Select Propagate up to level and enter a level number.

All leaf objects that are of a distance from the top level object that is greater than or equal to the
number you specify in this option are calculated.

If you do not enter a number, Teamcenter uses the default level of 0 indicating that all elements
below the top element are propagated.

In the following example, Station1 is selected and acts as the top element of the population.

5-15



_ 5. Verifying structure design

BOM Line

= 78 ROOT&;1-1 (view)

B .= Stationl-typedfa;1-1 (view)
= 78 Stationl.1-typedfA;1-1 (view)
= 79 Processl.1.1-typeB/a;1-1 {view)
" & Operationl.1,1.1/8;1-1
g Operation1.1.1.2f#;1-1
& Operation1.1.2/4;1-1

& Operation1.2/A;1-1
79 Station2-typeAfA;1-1 (view)

In the following figure, if the population start depth is 0, ROOT and Station2 are not populated
because they are not descendants of the top element. The elements in green are populated.

In the following figure, if the population start depth is 3, ROOT and Station2 are not

populated because they are not descendents of the selected element (Station1) and Station1.1,
Process1.1.1, Operation1.1.2, and Operation1.2 are not populated because they are less than
three levels from Station1.
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Configure the Process Gantt view _

4.  Click OK.

If the Process Gantt view is in calculated duration mode, it updates all start times and refreshes itself
after the populate operation.

If the critical path mode was turned on before this populate operation, Teamcenter turns it off because
the critical path has most likely changed after population.

Configure the Process Gantt view
1. Choose Edit->Options.

Teamcenter displays the Options dialog box.
2. Select Manufacturing from the tree.

3. Click the Gantt tab and set any of the following preferences:

Option Description
Show calculated duration Specifies whether the calculated duration time is displayed by
default in the Process Gantt view.

This information is stored in the
MEGANTTDefaultDisplayMode preference.

Full edit mode Allows you to use drag options to edit and modify the
elements in the Gantt chart.

This information is stored in the MEGANTTDefaultEditMode
preference.

Part Planner, Teamcenter 2412 5-17
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Option

Zoom level

Element height

Element color

Critical path element color

Selection color

Calculated duration color

Flow color

Critical path flow color

Implicit flow color

Description

Specifies the X-axis zoom level that is active when a Gantt
chart is opened.

Specifies the height of one element of the Gantt chart in the
navigation and the representation area (the amount of pixels
that are used for one element). There is no space between
the elements (10 elements use 10 times the space of one
element).

This information is stored in the MEGANTTElementHeight
preference.

Specifies the fill color of the elements in RGB code.

This information is stored in the
MEGANTTElementRGBfillColor preference.

Specifies the color of the critical path elements in the Process
Gantt view representation area.

This information is stored in the
MEGANTTDefaultMarkedColor preference.

Specifies the color of a selected element in the Process Gantt
view representation area.

This information is stored in the
MEGANTTDefaultMarkedColor preference.

Specifies the color of the duration time bar in the Process
Gantt view representation area.

This information is stored in the
MEGANTTDefaultDurationTimeColor preference.

Specifies the color of a flow in the Process Gantt view
representation area.

This information is stored in the MEGANTTDefaultFlowColor
preference.

Specifies the color of critical path flow in the Process Gantt
view representation area.

This information is stored in the MEGANTTMarkedFlowColor
preference.

Specifies the color of an implicit flow (created by Teamcenter
to retain necessary dependencies) in the Process Gantt view
representation area.

This information is stored in the MEGANTTImplicitFlowColor
preference.
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These preferences are applied to any newly opened Process Gantt view.
Edit operation resources

1. In the process structure, select the resource to be removed. To select multiple resources, either
hold the shift key (for contiguous objects) or control key (for noncontiguous objects) while clicking
resources in the list.

2. On the Edit menu, choose Remove, or click the Remove a Line =& button on the toolbar.
3. Assign new resources as necessary.

Resequence activities

As you modify your process plan, you may need to resequence the order or performance for operation's
activities.

Managing activity times with the Activities Gantt view

The Activities Gantt view displays activities and the chronological relation between them in a chart.
An activities Gantt chart is a bar chart that illustrates the work breakdown structure of an operation.
It illustrates the start and finish times using a timeline. The Gantt chart also shows the dependency
(sequence) relationships between the activities.

Using the Activities Gantt view, you can:

* Change the duration of elements.

* Populate the duration time based on leaf elements.
* Show and hide the critical path.

* Zoom in and out of the chart.

Note the following about the Activities Gantt view:

* The length of an element in the Gantt chart represents the duration of an activity. You can also set the
duration in the Activities view.

* You cannot set start times manually in the Activities Gantt view.
* To help you avoid making inadvertent changes to activity durations, the Activities Gantt view is

locked in edit mode when you first open it. You must unlock this mode by clicking +’3 before you can
modify duration times by dragging the time bar.
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Open the Activities Gantt view

* Right-click an operation in the structure view or an activity in the Activities view and choose Open
With->Activities Gantt.

Teamcenter displays the Activities Gantt view displaying the start time and duration time for each
activity in the operation. You can open multiple Activities Gantt views for comparison purposes.

Change duration times

1. Make sure that the Lock editing button  is off.

2. Move the cursor over the end of the time bar until it changes to a double-ended arrow ©.
3. Drag the end of the bar to the desired duration time.

Teamcenter changes the length of the activity time to reflect the new time.

Tip:

Teamcenter displays the duration time in a tooltip, as well as in the Duration column of the
Activities view.

Reset the scope
1.  Select a new operation in the structure view.
2. Click ¥y

Teamcenter removes the current activities from the Activities Gantt view and replaces them with the
activities of the selected operation.

Modify the view

Do one of the following.

Click To

[ Scale the chart up or down to accommodate the entire
process flow.

3N Scale the chart up to show the currently selected placed in
the middle of chart and taking up most approximately two
thirds of the chart.
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Understanding the calculated duration time _

Click To
e, Reduce the scale of the chart by a factor of two.
*, Enlarge the scale of the chart by a factor of two.

Understanding the calculated duration time

Duration of an activity is the overall time it takes to execute its direct children. If all the children

are parallel, it is the length of the longest child. Calculated duration of upper levels is based on the
calculated duration of lower levels. If the lower level has no children (for example, activities with no
subactivities), its calculated duration is equal to its duration.

» For an operation that has only one level of activities below it, the calculated duration is the length
of the longest path of activities. If the activities have start times associated with them, the calculated
duration is the overall time it takes to execute the activities taking the start times into consideration.

* For an activity with subactivities, Teamcenter first calculates the calculated duration of each
subactivity, and then calculates the longest duration of the activities based on the calculated duration
time of the subactivities.

If there are, for example, four activities with the same parent, having duration times of one second, two
seconds, three seconds, and four seconds, the calculated time for the parent activity is four seconds.

If, however, the second activity must be completed before the third, the calculated duration time is five
seconds for the parent process.

Use the Show calc duration button =_ to show or hide the calculated duration time. Teamcenter shows
a bar across the top of each activity displaying the calculated duration path of the children of this
activity.

Calculating start times based on calculated duration

When the calculated duration mode is turned on, the calculation of start times is based on the calculated
duration of the predecessors. If calculated duration is off, the start times are calculated based on the
duration of the predecessors.

Teamcenter always turns off the critical path mode when you change the calculated duration mode
because the critical path most likely changes after the calculated duration mode is switched.

Configure the Activities Gantt view
1. Choose Edit->Options.
Teamcenter displays the Options dialog box.

2. Select Manufacturing from the tree.
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3. Click the Gantt tab and set any of the following preferences.

Option Description

Show calculated duration Specifies whether the calculated duration time is displayed by
default in the Activities Gantt view.

This information is stored in the
MEGANTTDefaultDisplayMode preference.

Full edit mode Allows you to use drag options to edit and modify the
elements in the Gantt chart.

This information is stored in the MEGANTTDefaultEditMode
preference.

Zoom level Specifies the X-axis zoom level that is active when a Gantt
chart is opened.

Element height Specifies the height of one element of the Gantt chart in the
navigation and the representation area (the amount of pixels
that are used for one element). There is no space between
the elements (10 elements use 10 times the space of one
element).

This information is stored in the MEGANTTElementHeight
preference.

Element color Specifies the fill color of the elements in RGB code.

This information is stored in the
MEGANTTElementRGBfillColor preference.

Critical path element color Specifies the color of the critical path elements in the
Activities Gantt view representation area.

This information is stored in the
MEGANTTDefaultMarkedColor preference.

Selection color Specifies the color of a selected element in the Activities
Gantt view representation area.

This information is stored in the
MEGANTTDefaultMarkedColor preference.

Calculated duration color Specifies the color of the duration time bar in the Activities
Gantt view representation area.

This information is stored in the
MEGANTTDefaultDurationTimeColor preference.

Flow color Specifies the color of a flow in the Activities Gantt view
representation area.
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Option Description
This information is stored in the MEGANTTDefaultFlowColor
preference.

Critical path flow color Specifies the color of critical path flow in the Activities Gantt

view representation area.

This information is stored in the MEGANTTMarkedFlowColor
preference.

Implicit flow color Specifies the color of an implicit flow (created by Teamcenter
to retain necessary dependencies) in the Activities Gantt
view representation area.

This information is stored in the MEGANTTImplicitFlowColor
preference.

These preferences are applied to any newly opened Activities Gantt view.

Edit activity start times and durations in the Operation Activities tab
1. Expand the process hierarchy in the Process pane and select an operation.
2. Choose Open with— Activities.

3. Double-click a Start or Duration value. The value becomes editable.

Note:

The Calculated Start and Calculated Duration values cannot be changed.

4. Type anew value.
5. (Click outside of the entry box to exit edit mode.

The root activity's Duration is automatically recalculated using the new values.

Edit activity resources

When you modify a process plan, you may need to add resources to an operation's activities or edit
existing ones. All resources assigned to an activity are automatically assigned to its parent operation.

1.  Select an operation from the process structure.

2. Choose Open with— Activities.
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3. Select the activity to which you want to add resources.
4. Click the Edit Activity Occurrences button g.

The Edit Activity Occurrences dialog box is displayed. All resources currently assigned to the
activity or the activity's parent operation are listed in the dialog box. Add and delete resources for
the activity through this dialog box.

5. Do one of the following:

To Do this

Delete existing resources a. Select the resource to be deleted. To select multiple
resources, hold either the shift key (for contiguous
objects) or control key (for noncontiguous objects)
while clicking resources.

b. Click < to remove selected resources from the list or
click << to remove all resources from the list.

Assign additional resources * To assign a resource already in use by the activity's
parent operation, choose the resource from the
Occurrences on Operation list and move it to the
Occurrences on Activity list.

* To assign a new resource from the classification
hierarchy, click the Assign Resource button & The
Classification Search Dialog is displayed.

Using feature management

Using feature management

Teamcenter allows you to define features, which represent design or manufacturing features that are not
defined as part of the physical structure in the BOM.

Features are implemented as item elements, sometimes called generic design elements (GDEs).
Add item element features to a structure
You can add features to any structure (for example, a manufacturing process) as follows:

1. Select the BOM line to which you want to attach the feature and choose File*New-Item
Element.
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Teamcenter displays the Item Element dialog box.

2. Select the item element type from the left-hand pane in the dialog box, type a name and
description of the feature, then click OK to attach the feature.

Optionally, you can select the Open on Create check box and Teamcenter opens the feature
immediately.

You can also add a feature to a BOM line by copying or cutting the feature from another BOM line and
pasting it to the required BOM line.

Add connections between BOM lines in the same way as features, choosing the appropriate item
element for the connection. To add a revisable connection between two item elements, select the item
elements and choose Advanced->Connect. To add a nonrevisable link between two item elements,
select the item elements and choose File=*New-Non-revisable. To remove a connection or a link,
select the item elements and choose Advanced-»Disconnect.

The following figure shows a feature called CS as a consumed item in the op2 operation of the
water_pump_assy_proc process. Because the feature does not have revisions, there is no + sign in
its line.
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BOM Line / | Rule coni

00334508 -vvater_pump_assy (view)

_'_'JIIIIIHMIINWderJ:ump_rIurgu Workingl )
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O340 vaer LD Wiorknal )
003351 i4-water_pump_housing Workingl )
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L | |

Process Slructire
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=l “',ql O0344308-0p1 (view)
| E P 003348 8 water_pump_shatt (view)
-l DHEIIIEIid#I&acpZ {view)
We¥es
[#] "ﬁ‘S‘teM

Feature (item element) as consumed item in manufacturing process

Note:

The line assigned for the feature in the process structure carries an occurrence type with a specific
meaning, for example, consumed item, workpiece, or resource.
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Manufacturing Process Management creates a link between the occurrence path of the feature in
the product structure and its assigned line in the product structure.

Visualizing features

You can attach one or more JT files to a feature using the Rendering relationship, allowing the feature to
be viewed in the same way as any other item in the BOM. You can uncheck a line in the BOM containing
a feature if you do not want to visualize it.

The following figure shows a feature selected for visualization; in this case, the selected feature is

CS_shaft, a datum represented by a coordinate system. Click and hide the check mark in the BOM line to
hide the image.

e, — "Iﬂ = | = — | _—
BOM Line / - _ =

003345/ water_puanp_sssy (vew) w Q Ql':r_ﬁ“? 12 a8

< [ A00a34T i-vwater_pump_flange

= 00338608 water_pump_shaft (view)
7

[ 200334958 water_pump
7 003351 fs-water_pump_housing
[=cs

Generating reports for features

You can obtain several types of reports. For a selected process or part, the Report view lets you generate
a report of the selected type. For example, for a process, you can generate weld sequence, datum

utilization, and datum coordination reports. For a product, you can generate an unallocated welds
report.
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Sample report

Use the menu at the bottom of the view to choose the criteria for a report, and click the buttons to select
the desired action, such as generate, save, or view the report.

The weld process report is applicable to a station process structure built according to best practice. The
report assumes that the station process root contains multiple operations directly below it. You must
customize the report if the structure you use differs from this best practice.

Configuring process structures

Set configuration for multiple structures

Use the Configure Structure Contexts dialog box in to configure multiple structures revision rule,
effectivity, and other configuration items. This function is helpful if you are configuring more than one
structure to the same configuration.

To use this feature, make sure you load all structures that you want to configure in .
1. In, choose Advanced-Configure Structures.

2. Inthe Configure Structure Contexts dialog box, select Structures and Collaboration Contexts to
bulk apply variants, effectivity, and occurrences.
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a. Select the structures to configure by selecting the check box in the Structure Name column.
b. In the Revision Rule column, select the revision to use in the configuration.
c. Inthe Variant Rules column, select the variant to use in the configuration.

d. Inthe @ column, select the check box if unconfigured variants of the structure are to be
shown in the configuration.

e. Inthe & column, select the check box if unconfigured by occurence effectivity of the structure
are to be shown in the configuration.

f.  Inthe 4 column, select the check box if suppressed occurances of the structure are to be
shown in the configuration.

g. Inthe &# column, select the check box if unconfigured changes of the structure are to be
shown in the configuration.

h.  In the® column, select the check box if unconfigured assigned occurances of the structure is
to be shown in the configuration.

i.  Inthe Effectivity Groups column, select the effectivity groups to use in the configuration for
each structure.

j.  Inthe Effectivity column, select the effectivity to use in the configuration for each structure.
3. To update all BOM views with the selected values, click Apply.

4. To save all configuration changes including changes to loaded collaboration context, click Apply
and Save.

5. Toexit, click Close.

About process configuration

A manufacturing process plan consists of three interconnected structures:
* Part

* Processes and operations

* Work area

Configuration management helps you define and apply variant rules to each of these structures
independent of the other structures.
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Because the process structure can have its own lifecycle and variability, lines in a process can configure
out in one of the following ways:

* By occurrence effectivity

If you add an operation with occurrence effectivity, it is configured out when it is not effective. Show
these lines using the Show Unconfigured by Occurrence Effectivity button & in the structure view
or choosing Show Unconfigured by Occurrence Effectivity from the view menu.

The default state of this button is determined by the
MEShowUnconfiguredOccurrencesEffectivityDefaultState preference.

* By incremental change effectivity

If you make changes with an incremental change (IC) and if it carries effectivity, the changes related
to it are configured out if it is not effective. Show these changes by choosing the Show Unconfigured
Changes button %¢ in the structure view or choosing Show Unconfigured Changes from the view
menu.

The default state of this button is determined by the MEShowUnconfiguredChangesDefaultState
preference.

* By variants/options

If a BOM line carries a variant condition making it valid for a certain set of options, it is configured out
for a different option set for which it is not valid. Show these lines by clicking the Show Unconfigured
Variants button & in the structure view or by choosing Show Unconfigured Variants from the view

menu. Using this menu command also shows objects that were configured out using effectivity.

The default state of this button is determined by the MEShowUnconfiguredVariantsDefaultState
preference.

* By reference window

If you have a composition-type process, a line (for example, a consumed item) may be configured
out because it is configured out in the reference or parent window on which it is based. Teamcenter
does not differentiate why it was configured out in the other window. Show these lines by clicking
Unconfigured Assigned Occurrences from the view menu. In this case, the lines are gone from

this process window because they are configured out of the parent structure. It is irrelevant whether
they are configured out of the parent structure because of occurrence effectivity, incremental change
effectivity, or variants/options.

The default state of this button is determined by the
MEShowUnconfiguredAssignedOccurrencesDefaultState preference.

The following preferences play a role in what processes you see when child processes are configured out:
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 controllingOccsForProcessConfiguration

* typeAndRuleForProcessConfiguration

Select configuring structures

In some cases, it is unclear which loaded structures configure a loaded process. For example, a process
may contain consumed items from two different product structures and you only want to see the
operations containing parts from one of these product structures. Another example is when you have
two product structures and two process structures loaded. You want to configure each process by their
associated product structure.
You can define which loaded structures configure loaded processes.
1.  Select a process.
2. Do one of the following:

* In the process structure view menu, choose Define Configuring Structures.

* Choose Tools—>Define Configuring Structures.

Teamcenter displays the Define Configuring Structures dialog box that contains:

* The name of the selected process.

* The name of the collaboration context containing the selected process, if applicable.

¢ Alist of all loaded structures.
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In the Configuring Structures list, select one or multiple structures that you want to configure the
process. You can also clear all the selections so that the process is not configured by any structure.
This behavior is equivalent to not having any product structure loaded.

If only one structure is loaded, the Define Configuring Structures dialog box will not appear.

By default, a product contained within a collaboration context configures a process located in the
same collaboration context.

If you select an occurrence group in the first step, Teamcenter carries out the command on the
corresponding base view.

Tip:
* Teamcenter maintains the selection of a configuring structure until one of the structures is
unloaded. To maintain the selection, save the structures to a collaboration context.

* To use the pre-Teamcenter 9.0 behavior where each loaded composition structure is configured
by all loaded structures, set the MEConfiguringStructuresMode preference.
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Configuring structures by occurrence effectivity

About occurrence effectivity

The effectivity of an occurrence can be expressed as a date range or a range of units with respect to

an end item. An occurrence can have multiple expressions comprising date effectivity, unit effectivity, or
both. Multiple unit effectivity expressions may reference the same end item or different end items. If no
occurrence effectivity is specified, the occurrence is considered to be always effective; that is, it is not
constrained by any effectivity definition.

Occurrence effectivity is used principally for two purposes:
* To reflect changes to the structure over time as new parts replace old ones.

* To explicitly state the content of a unit or range of units as a means of managing the variability of the
product. This technique is an alternative to using options and variants to configure the parts needed
to fulfill a particular offering.

Occurrence effectivity is frequently used by manufacturers of military and aerospace products. The end
item may correspond to a serial number or the tail number of an aircraft.

For example, there may be different hydraulic cylinders in the landing gear of an aircraft, depending

on whether the aircraft is certified for unimproved runways. There may be additional differences to the
aircraft to meet this purpose, such as debris deflectors, wheels, and tires. Using options and variants,
you could define an option called RW_Class = Paved or Gravel, and there would be a variant rule on
stouter cylinder to configure it in for the Gravel option. Using occurrence effectivity, the unit number

of each aircraft unit that is certified for operation on gravel runways (for example, units 3-6, 17, 33-45)
would be used in the effectivity specified for parts such as stouter cylinders. The effectivity of the regular
cylinder would be specified using the other units (unit 1-2, 7-16, 18-32, 46-up).

Understanding occurrence effectivity
Understanding occurrence effectivity

Several occurrences may share an effectivity. When you edit the effectivity range on one occurrence,
Teamcenter applies the change to all occurrences. (This is generally the reason for sharing effectivity.)

You can also pack occurrences if they share the same unit or date range and access protection status.
Packed occurrences are displayed in a similar way to packed structure lines.

You cannot import or export structures containing occurrence effectivity. If you require individual
structure nodes to have effectivity, consider the use of incremental change.

If an occurrence does not have an associated effectivity object, Teamcenter assumes it is always effective
and it is configured regardless of the date or unit number set by the revision rule, as shown in the
following figure.
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If you do not split effectivities, you can optionally use the Configuration Item check box to indicate the
end item, although Teamcenter does not enforce this use.

Effectivity can be shared between
occurrences (and can have
multiple ranges)

Effectivity Object

ID: 12345 A100/A ID: 12340
From date  To Date From date  To Date
& Aug 04 7 Julos 1 May 05 -

Created by: Joe, on 1 Jan 05

Created by: Jim, on 1 Jan 04

Mo effectivity defined oo ____
- that iz, always valid

AZ0 P10 P20 P30

Occurrence Effectivity Rule

Date = 1 Apr 05 Configured
Component

Occurrence effectivity rule

When you create an effectivity condition on an occurrence, you change the parent BOM view
revision. Consequently, you must have write access to the BOM view revision. However, you can make
subsequent changes to the effectivity range if you have write access to the effectivity object, allowing
you to edit effectivity data after the structure is released.

Note:

The import or export of a structure containing legacy occurrence effectivities is not supported.
If you require individual structure nodes to have effectivity, consider using incremental change
instead of occurrence effectivity. Structures managed with incremental change can be imported
and exported using Multi-Site Collaboration.

Validating effectivity

You should check that effectivity ranges are consistent within the whole structure, ensuring that
effectivity ranges lower down the structure lie within ranges higher up. You may not be aware of the
constraints higher up the structure when you initially specify effectivity ranges at lower levels.

Teamcenter does not perform this validation automatically but you can include it as part of a workflow
process that approves the effectivity ranges. In certain cases, this validation may not be appropriate, for
example, when the structure is shared between different products.
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Defining mutually exclusive effectivity ranges

If you intend to define occurrences as mutually exclusive, manually check that they do not have
overlapping effectivity ranges. For example, in the following figure, there are two different types of
dynamo and it would be wrong to configure two dynamos at the same time.

Bike

A10

Effective In: 1 Jan 94 cmacaaca=- Effectve In: 1 Jan 95
Effective Out: 31 Dec 24 Effectve Out: -

AZ0 Azs
Hub Dynamo Rirm Dynamo

Mutually exclusive effectivity ranges

When specifying effectivity, you can make the association between the occurrences clearer by using the
same find number or attaching a special effectivity note to each.

Understanding unit net effectivity

For a large and complex structure, it is useful to understand the net effectivity of components within
the structure. A lower level component may have been originally specified for any effectivity or a large
range, but a narrower range applied at a higher level in the structure can reduce the net range for that
component line.

Unit net effectivity can be considered as the intersection of an occurrence’s unit occurrence effectivity
with its parent’s calculated unit net effectivity, from the specified structure line up to the top of the
structure. For a line without an underlying occurrence (top line of a structure), there is no occurrence
effectivity. This line is considered unconstrained and always configured. The unit net effectivity of a line
that has no unit occurrence effectivity is equivalent to its parent’s calculated unit net effectivity.

 If the line has only date effectivity expressions, these are ignored and the unit net effectivity is the
same as its parent’s calculated net effectivity.

* If there are multiple unit effectivity expressions with the same end item, these expressions are merged
before intersection with the parent’s calculated net effectivity.

* The intersection is taken with respect to the end item designations of the parent’s unit net effectivity
expressions. Unit effectivity expressions whose end items do not match any in the parent’s unit net
effectivity are ignored.

* If there is no intersection of the line’s unit occurrence effectivity and the parent’s unit net effectivity,
the line’s unit net effectivity is set empty (fully constrained).
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* The unit net effectivity of a line whose parent’s unit net effectivity is empty also has an empty unit net
effectivity, regardless of the line’s unit occurrence effectivity.

* The unit net effectivity of a particular component line is calculated when you display the line and is
not persisted in subsequent sessions.

Effectivity flow-down reporting helps the user understand effectivity ranges and the impact of changes,
especially as the complexity of the effectivity increases through the structure.

Calculate unit net effectivity

To calculate the net occurrence effectivity of a selected structure line, choose
Tools—>Effectivity>Occurrence Effectivity—>Calculate Net Effectivity.

Teamcenter displays the occurrence effectivity, unit net effectivity, and net effective occurrence
configured (EOC) information for the selected line.

00021/ 1-top (View) - Latest Working (Modified) - End ter - 000081/8;1-Endtem1, Date - "Now”, Unit - 5 0 E W )
BOM Line | Occurrence Effectivity| EOC - Effective Occ. Config'd | Unit Net Effectivity | Unit Net - Effective Occurrence Configured (EOC) |
5 00002118 1-top (View) True True
e 000022 78:1-c1 1-UP (D00081) True 1-UP (000051) Trus
A 000238 1-c2 True True

The unit net EOC is set to true if the occurrence would be configured in based on the comparison of
its calculated unit net effectivity with the revision rule occurrence effectivity entry. Teamcenter performs
this comparison at run time and it is not persisted.

P i

U Unit Net Effectivity Details for 000022/4;1-c1 ===

Property Mame Property Walue

Occurrence Effectivity 1-UP (D00081)
Unit Net Effectivity 1-UP {000081)
Unit Met - Effective Occurrence Configured (EOC) true

Note:

If you select a root line or more than one line, an error message is displayed.

Configuring by occurrence effectivity

If the revision rule controlling the configuration of a structure contains an entry for occurrence
effectivity, occurrences for which no occurrence effectivity is specified are configured, together with
occurrences whose effectivity expressions match some part of the revision rule occurrence effectivity

5-35



_ 5. Verifying structure design

entry. If Show Unconfigured By Occurrence Effectivity is selected, an occurrence may be shown or
hidden, depending on occurrence effectivity (which may be a greater range than unit net effectivity).

The calculated net effectivity is also compared with the revision rule occurrence effectivity entry.

* If the unit net effectivity of a line is unconstrained, the unit net-EOC is true, regardless of any
occurrence effectivity entry in the revision rule.

* If the unit net effectivity of a line is empty, the unit net-EOC is false, regardless of any occurrence
effectivity entry in the revision rule.

* Fora line whose unit net effectivity is not unconstrained or empty, its unit net-EOC is false if there is
no occurrence effectivity entry in the revision rule.

* If there is an occurrence effectivity entry in the revision rule, the unit net-EOC is true only if the unit
net effectivity matches some part of the revision rule occurrence effectivity entry.

* Any date effectivity expressions in the revision rule occurrence effectivity entry are ignored for the unit
net-EOC comparison. A date range is not considered as a scope for unit net effectivity,

You may explicitly set an occurrence effectivity entry in the existing revision rule by choosing Revision
Rule—>Set Date/Unit/End Item.... You can then set a unit range defining the scope of effective
occurrences you want to review. The Unit Net-EOC property shows whether the computed net
effectivity is in that scope.

Using effectivity cutback

While defining a product managed with occurrence effectivity, the effectivity decisions evolve as the
product content itself is developed. The design engineer makes decisions for effectivity ranges that
reflect the implementation plan for when additional or replacement parts should be included in the bill
of materials.

In general, there are many technical and logistical decisions that go into setting the date or unit range of
the effectivity. To support this process, the engineer must understand the chain of effectivity for a given
part. The engineer may choose to adjust the effectivity ranges when necessary. Over the life cycle of
development and service of the product, customers using occurrence effectivity replace parts with other
parts. As these changes are made, the historical chain of effectivity must remain consistent.

When a new occurrence of a part is specified as a replacement for an existing occurrence in a structure,
the effectivity of the replaced part should be reduced (cut back) so that it does not overlap with the
effectivity of the replacing part.

When a part with occurrence effectivity is replaced and cut back, prior generations that were replaced by
the cutback part should also be considered for cutback, if the range of the newest replacement overlaps
effectivity.
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Note:

Effectivity cutback is only supported with unit effectivity, not with date effectivity.

The following actions are supported by effectivity cutback:

* Replacing N parts with M replacements and updating ranges of effectivity. The historical chain of
effectivity retains the N:M relationship, in case a future cutback operation needs to fully span the
content of a link in the chain to cut it back.

* Validating prior replacements in the history of effectivity and updating accordingly.

* Enabling efficient updates to effectivity ranges after a replacement.

The following example shows how effectivity cutback occurs when an engineer modifies an assembly
that is managed with occurrence effectivity.

1. The engineer specifies replacement parts P21, P22, and P23 for parts P11 and P12 with a unit range
of 10-up.

The system adds the occurrences P21, P22, and P23 effective unit 10-up The effectivity of P11 and
P12 is cut back to the portion of the range not set on the replacements, namely units 1-9.

2. The engineer indicates parts P31,P32, and P33 are specified as replacements to P21, P22, and P23
for a range starting at unit 5.

The system determines from the chain of effectivity and replacements that P21, P22, and P23 are
replacements.

The full range of effectivity is overlapped, so P21, P22, and P23 are no longer in effect. The span of
replacement is complete, so the parts previously replaced are considered and P11 and P12 are cut
back accordingly to 1-4.

3. The engineer specifies P42 as a replacement for P32 for a range within the span of effectivity of
P32.

P42 is effective for the range specified (units 20-30) and the replaced occurrence split to 5-19, and
31-up.

4. The engineer adjusts the effectivity range of P42 to units 22-32.
The effectivity of P42 is updated to the new range.

5. Avreviewer or the engineer validates the effectivity chain of P42.
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The system evaluates the effectivity of P42 against the parts it replaced or is replaced by. It

identifies:

* Agap

Unit 20,21 does not include replaced (P32) or replacing (P42) parts.

* Anoverlap

Units 31 and 32 include both replaced (P32) and replacing (P42) parts.

6. The engineer replaces a part where only a portion of the historical replacement chain is changing.

While a cutback of P33 by replacing part P43 is unambiguous, there is not an unambiguous action
to take on P11 and P12 because P33 is only a subset of the historical chain:

(P11,P12):(P21, P22, P23):(P31, P32, P33)

After replacing an occurrence and performing a cutback of the replaced part, the effectivity range of a
part can be adjusted. If the new range overlaps with the effectivity of any parts in the historical chain of

effectivity, the system issues a warning.

The following table shows how effectivity cutback occurs in this scenario.

Part Part Part Part Part Part
Task P11 P12 P21 P22 P31 P32

1 Initial
state

Step

1-up 1-up

2 Replace 1-9 1-9
P11 &
P12
with
P21,
P22,P23
at unit
10

10-up  10-up

3 Replace 1-4 1-4
P21,
P22,
P23
with
P31,
P32,

Part Part Part
P33 P42 P43
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Part Part Part Part Part Part Part Part Part
Step Task P11 P12 P21 P22 P31 P32 P33 P42 P43

P33 at
unit 5

4 Replace 1-4 1-4 5-up 5-up 5-up 20-30
P32
with
P42 for
units
20-30

5 Adjust Warning 22-32
effectivi
ty of
P42 to
units
22-32

6 Replace Error Error 8-up 3-7
P33
with
P43 for
units 3-
7

When a link in a chain of occurrence effectivities is completely overlapped (that is, a complete cutback

is made of its entire range) it is logically removed from the structure. The system informs the user there
is no effectivity for that occurrence. A logically removed occurrence can be removed from the structure
and removed from historical chains of effectivity used for evaluation of future cutback operations. In this
situation, the change history is the only way to know the part ever existed in the structure.

Editing occurrence effectivity

To edit occurrence effectivity data, your Teamcenter user name must be included in the appropriate
effectivity user group and role that the administrator defines.
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Associate existing effectivity to an occurrence

Note:

Use this approach only when you want the effectivity to be the same for all occurrences sharing
this effectivity object. If you edit the effectivity object's date or unit number ranges, Teamcenter
applies this change to all occurrences that reference it.

4.

Select the line in the structure representing the occurrence with which you want to associate
effectivity.

Choose Tools—>Effectivity>Occurrence Effectivity->View, Create and Edit.
Teamcenter opens the Occurrence Effectivity dialog box.
In the Effectivity ID box, type the identifier of the effectivity object you want to associate with

the occurrence, and press the Enter key. Alternatively, you can search for the effectivity object by
clicking Search ®§ adjacent to the Effectivity ID box.

Teamcenter populates the date or unit number table with the ranges from the effectivity object.

Click OK and Teamcenter associates the effectivity with the occurrence.

Create effectivity on multiple occurrences

Create and associate the same effectivity with several occurrences by selecting the appropriate line
in the structure and choosing Tools-Effectivity>Occurrence Effectivity->Create on Multiple BOM
Lines. The effectivity may be:

Shared

Shared effectivity must have an ID. If you are creating shared effectivity, ensure the Use shared
effectivity check box is selected.

Unshared

Unshared effectivity has no ID. If you are creating unshared effectivity, ensure the Use shared
effectivity check box is cleared.

Modify the effectivity of an occurrence

Note:

Any changes you make affect all occurrences sharing the same effectivity object.

5-40




Modify the effectivity of an occurrence _

Select the line in the structure representing the occurrence whose effectivity you want to modify.
Choose Tools—>Effectivity>Occurrence Effectivity->View, Create and Edit.
Teamcenter opens the Occurrence Effectivity dialog box.

In the Occurrence Effectivity dialog box, choose Units or Dates effectivity, as appropriate, and
define the effectivity range.

* If defining unit effectivity, type the desired effectivity range in the Units box. Use the - character
within a continuous range, and the , character to separate discontinuous ranges. For example,
the unit range 1-5,7-9 defines effectivity for units 1 through 5, and 7 through 9 (but not effective
for unit 6).

* If defining date effectivity, select a cell in the From or To column, select a date from the calendar
(and optionally type a time), and click Set Date to place that date in the selected cell. Click
the Clear Date button to remove the date from the currently selected cell. Repeat this step for
additional cells until you have entered all the desired date ranges.

* Click the UP button to add the and up (open-ended effectivity) condition to the end of the unit
or date effectivity range. If you are defining date effectivity,

* Click the SO button to add the stock out condition to the end of the unit or date effectivity
range.

Note:

Teamcenter interprets UP and SO conditions as open-ended for revision configuration
purposes. The revision is considered effective for any value greater than or equal to the
unit or date value immediately preceding the UP or SO. Stock out indicates that existing
stocks of a component revision should be used up before the next revision.

* Check the Apply Access Manager effectivity protection check box to apply the predefined
access rules to this effectivity.

» (Optional) For date effectivity, use the End Item dialog box to define an end item to qualify
the effectivity range. You must use this with unit effectivity to specify a product, module, or
subsystem that carries the unit number to which this effectivity refers. You can select an end
item in one of the following ways:

* Clicking Open by Name % adjacent to the End Item box and searching for an item by
identifier and/or name.

* Copying an item to the clipboard before opening the Occurrence Effectivity dialog box and
clicking Paste T adjacent to the End Item box.
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* Clicking MRU 4= adjacent to the End Item box.

Note:

If you want to remove the entered end item, click Clear -+ adjacent to the End Item box.

4. Click OK to save the occurrence effectivity data you entered.
Remove effectivity from an occurrence
1. Select the line in the structure representing the occurrence whose effectivity you want to remove.
2. Choose Tools=Effectivity=>Occurrence Effectivity->View, Create and Edit.
Teamcenter displays the Occurrence Effectivity dialog box.
3. Click Remove to clear all boxes, including the identifier.

4. Click OK and Teamcenter removes the effectivity object from the selected occurrence. Any other
occurrences sharing this effectivity retain their references to the effectivity object.

Copying occurrences with effectivity

When you save a BOM view revision with a different name (perform a Save As action), Teamcenter
copies any occurrences that reference an effectivity object to the new BOM view revision. Thus, the
same effectivity ranges apply to the copied structure.

When you copy, cut or paste, Teamcenter does not reproduce any references to effectivity objects in the
copy occurrences.

Setting the date for occurrence effectivity

Teamcenter configures the occurrence effectivity by the date defined in the current revision rule.
Teamcenter uses an explicit date entry, if the current rule contains one. If the rule has no date entry,

the effective date defaults to today, but you can manually set a different date using the Tools—=Revision
Rule-Set Date/Unit/End Item menu command.

You can choose to show only the configured occurrences, or all occurrences. You can toggle this setting
by choosing View->Show Unconfigured by Occurrence Effectivity. If you display the EOC - Effective
Occ. Config'd column in the structure properties, occurrences that are configured show a Y. If the
occurrences are not configured, the column is blank.

Occurrences are configured if:

* The effectivity range encompasses the date specified by the current revision rule.
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* They have no effectivity object. Such occurrences are always configured, regardless of date.
Combining occurrence effectivity and variant configuration

Variant and occurrence date effectivity are occurrence-based configuration methods that operate
independently. The View menu includes separate commands to show or hide occurrences that are
unconfigured by the two methods. In some cases, you may want to view a specific variant of the product
at a particular effective date. In this case, you hide occurrences that are unconfigured by both date and
variants. Similarly, you may want to view a generic product at a particular date, in which case, you
would hide occurrences unconfigured by date only. To show how a single variant changes with effective
date, you can hide unconfigured variants only.

Configuring occurrences with multi-unit configuration
About multi-unit configuration

Teamcenter allows you to configure product structure occurrences of an assembly based on specified
multiple end items and the unit effectivity ranges for each of those end items. You can do impact
analysis and eliminate the duplicate work required to maintain different product structures and
complicated manual reconciliation.

A combination of multiple end items and range of units for each end item used to configure product
structure occurrences is referred to as a multi-unit configuration.

The administrator at your site enables this feature. It allows you to:
* Specify multi-unit configurations and save them as effectivity groups.

* Save a combination of effectivity groups and revision rule as a configurator context. You can use the
saved configurator context to apply the effectivity groups and revision rule to configure occurrences.

* View the configured structure in Lifecycle Visualization, CAD tools, and the embedded viewers of
appropriate rich client applications.

» Configure occurrences by matching the occurrence effectivity with the multi-unit configuration.

» Configure occurrences that are added and deleted by incremental changes by matching the
incremental change effectivity with the multi-unit configuration.

Note:

Teamcenter displays the Revision Rule Entry value for an incremental change (IC) configured
by a multi-unit configuration as Effectivity Group. Therefore, ignore the status of this check box
in the IC Information pane.
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When an occurrence has occurrence effectivity and it is removed in the context of an IC,

the occurrence is not configured if the multi-unit configuration matches the effectivity of the
removing IC. This occurs whether the occurrence effectivity matches partially or completely with
the multi-unit configuration.

Multi-unit configuration does not support nested effectivity and effectivity mapping.

Create a new effectivity group
1. In My Teamcenter, choose File-*New-Item.
Teamcenter displays the New Item dialog box.

2. Select Effectivity Group, enter the necessary name, description, and identifier, and then click
Finish.

Teamcenter creates the base revision of the new effectivity group. (Effectivity groups cannot be
revised, and you are unable to create further revisions of the new group.)

Capture a multi-unit configuration and save it to an effectivity group

1. In My Teamcenter, right-click an effectivity group revision and choose View/Edit Multi-Unit
Configuration.

Teamcenter displays the View/Edit Multi Unit Configuration dialog box with the View/Edit Multi
Unit Configuration pane visible.

Note:

The Most Recently Used option is not available in this dialog box. Also, the Open By Name
box is not available on the Effectivity Groups pane in this dialog box.

Caution:

This is a modeless dialog box. It allows you to copy items from other locations, such as your
Favorites folder, and paste them into the dialog box. However, it also allows you to perform
other actions, such as Revise and Close commands in My Teamcenter with the dialog box
open.

If you open this dialog box using View/Edit in the Set Date/Unit/End Item dialog box
(Effectivity Groups tab), the dialog box is modal and does not allow you to paste between
applications.

2.  Enter the necessary end item and unit range information, and then click Add, Edit, Remove, or
Undo to update the effectivity group, as follows:
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* To add an end item unit range, enter the end item ID and the effective unit range and click the
Add button. You can also search or browse for an end item to populate the End Item box. You
can also copy the end item from your Favorites folder in My Teamcenter and paste it here. You
can specify a combination of units or unit ranges in comma-separated format.

* To remove an end item unit range, select it in the table and click Remove.

* To edit an end item unit range, select it in the table and the system populates the End Item
ID and Unit Range boxes from the selected entry. After you make the required changes, click
Modify.

* To revert the last change made in the dialog box, click Undo.

Note:

Undo allows you to go back one level to the previous state in the dialog box. Thereafter,
any subsequent clicks on the Undo button cause the dialog box to toggle between its
current state and previous state.

Note:

You can view and edit effectivity groups with certain limitations. Use the View/Edit button in the
Effectivity Groups pane of the Set Date/Unit/End Item dialog box to add or modify the end items
by manually typing the necessary data. You cannot search for or copy and paste end items here.

Set an effectivity group to configure occurrences

You set an effectivity group or groups to configure the product structure occurrences in addition to the
revision rule.

1. Load the assembly to configure and choose Tools-»Revision Rule->Set Date/Unit/End Item.
Teamcenter displays the Set Date/Unit/End Item dialog box.

2. Enter the effectivity group identifier in the Effectivity Group box, and then click Replace, Insert, or
Append to update the list of groups.

Note:

To remove an effectivity group from the list, select it and click Remove.

3. (Optional) To view the multi-unit configuration on an effectivity group, select it and click View/Edit.
The system displays the View/Edit Multi Unit Configuration dialog box, as described previously. If
you have the necessary access privileges, you can also modify the configuration.

When you apply the configuration, the system matches the occurrence effectivities configured for
each occurrence with the multi-unit configuration set in the effectivity groups. Any occurrence whose
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occurrence effectivity is valid for any of the end item and unit range entries in the effectivity groups
is displayed. An occurrence is loaded only once even if its effectivity matches more than one end item
entry in the effectivity groups set in the session.

Caution:

You can configure product structures with incremental changes using effectivity groups. However,
only limited support is provided to configure occurrences with incremental changes using multi-
unit configuration and the following limitations apply.

You can configure only the addition and deletion of occurrences using effectivity groups. Other
edits in the context of incremental change cannot be configured.

An add occurrence edit is effective if the multi-unit configuration partially overlaps the
effectivity of the incremental change.

A remove occurrence edit is effective if the multi-unit configuration completely overlaps or is
within the limits of the effectivity of the incremental change. That is, a partial overlap is not
sufficient to configure the remove edit. If there are multiple remove incremental changes,
Teamcenter compares each of them with the multi-unit configuration separately. (It does

not calculate the total remove effectivity and compare a single value with the multi-unit
configuration.)

Teamcenter evaluates the configuration of an occurrence based on an incremental change
independently of its occurrence effectivity.

If Teamcenter finds competing incremental changes (one adding the occurrence and the other
removing it) and both can be configured with effectivity groups, it gives precedence to the add
occurrence edit.

The following examples show how occurrence effectivity and incremental change interact.

Occurrence Effectivity on Multi-unit
Structur effectivity removing IC1 configuration
e (explicit or and removing set on BOM
line Type implied) IC2 window Result
number
1 Componen Endltem(1-20) IC1(-) = Enditem1(1-9) Occurrence not
t Enditem1(1-9) configured.
IC2(-) =»
Endltem(10-20)
2 Componen Enditem(1-20) IC1(-) = Endltem1(1-20) Occurrence
t Endltem1(1-9) configured as
IC2(-) =» Teamcenter
Endltem(10-20) checks occurrence

effectivity, multi-
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Occurrence Effectivity on Multi-unit
Structur effectivity removing IC1 configuration
e (explicit or and removing set on BOM
line Type implied) IC2 window Result

number

unit configuration,
and each
incremental
change
individually.

Customizing occurrence effectivity

You can customize Teamcenter behavior when the user applies or sets occurrence effectivity on a BOM
line.

To allow customization of the behavior when setting effectivity on an occurrence, the bl_occ_effectivity
BOM line property is modifiable, and a setter method is provided on this property. Use the setter method
of the property to attach an extension point if required.

Managing incremental changes

Managing incremental changes

Incremental change management is the process of controlling changes and providing an audit history
of a part's definition and configuration. An incremental change collects together a number of structure
changes to a component such as addition or removal of components or changes to attachments (data).
Effectivity can be applied to incremental changes to configure the associated changes. This method of
change control allows several independent structure changes to be made concurrently, including the
addition or removal of unrelated components. Those changes can be implemented in any sequence.

The following actions constitute a reason for creating a change in manufacturing:

* Adding and removing existing processes and operations from parent processes.

Replacing a process or operation with another process or operation.

* Adding, removing, or replacing relationships between a top-level process and a target product,
process, and plant with other product and plant objects.

* Adding, removing, or replacing items from the setup structure at the operation level. This includes
consumed items, work areas, and resources.

* Adding, removing, or replacing objects that are attached to a process or an operation such as
datasets, forms, and other items.
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* Adding, removing, or replacing objects in an activity folder with other objects such as other activities,
tools, and programs.

A single change can add or remove multiple objects from an item or item revision. A single object can
be added to an item or item revision with different effectivities by several changes and removed with
different effectivities by several other change objects.

You can also create a baseline item revision by configuring all the incremental changes.

Note:

* Precedence relations between operations in a manufacturing process are not supported within
Part Planner.

* You can create incremental change (IC) information about occurrence groups and their content
(children). However, configuring the view to show or hide configured changes does not work for
this information. Only incremental change information that is common with the base view (in
the item structure) is filtered.

Show or hide incremental change management

Using incremental change management is optional. To use it, your administrator must set the
Incremental_Change_Management preference to true. When this preference is set to false, the
incremental change toolbar is not visible and any loaded items or relationships under incremental
change control display in a different color.

You can specify whether incremental change is applied per structure or per application using the
MEIncrementalChangeMode preference. If set to structure, incremental change is relevant only for the
selected structure and for the secondary views connected to the selected structure. In this mode, each
structure can use its own incremental change.

Turn off incremental change tracking
* Click the f‘? button in the toolbar.

Teamcenter removes the header information from the view and stops tracking edits.

Customize buttons

Incremental changes are displayed by icons at the beginning of a structure line. When you add or
remove a structure line, Teamcenter displays a plus or minus icon in front of the respective line.

* Customize when incremental change icons are displayed by choosing Tools=Incremental
Change-»Display Icons and selecting the contexts in which you want to see the icons.
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* Choose Tools=>Incremental Change-Display Icons->Hide/Remove Icons to always hide the display
of the icons in the tree structure.

Setting up incremental change

Before using incremental change, you must complete several setup procedures, including creating the
necessary change types, providing users with access, defining releases statuses, and writing revisions
rules.

Create a new incremental change
1.  Click the Create Incremental Change button ﬁ

Teamcenter displays the Create/Revise Incremental Change dialog box.
2. Click the IC Attributes tab and set the following incremental change attributes:

* Type an ID and revision for the change object. Alternately, click Assign to let the system assign
this information for you.

* (Optional) Type a description for the incremental change.

* Select a change type from the Incremental Change Type list. Note that some of these types
may be for general changes, not incremental changes.

3. Click the Effectivity tab and specify whether to set effectivity for the incremental change using unit
serial numbers or dates by doing one of the following:

Note:

You cannot specify an effectivity until the incremental change is released. An incremental
change may be released by a workflow process that is specific for your company or site.

If you do not specify an effectivity, Teamcenter creates the change object without a status.

The administrator determines the initial release status of all new incremental changes by setting a
site preference. If the preference is not set, you cannot set effectivity while creating the incremental
change. You must release the incremental change (revision) separately with the appropriate
process. Once the release status is attached, you can set the effectivity on the incremental change.

* Click Units and specify the range of serial numbers to which the effectivity is to be applied. You
can also click one of the following buttons:
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* UP button to define an unlimited effectivity from a starting number. For example, typing 1-UP
means the change is effective from unit 1 upward.

* SO button to define an effectivity until all stock is exhausted. For example, typing 1-SO means
the change is effective from unit 1 until no stock remains.

Tip:

The tooltip provides you with more information about the formatting for this entry.

» Click Dates to set effectivity based on calendar dates. Multiple date ranges can be entered. To set
a date:

* Type the start and end dates for the effectivity period into the From Date and To Date cells in
the date table.

* Select a date in the calendar table and click Set Date to specify both the From Date and the
To Date entries.

When the correct effectivity is shown, click OK.

If unit effectivity is set, populate the End Item box on the Effectivity tab using one of the following
methods:

* From the list of most recently used end items
* Using the Search function to open an item by name or ID
* By pasting an item from the clipboard

Click OK to finish creating a new incremental change and close the dialog box, or click Cancel to
cancel the operation.

Teamcenter creates a copy of the new incremental change in your New Stuff folder.

At an appropriate time, the designated user or a workflow process approves the change object by
adding the release status. The change object is now locked and you cannot use it to track further
changes to the process or operation.

Note:

You can use a Workflow handler that renames the status and retains the effectivity, for
example, the add_status handler with a -remove option.
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Showing unconfigured changes

You can configure the display of the tree table to show the following:

* All components and attachments.

* Only those components and attachments that are configured by the current revision rule.
To control the display of unconfigured changes:

* Choose Show Unconfigured Changes from the view menu to toggle between showing all lines or
only those set by the current revision rule.

To identify changes made in the current context, click the Changed by Current IC Edit Context column
header to re-sort the structure into changed and unchanged lines. This allows you to more easily identify
the changes made to the structure in the current context.

Find and make active an existing change object

When an incremental change is active, all edits are made in the context of that incremental change.
Teamcenter shows the ID and name of the active incremental change in the structure view header.

"% 000370-Assemble_housing X

$%, CMO005/4:1-2011-01-15
Process Structure
000370/48:1-Assemble_housing

Itermn Mame Clccun

Azzemble_housing

-3 000376/A;1-LR02384 (View) LRO2384
73 000377/A;1-LR3995a (View) LR3995a
-7 000378/A;1-W004493 (View) W004493
.58 000379/4;1-JD58674 (View) JD58674

You can also view the active incremental change in the Configuration Information dialog box by
clicking %/,

1.  Click the Select an Incremental Change context button ﬁ

Teamcenter displays the Select an Incremental Change context dialog box.

2. Type either the name or ID of the change object to be displayed. You can use wildcard search
characters, if necessary.

3. Click Find.
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All change objects matching your selection criteria are displayed in the dialog box. Use the
navigation buttons at the bottom of the dialog box to navigate the list.

4. Toselect an incremental change object for display, double-click the change object in the dialog box
list.

View or edit information about an incremental change

Do one of the following:

* (Click the Viewl/edit current IC information button 2.

* Click More IC Info in the Incremental Change data tab.

Teamcenter displays the View/edit Change dialog box, which includes the following tabs:
* IC Attributes shows the change object name, description, and tag type.

* Incremental Changes shows the individual changes to activities, components, attachments, created/
deleted data, and predecessors that are tracked against this incremental change.

Note:

A replacement is shown as an override.

* Effectivity allows you to view and edit the effectivity of the change object if you have the access
permission to do so. Double-click a specific release status to open a dialog box containing all the
effectivity information for the selected release status.

* Intents displays the intents for which the incremental change is valid.

You can create a new intent by clicking the Intent button and typing the appropriate information in
the Create Intent dialog box. You can then add the intent to the incremental change by ensuring it
appears in the Intent to add box and clicking +. You can also search for existing intents and add them
to the incremental change.

Note:

To make the Intents tab visible, set the Enablelntents preference to true.

You can also use the icons on a structure line to identify adds, removes, and absolute occurrences. For
attachments, these icons are displayed in the Attachments view, not the structure view.
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View incremental changes for a structure

To view all the incremental changes associated with a structure, select a line in the structure and choose
Open with=>Incremental Change. For each line, this view lists:

* Type

For attachments only, specifies the type of incremental change, create, delete, add, or remove. Note
that edits to attachments are shown as create types.

* IC Context

Specifies the incremental change objects affecting the structure, listed in the order they are applied.
* Release Status

Specifies the release status of the incremental change object, for example, Production.
 Effectivity

Specifies the date or unit number effectivity of the incremental change.
* IC Configured By

Specifies the revision rule that configures the incremental change for this structure. This allows you to
see if an incremental change is configured and, if so, how it is configured.

For attachment changes, the affected lines and changed relationships are also listed. For occurrence
attribute changes, the affected attributes and changed values are also listed.

To see more information about an incremental change, double-click the line in this pane; Teamcenter
displays the changes made by the incremental change.

Find recently used change objects

Click the Most Recently Used button (%) to display a list of previously used incremental changes from
which you can choose.

Track attachments with incremental changes

You can create an attachment to an item revision and track its status with an incremental change object,
as follows:

1. Ensure you have created the appropriate incremental change object and that it is active. The active
incremental change is shown in the structure view header.
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2. Select the structure line corresponding to the item revision under which you want to create the
attachment.

3. Choose Open with=Attachments.
4. Select the root node (item revision) in the Attachments pane.
5. Create a new attachment by choosing File=*New-»Dataset/Form.

Alternatively, you can attach an existing object by copying the dataset or form to the clipboard,
then pasting it to the root node (item revision) in the Attachments view.

Track changes to an attachment

To track changes (edits) made to an attachment, select the attachment (dataset or form) and choose
Tools=Incremental Change->Edit Attachment.

Teamcenter also tracks edits if you double-click the dataset or form. With a dataset, the change is
tracked when you open the form to edit; with a form, the change is tracked only when you click OK or
Apply. Teamcenter tracks the changes by creating a copy of the dataset or form.

The Attachments pane displays the appropriate version of the attachment according to the configured
incremental change against which the edits were tracked.

Note:
You can view the original, unchanged attachment in My Teamcenter.

If you open an attachment, check it out, and then close it, the checkout lock is not retained. The
checkout is retained only if you save the attachment at least once before closing it.

Track the creation or deletion of an attachment

You can track the creation of a dataset or form against an incremental change, so that the attachment
itself has an effectivity that is derived from the effectivity of the incremental change; this is in addition to
the effectivity applied by the incremental change that attaches the attachment to an item revision. This
feature may be useful if the attachment is attached to more than one item revision.

* To track the creation of an attachment, select the attachment in the Attachments pane and choose
Tools=2>Incremental Change—Create on Object.

* To track the deletion of an attachment, select the attachment in the Attachments pane and choose
Tools=Incremental Change-»Delete on Object.
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Track changes retrospectively

If you forgot to activate an incremental change, you can retrospectively track changes by making the
incremental change active and doing one of the following:

» Select the item or attachment that you wanted to track as added and choose Tools=Incremental
Change—->Add.

* Select the item or attachment that you wanted to track as removed and choose Tools=>Incremental
Change->Remove.

Teamcenter saves edits immediately to the database. It is not necessary to choose the Save Changes
command.

You can only make changes to the active incremental change, that is, the one shown in the structure
view header. If you try to edit an incremental change that is not configured by the current revision rule,
Teamcenter displays an error message.

Remove incremental changes

You can remove individual incremental changes one of two ways, from the Incremental Change view
or with an Incremental Change menu command.

Note:

You require write access to edit structures with incremental changes in this way.

For structure and attachment changes:
* If the corresponding change is a remove, Teamcenter deletes it.

* If the corresponding change is an add and the user has write access to the parent BVR, Teamcenter
deletes the add but not the occurrence. If you want to remove the occurrence, choose Edit-*Remove.
If the user does not have write access, the deletion request fails.

For occurrence attribute changes, if the change to undo is an add and it is the only change to the
attribute, the change and the override value are both deleted. In other cases, only the change is deleted.

Remove an individual change from the incremental change information pane

1. Inthe Incremental Change view, select the structure line of the occurrence or attachment whose
changes you want to remove.

2. Select the change to undo and click Undo Change, depending on the change type that you want to
remove. You can undo multiple changes in a single operation.
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Remove changes from an item with the Remove Changes command
1. Toremove changes to an occurrence, select the corresponding structure line.

To remove changes to a dataset or form, select it in the Attachments view.
2. Choose Tools=Incremental Change->Remove Changes.

Teamcenter displays the Remove Incremental Changes dialog box.

3. Select the check box next to each change you want to remove, or click Select All to remove all
changes, then click OK.

Note:

Occurrence attributes are not displayed in the Remove Incremental Changes dialog box; you can
only undo them from the Incremental Change Information pane.

Split an incremental change

You may want to change the effectivity of some of the incremental change elements in an incremental
change. As all elements of an incremental change have the same effectivity, you can only accomplish
this by moving some of the incremental change elements into a different incremental change. To do
this, choose Tools=Incremental Change->Split. You can move the incremental changes to an existing
change object or create a new change object for the purpose.

Working with incremental change baselines

Create an incremental change baseline item revision

Changes to a process plan can be managed by making incremental changes, which are tied to
incremental change objects. This enables you to track and configure the changes without forcing you
to create a new revision. After making several sets of incremental changes, you may want to roll up
the changes made into a new baseline revision. The baseline item revision allows you to create a new
revision of an item by capturing all the changes made using incremental change objects until the
configuration date or unit number. The baseline item revision can be created at any stage.

1. Select an item revision and choose Tools=Incremental Change—Incremental Change Baseline.
Teamcenter displays the Baseline dialog box.

2.  Type a name and a description. Teamcenter displays the selected item revision and revision ID by
default. These boxes cannot be edited.

3. Click OK.
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Baselining structures with active incremental changes

Optionally, when you create an incremental change of an item revision, any incremental changes that
are active are carried forward or rolled up. An active change is any incremental change that has an out
effectivity equal to or greater than the baseline effectivity, including any open-ended effectivity.

When you carry forward a change, the affected object of the change is copied to the new item revision.
The copy of the affected object is qualified to the same incremental change. Consequently, the old and
new copies of the affected object share the same change effectivity.

When you roll up a change, only the affected object of the change is copied forward. The qualification is
not present on the new item revision.

Determining active changes

Teamcenter drops, rolls up, or carries forward changes to the new item revision, depending on the
following conditions. (X indicates the baseline, which may be a unit number or date.)

Drop, roll up, or carry
Lower end Higher end forward? Explanation

<X <X Drop The change was effective in the past
with respect to the baseline and will
not be effective in the future. The
change is dropped.

<=X >=X Carry forward The change is effective and remains
effective to a certain pointin
the future. Beyond that point, the
change is not configured and is
therefore carried forward.

<=X up Carry forward if Pending The change is effective and remains
status or roll up if Secured effective in the future. It can be
status. rolled up into the next revision.

However, if the incremental change
is not released, it can be edited

and such edits may be reverted.
Therefore, if the status is Pending,
changes are carried forward.

>X >X,UP Carry forward The change is effective in the
future, so is carried forward.
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Note:

Teamcenter supports discontinuous effectivity, with multiple out effectivities. If any of the
effectivities is equal to or greater than the baseline effectivity, the change is considered active.

When you create the baseline, changes that are past effective are dropped, irrespective of status. For
example, if you create a baseline at unit 25, there may be changes on an incremental change with
effectivity on units 5 to 15. All these changes are dropped because they are past effective. If you
subsequently change the effectivity of this incremental change to span or cross baseline unit 25, you
must recreate the baseline to take the effectivity change into account.

Teamcenter determines if an effectivity is applicable in the current context. An item revision under
incremental change may have several status objects attached to it, and the objects may be different
types. A revision rule may have several entries configured by effectivity, and the entries may specify
different status and effectivity types. To determine if an effectivity statement on an incremental change
revision applies to the revision rule, Teamcenter checks that the combination of status type and
effectivity type (date or unit) match an entry in the revision rule.

Carrying forward or rolling up active changes

Teamcenter carries forward active changes if:

* The change is currently active and the qualifying incremental change is not released, or
* The change will be configured in the future.

It copies the affected object to the new item revision. It also connects the new copy of the affected
object by an incremental change element (ICE) to the same incremental change as the original affected
object.

Teamcenter rolls up active changes if the change is currently active and the qualifying incremental
change is released. It copies only the affected object to the new item revision.

ICEs link affected objects to revisions of incremental changes. As an incremental change evolves, the
affected object may be qualified by several ICEs to multiple revisions of the same incremental change.

If you do not assign explicit out effectivities, but supersede them with later in points (for example,

A: 1-UP, B: 10-UP, C: 20-UP), multiple revisions of the same incremental change may be considered
active. If the baseline effectivity is equal to or more than 20, the latest in rule determines that Cis

the currently configured revision. However, as you may subsequently change any effectivity, Teamcenter
carries forward the affected object with ICE qualification to all of these active incremental change
revisions.

Dropping inactive changes

If Teamcenter determines that a change is not active, it is dropped from the new item revision. If
the affected object is added by the incremental change, because the relevant change is no longer

5-58



Modify a process or plant structure _

active, Teamcenter omits the affected object from the new item revision. If the object is removed by
the incremental change, the removal is reversed and the affected object is copied forward without the
incremental change qualification.

Modify a process or plant structure

If a process structure or plant structure is write-protected, you can still modify its structure with
incremental changes. You can also add datasets or forms to an item revision or remove them from
a revision by defining an incremental change.

Exporting and importing incremental change data

About exporting and importing incremental change data

You can export changes (deltas) to the structure if they are tracked by incremental changes in two
formats—TC XML using a briefcase file or PLM XML. Teamcenter allows you to export the structure
changes alone (not the entire structure) without needing to create a new revision. The exported
changes contain all the relevant data required by the importing site to achieve the same structure
configuration as exists at the exporting site. You can export multiple independent, dependent, or
overlapping incremental changes in a single action.

When you use this feature, you must ensure the structure is configured with the required effectivity
and revision rules before initiating the export. Effectivity and revision rules are not exported with the
changes; you must ensure they are identical in the exporting and importing sites separately.

Teamcenter tracks and exports the following changes when they are tracked by incremental changes:

* Adding a new or existing line to the structure

Adding a new or existing subassembly to the structure

* Removing a line or subassembly from the structure

Modifying relative occurrence properties

* Creating or modifying absolute occurrence properties

Adding a new or existing attachment to a line, for example, a form or dataset

Deleting an attachment
* Modifying an attachment
When exporting incremental change data using PLM XML:

* The structure must be fully configured.
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* Any related changes that are not tracked by an incremental change are not considered for export.

* Changes in the context of incremental changes are considered as export candidates. For example, if
you add, modify or remove a structure line in the context of an incremental change, all of its parents
up to the top level are exported in addition to the affected line. However, the siblings of lines affected
by the incremental changes are not exported.

* If you add, modify, or remove a subassembly under an incremental change, its children exported even
though they are not directly affected under the incremental change.

You can create an incremental baseline for a structure that was already exported. This action creates

a new revision of the structure. As active changes are carried forward into the new incremental
change baseline revision, you may add new incremental change elements (ICEs) affecting the new
structure revision to the incremental change revision that is the parent of the original active ICEs. (This
incremental change revision may already be exported for the original structure.) Because the new ICEs
do not affect the revision of the structure that was exported when you perform a TC XML export, they
are exported as a stub. The incremental baseline action has no additional effect on the export of the
original structure and the incremental change revisions that affect it.

Export incremental change data using a briefcase file

1. Choose Tools—>Export—>To Briefcase.
Teamcenter displays the Export To Briefcase Via Global Services dialog box.

2. Click the Display/Set export options button @, in the bottom right-hand corner of the dialog box.
Teamcenter displays the TIE Export Configured Export Default dialog box.

3. Select the check box corresponding to each of the export options you want to use and then click
OK.

Teamcenter closes the TIE Export Configured Export Default dialog box.

4. Inthe Export To Briefcase Via Global Services dialog box, enter all the required information
including Reason, Target Sites, Option Set, Briefcase Package Name, Revision Rule, and Variant
Rule, and then click OK.

Note:

Ensure you select the TIEConfiguredExportDefault transfer option set to export incremental
change based deltas.

Teamcenter displays the Remote Export Options Setting confirmation dialog box.

5. Click Yes.
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Teamcenter starts the export of the product structure using the options you entered.
Import incremental change data using a briefcase file
1. Choose Tools=>Import—->From Briefcase.

Teamcenter displays the Import from Briefcase Without Global Services dialog box.

2. Navigate to or type the path and file name of the briefcase file in the Briefcase File box. Select
TIEConfiguredimportDefault from the Option Set list.

3. Click the Display/Set export options button @, and select the desired options.

4. (Optional) Select the Site Check-In after import box. If you select this box, all objects that are
checked out to the unmanaged site are checked in during the import process. Otherwise, you must
check them in individually after they are imported.

5.  Click Yes to begin the import.

Note:

The importing site does not verify it has the same base structure against which the delta was
calculated.

If you select a collaboration context for export of incremental change deltas, the export file
includes the structure context and configurator contexts contained in it, as well as the configured
incremental change data.

Export incremental change data using PLM XML
1. Choose Tools—>Export—>To PLMXML.
Teamcenter displays the PLMXML Export dialog box.

2. Enter the required export directory, file name, choose the appropriate IC delta transfer mode (for
example, ConfiguredDataExportDefault), and then click OK.

Teamcenter displays a confirmation message if the export is successfully completed. It generates
the output PLM XML file in directory the location shown in the PLMXML Export dialog box.

Import incremental change data using PLM XML
1. Choose Tools=>Import—->From PLMXML.

Teamcenter displays the PLMXML Import dialog box.
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Enter the name of the PLM XML file to import, choose the appropriate IC delta transfer mode (for
example, ConfiguredDatalmportDefault), select the required incremental change context, and
then click OK.

Teamcenter displays a confirmation message if the import is successfully completed. It imports only
changes to the structure, as captured in the exported PLM XML file.

Working with incremental changes and predecessors

About incremental changes and predecessors

A predecessor represents a sequential relationship between two processes, operations, or activities;

the predecessor must complete before the second process, operation, or activity. You can use this
relationship to track changes to the sequence of operations in a process or to activities in an operation.
For example, you can use it to define a flow of operations or processes to be effective from a certain date
or unit number. If you use a change object to add a predecessor, the change effectivity is attached to the
predecessor and the predecessor becomes effective as of that change.

The following figure shows how Manufacturing Process Management displays the predecessors of a
process or operation. If a + sign appears on the symbol, the predecessor was added with an incremental
change; if a — sign appears on the symbol, the predecessor was removed with an incremental change.
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Scope: MP3000f4; 1-MP Engine Assm Process (Yiew)

175 MP3000/A;1-MP Engine Assm Process (Yiew)
-9 MPE004{A; 1-Housing Assm (¥iew)
-8 MP3007/A; 1-Fuel Pump Assm (View)

0
-7 MPS009/; 1-Pulley Assm (View) 30
T MP3016{A;1-Oi Irket Assm (View) 50 r
-2 MP3017JA; 1-Inkake and Exhaust Assm (iew) &0 0 ™. Mp3008/A
+ ’11 MP3001/A;1-Cylinder Head assm (View) 70 Process b = Timing Assm
* 58 MP30013/A;1-Fusl Ral Assm (View) 80 ]
7 MP3018/A;1-PCM and O Fiker Assm {View) 80 e
+ 55 MP3020/A;1-Engine Mount Assm (View) & = )
& TR MP3014/4;1-Wacuum Assm (View) 340 73 MP3007/A
- Ty 4 0 Fuel Pump Assm
R %
E
h 4
73 MP3017/A
Intake and Exhaust
Assm

k4
3 MP3001/A
Cylinder Head assm

Incremental changes on predecessors
Add an incremental change on a predecessor

1. Open the PERT view.
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2. Create a new flow between (sequence) between the related processes or operations.
Remove an incremental change from a sequence

If you remove or delete a predecessor, it remains displayed in the PERT view but is marked for deletion
when the relevant change becomes effective.

To remove an incremental change from a sequence, do the following:

1. Open the PERT view on a process.

2. Select the sequence line and click Delete from the PERT toolbar.

Roll back incremental changes on the sequence

1. Open the PERT view on the process.

2. Select the target node of the sequence on which you want to remove incremental changes.
3. Choose Tools-?Incremental Change->Remove Changes.

Teamcenter displays the Remove Incremental Changes dialog box.

 Remove Incremental Changes @

EH MP3017/4;1-Intake and Exhaust Assm (View)

Select Changes to Remove

[] <= Remove with CNOOD7/A;1-IC1 on Predecessor MP3016-Oil Inlet Assm |
™ o o] ]
[[] ™. Add with CNO0O07/A;1-IC1 on Predecessor MP3007-Fuel Pump Assm Select None

[ oK ] [ Cancel J

4. Select the desired change and click OK.

Teamcenter removes the selected changes.
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Managing absolute occurrences (in-context editing)

Managing absolute occurrences (in-context editing)

An absolute occurrence is a specific instance of a component or assembly in a structure. It may be
independent of the top-level assembly and only meaningful in the context of a lower level assembly.
For example, you may have four occurrences of a wheel in the design of a vehicle; you can label one of
those occurrences as left rear wheel, which is an absolute occurrence of the wheel. When you open a
window containing the structure, each absolute occurrence is represented by a single line.

To create an absolute occurrence, you edit the occurrence line in context with respect to the assembly
in which the absolute occurrence data is meaningful. Hence, the creation of absolute occurrences is
sometimes referred to as editing in context.

Note:

Absolute occurrences are not the same as appearances. Absolute occurrences are generated when
you build the structure (edit in context) and do not have associated spatial information.

A component or subassembly that appears in more than one product structure can have the same
absolute occurrence in each structure.

You cannot create absolute occurrences directly, only by converting a relative occurrence and editing
its properties. Similarly, you cannot delete absolute occurrences directly. You cannot create absolute

occurrences on substitutes.

An absolute occurrence may appear more than once in the structure, depending on the context in which
you created it.

Interpreting absolute occurrence data

The following figure shows how absolute occurrences appear in the structure when in context editing is
enabled.
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Absolute occurrences in a structure

Note the following lines in this structure:

Line Purpose

20487187/C (view) The immediate parent that is in context for absolute
occurrence edits.

The line is also color-coded in the structure and in the title
bar of the pane where the current context is shown. The
color is green in this example but may be changed by your
administrator.

Lines that are not in the current context are grayed out.
Similarly, the out-of-context parts corresponding to the
grayed out lines may also be grayed-out in the viewer. You
cannot create absolute occurrences from grayed-out lines in

Part Planner, Teamcenter 2412 5-65
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Line

20367635_101/B (view)

20367635_201/A

20367635_3/A

Purpose

the current context and you cannot edit an existing property
value on such lines.

Lines below 20487187I/C (view) are generally not grayed
out and are in context.

This is a standard occurrence note. It is in context and may
be edited.

This occurrence note is not in context because it is not in all
occurrences of the immediate parent assembly.

The overriding note value in the context of 20487187 only
for this specific occurrence of the parent.

To obtain more information about edited absolute
occurrence data, place the cursor over any cell containing
the '—.-__1 icon. The tool tip banner shows the context in
which the edited data is valid.

By default, the assembly viewer highlights only those items in the assembly that are in scope in the
selected context; items that are not in context are shown grayed out. The administrator may optionally
change this behavior so that all items are shown.

The structure contains icons that indicate the status of the structure lines as follows:

Icon

Indicates

A line containing this icon is the context for the creation of certain
absolute occurrences. The line is also color-coded in the structure and in
the title bar of the pane where the current context is shown.

A line that contains this icon has one or more of the absolute
occurrences edited in a context but not necessarily the current context.

A property cell containing this icon is already edited in a context; the
current absolute occurrence data is shown in the cell. Each cell that
contains data for a specific absolute occurrence includes this icon.

A line that contains this icon before its name is a target for editing data
in the current context. Look fora (& icon in one or more properties
cells of the same line to identify if the necessary edits are already made.

Note:

This icon identifies a target in the current context. It may not
appear in the same line if you select a different context.
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Icon Indicates

’@ A line that contains this icon has an in-context edit made by an
incremental change. The edit may be an add, remove, or both.

t@_ A cell that contains this icon has an in-context edit removed by an
incremental change.

%]: A cell that contains this icon has an in-context edit added by an
incremental change.

tff A cell that contains this icon has in-context edits added and removed by
= an incremental change.

Showing and hiding the in-context line
You can show or hide the line that is the context of a particular in-context edit.
To show the line:

1. Click in a property cell, then click outside the same property cell. Ensure you do not select another
property cell.

Note:

Right-clicking when editing the value in a cell has no effect.

2. Hover the cursor over the same property cell, right-click, and then choose Show/Hide In-Context
BOM Line from the menu.

Structure Manager shows the in-context line highlighted in yellow and the editable property cells
are highlighted similarly.

To hide the line, click outside the property cell you edited, right-click, and then choose Show/Hide
In-Context BOM Line from the menu.

Structure Manager hides the previously highlighted in-context line.

Create absolute occurrences

To create an absolute occurrence, you must enable in-context editing mode and edit the properties of an
occurrence, as follows:

1. If necessary, expand the structure by choosing View->Expand Options-»Expand Below or
choosing Expand Below from the shortcut menu.
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2.

4.

Right-click the top line that is the context of this edit and choose Set In-Context from the shortcut
menu.

If a line in the displayed structure is marked with a '—.-__4 icon and colored green, it is the item that is
the context for the creation of absolute occurrences. if a line is grayed out, it is not in the selected

context and you cannot create absolute occurrences for these lines. The in-context item is also
identified in the title bar of the structure tree.

* You cannot enable in-context editing mode for a line that has no children.
* You cannot create an absolute occurrence in the context of its immediate parent.
* You cannot change the value of a property that is already overridden at a higher level.

Click the cell in the lower line containing the property you want to enter or edit. You must select
one of the following supported properties:

* Suppressed

* Position constrained

* Suppression constrained

* Any GRM relation impacted by preferences
* Any occurrence note

* Quantity

* Find number

e Occurrence type

* Variant conditions

* Variant formula

* Absolute transformation matrix
* Unit of measure

* Is designed in place

* Requires positioned design

Caution:

Ensure you have selected in-context editing mode. If this mode is not selected, the change is
made to every instance of the selected item anywhere in the assembly.

Type the required new value and press the Enter key. A %5 icon on the line indicates one of its
property cells has an absolute occurrence override.

Note:

If you create an absolute occurrence override of a property and the same property is already
overridden at a lower level in the structure, the new, higher level value replaces the existing value.
Conversely, you cannot edit an individual property value if the same property is overridden at a
higher level in the structure.
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Identify absolute occurrences

You can assign identifiers to absolute occurrences and these identifiers are displayed in two columns in
the property table, as follows:

* ID In Context (Top Level)

Shows only the identifier assigned to the line in the context of the loaded top-level line. You can add
or edit an identifier by double-clicking in this cell and typing the necessary value.

Note:

Any absolute occurrence identifiers defined at a lower level than the currently selected top-level
line are not visible.

If in-context editing mode is disabled, the top-level line is always considered the in-context line.

* ID In Context (All Levels)

Shows the identifiers assigned to the line in all contexts. You cannot edit this column.

Change absolute occurrence override data

You can change the override data for an existing absolute occurrence at any time. For example, you may
want to change the quantity assigned to a structure line to correct a previous error. It is not necessary

to enable context editing to make such changes, ensure only the correct context is selected, then
double-click the property cell and edit the value.

Note:

If you want to define relative occurrence data for a property that is already defined in context,
remove the absolute occurrence data from the property first.

Remove absolute occurrence override data

You can remove override data from an absolute occurrence without entering replacement data. To do
this, right-click the property to remove (that is, select the relevant cell) and choose the Remove In
Context Override command.

Deselect in-context editing mode

When you are not creating or editing absolute occurrence data, consider deselecting in-context editing
mode to avoid inadvertent changes.

* Right-click the green context line and choose Set in Context.
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Associate data with absolute occurrences
About associating data with absolute occurrences

During the design process, an engineer may attach data such as a CAD design file, viewer (JT) file,
classification information, and specifications to an item revision. The actual usage of the item revision in
the structure, including its transformation, is tied to an occurrence.

You can attach data to a specific instance of an item revision in the structure, which is represented by an
absolute occurrence. You can attach data that is unique to the absolute occurrence, or information that
is already attached to the associated item revision or occurrence. Examples of data that you may want to
attach to a specific absolute occurrence include:

* Cost data

* Transformations

* Quantity

* Variant conditions (not modular variant expressions)
* Viewer information

* Nameand ID

* Occurrence note, type, or find number
* Instance number

* Find number

* Occurrence position constrained

* Occurrence suppressed

For example, you may want to attach a different occurrence note to each absolute occurrence to specify
additional assembly work instructions.

The level of the absolute occurrence in the structure determines the precedence of data you attach to
it. Data attached at a high or mid-level in the structure override the corresponding data at lower levels;
data attached to an absolute occurrence at the lowest level does not override data elsewhere.

Associate a dataset or form with an absolute occurrence

1. Ensure you have selected in-context editing mode by right-clicking the structure line and choosing
Set In Context.
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2. Select the line containing the absolute occurrence with which you want to associate a new
instance-specific dataset or form and open it in the Attachments view.

3. If you are associating a new dataset or form, create it by choosing File->New->Dataset or
File->New—-Form, respectively.

If you are replacing an existing dataset or form, select it in the Attachments view. You can then
search for and insert a replacement dataset or form.

Associate a transformation with an absolute occurrence

Note:

You cannot associate a transformation (positioning information) with an absolute occurrence in
Teamcenter manufacturing process management; you can only make the initial association in
Structure Manager.

1. Ensure you have selected in-context editing mode by right-clicking the structure line and choosing
Set In Context.

2. Select the line containing the absolute occurrence for which you want to change the
transformation.

3. Select the Graphics view and choose Graphics=Transformation-Persistent Transformation.
4. Change the position of the affected component and save the changes.
Associate an occurrence note with an absolute occurrence

1. Ensure you have selected in-context editing mode by right-clicking the structure line and choosing
Set In Context.

2. Select the line containing the absolute occurrence with which you want to associate an occurrence
note.

3. Choose Edit>Notes, or click the Notes button on the toolbar.
Teamcenter displays the Notes dialog box.

4. Type the properties of the note and click OK.

Apply a variant condition to an absolute occurrence

1. Ensure you have selected in-context editing mode by right-clicking the structure line and choosing
Set In Context.
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2. Select the line containing the absolute occurrence with which you want to associate a variant
condition.

3. Choose Edit=»Variant Condition.
Teamcenter displays the Variant Condition dialog box.

4. Add a new variant condition to the absolute occurrence or edit the existing variant condition.
View attachments associated with an absolute occurrence

To view all the attachments associated with an absolute occurrence, select the line containing the
absolute occurrence and open the Attachments view. All the attachments to the absolute occurrence
are shown below the absolute occurrence.

Note:

If incremental change orders are used at your site, attachments associated with unconfigured
changes may be hidden. To view all absolute occurrence data, choose Show Unconfigured
Changes from the view menu or click % in the view toolbar.

Associating occurrence data in the context of a composition

A composition is a structure that comprises components from different top lines, in the context of a
configured top-level assembly. It is represented by a single line in the structure. It can contain a set

of occurrences, absolute occurrences, occurrence group and filtered occurrences (a filtered occurrence
references occurrence groups from the item it instantiates). For example, a composition may contain the
design view and the process view of the same assembly.

When you view a composition, the revision rule and variant conditions for the referenced window
configure the occurrences, if they are linked to a referring window by a corresponding absolute
occurrence for the relevant top level. The occurrence groups are configured according to the
configuration of absolute occurrences in the top level.

You can associate data to any of the absolute occurrences in the occurrence group, in the context of
the composition. You can subsequently view the data associated with absolute occurrences included in
occurrence groups in the structure.

If the content (members) of an occurrence group in the composition is changed in another location,
your view of the occurrence group is refreshed. Such changes may be made in the source or in another
instance of the group that is referenced in a composition.

You can change an occurrence group in the composition (for example, adding or removing members)
without having to return to the source view. Any changes you make to the composition are proliferated
to all other instances of the occurrence group.
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Add components in a context

You can add components to a structure in the context of the top level. These components are then
visible when you select the top line of the structure. The following examples show how resources may
be attached to a structure:

Welding_Cell 1
Robot from
Classification
Standard Definition
Welding Gun 1->Added in context of cell 1
Welding_Cell 2 Robot from
Classification
Standard Definition
Welding Gun 1->Added in context of cell 2
Factory 1
Welding Cell 1
Robot
Support Column 1->Added in context of Factory1
Welding Cell 2

When you open factory 1, you see welding gun 1 in the context of cell 1 and support column 1 in the
context of factory 1. If you view the same robot in My Teamcenter, none of these components are visible
as they are not part of a standard robot.

To do this, you can create an absolute occurrence in the context of a top-level item. Add welding gun 1
in the context of cell 1 by adding an absolute occurrence to cell 1 under the robot.

Note:

When you create an absolute occurrence for a top-level item, you also create absolute occurrences
for all children of a parent under which you add the component.
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Data precedence

About data precedence

You can associate data with an item revision or absolute occurrence. You can create the absolute
occurrence in the context of a top-level item.

The following figure shows how visualization (JT) files may be attached to items.

ltemRev1/A 6 JT file - filel jt

Topltem 1/A
S1

S11
|temﬂev1—happr|ﬂgp|[em146 JT file - file2.jt

Attaching visualization files to items
In this example, you can see file1.jt in the viewer in My Teamcenter without any context. However,
when you view the same item revision (ItemRev1) in the context of Topltem1, you see the JT file

(file2.jt) that is associated with the corresponding absolute occurrence (appr1) in the context of item
Topltem1/A.

You can associate a different JT file as an override if Topltem1 is revised from revision A to revision B.

Data is associated with an absolute occurrence in the context of a specified revision. When you revise an
item, the data associated with the previous revision is copied and you can change it as necessary.

Propagate override data

You can associate data to absolute occurrences in the context of an intermediate level, as well as in the
context of the top level, as shown in the following figure.
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ltemRev1/A o[ ITHile -flet j

Topltem 1/A
S1/A

S11/A
temRev1 Appr=at w.rt topltem1——@ JT file - file2.jt

Appr=b1 w.rt S11 [T JTile - file3 t

ltemBRev2 Appr=a2 w.r.t topltem1
Appr=b2 w.rt S11

ltemRev3 Appr=a3 w.r.t topltem1
Appr=b3 w.rt S11

Propagate override data

In this example, IltemRev1 has two override JT files, file2.jt and file3.jt. The file2.jt file is added in the
context of Topltem1/A, while the file3.jt file is added in the context of S11/A. Consequently, if you view
ItemRev1 in the context of Topltem1/A, you see the file2.jt file.

Override data in the context of a composition

You can associate data to a composition in the context of an operation or process setup. The following
figure shows how you may override data in the context of a setup.

Absolute occurrences
for Product1

Process Producti al
Operation1 (Setup) 51 a2
Resourcel S11 a3
Consumedltem-C1 _ _ _ _ _ _ _ _ __ _ ____ Cl. o ____ ad
Consumedltem-C2 _ _ _ _ _ _ _ _ _______ C2. _______ a5
occGroupd C5 ab
/{f
Abs occ. for C5 in Productl CcB a7

Abs occ. for C6 in Producti

Override occurrence data in the context of a composition
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This structure contains occurrences (Resource 1, and consumed items C1 and C2) and a collection of
absolute occurrences (occGroup1). This collection consists of absolute occurrences a6 and a7 which
Teamcenter configures if you load Product 1. Thus, a6 and a7 in the process structure are absolute
occurrences in the context of occGroup1. The consumed item C1 is an occurrence in the setup for
Operation 1 and is linked to absolute occurrence a4 in Product 1.

Note:

The process structure may also have its own absolute occurrences.

You can override data in the context of the process. You can also override data in the context of Product
1 through the absolute occurrences in the occurrence groups. The override data is controlled by a rule
that allows you to attach JT files at a top level and at an intermediate level. Consequently, a JT file
attached to ¢5 under Occurrence Group 1 in the context of the Operation 1 BOM view revision (BVR)
overrides the default file, and also the file associated with a6 in the product 1 BVR.

If you create absolute occurrences for the process structure and (assuming P6 is the occurrence for C5),
the data attached to P6 in the context of Process overrides data attached to a6 in the context of the
Product 1 BVR.

Override data in multiple contexts

You can create absolute occurrence data on a single line in more than one context. For example, you
may want to override the find number in the context of the top-level assembly and the quantity in the
context of a lower level assembly. Make these in-context edits in turn, ensuring you have selected the
correct context (line) each time. The system shows the relevant absolute occurrence data for the current
context and consequently data that applies to other contexts is hidden.

Note:

You cannot change the value of a property that is already overridden in a higher level context.

Understanding ID in context and assigned products

When assigning a product to a process or copying processes or operations from one process structure
to another, Teamcenter can assign the same ID in context (IDIC) to the structure lines in the source
and target structure. Doing so provides a method for Teamcenter to find the assigned objects in the
other structure, for instance, when using the Find in All Visible Views menu command or running an
accountability check.

This mechanism is controlled by two preferences:
* MECopyldinContextToAssignedLine

If set to True, Teamcenter copies any existing in-context IDs to the target structure when assigning a
product to a process or copying a process or operation from one structure to another. If an in-context
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ID does not exist, Teamcenter creates one on the source and copies it to the target object. Any
generated IDs are unique within the source and target structures.

If set to False, no in-context ID is copied.
* MECopyldinContextLowerLevels

If set to True, Teamcenter copies any existing in-context IDs of consumed items under subprocesses
and suboperations to the target structure when copying a process or operation from one structure to
another. If an in-context ID does not exist, Teamcenter does not create one.

If set to False, no in-context ID gets copied for the consumed items under subprocesses and
suboperations, even if one is present.

Note:

The MECopyldinContextLowerLevels preference is considered only if
MECopyldinContextToAssignedLine is set to True.

In the following example, if you copy process P1.1 from Proc1 in the upper pane to Proc4 in the lower
pane:

* Teamcenter only generates an in-context ID for the process that is being copied. It never generates an
in-context ID for subprocesses, suboperations, or their consumed items, regardless of the settings for
these preferences.

* |If MECopyldinContextToAssignedLine = false and MECopyldinContextLowerLevels = false,
Teamcenter does not copy any in-context ID.

Note:

For P1.1, the ID is not generated at the source if it is not present (in the following example, it is
already generated).
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After copying, under the Proc4 process, note that there are no in-context IDs in the ID In Context
(Top Level) column.

* |f MECopyldInContextToAssignedLine = true and MECopyldinContextLowerLevels = false, the
in-context ID for P1.1 and 11.1 only are copied. The existing in-context ID for 11.2 is not copied
because 11.2 is the consumed item of a lower level.

Note:

For P1.1, the in-context ID is generated at the source if it is not present and then copied. For
11.1, the ID is not generated if it is not present.
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ST DO0S30/A;1-P1.2 (View)
S (% 00053808 1-Proc2) | SO (Y 000S39/A1-Prec3) | T4
;'!.}", Lakask Working %, Nok Specifisd ¥ Nok Spacifisd
BOM Line | 1D In Context (Top Level) |
OO00S4018; 1 -Procd {visw)
L=l u'ﬂ 00052908 1=-F1,1 (Miew) KIBEMhOhAABaaA

Sm 000532 8; 1-P1.1.1 (View)
= O, 0005338 1-P1. 1.2 (View)
A S, 000536/4;1-11.2
P S, OO0S35/8;1-11.1 LISKEMhOhaAEaas

* If MECopyldinContextToAssignedLine = true and MECopyldinContextLowerLevels = true, the IDs
for P1.1,11.1, and 11.2 are all copied.
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Note:

For P1.1 the ID is generated at the source i

if it is not present and then copied. For I11.1 and 11.2,

if the ID is not present, it is not generated, but if it is present, it is copied.

oo (* 000S28/A;1-Proct) |

5 (ODOS34/4;1-Prodi)

B Lirss

T, Latest Worling "% Mok Specified 7Y Mok Specified

| 1D 1n Context (Top Level) |

",q 000S28/A;1 Proci Visw)

of 0321'&,1 P1.1. ltvlaw}
=8 D00S33/A;1-P1.1.2 (View)

EIEtMhOhAAESSA

Bpmm Ay 000S3IG/A;1-I1.2 kdGEMhOhAAE a8,
Emw S, ODOS3SIA;1-11.1 USKEEMhOhAABaas
5 OO0S30/6: 1-P1.2 (Wiew)
g (* 000S36E/0; 1-Procs) | B9 (* 000539/A;1-Proc3) - N
E*e‘\ Latest Working %L Mok Specified L Mot Specified
| BOM Line | 1D In Context (Top Level) |
m OO0S38108; 1 -Frocg (Vi)
| =508 000S23fa; 1-P1.1 (View) kIEEMhORAAEaSA
| o9 000532fA; 1-P1.1,1 (Yiew)
=5 OOOSIIFA; 1-P1.1.2 (Miew)
Bpm S, 000536/8;1-11.2 kdGEMhOhAAE a6
Hamw S, 000535785 1-11.1 USEEMhOhAABaas

Part Planner, Teamcenter 2412
© 2025 Siemens
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6. Managing process structure data

Running accountability checks

Running accountability checks

You can compare two structures to ensure all lines in the source structure are accounted for in the
target structure. For example, you can compare the EBOM structure to the MBOM structure to ensure all
parts and assemblies are assigned or compare the product structure and the process structure to ensure
that all occurrences of product components and features are used in the process structure as consumed
items. You can compare the entire assembly or only a subassembly to the process structure. These types
of comparison are performed using an accountability check.

Any differences found during the comparison are reported, as they may indicate problems in
manufacturing the product to its specification. However, an imbalance between the structures may
not necessarily indicate a problem with the structure itself.

An accountability check or comparison:
1.  Traverses the source structure.

2. Foreach line in the source, finds one or more matching lines in the target structure, according to
defined equivalence criteria.

3. For each pair of equivalent lines, identifies if there is a full match or a partial match. A partial match
exists if one or more aspects of the structures that you compare are not equal.

4. Colors each line in the structures and, if you have the correct license, opens the Accountability
Check Result view displaying the full matches, partial matches, and unmatched lines.

The following differences are reported:

* Lines in the source structure that do not have counterparts in the target
* Lines in the source that have more than one counterpart in the target

* Lines in the target that do not have counterparts in the source

* Lines in the source whose counterparts in the target have some significant difference, for example, a
different quantity

The analysis is done on the structures as they are configured in the rich client. You can run the analysis
with any combination of configuration options on both structures.

6-1



_ 6. Managing process structure data

When setting up the accountability check feature, a power user generally creates favorites—a collection
of typical options and settings for different situations. An administrator can publish these favorites for
different groups or roles so that regular users can then select one of them to quickly run the comparison.

Understanding line equivalence

When comparing product and process, the standard accountability check comparison is based on the
assignments between the structures. When comparing two process structures, Teamcenter additionally
uses the in-context ID and any common assignments to the same product to determine equivalence.
Because the accountability check is based on the assign action, it does not compare by item ID and does
not recognize if a line is copied from another structure or from the Newstuff folder.

Run an advanced accountability check

As an advanced user, you can set a variety of options before you run an advanced accountability check.
If you save these options as favorites, you can repeat the advanced accountability check using the same
options.

Note:

To run an advanced accountability check, you must have two linked source and target structures
to compare. These are typically a source engineering bill of materials (EBOM) generated from

a design BOM that is exported from a CAD application such as NX or CATIA, and a target
manufacturing BOM (MBOM) created for specific manufacturing needs from the EBOM. When

the EBOM is updated, the MBOM must be compared and updated as well. This is the purpose of
an advanced accountability check: the two structures must be examined to ensure that they share
equivalent BOM lines.

1.  Select the source objects in the source pane.
2. Select the target objects in the target pane.

3. Select source and target objects in structure views and open the Advanced Accountability Check
dialog box by choosing Tools—>Accountability Check->Advanced Accountability Check. Use one
of the following methods:

* Select a source line, open the dialog box, and then select a target line and click Set/add current
selection =t beside the Selected target objects box.

» Select the source and target lines in the structure views, and then open the Advanced
Accountability Check dialog box.
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5.

Run an advanced accountability check _

Tip:

As long as only the source and target views are open, autodetects and adds the correct
source and target lines to the Source objects and Target objects boxes.

Note:

dialog box.

You must select at least one line before you can open the Advanced Accountability Check

e

@ Advanced Accountability Check

Scope] Inclusion Rules| Reporting | Equivalence| Partial Match

Source objects: 001537/4;1-CAR EBOM (View)

001537/A:1-CAR EBOM (View)

Target objects: 001538/A;1-CAR MBOM (View)

l & Switch Source Target

001538/4;1-CAR MBOM (View)

Available Settings

(Optional) Change the source or target object at any time by selecting the desired line in the
structure and clicking the respective Set/add current selection button i=*. You can add multiple
scope lines from the same structure or remove a scope line by selecting it and clicking —.

-

@ Advanced Accountability Check

Scopel Inclusicn Ru|e5| Reporting| Equivalencel Partial Match

Source objects: 001537/4;1-CAR EBOM (View)

001537/4;1-CAR EBOM (View)

Target objects: 001538/4;1-CAR MBOM (View)

001538/4;1-CAR MBOM (View)

Available Settings

Ensure that you correctly selected the source and target objects. If not, switch the source and target
by clicking the Switch Source Target button.

6-3



_ 6. Managing process structure data

6. Click the Inclusion Rules tab, and do one of the following:

* Select Search currently expanded source lines to run the accountability check on the selected
lines and all visible lines below the selected lines. Additionally, you can choose to run the
accountability check on all the lowest visible (expanded) lines under the selected scope line by
selecting Compare lowest visible level of source.

* a. Select Search lines per filtering rule to expand the source and target structures and only
consider a subset of the lines during the accountability check.

b. Select the Source filtering rule. For a description of the filtering rules, move your mouse
over the list. The rules along with their short descriptions are displayed.

You can specify to which level in a structure you want the check to consider by selecting Limit
search in source/target to first x levels and typing a value for x.

Note:

For information about filtering rules, see Managing filter rules in the Tc XML and PLM XML
Configuration for Data Import and Export.

Note:

When you set these options, the values take effect in all applications that support
accountability checks.

7. (Optional) If you know the source and target scope lines to be different because these lines are
source and target specific, select the Do not compare selected lines check box [7].

In the advanced accountability check results, the selected scope lines do not appear as missing in
target and missing in source.

8. Click the Reporting tab and set the result reporting options.

9. Click the Equivalence tab and set the equivalence options.

10. Click the Partial Match tab and specify the partial match criteria.
11. Click OK to run the accountability check.

Teamcenter displays the Accountability Check view.
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Note:

The number of lines returned in the accountability check is limited by the value of the
MEAccountabilityCheckAllowableReturnedLines preference. If the number of lines to
return exceeds the preference value, a message will be displayed notifying you that there

are more lines to be returned, and that an Accountability Check Excel report has been created
and stored, thus saving the work.

12. After running the accountability check, examine the results and make any necessary modifications
to the structure.

13. Rerun the check using the same settings by clicking |2 in the Accountability Check view.

Note:
* Rerunning an accountability check does not recreate an accountability check report or a
result reported in an occurrence group.

* Forinformation about narrowing the scope of the accountability check, see the PLMXML
Export Import Administration Guide.

Types of structures you can compare

Using an accountability check, you can compare the following pairs of source and target structures:

EBOM and MBOM to see which of the EBOM parts are aligned to the MBOM

Product and product

Process and product to see if all parts are consumed

* Process and process

Process and plant

The following is an overview of the types of structures you can compare.

Set the result reporting options

The accountability check displays its results by highlighting the checked objects in the structure pane in
a variety of colors that you can change, if desired. To help users who cannot differentiate colors well, a
tool tip shows the name of the color. If the name is not available, the tooltip displays the RGB value.

1. Open the accountability check dialog box.
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2.

3.

4.

Click the Reporting tab.
Select one of the following:
* Reportin occurrence groups

Teamcenter can store and display the result of the accountability check in an additional tab in
the structure pane grouped by anomaly. This result is only computed for the source item and is
stored in the database as a structure of UsageCompareResultView objects related to the item of
the source revision. You can specify the name for the result of the check. By default, it is named
Compare Result.

o £1000411-Accountability Check test Source
[z 000411
{2 00041 1-View
£ 000411/ 1-Accountability Check test Saurce
L, Compare Result
L Second Result

* Report the selected check criteria

Teamcenter offers you two methods to visualize the results of the accountability check. You can
select one or both of the following:

* Select Color the compared objects to color the line and the matching lines according to the
match results and color scheme that you set in the Reporting section.

» Select Printable report to capture the results of the accountability check in an Excel
spreadsheet.

Check the display options you require:

Option Description

Full Match If the object (occurrence) in the source structure has one
and only one equivalent in the target structure, both
objects are set to the same background color. If you
also selected the Partial Match option, a full match also
means that all partial match criteria of the equivalent
objects match, for example, properties or relations, if you
use enterprise BOP structures. The default color is green.

Partial Match For equivalent objects (occurrences), if one or more
partial match criteria are not identical, both objects are
set to the same background color. The default color is
yellow.
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Option Description

Multiple Match If objects have more than a single equivalent in either
structure and all properties of the source objects are
identical to the properties of target objects, all objects
are set to the same background color. The default color is
orange.

Only available when you do not use net effectivity.

Multiple Partial Match If objects have more than a single equivalent in either
structure and in addition, one or more properties are
not identical, all objects are set to the same background
color. The default color is pink.

Only available when you do not use net effectivity.
Effectivity mismatch Only available when you use net effectivity.

For equivalent objects (occurrences), if the net
effectivities differ, both objects are set to the same
background color. The default color is orange.

Partial & effectivity mismatch Only available when you use net effectivity.

For equivalent objects (occurrences), if one or more
properties are not identical and the net effectivities differ,
both objects are set to the same background color. The
default color is pink.

Missing Target If occurrences of the source structure are not found in
the target, the source objects are set to this color. The
default color is red.

Missing Source If occurrences of the target structure are not found in the
source structure, the target objects are set to this color.
The default color is light blue.

5. (Optional) Change the default color by clicking =+« next to the color.

6. Set the colors by choosing a color swatch, and setting HSB (hue, saturation, brilliance) or RGB (red,
green, blue) values.

Set the equivalence options
1. Open the accountability check dialog box.
2. Click the Equivalence tab.

3. Select the comparison options you require:
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Option Description

Equivalent If you use enterprise BOP structures, the accountability check takes process
Logical logical designators into consideration as an additional comparison criteria
Designator when checking the process, operation, or partition lines for equivalence.

This check box is available only when both structures are enterprise BOP

structures.
Equivalent If you use publish links, the accountability check highlights occurrences that
PublishLink are mapped using publish links. If a part occurrence is set to not require
Connection positioned design, it is also taken into consideration.

Note:

When checking accountability between structures, the direction of tracelinks is not
considered.

Specify partial match criteria

You can specify which data to compare between equivalent lines. You can choose to compare a specific
set of properties or, if you are comparing enterprise BOP structures, you can additionally compare any
relation type of these lines to other lines. For example, you can compare assignment or predecessor
relations.

1. Click the Partial Match tab.
2. On the Properties tab, select Consider values of properties when searching for a partial match.

3. Choose the properties that you want included in the accountability check by selecting them in the
Available Properties list and clicking -+ to move them to the Selected Properties list.

The accountability check matches lines in the source and target that have the same properties as
those you select in the Selected Properties list. Your administrator determines which properties
are available for selection in the AdditionalAccountabilityCheckProperties preference. Any
differences in the selected properties are identified as differences between the structures.

The values of the DefaultAccountabilityCheckProperties preference are ignored.
About the Accountability Check view

When you run the accountability check, Teamcenter displays the results in the Accountability Check
view. This view lists the problematic lines in the source and target and provides a list of conflict details.
Lines that are colored in the source and target structures are also colored in the view. Fully matched
lines are not listed by default.
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Note:

Displaying fully matched lines in large structures can clutter the view

Lines in the Accountability Check view behave in the same fashion as lines in the source and target
structures. If you remove a line in the view, Teamcenter removes the line from the source or target. You
can copy lines from the view into the clipboard, drag them to another structure, or send them to another
application.

When you select or target line that is marked as having net effectivity or being a partial match,
Teamcenter displays the conflicts in a third pane at the bottom of the view.

When you select a line in the source section of the Accountability Check view, you can click the
Equivalent Lines tab in the target section of the view to find the lines in the target structure that match
the selected source line, and vice versa. These lines are then selected in the visible structure views.

When you work through the accountability check results, resolving conflicts, the accountability check
results are not updated—the lines remain highlighted in the original check colors. To update the lines,
you must rerun the accountability check. You can do this using the same settings by clicking & in the
Accountability Check view.

Note:

The Accountability Check view is not displayed when one or both of the structures being
compared is an intermediate data capture.

Display the partial compare results
After running an accountability check, you can view the partial compare results. Do one of the following:
* Select a partial match line in either the Source or Target section of the Accountability Check view.

Teamcenter displays the partial compare results in the Partial Match section at the bottom of the
view.

* Right-click a partial match line in the structure pane and choose Partial Compare Results, or choose
Tools=Accountability Check-Partial Compare Results.

Teamcenter displays the Partial Compare Results dialog box.
View settings used to run the accountability check

You can display a read-only listing of the settings in force when you ran the accountability check report.

e Click A,
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Teamcenter opens the Accountability Check Settings dialog box displaying the scope and
configuration in effect at the time the check was made. This is not necessarily the same as the
currently active configuration.

Filter accountability check results

When you run the accountability check, you can select check criteria in the Accountability Check dialog
box. After running the report, you may find that the Accountability Check view shows too many results
and the display is cluttered. You can filter out some of the check criteria in the view to make it more
readable without having to rerun the accountability check.

1.  Click Filter.
2.  Clear the categories that you want to hide in the view and click OK.

Teamcenter displays only those categories that are selected in the Filter dialog box. The filter button is
turned on when you remove the check mark from any categories to indicate that filtering is applied.

Using the Accountability Check view options

The Accountability Check view provides a multitude of options that are common to many views.
Do any of the following:

* Find individual objects in the view.

* Customize the column display.

Clear display

You can reset all background colors on objects in the active window and their corresponding objects in
the process window to the default colors.

* Choose Tools->Accountability Check->Clear Accountability Check Display.

Note:

The command works only if either the source view or the target view is the active window.

Filtering and expanding source and target structures

You can narrow the scope of the accountability check by limiting it to only the lines pertinent to your use
case.
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The filter mechanism is based on closure rules that traverse the structures and take only those objects
specified in the closure rules into consideration. The closure rules that are used in the accountability
check are referred to as inclusion rules and are not available to use for importing and exporting.

By default, Teamcenter presents you with a set of inclusion rules. Your administrator can modify these
inclusion rules or create new ones to suit your business needs.

Note:

When running the accountability check based on inclusion rules, there is no need to expand or
unpack any of the structures. This improves the performance of the check.

When running the accountability check without inclusion rules, you must first expand and unpack
the compared lines in the source structure.

Expanding a structure based on closure rules also plays a role in which objects are taken into
consideration in the accountability check. If you expand using an appropriate closure rule, you may
not have to set an inclusion rule when running an accountability check.

Inclusion rules

Inclusion rule
AccountabilityAll
AccountabilityLeavesOnly

AccountabilityLinkedAssm
OrLeaves

AccountabilityProcess
Consumption

AccountabilityProcess
Assignments

AccountabilityProcessAll
NoAssign

AccountabilityProcessAll

Description
Includes all lines.
Includes only leaf nodes; excludes all hierarchy nodes.

Includes assigned assembly nodes but excludes their
children. If an assembly is not assigned, includes its leaf
nodes.

Includes assigned nodes under a process or operation that
are of occurrence type MEConsumed. Excludes all process
and operation nodes.

Includes assigned nodes (including work areas, parts,
and tools) under processes and operations. Excludes all
processes and operations nodes. If the assigned-from
structure is not loaded, those nodes are also excluded.

Include process and operation nodes.

Include process and operation nodes and all of their
assigned nodes. If the assigned structure is not loaded, their
nodes are excluded.
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Inclusion rule Description

AccountabilityProcessOnly Includes processes, operations, and process areas only.
WithPA

ACPlantBOPDerivedProcesses Includes only operations and processes that are linked to the
AndOps source (for example, in a product BOP). This rule is used

when comparing a product BOP to a plant BOP and skips
plant-specific operations.

Note:

None of the inclusion rules include occurrence group nodes, but they can include the children
under those nodes.

Specifying levels for comparison

If you use inclusion rules, you can limit the number of levels that the accountability check considers for
comparison. In the following figure, processes C1 (ID = 034730) and C2 (ID = 034731) are selected as
the source in an accountability check. To specify a level, run an advanced accountability check.

B Lires
% ExcutionRule_depth_test/a; 1 (vew)
SR 034730 /A 1o 1 (view)
= ¥ 0I4TILA; 111 (wew)
= o 034737 /A 1-C111 (view)
% 034747/A; 11111
& 034748 8; <1112
- o 034738/ 1112 (view)
% 0347458 1c1121
% 034750/8; 11122
= W 0347344 1012 (view)
& 034739/A; 1121
A 034730/8; 1122
R34 73 1/A; 12 (wew]
= 4 DIATIEA; 121 [view)
& 034745/4; 1211
& 034796/4; 1212
= 0347364122 (wiew)
A 34743 1201
o 0347448, 10222

If you specify a level of 1, the accountability check considers the following items for comparison:
c11,c12
c21, c22

If you specify a level of 2, the accountability check considers the following items:

c11,c12, c21, c22
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c111,c112, c121, c122, c211, c212, c221, c222

Expanding structures to check

Whether or not you need to expand a target structure before running an accountability check depends
on the settings of the following two preferences:

MECopyldinContextToAssignedLine

MECopyldinContextLowerLevels

Note:

If there are packed lines in the source window, the accountability check may report incorrect
results for the quantity of an absolute occurrence of a component that is packed to a sibling. To
avoid this situation, always unpack all lines before starting an accountability check.

Expanding a structure based on closure rules also plays a role in which objects are taken into
consideration in the accountability check. If you expand using a closure rule, it may have the same
effect as setting an inclusion rule.

Understanding net effectivity

You can use net effectivity during the accountability check if the following is true:

* Defining unit effectivity on an occurrence is enabled.

* The ability to configure structures to show multiple units on multiple end items at once is configured.
* The net effectivity compare extension is registered.

When these points are fulfilled, you can compare the effectivity of matching source/target objects.
However, the effectivity that you define on each object is not necessarily the actual effectivity. The actual
effectivity is the intersection of all effectivities set on the path from the root node to the selected object.
This intersection is referred to as net effectivity. In addition, when you compare two structures, the net
effectivity includes the intersection of the effectivities of these two structures.

Create a printable Excel report

Teamcenter can create a printable Excel report containing the results of an accountability check. If you
have write access to the target structure, Teamcenter stores the Excel file as a dataset on the top-level
item revision of the target structure. If you do not have write access, Teamcenter stores the Excel file in
the Newstuff folder.

1. Open the Accountability Check dialog box.
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2.

Select all necessary options to create the accountability report.

Click the Reporting tab and select Report the selected check criteria.
Select Printable report.

Assign a name for the new dataset.

If a dataset of this name and type already exists in the item revision, Teamcenter opens a dialog
box where you can change the name or replace the dataset with the new one. You can change this
behavior in the TC_CRF_overwrite_existing_dataset_content preference. If this preference is set
to 1 (true), Teamcenter does not remove the dataset but replaces the content.

Click OK.

Teamcenter creates a report containing:

* General information such as the date and time of the check and the user ID and name.
* Compare options.

* Context data such as the source top level item, the target top level item, incremental change,
and revision and variant rules.

* Accountability check results such as the source name, target name, match status, and all
the checked properties. Multiple matched objects and missing source objects are displayed in
separate sections.

Teamcenter adds the Excel file to a dataset attached to the target structure.

Note:

If you use the MEAccountabilityCheckEnableNetEffectivity preference to report net
effectivity mismatches, the Excel report also reports those mismatches.

et
L Memmalched Twpeis
: i _IDocurrancs Efctihity|
Gy
DOD0SEA: 1-23 1015 (DO00S0) DOD0SELA 1.2% 00049 EBON [1-158 X118 [ n Serce
BOD0SEA 1-a3 |50 (B00050) i) GODOSEM, T-a |5-8 [HD0050] M0045-EBOM | 16-20 Migsing in Sounce
ON05EA 123 MO50-MBOM| 1, 3, 16-UP Messing in Sowece
GODOSEA:1-a3 [5-8 [00050) MBOM |2, 4 Miing n Source
CODOSEA 1-ad JOOE0-MBOM[S. 1115 1 Owerdapping
CODOSALA. 1-a3 15-8 [G00050) 16-20 (00)10 000250 B0 [ 10 1 Owerdnppang
D00050-MBOM |6, 8 1 O 3peang
| (] i Dusdapping
DOD5E A, 16 [0 HAug-2015 00:00 bo 2‘5-'1& COD0SE A 1-:6' :I.'c"IZI |I]El}l}5I]-I||BOMI1 35790 (1] Missing in Target
TODOESA, 1-a8 6 (00US0) Ten TE005 A, 148 |8 (DO0045) T30 | e I To [Mkssing n Targst
| | | 1 | |000045-EBOM [ (] i [Messing in Source
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Customize the Excel report
1. Create your own XSL style sheet.

2. Add it to the Accountability Check Report (TC_2007_00_CUS_RPT_0002) report in the Report
Builder application.

3. Modify the AccountabilityCheckReportStylesheetName preference to contain the name of the
new style sheet.

Note:

If you created a custom style sheet prior to upgrading to Teamcenter 11.4 or greater, by default,
the Excel report uses a new style sheet called acc_chk_rpt_excel.xsl. Your customized stylesheet
must have a different, unique name (for example, my_acc_chk_rpt_excel.xsl). When the value of
the preference MEAccountabilityCheckReportCombineLines is true (default), the generated xml
file will not support legacy stylesheets. To generate legacy data xml files, change the preference
value to false.

Reporting the check result in occurrence groups

Alternatively to reporting the accountability check results in colors, Teamcenter can report anomalies in
occurrence groups that are displayed in an additional tab in the structure pane. These occurrence groups
are stored as persistent objects in the database.

If you compare the base view of the entire product structure or a subassembly, the accountability check
searches for every BOM line in the process plan. If you compare the manufacturing view of the product
or a subassembly, the check only searches for a line in the process plan if the line's direct parent is

an occurrence group. In the manufacturing view, if the BOM line's direct parent is not an occurrence
group, you must allocate it to the view as a component of a subassembly in the original EBOM. For
example, component C is part of subassembly A in the EBOM, while subassembly A is assigned to the
manufacturing view under occurrence group G. Consequently, C also appears in the manufacturing view
under A, then under G. The direct parent of A is an occurrence group, while the direct parent of Cis A,
which is not an occurrence group. When you compare structures, the utility searches for A but not for C.
Typically, if you did not allocate to the manufacturing view, you would not expect to consume it in the
process.

The scope of the comparison depends on the selections you made in the Accountability Check dialog
box.

Generate the results grouped by anomaly
1. To generate the report:

a. Open the Accountability Check dialog box.
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b.  On the Reporting tab, click Report in occurrence group.
c. Click OK.

The Create Compare Result View dialog is displayed.

& Create Compare Result View

Mame: | ICﬂmpare Result

Description: | Accountability Check test Target

Ok Cancel

000411/A:1-Accountability Check test Source <==> 000412/4;1-

d. Modify the system generated Name and Description as required.

The Name of the result view is displayed as the name of the additional tab. Multiple result
views can be displayed at a time. If a view with the same name exists, the system displays a
message asking if the result view should be overwritten or renamed. In this case, you must

have write access to overwrite the existing view.

e. Click OK.

Teamcenter creates UsageCompareResultView objects for each type of anomaly and displays

them in the Compare Result tab.

& Create Compare Result View

Mame: | tﬂmpare Result

Description: | Accountability Check test Target

| OK Cancel

000411/A;1-Accountability Check test Source <==> 000412/4;1-

Teamcenter creates occurrence groups for each type of anomaly and displays them in the Compare
Result tab (an occurrence group tab). The names of the anomalies are fixed and are as follows:

¢ Unused/Under-used
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Contains all occurrences in the source pane that do not match an occurrence in the target pane.
* Completely Used

Contains all occurrences in the source pane that match a corresponding occurrence in the target
pane.

e Over-used

Contains all occurrences in the source pane that match more than one occurrence in the target
pane.

e Partial Match

Contains all occurrences in the source pane that have mismatched properties compared to their
corresponding occurrence in the target pane.

2. (Optional) Expand the subgroups to view the items contained in these groups and take appropriate
action.

You must rerun the accountability check to view any changed results.
Releasing preliminary structures

About baselining or preliminary structures

You can release intermediate structure data for other users or suppliers to review or consume. An
intermediate data release or baseline of in-progress data is sometimes called a preliminary data indicator
(PDI).

You must create a baseline (PDI) of the related product structure and plant structure before you create a
baseline of the process structure. This allows you to reproduce the process structure when necessary by
applying the appropriate product and plant configuration rules that were applied when you created the
PDI.

Creating PDIs

When you create a PDI, Teamcenter traverses each child of the structure, creates a new item revision
under a specified baseline revision ID, and releases the new item revision. It does not include any
occurrence groups in the structure in the PDI.

Creating a dry run

Before creating a new item revision for a PDI, you can optionally make a dry run to validate the
baseline. Teamcenter provides detailed status information about the structure. If there are any errors
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in the structure, Teamcenter displays their details, halts the baseline process, and does not release the
structure. Your administrator can set a preference that determines if validation is always required before
you create the baseline, or if you can validate the structure only when you consider it necessary.

Creating precise and imprecise baselines

Depending on the configuration of your structure, you can create the baseline as a precise structure or
an imprecise structure. If you want a precise structure of a process, you must also baseline the product
structure and plant structure first to be able to reproduce the revision status of the PDI in the future. In
this case, all the relevant structures (product, plant and process) must be precise to allow their accurate
reproduction in future sessions.

Viewing a PDI

You can view a PDI immediately when the baseline is created. However, the revision rule is not
automatically applied when the baseline is loaded, and you must apply it manually.

You can also view the baseline in My Teamcenter and choose the appropriate item revision from the list
of available item revisions. You can distinguish baseline revisions from other released revisions by the
specific revision ID format.

Create a baseline of a structure
1. Open the structure revision.
2. Select the top line of the structure and choose Tools->Baseline.

Teamcenter checks if you can create a baseline of the selected revision. If not, Teamcenter displays
the reason (for example, you cannot create a baseline from an existing baseline). Otherwise,
Teamcenter displays the Baseline dialog box, showing the item ID, baseline revision, and baseline
name.

3. Enter the following information in the Baseline dialog box.

Box Entry
Description Type a description of the baseline.
Baseline Template Choose a baseline release procedure template

from the list of available procedures. Your
administrator defines the available procedures
with the Baseline_release_procedures
preference.

Job Name Note the job name. The job name is
automatically generated and you cannot change

6-18



Create a baseline of a structure _

Box Entry

it. Your administrator defines the naming
scheme in the Business Modeler IDE application.

Baseline Label Type an alphanumeric string that represents the
baseline label. Teamcenter uses the label you
enter as the name of the baseline folder. This
box is only displayed if your site uses baseline

labels.
Job Description Type a description of the PDI job.
Open On Create Select this check box if you want Teamcenter to

open the baseline for viewing when it is created.
You must apply the revision rule manually when
the baseline is open.

Dry Run Creation Select this check box if you only want to validate
the structure as suitable for creating a baseline.
If you clear this check box, Teamcenter validates
the structure and creates an item revision for the
baseline.

Note:

Your administrator can set

the Baseline_dryrun_always system
preference to determine if a dry run is
always required.

Precise Baseline Select the type of baseline to create— precise or
imprecise. Your site may be configured to allow
only precise baselines, depending on the setting
of the Baseline_precise_bvr preference.

Click OK or Apply to create the baseline. Alternatively, you can click Cancel to exit without creating
a baseline.

Teamcenter optionally creates a baseline folder to hold the baseline. Your administrator specifies if
a folder is created by setting the baseline_create_snapshot_folder preference.

If the value of this preference is 0, the baseline folder name is in the format
Baseline_Itemld_BaselineRevild and may be truncated to 32 characters, if necessary. The folder
is attached to the top structure.

If the value of this preference is 1, the baseline folder name is the alphanumeric string you entered
in the Baseline Label box in the Baseline dialog box.

6-19



_ 6. Managing process structure data

Note:

In addition to setting this preference, you must set the Snapshot relationship

on the item revision to make the snapshot folder visible. Do this by choosing
Edit>Options->General-Item Revision and adding Snapshot to the Shown Relations
column of both the General and Related Object tabs.

Caution:

If you expand the baseline item revision below a certain level, the application displays
duplicate objects.

5. Save the revision rule for the product structure, process structure, and plant structure by saving the
structure as a collaboration context. After you do this:

* The product root item is the baseline product.
* The plant root item is the plant baseline.

* The process root item is the process baseline.
Managing intermediate data captures

About intermediate data captures

An intermediate data capture (IDC) is a PLM XML file that contains an exported structure with the
configuration in effect at the time the IDC is created. An IDC may contain any configured structure
including a collaboration context, structure context, or group of BOM lines. You can manage the PLM
XML file in the same way as any other workspace object, including assigning it to a workflow, assigning
it a release status, running accountability checks, and controlling access privileges with Access Manager.

After you create an IDC, it appears as a separate structure view and an entry for it appears in the
Collaboration Context Tree view.

After creation, you can compare an IDC to existing structures. For example, if you create an IDC from a
product structure, and then make modifications in that product structure, you can run an accountability
check that compares the IDC to the modified structure to see the modifications.

To compare IDCs with each other or another structure, each line being compared must contain an
in-context ID. Your administrator can run the bom_expand utility to ensure that each relevant line in the
structure is stamped with an in-context ID.

When you create an IDC, Teamcenter uses transfer modes to export the structure and alias files to
determine what to include in the IDC viewer. If you want to export custom objects or properties to the
IDC, you must ensure that a transfer mode exists that contains clauses that includes these objects. You
must also ensure that the alias files are modified to include the desired objects. If you want to see these
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objects or properties in the IDC viewer in the rich client, you must modify the alias files so that the
viewer can extract them from the request object’s XML. The location of the various alias files is found in
the following preferences:

» Structure_Alias_File

* Attachment_Alias_File

* Dataset_Alias_File

An intermediate data capture structure is view-only. You cannot make changes to this structure.

There are various views available when working with an IDC, such as the Attachments view and the
Graphics view.

Capture structures in an IDC

1.  Select the root object in the structure and choose Tools=Intermediate Data Capture. You can
capture BOM lines, an occurrence group, a structure context with multiple roots, or a collaboration
context containing multiple structures.

Teamcenter displays the New Intermediate Data Capture dialog box.
2. Select the type of IDC you want to create in the list on the left.

3. Type the name and optional description of the intermediate data capture, and select the
appropriate transfer mode name from the list.

4. Toopenthe IDCin Part Planner, select Open on Create. If you do not select this option, you can
find the IDC in the Newstuff folder in My Teamcenter.

5. Click OK or Apply.

Teamcenter validates the objects you selected. If any of the objects cannot be captured,
Teamcenter displays an error message, otherwise it creates the PLM XML file containing the IDC
and displays it in a structure view.

6. (Optional) Open the IDC in the Viewer view in My Teamcenter or in the Object View tab in Multi-
Structure Manager to see a list of the captured states, including their descriptions and creation
dates.

7. (Optional) If you make changes to the originally captured structure, create a new captured state in
My Teamcenter or Multi-Structure Manager by clicking Add State.
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Administering process template rules

Working with copy action rules

Copy action rules define how process structures and their individual processes, operations, and activities
are duplicated when you use a process template to create a new process structure. These copy actions
are defined by your administrator as preferences.

The available copy actions include:

Copy action Result

Ignore No copy action is taken. Neither the database object nor any references
to it are duplicated in the new structure.

Copy by Reference The duplicated process structure references the original object in the
database. Any changes to the database object are reflected in the
duplicated structure.

Clone and Reference The database object is cloned and the duplicated process structure
references the newly cloned object. Any changes made to the original
database object are not reflected in the duplicated structure because
it references the cloned database object, not the original database
object.

Determining copy action candidates

Copy action candidates are the objects considered for duplication into the new structure when a process
template is used.

When you create a new process structure from a template, the template process is opened behind the
scenes as the root in a temporary BOM window. The process is expanded, and each child of the process
becomes a copy action candidate.

Rules defined as preferences by your administrator determine the copy action to take for each child item.
Each child item chosen for a Clone copy action is expanded and its children also become copy action
candidates. This process occurs recursively until every branch in the BOM window is either exhausted or

not cloned.
Copy action candidate Copy actions available
Objects found in structures * Ignore
* Copy by Reference
* Clone and Reference
Items found by relation * Ignore

* Copy by Reference
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Copy action candidate Copy actions available
¢ Clone and Reference

Objects found in folders Copy actions available for objects found in folders are
processed following the set of rules and specifying a relation
of attribute equal to contents.

Creating copy action rules

When an object is a copy action candidate, the copy action is determined by a series of rules that are
identified by preferences. For each rule, the system administrator indicates specifications for the parent
object, the child object, and the relation. The administrator also specifies the copy action.

Relation specifications

Relation specifications can be by:

» Teamcenter relation type

* BOM structure occurrence type

* Folder content

The Teamcenter relation type may be a wildcard character or a Teamcenter relation type name.

The structure occurrence type may be an asterisk, null (for no occurrence type), or the occurrence type
name.

Folder contents are specified with the string contents.
Occurrences in cloned structures

Any occurrence in the BOM view revision of a cloned item, process, or revision is considered a cloned
occurrence, regardless of whether the loaded child object is cloned or referenced. Quantities, occurrence
types, notes, find numbers, and user interface locations of cloned occurrences match those in the
template occurrence.

Each occurrence predecessor is processed according to the following rules:

* If the predecessor sibling was ignored during the copy action and is not represented in the clone, the
predecessor is not set.

* If the predecessor sibling is cloned, the predecessor is the clone.

* If the predecessor sibling is referenced, the predecessor is the same as in the template.
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Applying copy action rules

When a new structure is created from a template, the first copy action rule specified by the preference
that applies to an object determines the copy action. This lets you specify general copy rules using
wildcards that can be overridden with more specific rules.

For example, to apply a specific copy action rule to a child item, you could use a wildcard to specify a
general rule for the parent item but have a specific rule in place for the child. When the template is used
to duplicate a structure, the general parent specification is overridden by the specific rule for the child.

The default copy action rule is Copy by Reference, where the duplicated process structure references
the original object in the database.
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Managing time with the Time view

Using the Time view you can manage time information on activities, operations, and processes. You can
start by estimating the time it takes to execute operations. Later, you can refine the time information by
defining activities holding time information. You can define the category of each activity, for example,
Value Added or Non-Value Added, and later analyze how much time in your overall process structure
(or any other process level) is spent on each category. This view also lets you roll up the time
information from lower levels to upper levels and define the allocated time of each of the leaves.

The Time view provides information specific to the process or operation so that its appearance varies
depending on which of these you select.

Times are stored in the Time Analysis form on the process or operation. Activity times are stored as
fields directly on the class. In contrast to process or operation, there is no additional activity time form.
You can modify times in the Time view and these changes are then reflected in the forms.

Time units are stored in seconds in the database. You can configure which units are shown in the Time
view.

Open the Time view

1. Select a process or operation.
2. Choose Open with=Time.
Teamcenter opens the Time view.

* If a process is selected, the Time view contains the Time Values and Time Analysis sections.

Use this section To

Time Values Edit allocated, estimated, and simulated times for a
process or operation. Use the Calculate button to
populate the allocated time and roll up the summary
to upper levels.

Time Analysis See the analysis of the activities for the selected
object. The total work, total duration, and pie chart are
calculated for the activities of all descendents of the
selected process or operation.

* If an operation is selected, the Time view additionally contains the Work Content and Activities
sections.
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Work Content Display the work content of the operation. This is
customer-specific information and is not used for any
calculation. You can expand or collapse this section to
suit your needs.

Activities Edit operation activities with time information and
classify them into time categories.

Edit operation activities

Activities are intended to break down an operation to define its detailed time information. Each activity
can have the following time information:

e Code

The code of an activity is defined in a time standard such as the Methods Time Measurement (MTM)
system or in your company'’s standard.

* UnitTime

The unit time is the time it takes to execute this activity.
* Frequency

Frequency represents how many times this activity is executed. The defaultis 1.
* Work Time

The total time it takes to execute this activity. This work time is the result of multiplying the unit time
by the frequency.

» Category
The time category to which this activity belongs (for example, Value Added).

With the Time view open for an operation, do any of the following:

Use To

Add Below Add a new activity as a descendent of the selected activity.
Add After Create a new sibling activity after the selected activity.
Data Card Open the Data Card dialog box.
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Use To

Time System Open the TiCon Search view to search for elements in the
TiCon time system.

Remove Delete an activity.
Properties Open the activities Properties form.
Move Up Change the order of the activities. This order is also reflected
in the Activity Flow PERT chart.
Move Down
Note:
Use these buttons to change the order of a linear flow
of activities only. If you use these on parallel flows, the
changed order can lead to incorrect flows.
F2 key or select the cell Edit the cell contents, including the name.
Shortcut menu Obtain additional commands to perform on a selected
activity:
* Cut/Copy/Paste
* Expand
* Expand Below
* Collapse Below
* Refresh
* Properties
* Activity Assignments
Note:

If an activity in the Activities table of the Time view contains child activities, the time displayed
for it is the cumulative time of all the child activities. For this reason, you cannot use Add Below if
an activity already contains a time, and you cannot use Replace if the activity already has children.
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Adding activities based on the Methods Time Measurement (MTM) system

You can add activities based on predefined time information available in the Methods Time
Measurement (MTM) system to operations in the Time view. This system sets industry-standard times
required to perform standard manual tasks. The standards include a list of time elements where each
element represents a specific and short step a worker can perform as part of the execution of an
operation. Typically, the time elements are organized into groups according to types, distance, and
difficulty. The standards are based on repeated measurements done on real production lines.

In the Time view, you can open a data card and select individual tasks containing a set time. Each of
these tasks is added as a separate activity, including a name, unit time, and code as defined in the data
card. You can then use these standard times to run time calculations and analyses.

Note:

You must install this feature before using it.

You can also replace the MTM data card with a customized one that includes times required for tasks
that are specific to your company.

Add activities using a data card

Note:

You must install the MTM data card before using it.

1. In the Activities section of the Time view, select an activity where you want to add the MTM
activity.

2. If you are familiar with time codes, type the code directly in the Code box of an activity.

Teamcenter automatically retrieves the time and name of the activity from the data card. In this
way, you can use the time standards without needing to open the data card.

Otherwise, click .

Teamcenter displays the Data Card dialog box containing lists of predefined activities.
3. Select one of the following:

¢ Add Below
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Adds the new activity below the activity that is selected in the Activities section of the Time
view. You cannot use this option if the activity selected in the Time view already has an
associated time.

* Add After

Adds the new activity at the same level as the selected activity in the Time view. You cannot use
this option if the selected activity is the root node.

* Replace

Replaces the activity selected in the Time view with the new activity. You cannot use this option
if the activity selected in the Time view has children.

4. Use the tree structure on the left in combination with the tabs to navigate to the appropriate time
element.

5. Select a time element in the table.

Teamcenter adds an activity corresponding to the selected time element to the Activities section of
the Time view in the manner you indicated in step 3.

6. (Optional) Select different activities and repeat these steps to continue to add or replace activities
while the Data Card dialog box is open.

Edit data card activities in the Time view

Since time codes are common and generally known to time engineers, Teamcenter allows you to type
the code directly in the Code box of an activity. Teamcenter automatically retrieves the time and name
of the activity from the data card. In this way, you can use the time standards without opening the data
card.

1. Double-click in the Code cell of an activity in the Activities table.
2. Type a modified entry into the cell.

* When you edit the Code cell, Teamcenter provides you with a list of all the codes available in
the data card. As you type a new code, or any part of a code, into the cell, Teamcenter reduces
this list to show only those codes from the data cards that contain the characters you type. For
example, if you type kz, the list displays all codes that contain those two consecutive letters
anywhere in the string, such as 2000AKZ05. Select a code from the list and press the Enter
key. Teamcenter replaces the time information of the activity with the new time information as
defined in the data card.

* If you edit the time entry of the cell, you overwrite the predefined data card time.
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* The tool tips in the Activities table display the complete activity data card information.
Managing activity times using the TiCon integration

Using the TiCon integration

You can access time data from TiCon, an external time management system, using a web service

and assign the data to activities. You can search for time elements in TiCon, create new operations
containing time activities, or overwrite existing activities with the timing data of time elements, and
update activities assigned to time elements that were changed in TiCon. You can use the existing time
management features to calculate time analysis based on the TiCon data.

Teamcenter automatically creates a new operation for each TiCon time activity that you add to a process
structure. It calculates the allocated time of the process based on the PERT flows of the process. If you
update the PERT flows using the Resequence Structure command, the allocated time contains the sum
of all the activity times contained in the child operations. If you do not update the PERT flows, the
allocated time on the process represents the maximum time of all the child operations.

You can to map your company'’s activity properties to the TiCon time element attributes.

Note:

The speed in which data is returned from the TiCon server is dependent on your network
connection to that server.

Log on to TiCon

1. Do one of the following:
* Select a process to which you want to add time data and choose Open With->Time.

* In the Activities section of the Time view, select the activity to which you want to add additional
TiCon time elements or replace existing ones.

2. Click the Open TiCon Search button @)
Teamcenter displays the TiCon Login dialog box.

3. Type your TiCon user name and password, select a data area in which to work, and click Login.

Teamcenter connects to the TiCon time system and opens the TiCon Search view.

Search for time elements

1. LogontoTiCon.
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Teamcenter connects to the TiCon time system and opens the TiCon Search view.

2. Inthe Search Criteria section, type the criterion for which you want to search. By default, you can
search for code, index, or variant of a time element.

You can use the * or % as a wildcard to assist your search.

Your administrator can customize which search criteria are displayed in the Search Criteria section
in the METimeSystemSearchCriterionFields preference.

3. Click Search.
Teamcenter lists all results in the Search Result section of the TiCon Search view.

Your administrator can customize which columns are displayed in the Search Result section in the
METimeSystemSearchResultFields preference.

Add and replace activities by assigning time elements

1. Search for a time element and select an appropriate one from the Search Result section of the
TiCon Search view.
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* Query Definition

Query type: ’Configl -
~ Search Criteria

Code: Index:

Wariant: Description:  *check®

Data area: | 4All -

’ . Searchl ’ & Clear ]
 Search Result

Code Index  Variant Data area Description Basic Time... Indicatorl it
4MOS-MCL... 1 Check criterion (number... 072 MOMNE - M... !
4MOS-MC2... 1 Check line (each DIN A4 li.. 5.04 MNOME - M... 3
SLTSZSKF..L 1 Transp. Forklift truck, Lift.. 7614 MOME - M...
SLTSZ5KG..L 1 Transp. Walkie stacker, Lif.. 29.52 MOME - M...
SLTSZ5KS..L 1 Transp. High-lift truck, Lif.. 87.3 MNOME - M...
5MOS-VB-A.. 1 Check, data field small 1.44 MOME - M... -
+ Time Element Insertion

Scope objects: 000047 /A1 -process (View) -;_,@

[Include time element structure,  Limit to this level: |1

[[] Populate allocated time.

Operation narme:  Transp. Forklift truck, Lift check

Add Below | | Add After Replace

If the time element in TiCon contains a substructure, specify the number of levels of structure that
you want to include in the activity structure. You can select from one to five levels, or all levels by

selecting Unlimited.

(Optional, for a process only) In Operation name, overwrite the name of the TiCon activity.
By default, Teamcenter assigns the description of the TiCon element as the name of the new

operation containing that activity.
Do one of the following:

» With a process selected as scope, click Add Below.

Teamcenter creates a new operation as a child of the selected process and adds the selected
search result below the operation. If you select multiple TiCon elements, Teamcenter creates
a new operation for each one. You cannot use this option if the scope activity already has an

associated time.
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» With an activity selected as scope, click Add Below.

Teamcenter creates an activity with the selected time element and adds it under the current
scope. This option is available only for a root activity or an activity that is not associated with a
time element.

* With an activity selected as scope, click Add After.

Teamcenter adds the selected search result at the same level as the scope activity. You cannot
use this option if the scope activity is the root node.

* With an activity selected as scope, click Replace.

Replaces the scope activity selected in the Time view with the selected search result. You cannot
use this option if the scope activity has children.

5. Select Populate allocated time to calculate the allocated time on the parent process.
This option is available only if the view’s scope is a process.

6. (Optional) To add an element to a different activity, select the activity in Activities section of the
Time view and click Change Scope ;="or click Unlock Scope to work on the selected activity
instead.

Update activities assigned to time elements

Over time, time data can change and it can become necessary to update the TiCon time elements
contained in your structure.

1. Do one of the following to select the object to update:
* Select a process or operation in the structure view.
* Select an activity in the Activities section of the Time view.
2. Choose Tools=TiCon-»Update from the main toolbar.
Teamcenter displays the TiCon Update dialog box.

3. If the time element in TiCon contains a substructure, specify the number of levels of structure that
you want to include in the activity structure and click Start.
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Tip:

You can use this option to remove levels from or add levels to a substructure by specifying
fewer or more levels than you did when you created the activity or last performed an update.

Teamcenter compares all the time information in the activities belonging to the selected structure
with the current time information for the associated time element in TiCon. If it finds differences, it
lists them in the dialog box.

4. (Optional) Navigate through the changes selecting each line. For each selected line, Teamcenter
displays the potential change at the bottom of the dialog box.

5. Click Update to apply the changes, or Cancel to close the dialog box without updating.

Log off the TiCon time system
Do one of the following:

* In the View Menu list, select Logout.
* Choose Tools=TiCon->Logout.

The next time you attempt to search in the TiCon Search view, you must log on again.

Performing a time analysis

When Teamcenter performs a time analysis, it calculates total work and total duration of descendents
of the selected object. In addition, it calculates the time required for each category of time and displays
these in a pie chart. By default, Teamcenter provides you with three categories of activities, value-added
(VA), non-value-added (NVA), non-value-added but required (NVABR). Your administrator can configure
the time view to suit your needs.

* If you select an operation, Teamcenter performs a time analysis automatically when you open the
Time view.

* If you select a process, these calculations can be very time-consuming, so you must initiate them
manually by clicking Calculate.

Note:

Teamcenter caches the time analysis calculations for a process but does not update them
automatically if any changes occur. If you make any changes that affect stored times, you must
click Calculate again to obtain the updated values.
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Teamcenter does not save the time analysis information to the database, it only saves it in the
current session. It does this because a time analysis result depends on the current configuration of
the structure. You can generate a report of the time analysis which is saved as an attachment to
the process.

Populate allocated time

Allocated time is the official time of each process and operation. You can manually define the allocated
time or you can populate it from other time fields. You can choose the basis on which to calculate the
allocated time. This calculation updates the allocated time of all the descendents of the selected process
or operation. The calculation is done from the lowest level upwards (rollup).

If flows between operations are created in a PERT chart, populating the allocated time will sum up
the values of sub-levels and display the sum in the target process. If flows are not created between
operations in PERT chart, then to sum up the values of sub-levels and display the sum in the target
process, you or an administrator must update the MECollectionTypeProcesses preference with the
process type (Process or the internal name of the custom process type).

1. Do one of the following:
* In the Time view, in the Time Values section, click Calculate.
* Choose Tools - Populate Allocated Time.
Teamcenter opens the Populate Allocated Time dialog box.

2.  Select one of the following:

Use this option To calculate allocated time based on

Estimated Time Time information used in the preplanning stages, before
detailed time analysis data is available.

Simulated Time Time values that are determined as a result of a
simulation.

Time Analysis Duration The total duration as calculated in the Time Analysis
section.

Prioritized list of time properties A configured list of data sources. Teamcenter considers

these sources in order of their appearance in this list,
looking for a value that does not equal zero. As soon as

it finds one, Teamcenter populates the allocated time and
does not consider the rest of the list.

You can move data sources up or down in the list, or
remove them completely. If you select only one option,
for example, Simulated Time, in this list, Teamcenter




Use this option To calculate allocated time based on

behaves in an identical fashion to selecting Simulated
Time on the upper part of this dialog box.

This list of data sources is not evaluated if the node has
children whose accumulated allocated time is not equal
to zero.

(Optional) Specify how many levels are populated by selecting a value from the Populate up to
level list.

All leaf objects are calculated that are of a distance from the top-level object that is greater than or
equal to the number you specify in this option.

Select Populate zero values if you want to override the allocated time for a specific object with
zero values, even if the object’s original allocated time value is not zero.

If you select this option in conjunction with the Prioritized list of time properties option,
Teamcenter populates allocated time with zero values if all the values of the sources in the list
are zero.

If you do not select this option, original values that are not equal to zero are not replaced with zero
values.

Filtering activity attachments from the structure

You can suppress the display of different types of attachments in the Activities section of the Time view

using the METimeTabFilteredComponents preference. If you want to see the attachments, open the

Attachments view on the operation activity.

Working with time reports

Creating time reports
When working in the Time view, you can run two reports:
Time Analysis Report

This report summarizes the time analysis for the selected object and below that object. It includes
the time analysis information for each process and operation. It contains the name of the process,
operation or activity, code, unit time, frequency, work time, duration, and times for different
categories. You run this report from the Time Analysis section of the Time view.

Allocated Time Report




This report contains the name of the process or operation, allocated, estimated, and simulated times
and the duration. You run this report from the Time Values section of the Time view.

Teamcenter creates these reports as Excel files that are attached as datasets to the corresponding object.
You can customize the reports in the Report Builder application.

Run a time report

1. Inthe Time view, do one of the following:
* In the Time Analysis section, click Report to create a time analysis report.
* In the Time Values section, click Report to create an allocated time report.
Teamcenter opens a dialog box where you can specify the name of the dataset.

* If the TC_CRF_overwrite_existing_dataset_content preference is set to true, Teamcenter
replaces the contents of the dataset.

* If the TC_CRF_overwrite_existing_dataset_content preference is set to false, Teamcenter
creates a new dataset.

2. Type a new name into the box, or click Replace to overwrite the dataset contents.
3. Click OK to close the resulting dialog box and open the report.

If you create a time analysis report, Teamcenter calculates and exports the time analysis values of
the selected object and all its descendents. If you generate an allocated time report, no calculation is
performed. The report reflects the current state of the data.

Customizing a time report

You can customize a time report in any of the following ways.

* Change the report to be used by changing the value of the METimeAnalysisReportDefinitionID or
MEAIllocatedTimeReportDefinitionID preferences.

* Add one or more style sheet to the report definition by modifying the
METimeAnalysisReportStylesheet and MEAllocatedTimeReportStylesheet preferences.

* Customize the report contents in the Report Builder application.
* The SHOW parameter specifies which Teamcenter columns are displayed as rows in the report.

* The TRANSFER_MODE parameter specifies the name of the transfer mode to be used to export
additional data. You must customize the XSL style sheet to show the exported data.
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Configure the Time view

In addition to configuring the Time view using preferences, you can configure the following:
* Add new categories in the Business Modeler IDE application.

» Specify the color in which each time category appears. This category is reflected in the Activities
section of the Time view and in the colors of the pie chart in the Time Analysis section.

1. Choose Edit-Options.

Teamcenter opens the Options dialog box.
2. Click Manufacturing in the hierarchy tree.
3. Click the Time tab.
4. Inthe Colors Representing Time Analysis Types section:

a. Click any of the displayed colors.

Teamcenter opens the Color Chooser dialog box.

b.  Click a new color.

c.  Click OK.

These changes are saved in the MEActivityTypeColors preference.

* Change the time unit that appears in the Time Analysis section as follows:

1. Choose Edit->Options.

Teamcenter opens the Options dialog box.
2. Click Manufacturing in the hierarchy tree.
3. Click the Time tab.

4.  Choose the time unit that you want to display in the Current Time Unit list. You can choose
from any of the following units:




5.

Unit ID
1000th_min
100th_min
10th_min
FAC

MOD

TMU

day

hour
minute

second

(Optional) Make further adjustments to the time units using the MEAvailableTimeUnits and

Long display
name (localizable)

1/1000 min
1/100 min
1/10 min
FAC

MOD

T™MU

Day

Hour
Minute

Second

MECurrentTimeUnit preferences.

Configure the Time view _

Short display
name (localizable)

0.00Tm
0.0Tm
0.1Tm
FAC
MOD
TMU

d

h

min

sec

Multiplier to
seconds

0.06
0.6

6

0.18
0.129
0.036
86400
3600
60
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8. Process documents and work
instructions

Creating, viewing, and editing manufacturing documentation

About manufacturing documentation

Teamcenter manufacturing documentation provides rich work instructions and collaboration between
departments, integrated with the planning environment, leveraging Teamcenter data management
capabilities.

e Teamcenter Publish

Provides an environment for creating work instructions for manufacturing operations. Teamcenter
Publish enables you to author, distribute, and visualize the most current product and process data. Its
main features include:

» Technical illustrations including text, 2D images, 3D graphics, table, text, and hyperlinks (for
example, a link to a movie file) to improve clarity and enhanced quality on the shopfloor.

* Easy update based on the most current planning data in Teamcenter, reducing rework and update
times.

* Batch processing and scheduling of reports.

* Familiar Microsoft Visio authoring environment allowing WYSIWYG editing.

Using Teamcenter Publish

To create or view manufacturing documentation using Teamcenter Publish, install Microsoft Visio. Both
Visio Standard and Visio Professional are certified. You can install Visio before or after the Teamcenter
installation.

The Save as PDF feature is included with Visio and does not require installing the separate PDF add-in.

The administrator creates an alias file that determines the permissible contents of the documentation.
For example, if the administrator uses the default alias file, you can create work instructions and product
manuals, and a view for each of these is available.

When you first select a documentation view, Teamcenter loads the Visualization Illustration and Visio
components. Depending on your workstation, this process may take several seconds to complete and
Teamcenter displays a progress dialog box until it is complete.
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_ 8. Process documents and work instructions

Working with publishing tools

You can create publishing pages in the embedded viewer and collect them into portfolios. A typical
publishing page is a work instruction document, and a portfolio may contain all the work instructions
needed at a particular assembly station. By default after installation, Teamcenter provides you with
sample files. To use publishing tools in your environment, you must configure it to suit your needs.

Publishing pages are Visio files that are saved as datasets with the selected BOM line.

Visio documents are constructed using shapes that can appear as text and graphics. A rich library of
shapes are provided in the Visio installation.

The Teamcenter publishing tools extend the shape library to include shapes called assets that you can
link to data in Teamcenter. Assets can display text, tables, images, or a link to a Microsoft Word file or
master form. For example, in Teamcenter you can configure a product assembly, view it, add markups,
and capture the graphics in a product view (snapshot) that you can then display in a 3D asset. If the data
in Teamcenter is subsequently updated, you can update the publishing page to show the changes.

You can organize collections of publishing pages into portfolios, which you can view, publish to HTML
for a Web server or publish to PDF, or print in My Teamcenter using the options that appear in the
Graphics view after you select the portfolio object. A portfolio can contain multiple work instructions,
generic pages, header and footer information, a table of contents, and cover and trailer pages.

Publishing page roles

Publishing page documents can be used for any number of purposes. By default, two roles are provided,
Work Instructions and, when a product structure is selected, Product Manual. Your database may be
configured to support any number of roles. This documentation refers to the Work Instructions role, but
the behavior of the pane is the same for each role.

Creating and editing publishing pages overview

When you first open the Work Instructions view, you see a blank page.
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Creating and editing publishing pages overview _
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You can immediately begin to create a work instruction on this page or you can load a template and
work from there.

The following is an overview of the process for creating a publishing page.
1. Add any static Visio shapes, text or graphics you need to the page.
2. Associate the page with an alias file.

Alias files tell Teamcenter what data to display in different assets on the page and how to find that
data. This step is optional; a default file is loaded.

3. Place the required assets on the page. These are placeholders. You can place the following objects
in a work instruction page, each embedded in an asset of the same name:

Text that is bound to a property of an object in Teamcenter.

Tables whose cells map to object properties in Teamcenter.

2D images (for example, BMP, GIF or JPEG files)

3D geometry assets
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_ 8. Process documents and work instructions

These are objects that you create or view in the embedded viewer, such as a factory view or the
desired state of the product at a certain assembly station.

* 2D snapshots

These are dynamic objects that represent a 2D scene (a view of the base image and markups)
that are associated with a BOM line in your product structure.

e Links
You can create a link to a Microsoft Word file or text file.
4.  Associate the asset with a transfer mode and an alias name.

The transfer mode and the alias tell Teamcenter how to find the data in the database that is
displayed in the asset.

5. (Optional) Save this page as a template for reuse.
6. Select one or more assets and an object in Teamcenter to populate the assets.

This step traverses the structure to find the desired data or files and places them in the selected
assets.

The objects used to populate assets depend on which structure line is selected.

Note:

Be careful when selecting new structures for populating assets. You must first click the Disable
response to selections button ¥ and then select a different structure. If you do not, the scope of
the Work Instruction view changes and Teamcenter attaches the newly created work instruction
dataset to the newly selected structure.

Create a publishing page

1. Right-click the BOM line with which you want to associate the work instructions, for example, the
item revision of an assembly or operation, and choose Open with = Work Instructions.

The selected line is the scope for the work instruction that you create. The new work instruction is
attached to the line that you select here.

Note:

Be careful when selecting new structures. You must first click the Disable response to
selections button ¥ then select a different structure. If you do not, the scope of the
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Binding assets overview _

Work Instruction view changes and Teamcenter attaches the newly created work instruction
dataset to the newly selected structure.

2. From the menu commands in the Work Instructions view, choose File - New Tl Dataset.
Teamcenter displays the New Dataset dialog box.

3. Type a name and description in the boxes at the bottom of the dialog box and click OK.
Teamcenter creates the new publishing page dataset.

4. To add data placeholders (assets) to the template:

Click To add

Data found in a text file attached to a structure line.

iz | A collection of data found in various properties in tabular
form.

@ A link to a Microsoft Word file or a text file.

B A 2D image or a 2D snapshot attached to a structure
line.

i A 3D image attached to a structure line.

5. Drag these placeholders to the desired spot on the page, resizing if necessary.
6. Right-click the asset and choose Bind.
Teamcenter displays the Bind Table Placeholder dialog box.

7. Select the transfer mode and alias to use for the data to populate this asset and click OK.

Note:

The work instructions are attached to the BOM line with a IMAN_MEWorkInstruction
relation.

Binding assets overview

There are several different types of placeholders (assets) that you can place on a publishing page. Each
of these must be bound with data from a structure. When you bind the asset, the Bind dialog box
contains a list of transfer modes and a number of choices, called aliases, from which you can select.
The choice you make for each asset defines how Teamcenter finds the data that is displayed in the asset
when you populate it.

8-5



_ 8. Process documents and work instructions

Bind textual information

You can bind information found in the text field of an object's properties. You can enter free-form text
within the asset to complement the bound information. For example:

Operator must tighten &&SUM(<alias_1>)&& bolts with torque &&MAX(<alias_2>)&& and any
other &&alias_3&&.

Teamcenter creates a placeholder for the text on the work instruction page.
Save the work instruction.

You must always save a work instruction once to create the dataset before you can populate an
asset.

Click the Text Tool button A to add free-form text to the asset.
Right-click the placeholder and select Bind.

Teamcenter displays the Bind Text Placeholder dialog box.
From the Transfer Modes list, select tcm_export transfer mode.
You can select only one transfer mode per text alias.

In the Aliases list, open the ObjectProperties entry and select the piece of textual information that
you want to embed. You can choose to manipulate the asset data using the list of simple formula.

Each piece of bound data is added to the end of the text asset. You may have to rearrange the
information after binding the data.

Click Add.

Tip:

* You can also type the binding directly into the text asset if you know the format.

* You can bind multiple times to create free-form text plus embedded text in one asset.
Switch back and forth between binding and typing free-form text by doing the following:

* Click the Arrow Tool [z button and right-click the text asset to access the bind dialog.

* Click the Text Tool button A and select the text asset to type free-form text.
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Bind data to display in a table format _

8. Select the object in the structure view containing the text that you want to embed in the
Teamcenter window. For example, if you want to embed the description of a particular item
revision, select that item revision in the structure view.

9. Inthe Work Instruction view, with the text placeholder still selected, click the Populate Asset
button €.

Teamcenter displays the specified text on the work instructions page.
Bind data to display in a table format
Use the table asset to embed multiple pieces of information about a selected object.
1. In the Work Instructions view, click [].

Teamcenter creates a placeholder for the table on the work instruction page.
2. Save the work instruction.

You must always save a work instruction once to create the dataset before you can populate an
asset.

3. Right-click the placeholder and select Bind.
Teamcenter displays the Bind Table Placeholder dialog box.
4.  From the Transfer Modes list, select tcm_export transfer mode.

5. Inthe Aliases list, open the appropriate alias, and select the type of information you want in the
list and click the plus sign.

If you select multiple entries, the selected objects appear as columns of the table in the same order
as in the Aliases pane.

6. Click OK.

7.  Select the revision in the structure view containing the objects that you want to embed in the
Teamcenter window. For example, if you want to embed the ID, name, and description of all
members of an assembly, select the assembly root structure in the structure view.

8. Inthe Work Instruction view, with the table placeholder still selected, click the Populate Asset
button €.

Teamcenter displays the specified information on the work instructions page.
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_ 8. Process documents and work instructions

Bind linked data

To bind linked data, a dataset with a .txt file imported into it must exist. In addition, you must be able to
open this .txt file in an associated text editor.

1. In the Work Instructions view, click &.
Teamcenter creates a placeholder for the link on the work instruction page.
2. Save the work instruction.

You must always save a work instruction once to create the dataset before you can populate an
asset.

3. Right-click the placeholder and choose Bind.
Teamcenter displays the Bind Link Placeholder dialog box.
4. From the Transfer Modes list, select the ExportGraphic transfer mode.
5. From the Aliases list, select LinkedDataset.
6. Inthe Attachment view, select the text dataset and click Populate in the Work Instructions view.
Teamcenter displays the link on the work instructions page.
Bind a 2D image
You can bind a 2D image that is attached to a revision.
1. In the Work Instructions view, click fa.
Teamcenter creates a placeholder for the image on the work instruction page.
2. Save the work instruction.

You must always save a work instruction once to create the dataset before you can populate an
asset.

3. Right-click the placeholder and select Bind.
Teamcenter displays the Bind Image Placeholder dialog box.
4. From the Transfer Modes list, select ExportGraphic transfer mode.

5. Inthe Aliases list, open the 2DGraphic entry and select file.

8-8



Bind a 2D snapshot _

6. Open the Attachments view.
7.  Select the image that you want to embed.

8. In the Work Instruction view, with the image placeholder still selected, click the Populate Asset
button €.

Teamcenter displays the selected image on the work instructions page.
Bind a 2D snapshot
If you embed a 2D snapshot, a 2D geometry asset must exist for it.
1. In the Work Instructions view, click .
Teamcenter creates a placeholder for the image on the work instruction page.
2. Save the work instruction.

You must always save a work instruction once to create the dataset before you can populate an
asset.

3. Right-click the placeholder and select Bind.
Teamcenter displays the Bind Image Placeholder dialog box.

4.  From the Transfer Modes list, select ExportGraphic transfer mode.

5. In the Aliases list, open the 2DSnapshot entry and select file.

6. Do one of the following to specify which 2D snapshot should be populated:
* In the Attachments view, select the snapshot.

* In the 2D Viewer view, open the 2D Snapshots Gallery dialog window and select an existing
snapshot.

* In the 2D Viewer view, arrange the snapshot. When you populate the asset, Teamcenter
automatically creates the snapshot for you.

7. Inthe Work Instruction view, with the image placeholder still selected, click the Populate Asset
button €.

Teamcenter displays the 2D snapshot on the work instructions page.
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Note:

If you receive an error saying Failed to load Error document (2DSnapshot & file) when
populating a 2D asset, the 2D snapshot does not contain a 2D geometry asset.

Recapture the 2D snapshot with the option to capture 2D geometry asset data turned on.

Bind a 3D asset

1. Open a structure to which you want to attach a work instruction.

2. In the Work Instructions view, click the 3D Graphic button®,.
Teamcenter creates a placeholder on the work instruction page.

3. Inthe Work Instructions view, select File - Save Tl lllustration.

You must save the work instruction once to create the dataset. If you do not save first, you receive
an error when populating the asset. Once the dataset exists, this step is no longer required, unless
you want to save changes to the work instruction page.

4. Right-click the placeholder and select Bind.
Teamcenter displays the Bind Geometry Asset Placeholder dialog box.
5. From the Transfer Modes list, select ExportGraphic transfer mode.
6. Inthe Aliases list, open the 3DGeometryAsset entry and select file.
7. Do one of the following to specify which 3D geometry should be populated:

* In the Graphics view, open the 3D Product View Gallery dialog box, create a snapshot, then
select it.

Caution:

You must ensure that the Add or Update 3D Geometry Asset option is selected before
you create a snapshot.

* In the Attachments view, select the 3D snapshot.

* In the Graphics view, arrange the snapshot. When you populate the asset, Teamcenter
automatically creates the snapshot for you.

8. Inthe Work Instruction view, with the placeholder still selected, click the Populate Asset button

) £




SRR—

Teamcenter displays the 3D geometry asset on the work instructions page.
Populate an empty asset
When you populate an asset, you associate Teamcenter data with it.
1. Select the asset.
2. Select the object in Teamcenter to which you want to link the asset.
3. Disable response to selections by clicking .

When selecting structures to populate assets, it is important to understand the role of the Disable
response to selections button. Clicking this button locks the view so that when you select a line in
a different structure, the scope of the view does not change and the work instruction dataset, when
created, is attached to the originally selected structure line. If the view is not locked (it responds to
selection), when you select a line in a different structure to populate an asset, the work instruction
dataset is attached to the newly selected structure line.

4.  Click the Populate Asset button € or menu command.
Creating a publishing page template

Your site may provide publishing page templates whose content can be used as the starting point for the
creation of a new publishing page. A publishing page template is a publishing page dataset that is not
populated with actual data.

A page template may contain standard data such as a company logo, pictures, and required text. It may
also contain empty placeholders, whose content you must fill for each instance of a publishing page you
create from the template.

You can classify templates in the Classification application for easy retrieval.

Classify a template

1. Add the TCPublishingPage business object type to the ics_classifiable_types preference.
2. Create a publishing page template.

3. Inthe Attachments view, select the template and choose Send to-»Classification.

4. In Classification, classify the template.

The template is now available when you create a new publishing page from a template.
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Create a publishing page from a template

1.

If you know the name of the required template, type it in the Template name box.

If you do not know the name of the template, you can search the database for it. In the Templates
pane at the top of the dialog box, click the Find a Template by name button _%.. next to the
Template name box.

Teamcenter displays the Find by Name dialog box, and you can search by part of the name and
with wildcard (*) characters.

If templates are classified, you can click Classification Search Dialog ' - to find the template you
require.

When you identify the publishing page you want to use as a template, double-click the name to
select it and return to the New Dataset dialog box.

(Optional) Click the Add To Favorites button to add the selected template to the list in the
Templates pane above it.

(Optional) Click the Use as Default button to use the specified dataset as the default template if no
Tl dataset is loaded.

In the File section, select Use Template.
Type a name and description in the relevant boxes.
Click OK.

Teamcenter creates the new publishing page dataset.

Using default templates

All of the default templates contain 3D geometry assets. You can add the following details to specific
page templates.

Template Purpose

TCPartList Specifies the part list table. When populated, it lists all the parts

under the selected BOM line. It includes the item identifier, item
name, revision identifier, description, and find number of each part
in the list.

TCAssemblyOperation Use this template at the operation level in a manufacturing

structure. It briefly describes the operation, its activities, the
consumed parts, and tools required to perform the operation. The
Activities table lists all the activities under the selected operation,
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Example — Populate assets using the TcPartList template _

Template Purpose

their descriptions and durations. The consumed parts table lists the
parts consumed by the selected operation, their identifiers, names,
revision identifiers, descriptions, and logical identifiers. The Tools
table lists the set of tools required by the operation, their identifiers,
names, and descriptions.

TCOperationRouting This template lists manufacturing process details, including the
operations under it, the consumed parts of those operations and
the list of tools used in those operations. Use this template at
the process level. The Operations List table lists all the operations
under the selected process. The consumed parts table lists all the
consumed parts under all the operations below the process. The
Resource List table lists all the resources under all the operations
below the process.

TCActivityDetails This template describes the activities under an operation. Use this
template at the operation level of a structure. For each activity, the
name, description, start time, duration, calculated start time, and
calculated duration are listed.

TCActivityRouting This template lists manufacturing activity details, including the
operations under it. Use this template at the operation level.

TCActivityToolList This template contains detailed description of the activities in the
structure. It may also be used at the operation level. It lists the
following activity details:

* The Activities Consumed Parts table lists all the activities, their
descriptions, and the parts consumed in each of these activities.

* The Activities Used Resources table lists all the activities, their
descriptions, and resources used in each of the activities.

Example — Populate assets using the TcPartList template

Teamcenter delivers several templates that are ready for you to use. The following is an example of how
to use the TcPartList template.

1. Load a product assembly. To use the 3D asset, you must load an assembly that displays parts in the
assembly viewer.

2. Select a BOM line to which you want to add a publishing page. You can select the top line, if
necessary.

3. Open the Work Instruction view or some other publishing page view.

4.  Hide the response to selections by clicking #".
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1

In the publishing page view, select File*New Tl Dataset.
6. Inthe dialog box, find the TcPartList template by name and use it as the starting template.
7.  Specify a dataset name and click OK. The template should appear in the publishing page viewer.

8. Populate the table assets by selecting the node (BOM line) whose data you want to populate in the
table asset component in the relevant structure view. Then select the table asset component in the
publishing page view and choose Edit->Populate Asset.
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9. Populate the 3D geometry asset as follows:

Wl
1

|

a. Click the Graphics view to make it the active view.

b.  Turn on parts and use the 3D viewer to manipulate the view until it shows what you want to
see in the asset. Include markups if desired.

c. Ensure thata BOM line is still selected, then select the 3D asset in the publishing page viewer
and select the Populate button. This creates a new snapshot (product view) dataset and
populates the asset with it. You can also populate a 3D asset from an existing snapshot.
However, the dataset must have an asset file attached to it. Asset file creation is an option; use
the named reference dialog to determine whether or not the dataset has an asset file.

* Select a snapshot dataset in the Attachments view or in another application.

* Select a 3D snapshot (product view) in the Product Views dialog box of the assembly
viewer. Asset file creation is controlled by a menu in this dialog box.
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Updating publishing pages

When an asset is populated, a reference to the selected Teamcenter populating object is stored in the
asset. If the data in Teamcenter changes, you can update the asset to show the changes. Updating is not
automatic; you must explicitly perform an update.

Take, for example, the TcPartList template’s table. Long after you create the publishing page and
populate the table asset, the product structure can be modified. tem names can change or BOM lines
can be added or removed from the line that was used to populate the table. After this happens, you can
update the publishing page to show the changes.

Update an asset
1. Open the page dataset in a publishing page viewer anywhere in Teamcenter.
2. Select the asset and choose Edit - Update Asset from the page viewer menu.

The new contents of the asset are displayed, along with a triangle indicating that the display shows
new (and so far unaccepted) data.

3. Switch between displaying the old and the new data by choosing Show Original Data and Show
New Data from the asset's shortcut menu. The asset is in an uncommitted state. You cannot
update the asset again or repopulate it while it is in this state.

4.  Accept or reject the change by choosing Accept New Data or Accept Original Data from the
asset’s shortcut menu. All of the assets on a page can be updated at once using the publishing
page Edit & Update Technical lllustration menu. Other Edit menus let you toggle the display and
accept or reject the changes for all of the assets on the page at once.
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Note:

You cannot update data in the database (other than the publishing page itself) by updating
an asset. Assets can only display what is already in the database. To update a 3D asset, you
must first update the snapshot dataset in the assembly viewer.

Repopulate an asset

An asset that has been populated can be repopulated with a different Teamcenter component.

1.

Select the asset in the publishing page view.

Select the component in another view, and choose Edit & Populate Asset in the publishing page
view.

Switch between displaying the old and the new data by choosing Show Original Data and Show
New Data from the asset's shortcut menu. The asset is in an uncommitted state. You cannot
update the asset again or repopulate it while it is in this state.

Accept or reject the change by choosing Accept New Data or Accept Original Data from the
asset’s shortcut menu. All of the assets on a page can be updated at once using the publishing
page Edit & Update Technical lllustration menu command. Other Edit menus let you toggle the
display and accept or reject the changes for all of the assets on the page at once.

Note:

You cannot update data in the database (other than the publishing page itself) by updating
an asset. Assets only can display what is already in the database. To update a 3D asset, you
must first update the snapshot dataset in the Graphics view.

View populating and end objects

The populating object is the one that was selected when the asset was populated. The end object is
the object that is actually displayed in the asset after it is populated. These can be the same object, or
different ones, depending on your alias definition.

You can view these objects.

1.

2.

Select the asset in the Work Instructions view.
Do one of the following:

* To show the populating object in My Teamcenter, choose Edit - Asset Components - Send to
My Teamcenter - Populating Components.
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* To show the end object in My Teamcenter, choose Edit - Asset Components = Send to My
Teamcenter - End Object.

* To view the populating object in the default viewer without switching applications, choose
Edit - Asset Components - View Populating Components.

* To view the end object in the default viewer without switching applications, choose Edit =
Asset Components - View End Object.

Note:

These menu commands may not work depending on how the alias file is implemented. For more
information, contact your administrator.

Create a new work instruction

1. Select the BOM line with which you want to associate the work instructions, for example, the item
revision of an assembly or operation.

2. Open the Work Instructions view.
3. Inthe Work Instructions view, choose File - New Tl Dataset.
Teamcenter displays the New Document dialog box.

4. If your site uses templates, select the name of a template, enter a dataset name, and click OK.

Note:

The work instructions are attached to the BOM line with a IMAN_MEWorkInstruction
relation.

Add new pages to the work instructions or product manual
* Choose Insert - New Page.

Teamcenter adds a new, blank page to the active work instructions or product manual. You can also
search for an existing page by name or use a Classification search to find a classified page.

Delete pages from the work instructions or product manual
1. Choose Edit - Delete Pages.

Teamcenter displays the Delete Pages dialog box containing a list of available pages.
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2. Select the page to delete and click OK.
Teamcenter deletes the page from the work instructions or product manual.
Save changes to the work instructions or product manual
* Choose File - Save.
Teamcenter saves any changes that you made.
Reserve space for headers and footers

You reserve space for headers and footers on a publishing page. When you print or export the work
instructions or product manual, any shapes on the publishing page are clipped to the defined margins.

1. Open the work instructions.
2. Choose View - Page Margins.

Teamcenter adds a gray-shaded background at the top, bottom, left, and right of the page.
Add export tags

You can add export tags to a page that are replaced with actual information when you print or export it.
For example, if you select page, the actual page number appears. Additional export tags include date,
long date, document file name, portfolio file name and total number of pages.

1. Open the work instructions or product manual.

2. Choose Insert - Portfolio Export Tag and select a tag from the displayed list. The tag you select
appears on the work instructions or product manual.

3. (Optional) Move or resize the export tag on the work instructions or product manual.
Navigate to another publishing page
Use one of the following methods to navigate to another publishing page:
1. Choose View - Page - Go to.
Teamcenter displays the Select Page dialog box.
2.  Select the page to you want to navigate.

_Or_
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Use the navigation arrow buttons to browse through the available pages.
Export publishing pages to HTML
1. Choose File - Save as Web Page.
Teamcenter displays the Save As dialog box.
2. Type a name for the exported file and click Save.
Teamcenter displays the Save as Web Page dialog box.
3. Change settings for the following options:

Tab Options Description

General tab Pages to Publish Choose Select All to print all pages or Select
Pages from and then type the page span.

Publishing options Select any of the publishing options, which
appear in the finished Web page to aid
navigation and searching.

Additional options Choose any of the following:
* Automatically open Web page in browser
* Organize supporting files in a folder

* Type text in the Page title box to name the
exported HTML output.

Advanced tab Output formats Select a format for the HTML output.

Provide alternate format Choose a format from the list.
for older browsers

Target monitor Choose the monitor size.

Host in Web page Select a Web page from the list or browse to a
file.

Style sheet Select a style sheet from the list or browse to a
file.

4. Click OK.

Teamcenter displays the publishing pages as a Web page in your default browser.
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Export publishing pages to PDF

You can print a portfolio to PDF in My Teamcenter. Before you do this, you must install third party
software capable of creating PDF output.

1.  Create a portfolio.

2. Open My Teamcenter.

3. Inthe File menu on the viewer tab, choose Publish PDF to Database.
About portfolios

Portfolios act as a container for work instructions or product manuals and supporting documents,

such as a table of contents, cover or trailer pages, and header and footer information. Portfolios may
contain a reference to a publishing page or generic page or to an embedded generic page. You can use
portfolios to store document structure information, print multiple publishing pages, and export portfolio
contents to HTML or PDF.

You generate portfolios in Manufacturing Process Planner, Part Planner, Multi-Structure Manager, Service
Planner, or Plant Designer. You manage portfolios in My Teamcenter only.

When managing a portfolio:

* Use container nodes to add an organizational hierarchy to the portfolio. Think of container nodes as
chapters in a book, in which you can separate and group documents. Container nodes are useful for
multiple levels in the table of contents.

* During printing operations, Teamcenter creates the table of contents information in a dynamic page.

* Create generic pages for any information page to add to the portfolio, such as cover or trailer pages.
Generic pages are not considered publishing pages and Teamcenter does not apply headers and
footers to them.

» Add header and footer information to portfolios by creating a special page. Teamcenter copies the
shapes in this page to the published pages during printing and export operations. The same header
and footer appears on every page.

* When adding supporting documents to portfolios, choose from the following options:
* Insert Reference
Select a supporting document for the portfolio to reference.

¢ Create
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Add a new supporting document that Teamcenter embeds in the portfolio. You can only create and
embed generic pages.

* Embed
Copy a supporting document into the portfolio.
Create a portfolio

1. Select the BOM line to which you want to associate the portfolio, which may be a configured item
or process revision or occurrence in the structure. The portfolio contains the publishing pages that
are attached to the BOM line’s child lines.

2. Inthe Teamcenter window, choose Tools = Generate Portfolio.
Teamcenter displays the Generate Technical Portfolio dialog box.
3. Inthe dialog box, enter a name and select a role such as Work Instructions and click OK.

Teamcenter creates a portfolio dataset that contains all of the appropriate pages. The portfolio
is created under an intermediate data capture (IDC). If a structure context is opened, the IDC is
attached to the structure context. Otherwise it is stored in the New Stuff folder.

4. (Optional) To view the portfolio, select it in My Teamcenter and click the viewer tab.

Tip:

Note the menu and toolbars in the Graphics view. These commands help you manage
portfolios.

Create container nodes
You can create one or more container nodes in the portfolio in My Teamcenter in the viewer.
1. Select the portfolio Ef] in the Newstuff folder in My Teamcenter.
Teamcenter opens the viewer.
2. Using the menu commands within the Viewer view, do one of the following:
* Choose Actions - Create and select Container Node.

* On the Technical Portfolio toolbar, click the Create container button ®,.
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Create the table of contents
You can create the table of contents for a portfolio in My Teamcenter in the viewer.
1. Select the portfolio Efl in the Newstuff folder in My Teamcenter.
Teamcenter opens the viewer.
2. Using the menu commands in the viewer, do one of the following:
* Choose Actions - Create and select Table of Contents Placeholder.
* On the Technical Portfolio toolbar, click the Create table of contents button [F.
Add a generic page
You can add a generic page to a portfolio in My Teamcenter in the Portfolio pane.
1. Select the portfolio B in the Newstuff folder in My Teamcenter.
Teamcenter opens the Portfolio pane.
2. Select an area to place the generic page.
3. Using the menu commands within the Portfolio pane, do one of the following:

¢ Choose Actions = Create, Actions = Insert Reference or Actions - Embed, and select
Generic Page.

Note:

You cannot search using the classification search if working in My Teamcenter.

* On the Technical Portfolio toolbar, click the Create generic page button .
Add a new page in My Teamcenter

When you edit a portfolio in My Teamcenter, you can insert pages by choosing the Insert
Reference->Technical lllustration or Generic Technical lllustration menu commands. In the resulting
dialog box, the Classification search button is not available. To use the Classification search, you must
send the portfolio to Manufacturing Process Planner.

* If you created the portfolio using the Generate Portfolio menu command:

1.  Select the portfolio in My Teamcenter and send it to Manufacturing Process Planner.
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2. Open the Collaboration Context view and expand the portfolio intermediate data capture.

3. Right-click the portfolio and choose Open With—>Viewer.

Wark Instru ctinnm

File Actions ToolBars

_!...J@ EE D=

Page
— [0 portfolio_001

4. Choose Actions—Insert Reference—>Technical lllustration or Generic Technical lllustration.

The Classification search is available.

* If you do not generate the portfolio from the menu command, you can view the portfolio in
Manufacturing Process Planner as follows:

1. Create an item.
2. Copy the portfolio dataset and paste it to the item revision.
3. Send the item revision to the Manufacturing Process Planner application.

4.  Open the Collaboration Context view and proceed as above. You can copy the dataset from

the Classification Search Dialog to the clipboard and paste it into the portfolio dataset in My
Teamcenter.

Create a header and footer page

You can create a header and footer page in a portfolio in My Teamcenter in the viewer. Teamcenter

copies the shapes in this page to the published pages during printing and export operations. The same
header and footer appears on every page.

1. Select the portfolio Efl in the Newstuff folder in My Teamcenter.

Teamcenter opens the viewer.
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8.

Select an area in the portfolio to place the header and footer page.
Using the menu commands within the viewer, do one of the following:

¢ Choose Actions = Create, Actions - Insert Reference or Actions - Embed, and select
Header/Footer Definition Page.

¢ On the Technical Portfolio toolbar, click the Create header/footer data button ).
Teamcenter opens a new viewer window with a blank page.

Using the commands in the new window, choose t Insert = Portfolio Export Tag and select one of
the following:

* Date

* Long Date

* Document File Name

* Portfolio File Name

* Pages

* Total Number of Pages

Teamcenter creates a placeholder for the object on the page.

Move the placeholder to the desired position.

When you have placed all desired export tags, choose File - Post to Technical Portfolio.
Click Close.

In the viewer, click File = Save.

Modify header and footer information

1.

Select the portfolio Bfl in the Newstuff folder in My Teamcenter.
Teamcenter opens the viewer.
Right-click the header and footer page in the portfolio tree and choose Open.

Make any necessary changes.
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4. Choose File = Post to Technical Portfolio.

5. Click Close.

6. Inthe viewer, click File - Save.

Add a work instruction

1. Select an area in the portfolio to place the work instructions.

2. Do one of the following:
* Choose Actions - Insert Reference and select Technical lllustration.
* On the Technical Portfolio toolbar, click the Technical Illustration button.
The system displays the Insert Page dialog box.

3. Click the Find a page by name button and type the name of the work instruction that you want to
add.

4. Click Open. The work instruction you chose appears in the tab.
Publish a portfolio to HTML

You can publish a portfolio on a Web server by exporting its contents in HTML format. This allows
consumer users access to work instructions or product manuals from any Web browser.

1. Choose File = Publish Zip to Database.
The system displays the Publish to HTML Options dialog box.
2. Edit the export options in these ways:

Tab Options Description

General tab Destination Folder Specify the destination folder where the
export data is written by clicking Save.

Note:

Specifying the destination folder is
the only required selection in this
dialog box. All other options in
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Tab

Export
Options tab

Options

Create zip file

Use title page
template

Replace or remove
logo

Stop if error occurs

Produce flat output

Publishing options

Description

this dialog box are discretionary
selections.

Create a ZIP file of all export data. Click the
Browse button to specify the location of
the ZIP file. Use this option to allow users
without access to Teamcenter to view the
data.

Use a template file for the main HTML title

page. Click the Browse button to choose
the HTML file.

By default, the HTML output includes the
Siemens Digital Industries Software logo.
To replace the default Siemens Digital
Industries Software logo graphic, click the
Browse button to locate a replacement
graphic. To remove the default Siemens
Digital Industries Software logo graphic,
click the Remove button.

Stop the export operation if an error is
encountered.

Remove the portfolio structure and
document hierarchy.

Indicate specific control panes to be
included in the HTML output for each
published page.

* Choose Show Details to display custom
shape properties.

* Choose Go to Page to include navigation
for multi-page work instructions or
product manual.

* Choose Search to enable the ability to
search shapes.

* Choose Pan and Zoom to enable
panning and zooming on a page.
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Tab Options Description

Note:

The Publishing Options option is
only applicable if you select VML
for the Output format (VML is the
default). VML output only displays
Publishing Options if you use the
Internet Explorer browser.

Advanced Output formats Choose the primary output format for the
Options tab exported published pages.
Provide alternate Indicate a secondary output format for
format for older exported published pages, used for older
browsers browsers.
Display options Select a target monitor size.
3. Click OK.

The Report Definition wizard displays the status of the export operation.

Note:

Name lists the supporting documents in the portfolio; Status indicates if the supporting
documents were exported.

4.  Click Next.

The system displays the Create Report Output dialog box.
5. Create a standard or custom report output format.
Publish a portfolio to PDF

You can create a PDF file from the portfolio that is attached as a dataset provided you have Microsoft
Office installed.

1. Select the portfolio B in the Newstuff folder in My Teamcenter.
Teamcenter opens the viewer.

2. Using the menu commands in the viewer, choose File = Publish PDF to Database
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Teamcenter creates the PDF and attaches it to the portfolio dataset. You can view it in the viewer.
Creating manufacturing documentation in batch mode overview

You can create and update Teamcenter work instructions and portfolios in batch mode, processing
multiple documents using the Teamcenter Publish Batch dialog box. You do not need to process
individual documents manually. You can schedule these tasks to take place immediately or at a later
date.

Batch processing uses the Dispatcher infrastructure for scheduling create and update features.
Additionally, Dispatcher has built-in status, logging, and error reporting features.

You must set up the batch processing in the Manufacturing Process Planner or Multi-Structure Manager
applications. You can use My Teamcenter to modify the scheduling of the batch process.

Creating textual work instructions using standard text

Authoring work instructions

Authoring work instructions overview

You can write new work instructions, or edit existing work instructions in the Textual Work Instructions
view if the access control list permits. Work instructions are associated with operations or processes in a
process structure.

The Textual Work Instructions view opens in view mode (read-only). When entering edit mode,
Teamcenter checks out the operation or process and enables editing. When exiting edit mode,
Teamcenter checks in the operation or process and filters out editing. If you want to edit the work
instructions on multiple operations, you can check them out manually before you begin. This decreases
the time it takes to edit each individual work instruction.

If this is the first editing session for the current work instructions document, Teamcenter loads the work
instructions template, as defined in the MEWiWorkInstructionTemplate preference.

You can double-click the work instructions preview datasets in the Teamcenter Attachments view to
open them in their associated applications. For example, if the preview file is stored in PDF format, it
opens in a PDF reader.

The preview file is in one of the following formats: PDF, MHT, DOCX, or RTF, as configured in the
MEWiPreviewFormat preference.

All editing changes take effect only after you perform a Save operation. For example, if you search
for a text snippet in the Structure Search view, your search only returns results for already saved text
snippets.
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When adding standard text elements (from a standard text library) to work instructions documents
(associated with operations or processes in a process structure), ensure that both the library structure
and the process structure have the same configuration rule. If the configuration rule of the library
structure and the process structure are different, you may be adding data with the incorrect revision. In
this case, Teamcenter issues a message to inform you what has happened.

The following figure displays a process structure and a standard text library structure. The two views
on the right are the Textual Work Instructions view displaying the work instructions document of an
operation, and beneath it the Standard Text view displaying a preview of a standard text element.
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Activate the textual work instructions editor
Activate the textual work instructions editor in one of the following ways:
¢ Choose Window-Show view-Textual Work Instructions.

* Right-click an operation or process in the process structure and choose Open with->Textual Work
Instructions.

* Right-click an operation or process in the Result pane of the Structure Search view and choose Open
with->Textual Work Instructions.
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Edit work instructions

When you select an operation or a process in the process structure, Teamcenter displays the preview
file associated with the selected operation or process. If no preview file is defined, the Textual Work
Instructions view displays the following message:

No preview file is avail able
* Click Edit g* .

When entering edit mode, Teamcenter checks out the operation or process, updates property
controls, and enables editing. You can now begin editing the work instructions document.

Tip:

If you edit multiple work instruction documents and want to decrease the time it takes to open
each individually for edit, check out all the owning processes or operations manually before

clicking Edit ‘?

When editing work instructions, you can add and remove content of standard text, text, and data
collection definitions. Teamcenter applies all the changes after you click Save [5].

Note:

* Typically, you can use standard text for many of the steps of your work instructions
document. Supplement these with text and data collection definitions to create a complete
work instructions document.

 If the administrator adds operation or process properties to the template, these are visible in
the document header. You cannot edit them.

Add text

Click anywhere in the document and write the new text. After performing a Save operation, Teamcenter
captures the text in a text control and links it to the database. The text becomes searchable and
localizable in Teamcenter. If you wish the text to remain in the body of the document and not in a text
control, set the METWICreateTextControlsOnSave preference to False.

Add a symbol

You can add symbols to the work instructions document. The symbols appear in the document in the
symbols section.
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Note:

By default, adding and removing symbols is enabled in the Standard Text view. If you do not use a
standard text library, your administrator can move these buttons to the Textual Work Instructions
view.

1.  Click anywhere in the Textual Work Instruction view.

The Teamcenter focus returns to the view.
2. Click Add symbol g3

Teamcenter displays the Add Symbol dialog box listing all the symbols (contained in Work
Instructions Symbol datasets) in the database. If you manage symbols in a folder structure, this
structure is reflected in the Add Symbol dialog box.
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Fo

i Add Symbol

type filter text

H EarProtection
& FaceShield

Ei GazMask

ﬂ Goggles

m HandProtection
E Mazk

E SafetyBoots
A safetyHelmet

| ok

J

Apply

|| cancel

3. Do any of the following:

* Enter any part of the name of the symbol for which you are searching in the search box.

Teamcenter automatically filters search results as you type.

* Browse through the results by selecting each symbol in the list and viewing the thumbnail in the

right pane.

* Click 55 to switch to the thumbnail view where you can view all symbols.
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& Add Symbal

type filter text

Mask

SafetyBoots SafetyHelmet

4. Select one or multiple symbols and click OK to close the dialog box or Apply to add the symbol but
leave the dialog box open for further selection.

Teamcenter adds the desired symbols to the symbol section in your document.
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Note:

Teamcenter always adds symbols to the symbol section. It does not matter where the
cursor is when performing the Add symbol operation.

You may select multiple symbols and add them with a single Add symbol operation.

You cannot insert a particular symbol more than once.

After performing this action, you cannot undo any previous actions (the Undo list is

cleared).

Remove a symbol

* In the document, select the symbol you want to remove and click Remove symbol E:

Note:

By default, the Add Symbol and Remove Symbol buttons are located in the Standard Text
view. If you do not use a standard text library, your administrator can move these buttons to the
Textual Work Instructions view.

Teamcenter removes the symbol.

Note:

After performing this action, you cannot undo any previous actions (the Undo list is cleared).
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Add a data collection definition

You add a data collection definition to the document. This contains an instruction to perform data
collection on the shop floor. You can also define the required properties for the new data.

For example, if you require production workers to note a torque value, you can use text followed by a
data collection definition.

i Text |
Record torque value: l

i torque |

Note:

Data collection definitions are not visible in the Teamcenter structure.

1. Place your cursor at the location at which to add the data collection definition and click New dcd
_-:r-f

=

The New Data Collection Definition wizard is displayed.
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-

@ Mew Data Collection Definition

Data Collection Definition Type
Proceed to create an object of selected type.

i 4 Most Recently Used
a =] Complete List
5 Boolean Data Collection
o Buyoff Data Collection
—, Duration Data Collection
5 Irnage Data Collection
5 Integer Data Collection
5 Procedure Completion Data Coellection
IE Real Murnber Data Collection |
5 String Data Collection
5 Tirne Stamp Data Collection

< Back Mext =

Einish

Cancel

The following data collection definition types are available:
* Boolean

* Buyoff

* Duration

* Image

* Integer

* Procedure Completion

* Real Number

* String Data

* Time Stamp
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¢ List of Values

All the data collection definition types can be user-customized and are automatically supported by
the editor.

Select the type of data control definition or type it and click Next.

The Data Collection Definition Create Information wizard is displayed.
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. N
@ Mew Data Collection Definition E@g

Data Collection Definition Create Information

Define the information for the creation of a Data Collection Definition @

I Real Number Data Collection

Real Mumber Data Collection Information

= Properties (required)

Mame:™ Torgue Value
Description:
Iz Optional: (71 True @ False

Mumber Of Decimal Places: 2

Minirnum Allowed Value:

Maximum Allowed Value:

Alert Minimurn Value:

Alert Maximum Value:

Caution Minimum Value:

Caution Maxirnurm Value:

Out-0f-Range Behavior: -
Data Acquisition Method: -

Placeholder String:

Next > [ Einish ] ’ Cancel

3. Enter the attributes for the new data collection definition and click Finish.
* Name is required; all the other attributes are optional.

* The Placeholder String property holds the characters to be displayed in the document. If this is
left empty, ... (an ellipsis) is displayed in the standard text document.
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* The default value for Is Optional is False. This means that the data collection definition is not
optional and a measurement must be recorded. You can set Is Optional to True to make the data
collection definition optional.

The new data collection definition is displayed in your document.

Note:

You cannot copy data collection definitions.

Data collection properties

In addition to the Name, Description, Is Optional, and Placeholder String properties that each data
collection type possesses, most data collection types have additional properties, except for Boolean
Data Collection and Duration Data Collection.

The following table lists the additional properties and the data collection definition types that include
them.

Property Data collection definitions

Time format Time Stamp, Procedure Completion, Buyoff

Allow characters String

Maximum length String

Minimum allowed value Integer, Real Number

Maximum allowed value Integer, Real Number

Caution minimum value Integer, Real Number

Caution maximum value Integer, Real Number

Alert minimum value Integer, Real Number

Alert maximum value Integer, Real Number

Number of decimal places Real Number

Out-Of-Range Behavior Integer, Real Number, Image

Data Acquisition Method Integer, Real Number, Image
Note:

An administrator can add the List of Values type as a customized type when he or she sets up
standard text.
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View and edit properties

You can view the properties of a data definition collection, planner input field, or standard text
document.

» Select a data definition collection, planner input field, or standard text document and click Properties

The Properties dialog box appears.

i Properties ﬁ

Mame: Torque Value
Description:
Is Optional: () True @ False

Murmber Of Decimal Places: 2

Minirmum Allowed Yalue:

Maximumn Allowed Value:

Alert Minirmurm Value:

Alert Maxirnum Value:

Caution Minimum Value:

Caution Maxirmurm Yalue:

Out-0f-Range Behavior: d
Data Acquisition Method: o7

Placeholder String:

| ok || cancel

A data definition collection can appear in the current textual work instructions document in one of two
ways:

* Directly inserted into the current textual work instructions document—all the properties are editable.
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* As part of the content of standard text that you added to the textual work instructions document—
some properties are not editable, as defined in the MEWiDcdNotEditableProperties preference.

Note:

* For data collection definitions added to your work instruction document as part of a standard
text, the MEWiDcdNotEditableProperties preference lists the properties that are not editable
for each data collection definition type.

* The default value is Placeholder. The administrator can delete this value to enable editing
the Placeholder value.

* The administrator can delete the values for a specific data collection definition type.

» |If the MEWiDcdNotEditableProperties preference for a specific data collection definition
type is empty, all its properties are editable. If, however, the preference for a derived data
collection definition type is empty, the preference inherits properties from its basic data
collection definition type ancestor.

* You can add other properties to the MEWiDcdNotEditableProperties preference to protect
them.

* You can edit the Placeholder String property by typing in the document without accessing
the properties of the data collection definition. To complete the change, click anywhere in the
document outside the data collection definition.

All the planner input field properties in the Textual Work Instructions view are read-only except for
Value and Skip Validity Check.

Teamcenter enables you to omit the validity check for a planner input field. This is useful, for example,
in an incremental drilling process. The process requires drilling a hole of a specific diameter and then
drilling again to increase the diameter to a very accurate value. The result of the initial drilling operation
does not meet the requirements noted in the planner input fields. The result of the subsequent drilling
operation does, however, meet the requirements. In this case, it is desirable to skip the planner input
field validity check for the initial drilling operation.

If you set Skip Validity Check to true, Teamcenter omits all the validity checks except for the following:

* String length - If the length of the Value you entered exceeds the Maximum Length for the planner
input field, Teamcenter issues a warning that the string will be truncated when you save the planner
input field. You can either proceed or edit the string.

* If Is Optional is set to False, Teamcenter performs all validity checks on the planner input field even if
Skip Validity Check is set to true.
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Remove a data collection definition

* Select the data collection definition and press the Delete key.

Note:

If the data collection definition is embedded in the content of standard text that you added to
the textual work instructions document, you cannot delete it.

Add reference

You can link text in your textual work instructions to datasets or product views. For example, you can
instruct the operator to read a safety instructions document and provide a link to the dataset containing
that document. You can instruct the operator to measure a particular dimension on a part and provide a
link to the product view displaying the part with the dimension emphasized.

1.  Select one of the following to be the target for the new reference:
* Dataset in the Attachments or Search Results view.

* Product view in the Attachments view or Product View Gallery.

Note:

* If the Product View Gallery is visible, the system uses the product view from the gallery
even if you have selected product views in the Attachments view or Search Results
view.

* The product view must be attached to the current process (or a process nested under
the current process).

* If you select an item that is neither a dataset nor a product view, the system returns an
error.

2. Place your cursor at the location in which to create the new reference.
3. Click Add Reference i=*.

A content control is added to the document referencing the dataset or product view.
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If you select text before invoking the command, the reference is created with the selected text. If
no text is selected, the reference displays the name of the referenced dataset or product view.

4. If you wish to change the text of the reference, use the keyboard to place your cursor in the content
control and edit the text. Even though you have changed the text of the reference, it still links to
the same target.

Note:

You cannot change the referenced target. If you need to do this, delete the reference and
create a new one.

Activate reference
Do one of the following:
* Click the reference and click one of the following:
* For a referenced dataset, click Open Referenced Object *
* For a referenced product view, click Apply Referenced Product View .

¢ Double-click the reference.

The target document opens in its native application. If the target is a product view, the graphic view
refreshes and displays the target image.
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Add standard text

You can insert the content of standard text to your textual work instructions document to compose a
procedure.

1.  Select a standard text element in the library structure or the Search view.

2. Place your cursor at the location in the textual work instructions document at which to add the
standard text and click Add standard text document g

The standard text content is added to the textual work instructions document. The text is embedded in
a text control, named after the source standard text element and is not editable. If the source standard
text element contained symbols, these are added to the symbol section of the textual work instructions

document. A specific symbol only appears once even if it is associated with more than a single source
standard text element.

It is also possible to add data collection definitions and planner input fields to the textual work
instructions document.

Note:

* You cannot copy standard text. If you attempt to do this, Teamcenter returns an error message
and clears the undo stack.

» Standard text elements are not visible in the process structure.

* Ensure that the configuration rule applied to the library structure is the same as that applied
to the process structure. This ensures that you add the same content to the textual work
instructions document as that which you viewed in library.

* If adding the standard text document causes the addition of a symbol to the textual work
instructions document, Teamcenter clears the undo stack.

Remove standard text

* Click the standard text document and press the Delete key.

Note:

* Teamcenter also removes symbols associated with the standard text element from the textual
work instructions document.

* If a symbol is associated with more than one standard text element, Teamcenter retains it in the
textual work instructions document.
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e Teamcenter clears the undo stack. |

Finding invalid planner input fields

If there are invalid planner input fields in your standard text document, it can be a tedious task to locate
them and correct the problem. This may occur if, for example, a new revision has come into use where a
property has been updated. Even if there are invalid planner input fields in your standard text document,
Teamcenter enables you to save your work. When you next open the document, Teamcenter issues a
message that there are invalid planner input fields.

Find invalid planner input fields
1.  Click the Validate PIF button &

The Find Invalid Planner Input Fields dialog box appears.

& Find Invalid Planner Input Fields 5

Value: | 178.005 ET

Details: | 1.Value should be less than or equal to Maximum Allowed Value,
2.The number of decimal places used in the Value should not exceed the permitted limit.

< Previous ] [ MNewxt = ] [ Close

Note:

If there are no invalid planner input fields, Teamcenter issues a message instead of opening
the dialog box.

2. Click the Properties button and fix the invalid planner input field as required.

The Details section displays Valid to indicate that you have fixed the current invalid planner input
field.

3. Click Find Next and fix the next invalid planner input field as many times as necessary.

Note:

Teamcenter allows you to save and close the current document and continue fixing invalid planner
input fields in your next work session.
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Save changes
* Click Save J_.] to save the current changes in your document.

Teamcenter saves the document and updates the preview document.

Discard changes

* Click Discard changes E:j to discard your current work and reload the last saved version of the

document.
Set the scope

In edit mode, you can change the editing focus from the current document to another document (the
new scope) without exiting edit mode.

1. Click the desired element in the structure.
2. Click Set scope k "'}

If there are unsaved changes in the current document, Teamcenter prompts you to save them
before exiting the current document.

Teamcenter closes the current document, checks out the target operation or process, and loads the
target document. You can now begin editing the target document.

Note:

The Set scope command does not work if any of the following conditions apply:
* The target scope is not an operation or process.

* You do not have permission to edit the target scope, as defined by the access control list in
Access Management Using Rules and ACLs.

About creating textual work instructions using standard text

Teamcenter enables creating textual work instructions using standard text as building blocks. These
textual work instructions are associated with operations or processes in the process structure.

The standard text library is a Teamcenter structure comprised of standard text folders and standard text
elements nested under the folders. Standard text content is associated with standard text elements by a
specific type of dataset and is accessible in the Teamcenter Attachments view.
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The benefits of standard text include:
 Standardization and consistency of textual work instructions throughout the entire organization.

* Managing standard text content. Standard text enables you to write once only and reuse the same
text many times.

* Easy maintenance of up-to-date textual work instructions when products are upgraded. Make a single
change in a procedure and propagate the change through all the relevant documents.

* Improved accuracy. Textual work instructions are intrinsically connected with the process structure;
they are a textual expression of the manufacturing process.

* Textual work instructions are composed by the planners or engineers who designed the process,
increasing accuracy.

» Standard text is stored in the database, enabling you to search for text by its ID, name, or the text
itself.

* Easy localization.

» Easy transfer of documents between different virtual engineering systems.
Typically, there are three user roles involved in creating textual work instructions:
* Administrator

Responsible for creating and maintaining standard text templates and textual work instructions
templates. The MEWiStandardTextTemplate preference defines the template used for standard text
documents, and the MEWiWorkInstructionTemplate preference defines the template used for textual
work instructions. By default, both preferences are set to the same template. The administrator can
change these templates or create new ones according to organizational requirements. The templates
are in Microsoft Word DOCX format and are associated with a dedicated dataset object.

e Librarian

Responsible for creating standard text libraries, managing standard text folders and elements,
authoring standard text, and creating and managing standard text symbols. Standard text is written in
a generic style so that it can be reused in varying contexts. An example of standard text is a procedure
describing how to mount a wheel on a car and this can be reused in multiple projects. The librarian
uses the standard text editor to write standard text elements and the standard text library interface to
manage them. Additionally, the librarian may use the Teamcenter Search view and Results window
as aids.

* Planner or engineer
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Uses standard text as building blocks to compose work instructions. Planners cannot edit standard
text in the standard text library; however, they may add free text to the work instructions document
associated with an operation or process and edit properties related to the standard text content.
Additionally, the planner may use process structure, the textual work instructions editor, Teamcenter
Search view, and the Results window as aids.

You can use Access Manager to configure various permissions for different roles using access control lists
(ACLs). Siemens Digital Industries Software recommends using the scenario of administrator, librarian,
and planner.

Note:

To use standard text features, Microsoft Word is required. For certified versions, see the Hardware
and Software Certifications knowledge base article on Support Center.

Creating standard text symbols

By default, all standard text and work instructions have a symbol section at the top of the body text
(just below the header). Teamcenter adds symbols to the symbol section (and nowhere else). However,
Teamcenter only adds symbols of the Work Instructions Symbol type.

Librarians can create symbols for use in standard text and work instructions by adding a graphic file to a
symbol dataset in My Teamcenter. You can manage the symbols by creating symbol libraries and folders
and nesting the symbols.

Manage standard text symbols

If you have a large number of standard text symbols, you can create symbol libraries and folders in My
Teamcenter. This enables you to organize your data and facilitates using symbols.

1. In My Teamcenter, select an object to be the parent of the new symbol library or folder and choose
File-*New-Other.

The New Business Object dialog box appears.
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F "
& New Business Object E@g

Business Object Type
Proceed to create an object of selected type. @

syrmbol - 4

#= Most Recently Used
a =] Complete List
2 Work Instructions Symbol
=) Work Instructions Symbol Folder
=1 Work Instructions Symbaol Library

< Back Next > s

Select Work Instructions Symbol Library or Work Instructions Symbol Folder and click Next.

Alternatively, type symbol in the search box. The New Business Object dialog box filters the
objects and displays only symbol types.

The Object Create Information dialog box appears.
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F '1
% MNew Business Object SN
Object Create Information
Define business object create information @

iz Work Instructions Symbol Library

Work Instructions Symbol Library Information

+ Properties (required)

Marme™ Work Instructions Symbols
Description:
Relation | Contents - Open On Create

Meut = [ Einish ] ’ Cancel

3. Type a name in the Name box, enter other optional attributes, and click Finish.

Teamcenter displays the new symbol library or folder under the selected object in My Teamcenter.

Create a standard text symbol

1. In My Teamcenter, select an object to be the parent of the new symbol (for example, symbol folder)
and choose File-»New-Dataset.

The New Dataset dialog box appears.

8-50



Create a standard text symbol _

F B
ﬁ MNew Dataset u

Mame: | piack ¥|

Description:

Wark Instru...

Tool Used: | JPEG Tool -

Import: JPEG_Tool
GIF Toaol | E]

Relation [TIF Tool -

PMG_Tool
PV

["] Open On Create

Lok | [ aepy || Cancel |

2. Select Work Instructions Symbol on the left side of the dialog box.
3. Type a name in the Name box, and enter other optional attributes.
4.  Click the browse button next to the Import box.

The Upload File dialog box appears.
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"' ™
% Upload File (S
Look in: . temp ': 2l
T ™ EarProtection.jpg Parameters
= ™ FaceShield,j .
"’uy ™ Goggl Jpépg File Type: Binary
Recent Items aggles. o .
™ HandProtection.jpg Reference: [esIpG =
; e
™ Mask,jpg

! ™ MNoFirejpg

Desktop ™ Respiratorjpg
™ SafetyBoots,jpg

Mes0BMP

Mes0GIF

I; ™ SafetyHelmet,jpg Eej:_[f‘;ﬂ
e
My
Documents
¥
Computer

e
Qg File name: Mask.jpg oo
Network Files of type: | MesdIPG (jpg) *)

5. From the Reference list, select the desired file format.

The Work Instructions Symbol dataset can contain graphic files of the following formats: BMP,
JPG, GIF, PNG, and TIF.

Teamcenter displays the selected format in the Files of type list and filters the display accordingly.

6. Navigate to the desired symbol file and click Import.

Note:

Only a single file should be imported per dataset.

The Import box contains the imported file name.

7.  Select a tool from the Tool Used list according to the reference type of the imported file:

Reference type Tool used
BMP PV

JPG JPEG_Tool
GIF GIF_Tool
PNG PNG_Tool
TIF TIF_Tool
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8. Click OK.

Teamcenter creates the symbol dataset.

Note:

After creating the dataset, you can double-click it to launch the tool and display its image.

Creating standard text library structure

A standard text library object is a Teamcenter structure and is the root of a hierarchical structure
comprised of standard text folders and standard text elements.

Each standard text element can be associated with specific content comprised of text, data collection
information, and symbols. Following is an example of a standard text library structure and the standard
text editor displaying a preview of specific standard text content.

=0 StandardText ke =0
&~ || 2 7
002117/A:1-Goggles o

B 002106-5Standard Text Library X

v @ DT (D)

%, Latest Working & Today W, Mot Specified '5."?\ Mot Specified

»

BOM Line | Is Standard Text Ele...
) 002106/4;1-5tandard Text Library (View)
-7 002107/A;1-Fasteners (View)
23 002110/8:1 -Rivets (View)
(B 002112/A:1-Wrench True
' ----- Eig 002113741 -5crew Driver True —
[ 002114781 -Run Down True Use goggles when performing this action. E
-0 0021117801 -Screws (View)
-0 002108 /4,1 Safety (View)
& 002116/ A;5-Ear Protection True
- By
& 002118/A;1-Face Shield True
& 002119/A;1-Hand Protection (Heat) True i
& 002120/A:1-Hand Protection (Frost)  True
[ 00212178, -Mask True
E,i 002122/4;1-Respirator True
[ 002123/4;1-Safety Boots True
[ 002124781 -Safety Helmet True
[ 002125/4;1-Fire Safety True
G-I0F) 0021094401 - General (View)
< | 11 | 3 ] (1]

Standard text elements are revisable.

Note:

You can add standard text library structures to collaboration context objects.
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You can use Manufacturing Process Planner or Part Planner to create standard text libraries, folders,
and elements. You can use the standard text editor to edit standard text and then use the textual work
instructions editor to insert the content of the standard text to create work instructions.

Create a standard text library

1. Choose File-*New->Standard Text-»Standard Text Library.

The New Standard Text Library wizard is displayed.

i h
Q Mew Standard Text Library u

h Standard Text Library

@ Select the Standard Text Library type that you want to create.

Select Type
Enter Standard Text Libr
Enter Additional Standa
Enter Additional Standar
Enter Attach Files Inforr
Define Workflow Inform
Enter Identifier Basic Infi
Enter Additional ID Infor
Enter Additional Rev Infi
Assign to Project object:
Define Optiens

A R R RERE ERY

4 Back ' Finish & Home

2. Select the library type and click Next.

The New Standard Text Library basic information window is displayed.
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i N
Q Mew Standard Text Library M

.{_" Standard Text Library
Li; Define the basic information for the new Standard Text Library.

@ Select Type Standard Text Library Information

¥ Enter Standard Text 1D/ Revision - Name

@ Enter Additional Standa 002075 * N ¥ Standard Text Library ¥ Assign
@ Enter Additional Standar -

@ Enter Attach Files Inforn Lkl SR 15

i@ Define Workflow Inform | Description:

@ Enter Identifier Basic Infi

W Enter Additional ID Infor

@ Enter Additional Rev Infi | Unit of Measure: ||

@ Assign to Project object:

@ Define Options

| 4 Back | [ Nex ) | | ¥ Finish || 2 Home || ® Close |

3. Type entries for the following mandatory boxes: ID, Revision, and Name.
4. Click Next to add optional parameters or Finish to create the new standard text library.

The application displays the new standard text library as a new root. This is a structure context with the
standard text library at its root.

Create a standard text folder

1. Select a standard text library or folder and choose File-*New-»Standard Text-»Standard Text
Folder.

The New Standard Text Folder wizard is displayed.

8-55



_ 8. Process documents and work instructions

i N
ﬁ Mew Standard Text Folder u

[@ Standard Text Folder

E] Select the Standard Text Folder type that you want to create.

Select Type
Enter Standard Text Fold
Enter Additional Standar
Enter Additional Standai
Enter Attach Files Inforn
Define Workflow Inform
Enter Identifier Basic Infi
Enter Additional ID Infor
Enter Additional Rev Infi
Assign to Project object:
Define Options

A E R R ERER E'RY

| 4 Back | ’ MNext | l | W& Finish || & Home || ®Ciose |

2. Select the folder type and click Next.

The New Standard Text Folder basic information window is displayed.

r h
% Mew Standard Text Folder u
[% Standard Text Folder
_ @ Define the basic information for the new Standard Text Folder.

Select T
@ Selec yPe Likrary Information
-3 Enter Standard Text ID / Revision - Name
g Enter Additicnal Standar |UUZD88 *| / |A *| ) |Faster1ers ak-| |£\55ign|
Enter Additional Standal
@ Enter Attach Files Inforn Ll e B
i@ Define Workflow Inform | Description:
@ Enter Identifier Basic Infi
@ Enter Additional ID Infor
@ Enter Additional Rev Infi |Unit of Measure: =]
@ Assign to Project object:
@ Define Options
[ 4 Back ] ’ Mext | l ’ 'ﬁFinish H % Home ” @Ciose ]

3. Type entries for the following mandatory boxes: ID, Revision, and Name.

4. Click Next to add optional parameters or Finish to create the new standard text folder.
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Teamcenter displays the new standard text folder nested under the selected standard text library or
folder.

Create a standard text element

1. Select a standard text library or folder and choose File*New->Standard Text-Standard Text
Element.

The New Standard Text Element wizard is displayed.

i h
ﬁ Mew Standard Text Element M

Standard Text Element

@ Select the Standard Text Element type that you want to create.

Select Type
Enter Standard Text Elen
Enter Additional Standar
Enter Additional Standai
Enter Attach Files Inforr
Define Workflow Inform
Enter Identifier Basic Infi
Enter Additional ID Infor
Enter Additional Rev Infi
Assign to Project object:
Define Optiens

A S E R REERRRY

4 Back Mext P W& Finish & Home

2. Select the element type and click Next.

The New Standard Text Element basic information window is displayed.
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i N
Q Mew Standard Text Element u

Standard Text Element
@ Define the basic information for the new Standard Text Element.
@ select Type Standard Text Element Information
¥ Enter Standard Text 1D/ Revision - Name
@ Enter Additicnal Standar 002002 * (A * _ Wrench ¥ Assign
@ Enter Additional Standai -
@ Enter Attach Files Inforn Lkl SR 15
i@ Define Workflow Inform | Description:
@ Enter Identifier Basic Infi
W Enter Additional ID Infor
@ Enter Additional Rev Infi | Unit of Measure: [=]
@ Assign to Project object:
@ Define Options
| 4 Back | [ Nex ) | | ¥ Finish || 2 Home || ® Close |

3. Type entries for the following mandatory boxes: ID, Revision, and Name.
4. Click Next to add optional parameters or Finish to create the new standard text element.

Teamcenter displays the new standard text element nested under the selected standard text library or
folder.

The following figure displays a standard text structure.
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g 002106-Standard Text Library X w BER[ZAFT RV =0
% Latest Working %) Today T Not Specified #% Not Specified
| BOM Line Is Standard Text Element Active | Item Type
Il; 002106/4;1-5tandard Text Library (View) Standard Text Library
EI@ 002107/4;1-Fasteners (View) Standard Text Folder
E—J@ 002110/ 4:1-Rivets (View) Standard Text Folder
----- Ei-‘ 002112/4;1-Wrench True Standard Text Element
----- Ei-‘ 002113/4;1-5crew Driver True Standard Text Element
(. Ei-‘ 002114/4;1-Run Down True Standard Text Element
EJ"@ 002111741 -5crews (View) Standard Text Folder
E—:I@_'- 002108/ A;1-5afety (View) Standard Text Folder
[i* 002116/4;5-Ear Protection True Standard Text Element
[i* 002117/4;2-Goggles True Standard Text Element
[i* 002118/4:1-Face Shield True Standard Text Element
[i* 002119/4:1-Hand Protection (Heat) True Standard Text Elerment
[i* 002120/4:1-Hand Protection (Frost)  True Standard Text Elerment
[i* 002121 /4.1 -Mask True Standard Text Element
[i* 002122/4:1-Respirator True Standard Text Element
[i* 002123/4;1-5afety Boots True Standard Text Element
[i* 002124 /4;1-5afety Helmet True Standard Text Element
[i* 002125/4;1-Fire Safety True Standard Text Element
EJ--@ 002109/A;1-General (View) Standard Text Folder
1| 1l 3

Getting started with standard text editor

You can locate standard text libraries using My Teamcenter or with the Teamcenter Search view and
send them to Manufacturing Process Planner or Part Planner.

The following items are associated with each standard text element (after adding text to it and saving
it):

s Preview file

When you click the standard text element, the standard text view displays a preview. Preview files
are in one of the following formats: PDF, MHT, DOCX, or RTF, as defined in the MEWiPreviewFormat
preference. The preview file is updated with the latest information you entered in the standard text
document.

Note:

Preview files in MHT format do not display the headers and footers.

The preview file is not visible in the library structure. However, you can double-click it in the
Teamcenter Attachments view to open it in its associated application. For example, if the preview
file is stored in PDF format, it opens in a PDF reader.

¢ Document
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When you enter edit mode, Teamcenter closes the preview file and loads the live standard text
document. All the data you enter is stored in this file.

The standard text document is not visible in the library structure.

View standard text content

1. In My Teamcenter, right-click the standard text library and choose Send to-*Manufacturing
Process Planner or Send to-»Part Planner.

2. Inthelibrary, right-click a standard text element and choose Open with-Standard Text.

For a new standard text element that does not contain any text, no preview is available; in this
case, the Standard Text pane displays the following message:

No preview file is available

After adding text and saving the standard text element, accessing the Standard Text view opens
and displays the preview file associated with the selected standard text element.

Editing standard text documents

Editing standard text—overview
You can edit standard text when the elements are active and the access control list permits.

When editing standard text, you can add and remove text, data collection definitions, and symbols.

* Click Edit /.

Note:
* Only the librarian is permitted to enter edit mode, as defined in the access control list.
* All editing changes take effect only after you perform a Save operation. For example, if you

employ a standard text query to search for a text snippet in the Structure Search view, your
search only returns the result for an already saved text snippet.

Edit standard text

1. Right-click a standard text element in the standard text library and choose Open with->Standard
text.

The Standard Text view opens and displays the preview file associated with the selected standard
text element. If there is no preview file, the Standard Text pane displays the following message:
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No preview file is available

Edit standard text _

Note:

* When the standard text editor is running in preview mode, y
text element in the standard text library and the preview is a
to display the newly selected element. You can also preview
elements.

ou can select any standard
utomatically refreshed
deactivated standard text

To edit the standard text element, click Edit 5’ }

When entering edit mode, Teamcenter closes the preview, checks
and loads the standard text document. Teamcenter marks the che
symbol.

i 002106-5tandard Text Library X

i @

T Latest Working & Today W Not Specified #» Not Specified

out the standard text element,
cked-out element with the Ef_—,

D% P = o

! BOM Line Is Standard Text Element Active |

Itemn Type

II',_‘ 002106/4;1-5tandard Text Library (View)
L‘—J% 002107 /4:1-Fasteners (View)
-7 002110/ A1 -Rivets (View)

- [E 002112/A1 -Wrench True
- ----- Eig 002113/4:1-5crew Driver True
REN002114/A:1-Run Down False

-7 002111/ A:1-Screws (View)
-1 002108/ 8:1-Safety (View)
-2 002109/A;1-General (View)

[
£

4 L

Standard Text Library
Standard Text Folder
Standard Text Folder
Standard Text Element
Standard Text Elernent
Standard Text Element
Standard Text Folder
Standard Text Folder
Standard Text Folder

If this is the first editing session for the current standard text element, Teamcenter loads the
standard text template, as defined in the MEWiStandardTextTemplate preference.

You can now begin editing the document.

Note:

* If you have deactivated a standard text document, for example, if
access edit mode.

document.

* When accessing edit mode, the cursor is placed after the last character in the standard text

it is out-of-date, you cannot
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* When exiting edit mode, Teamcenter checks in the standard text element.

Add text

Click anywhere in the document and write the new text. After performing a Save operation, Teamcenter
captures the text in a text control and links it to the database. The text becomes searchable and
localizable in Teamcenter. If you wish the text to remain in the body of the document and not in a text
control, set the METWICreateTextControlsOnSave preference to False.

Add a symbol

You can add symbols to the standard text element. The symbols appear in the document in the symbols
section. When you add the content of a standard text document to a work instructions document,
Teamcenter also adds the symbols of the standard text document to the work instructions document.

Note:

Your administrator may have moved the Add Symbol and Remove Symbol buttons to the Textual
Work Instructions view. If this is the case, you can add symbols directly to a work instruction
document without adding them to a standard text element first.

1.  Click anywhere in the standard text view.

The Teamcenter focus returns to the standard text view.
2. Click Add symbol |1§|

Teamcenter displays the Add Symbol dialog box listing all the symbols (contained in Work
Instructions Symbol datasets) in the database. If you manage symbols in a folder structure, this
structure is reflected in the Add Symbol dialog box.
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i Add Symbol

type filter text

H EarProtection
& FaceShield

Ei GazMask

ﬂ Goggles

m HandProtection
E Mazk

E SafetyBoots
A safetyHelmet

| ok ||  Appy || Cancel

Do any of the following:
* Enter any part of the name of the symbol for which you are searching in the search box.
Teamcenter automatically filters search results as you type.

* Browse through the results by selecting each symbol in the list and viewing the thumbnail in the
right pane.
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- y

& Add Symbal

type filter text

HandProtection Mask

SafetyBoots SafetyHelmet

4. Select one or multiple symbols and click OK to close the dialog box or Apply to add the symbol but
leave the dialog box open for further selection.

Teamcenter adds the desired symbols to the symbol section in your document.
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B3 cop % Can't Red 3 Replace [ Insert Table

3 - b7 - - - 0
[ Paste | @ Quick Print | [ Select W A-Aar | A A
Clipboard Basic Review Insert Font

e _—
=N B, standard Text X Elmma g e L &P =0
—
002117/4:1-Goggles Add Symbol |
It |
General Font Styles & e
# Cut éﬁ Advanced Find ‘? Spelling & Grammar @ Insert Picture  Univers - 11

B I U -abe x, x|

& 002106-Standard Text Library 53
= 2 [@BleF %) 7
‘5 Latest Working T8 Today ) Not Specified ¥ Mot Specified
BOM Line | 15 Standard Tex
i [ 002112781 -Wrench True -
& 002113/4;1-Screw Driver True
[l 002114/A;1-Run Down True B
I3 002111 /401 -Screws (View) =
002108/ AcL-Safety (View)
[ D02116/4;5-Ear Protection True ’
[t 002117/4:3-Goggles True
- By D02118/A;1-Face Shield True
P ae 002119/4:1-Hand Protection (Heat) True <
4| [ | r
< Search Results 57 =g
-] 2 7
General... - Result: Page 1 of 1 objects found
=
a O General... (1)
4[5 Work Instructions Symbols
[F23] Face Shield
[£3] Ear Protection
E23] Goggles
[£3] Hand Protection
] Mask
23] No Fire
‘< L ¢

O RS N I I T N R - S B N R

| ——

Use guggle when performing this action.

I—— Y

W o owd

1} 13

Note:

cleared).

* Teamcenter always adds symbols to the symbol section. It does not matter where the
cursor is when performing the Add symbol operation.

* You may select multiple symbols and add them with a single Add symbol operation.
* You cannot insert a particular symbol more than once.

» After performing this action, you cannot undo any previous actions (the Undo list is

Remove a symbol

* In the document, select the symbol you want to remove and click Remove symbol E:

Teamcenter removes the symbol.

Note:

After performing this action, you cannot undo any previous actions (the Undo list is cleared).

Add a data collection definition

You add a data collection definition to the document. This contains an instruction to perform data
collection on the shop floor. You can also define the required properties for the new data.
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For example, if you require production workers to note a torque value, you can use text followed by a
data collection definition.

{ Text |
Record torque value: l

: torque |

Note:

Data collection definitions are not visible in the Teamcenter structure.

1. Place your cursor at the location at which to add the data collection definition and click New dcd
_-:r-f

g

The New Data Collection Definition wizard is displayed.

r B
E}__.., Mew Data Collection Definition E@g

Data Collection Definition Type
Proceed to create an chject of selected type. @

» 4= Most Recently Used
4 =] Complete List
) Boolean Data Collection
Ef Buyoff Data Collection
5 Curation Data Collection
5 Image Data Collection
) Integer Data Collection
Ef Procedure Completion Data Cellection
g Real Mumber Data Collection
) String Data Collection
) Time Stamp Data Collection

The following data collection definition types are available:

¢ Boolean
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* Buyoff

* Duration

* Image

* Integer

* Procedure Completion
* Real Number

* String Data

* Time Stamp

* List of Values

All the data collection definition types can be user-customized and are automatically supported by
the editor.

Select the type of data control definition or type it and click Next.

The Data Collection Definition Create Information wizard is displayed.
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. N
@ Mew Data Collection Definition E@g

Data Collection Definition Create Information

Define the information for the creation of a Data Collection Definition @

I Real Number Data Collection

Real Mumber Data Collection Information

= Properties (required)

Mame:™ Torgue Value
Description:
Iz Optional: (71 True @ False

Mumber Of Decimal Places: 2

Minirnum Allowed Value:

Maximum Allowed Value:

Alert Minimurn Value:

Alert Maximum Value:

Caution Minimum Value:

Caution Maxirnurm Value:

Out-0f-Range Behavior: -
Data Acquisition Method: -

Placeholder String:

Next > [ Einish ] ’ Cancel

3. Enter the attributes for the new data collection definition and click Finish.
* Name is required; all the other attributes are optional.

* The Placeholder String property holds the characters to be displayed in the document. If this is
left empty, ... (an ellipsis) is displayed in the standard text document.
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* The default value for Is Optional is False. This means that the data collection definition is not
optional and a measurement must be recorded. You can set Is Optional to True to make the data
collection definition optional.

The new data collection definition is displayed in your document.

Note:

You cannot copy data collection definitions.

Data collection properties

In addition to the Name, Description, Is Optional, and Placeholder String properties that each data
collection type possesses, most data collection types have additional properties, except for Boolean
Data Collection and Duration Data Collection.

The following table lists the additional properties and the data collection definition types that include
them.

Property Data collection definitions

Time format Time Stamp, Procedure Completion, Buyoff

Allow characters String

Maximum length String

Minimum allowed value Integer, Real Number

Maximum allowed value Integer, Real Number

Caution minimum value Integer, Real Number

Caution maximum value Integer, Real Number

Alert minimum value Integer, Real Number

Alert maximum value Integer, Real Number

Number of decimal places Real Number

Out-Of-Range Behavior Integer, Real Number, Image

Data Acquisition Method Integer, Real Number, Image
Note:

An administrator can add the List of Values type as a customized type when he or she sets up
standard text.
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Add a planner input field

You can use a planner input field in a standard text document to create generic standard text elements

for repeated use in varying scenarios. This is done by combining text and planner input fields. For
example:

i Text | : Diameter |
Use a drill bit of diam eter] 5 mm'

2 mm

8 mm
10 mm

You can also define the required properties for the new data.

Note:

Planner input fields are not visible in the Teamcenter structure.

1. Place your cursor at the location at which to add the planner input field and click New pif [

The New Planner Input Field dialog box is displayed.
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2P New Planner, Input Field |:I[E

Planner Input Field Type

Select the bype of PRF bo be created @

| &)

= = Complete List
E MesOMEInkegerPFFarm
[ MesOMER=alPFFarm
[ MesOMEStringPFFarm

The following planner input field types are available:
* Integer

* Real

* String

e Customized

Note:

Customized planner input fields require a dedicated style sheet. If this is missing, the New
Planner Input Field dialog box prevents you from proceeding to the next stage.

All the planner input field types can be user-customized and are automatically supported by the
editor.

Select the type of planner input field or type it and click Next.

The Planner Input Field Create Information dialog box is displayed.
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29 New Planner, Input Field |:|@

Planner Input Field Create Information

Define Planner Input Field create information @

MesOMEStringPFForm

15kringPIFINformation!

+ Properties

object_name; * Skring PIF
Skring PIF
ohject_desc:
mes0MaxLength; | 512 |

mes0valueyalidator; | |

[ Einish l [ Cancel

Enter the attributes for the planner input field definition and click Finish.

Name attribute is required; all the other attributes are optional.

The new planner input field is displayed in your document. It displays Name in its title bar.
Click Finish.

Teamcenter performs a validity check on the new planner input field.

Planner input field Teamcenter checks that...

type

Integer The value is not less than the minimum (if defined) and does not exceed the
maximum (if defined).

Real The value is not less than the minimum (if defined) and does not exceed the
maximum (if defined).
The number of fraction digits does not exceed the allowed number (if
defined).

String The number of characters in the string does not exceed the maximum

length. If it does, Teamcenter truncates the excess characters when saving
the planner input field. The default maximum length is 512 characters.
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Planner input field Teamcenter checks that...
type
The string is in the legal format (if defined). Teamcenter checks whether the

string conforms to regular expression patterns. The following are examples
of commonly used regular expression patterns:

* Date (dd/mmlyyyy): (0?[1-9]|[12][0-9]|3[01])/(0?[1-9]]1[012])I((19]
20)\d\d)

e Email: A[_A-Za-z0-9-]+(\.[ _A-Za-z0-9-]+)*@[A-Za-z0-9]+
(\.[A-Za-z0-9]+)*(\.[A-Za-z]{2.]1)$

« IP address: A([01]7\d\d?|2[0-4]\d|25[0-5])\.([01]7\d\d?|2[0-4]
\d|25[0-5])\.([01]2\d\d?|2[0-4]\d|25[0-5])\.([01]?
\d\d?|2[0-4]\d|25[0-5])$

Note:

* If the validity check fails, the system issues an error message detailing the problem. The Planner
Input Field Create Information dialog box remains active until the problem is solved.

* You cannot copy planner input fields.

View and edit properties

You can view and edit the properties for data collection definitions and planner input fields.

* Click Properties E]’ to view or edit the properties of the selected item in the current document.
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il ™
i Properties ﬁ

Marme: Torque Value
Description:
Iz Optional: (™) True @ False

Murnber Of Decimal Places: 2

Minirmum Allowed Yalue:

Maximum Allowed Value:

Alert Minimum Value:

Alert Maxirmum Value:

Caution Minimum Value:

Cauticn Maximum Yalue:

Out-0f-Range Behavior: i
Data Acquisition Method: 57

Placehalder String:

| ok || cancel

Note:

You can edit the Placeholder String property in-place without accessing the properties of the data
collection definition. To complete the change, click anywhere in the document outside the data
collection definition.

Remove a data collection definition
* Select the data collection definition and press the Delete key.
Remove a planner input field

* Select the planner input field and press the Delete key.
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Save changes
* Click Save J]] to save the current changes in your document.

Teamcenter saves the document and updates the preview document.

Discard changes

* Click Discard changes E:j to discard your current work and reload the last saved version of the

document.
Set the scope

In edit mode, you can change the editing focus from the current document to another document (the
new scope) without exiting edit mode.

1. Click the desired element in the structure.
2. Click Set scope k "'}

If there are unsaved changes in the current document, Teamcenter prompts you to save them
before exiting the current document.

Teamcenter closes the current document, checks out the target standard text element, and loads the
target document. You can now begin editing the target document.

Note:

The Set scope command does not work if any of the following conditions apply:
* The target scope is inactive.
* The target scope is not a standard text element.

* You do not have permission to edit the target scope, as defined by the access control list.

Activate/deactivate a standard text element

You can deactivate a standard text element if it is no longer valid. You cannot edit inactive standard text
elements or add them to textual work instructions.

* To deactivate a standard text element, select it and change its Is Standard Text Element Active cell
from True to False.
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f 002106-Standard Text Library X ) @ (@) F%[v]" =08
W Latest Working ® Today T Not Specified & Not Specified
| BOM Line Is Standard Text Element Active | Itern Type
II',_" 002106/ A;1-5tandard Text Library (View) Standard Text Library
L‘—J@; 002107 /A;1-Fasteners (WView) Standard Text Folder
E\‘@; 002110/4;:1-Rivets (View) Standard Text Folder
- [ 002112/ -Wrench True Standard Text Element
' ----- Eig 002113/4;1-5crew Driver True Standard Text Element
: b Eig 002114/4;1-Fun Down False Standard Text Element
@; 002111 /A1 -Screws (View) Standard Text Folder
E]--@; 002108/ 4;1-5afety (View) Standard Text Folder
EJ--@; 002109/4;1-General (View) Standard Text Folder
4 m P

» To reactivate a standard text element, change its Is Standard Text Element Active cell back to True.

* If the Is Standard Text Element Active column is not visible, use the Change Columns dialog box to
display the Is Standard Text Element Active column.

* You can still view deactivated elements.
Search a standard text element for a specific text string
You can search for standard text elements that contain specific text in their documents.

The METWICreateTextControlsOnSave preference must be set to true for this search to function
properly.

* Type the string in the text field at the top of the Standard Text Library view and click /2.
Teamcenter displays all the standard text elements in the Search Results section at the bottom of the

view. You can work with these lines in the same fashion as you work with the lines at the top of the
view.
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|~ Product #1 |1 Process fy 003124-Demo_sbe lib %

pre

BOM Line

i 003124/8:1 -Demo_ste_lib (View)
=7 003125/A;1-folder (View)
[ 003126/A:2-5TX_EN
003127/4;3-5TX_EI2
EWasll003128/A,3-STX_EB
003129/8:2-5TH_El4 True
[ 003130/4:2-5TX_EIS True

1 1] 3

+ Search Result [ 2 ]

BOM Line Itemn Type
003126/4:2-5TX_EIL Standard Text Element
0023127/8:3-5TH_EI2 Standard Text Element
] 1 3
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9. Collaboration and CAM integration
Working with projects

About projects

Projects represent and control access to a particular piece of work that may be accessible to multiple
organizations, such as project teams, development teams, suppliers, and customers.

Objects, such as items, item revisions, datasets, and forms can be assigned to projects. Additionally,
folders, or folders and their contents can be assigned to projects. Items, item revisions, and engineering
change objects can be assigned to projects during the creation process. All other workspace objects can
only be assigned to projects after the object has been created. Objects can be selected from search
results and assigned to a project or projects.

When an object is assigned to a project, attachment objects, as defined by the propagation rules, are
also assigned to the project. Propagation rules are determined by include and exclude relations lists. By
default, the include relation list contains the following relation types:

Specification

Manifestation

AltRep

EC_affected_item_rel

EC_solution_item_rel
You can only assign objects to projects if you are a privileged project team member.

If you are a Teamcenter administrator or a project administrator, you can assign multiple objects in a
structure to a project by running the update_project_bom utility. You can also use this utility to remove
multiple objects from a structure.

Assigning objects to projects

Objects can be assigned to projects either during the creation process or after they are created. Items,
item revisions, and engineering change objects can be assigned to a project during the creation process,
all other objects must be assigned after they are created.

Objects can be assigned to projects by making selections from the tree or Properties table or by
selecting from the search results display.
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Note:

You can select from different lists of values (LOVs) for a property, depending on which project the
object is assigned to.

Assign objects to projects from the tree or Properties table
1.  Select one or more objects in the tree display or Properties table.
2. Right-click and choose Project->Assign, or choose Tools->Project=Assign from the main menu.

If multiple objects were selected in step 1, the system displays the Assign Objects to Projects
dialog box. If a single object was selected, the system displays the Assign an Object to Projects
dialog box. The projects of which you are a privileged member are displayed in the Projects for
Selection list.

Caution:

The objects you selected in step 1 may already be assigned to one or more projects. However,
this is not reflected in the selection list.

3. Select the project or projects to which the objects will be assigned and move them to the Selected
Projects list using the right-arrow button. To select all projects in the list, click the double-arrow
button.

4. Click Apply to assign the objects to the projects and retain the dialog box. Click OK to assign the
projects and dismiss the dialog box.

Note:

You can also assign a selected object to a project by dragging it onto the project icon.

Assign objects to projects by search results page
1. Right-click a search results tab.

Teamcenter displays the Explorer shortcut menu.
2. Choose Project=>Assign.

Teamcenter displays the Assign Object to Projects dialog box.

3. Select the project or projects to which the objects will be assigned and move them to the Selected
Projects list using the right-arrow button. To select all projects in the list, click the double-arrow
button.
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4. Select the objects to be assigned by selecting either the Current Page or All Found Objects
button.

5.  Click Apply to assign the objects to the projects and retain the dialog box. Click OK to assign the
projects and dismiss the dialog box.

To selectively assign objects displayed in the search results tab, select the search results tab and perform
the steps described in Assign objects to projects from the tree or Properties table.

Remove objects from projects

1. Select one or more objects in the tree display or Properties table. You can also select the objects
from the results of a search.

Note:

Two standard search forms, the Projects Search form and Objects in Projects form can be
used to locate objects for removal from a project.

2. Right-click and choose Project-*Remove, or choose Tools->Project-*Remove from the main
menu.

If multiple objects were selected in step 1, the system displays the Remove Objects From Projects
dialog box. If a single object was selected, the system displays the Remove an Object from
Projects dialog box. The projects of which you are a privileged member are displayed in the
Projects for Selection list.

3. Select the project or projects from which the objects will be removed and move them to the
Selected Projects list using the right-arrow button. To select all projects in the list, click the
double-arrow button.

4.  Click Apply to remove the objects from the projects and retain the dialog box. Click OK to remove
the projects and dismiss the dialog box.

Using NX CAM Integration

Using NX CAM Integration

The NX CAM Integration allows you to manage your NX CAM setups and output files, such as CL source
files, NC data, and shop floor documentation files, in the Teamcenter database. The output files are
automatically attached to a process structure. The benefits of these files and setup being managed in
Teamcenter are that the information is shared in a common manufacturing information management
platform. The latest data is associated by the Part Planner application to create and deliver a consistent
part.
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Creating the setup templates allows you to leverage established machining practices against new
manufacturing. For example, a series of parts with similar or identical features such as holes or pockets
might typically use the same cutting tools, feeds and speeds, clamps, fixtures, and machine tools. These
features are assembled once in the CAM setup template and used repeatedly, establishing best practices.
In addition, all items that were part of the CAM setup template assembly are included in the process
planning setup, which allows the where-used search functionality to be used. Also, by associating all
CAM operations and data to the process (which is associated to the product), you have all CAM data
available in the database associated with the product for any subsequent work with that product.

You can generate shop floor documentation (shop docs) to convey information to the shop floor. This
information may include tooling lists, operations lists, custom reports, setup drawings, and inspection
sketches.

If the NC programmer creates a tool in the CAM environment, it is available in Manufacturing Process
Management. Similarly, any machine tool that is referenced in NX Library is available in Manufacturing
Process Management.

Tooling libraries for the CAM environment may be maintained in Classification, allowing you access to
tool resources from Part Planner.

Setting up a machining environment using the master model concept

The CAM integration supports the Master Model concept for setting up an assembly part. The Master
Model approach enables you to separate the derived data for a part, from the basic geometric definition
of it. A good example of this, in practice, is to separate NC data from the geometric definition of your
part. To do this, you create a separate part file and then include the master part file (the geometry) as

a component in it. You can then create NC data in a part file that references the geometry and other
necessary part files, as follows:

CAM part (ugmaster of MENCMachining type)
|_geometry (ugmaster)
| machine (for example, sim010101_001)
| fixtures
| workpiece

Create operations

A planner creates NCMachining operations in Part Planner for each CAM setup required for a machining
operation. When NX CAM Integration is started, the machining operations that were defined by the
planner display as setups within the NX Manufacturing application for the NC programmer to choose
from.

1. In NX, create your own setup. The NCMachining operation uses the setup template to position
the workpiece in the correct location in an assembly that includes all of the components that
were saved in the template. In addition, the template can include NX CAM objects such as tools,
coordinate systems, and program groups pre-set for the generation of CAM tool paths.
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2. In Part Planner, open the geometry part (item) in the structure view.
3. Create a new process.
4. Associate the product as target for the process.

5. Create operations under the new process. Any operation that you want to open in NX CAM must be
of the NCMachining type or of a type you have specified to be supported in NX CAM.

6. (Optional) Add resources (tools, machines or fixtures) to the machining operations using the
Classification Search Dialog. The process resembles the following:

5 53684/A - Process
Process_for_Product

Occurrence Type

-4, 53686/A - 0OP10 oP

., 53687/A - 0P20 op

- &2 53688/A — OP30 NCMachining
Loa sy ltem METool
ugto101_001/A ltem METool
L aismy ltem METool
ugt0202_001/A
T~ oP N
ugt0212_001/A NCMachining

& 53689/A — OP40
- &2 53690/A — OP50

These resources have an METool occurrence type. You can list the occurrence types by adding the
Occurrence Type property to your column list.

Open NX CAM Integration

Once you create operations in Part Planner, you can open NX Manufacturing to create the NX operations
required to machine the part.

1. In the Attachments view in Part Planner, with the root process selected, double-click the geometry
part to open itin NX.

2. In NX, start Manufacturing.
The Machining Environment dialog box is displayed.

3. Select cam_part_planner_mrl.dat.
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The Setup Selection dialog box opens showing the product containing the process you created to
manufacture this part. All operations of MENCMachining type (or any custom NX CAM Integration
type) are visible under this process, as follows:

Setup selection

Object Name
53683 Product
3 53684 Process_for_Product
2 53688 OP30
S 53690 OP50

Select a planning operation (for example, OP30 or OP50).

The Library Class Selection dialog box displays the available CAM setup templates. These
templates contain the different setup types that are available by default in Manufacturing, such
as operation types, tool types and method types.

Select a setup template that you created in step 1.

The information in the selected setup template is copied into your new CAM part, thus initializing
it.

It may be necessary to position a machine or fixture if you added them to the Teamcenter
operation. If you added any resources in Teamcenter, you now see them in NX.

You are now ready to create NC operations.

Create CAM data

After you enter the NX Manufacturing application, create CAM output data in your usual way. There is
no difference for the NC programmer in creating CAM data to working in NX native mode.

1.

2.

3.

Note:

You can only make changes to CAM NC machining operations in NX; you cannot change these
operations in Teamcenter and export the changes back to NX.

Create CAM operations.
Create or retrieve tools from the database.

Retrieve or replace a machine.
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4. Generate tool paths and NC files (CLSF or NC file)
5. Generate shop floor documentation.
6. After you complete this work, save the file.
You are prompted to import the datasets you have created into the Teamcenter database.
7.  Click OK.
The Import Files for Part dialog box appears.
8. Click OK.
In Teamcenter:
* The CAM part file is stored with the planning operation.

* The machining setup is stored under the planning operation (for example, geometry (master),
machine, fixtures, and tools).

* Shop floor documentation is attached to the planning operation.

* Each time you postprocess, the system generates an activity with the name of the CAM program
group and attaches all related NC files to it.

You are now ready to look at your work in Teamcenter.

Display CAM data in Part Planner

To display data that was created in the CAM environment in Part Planner, do the following:
1. Open Part Planner.

2. Open the top-level process where the NX CAM Integration data was created.

3. Inthe process view, right-click the MENCMachining operation for the newly generated CAM
output.

4. Choose Open with=Activities.

An MENCProgram activity is created under the operation using the program name of the object
selected in NX CAM for postprocessing. This activity contains:

 Datasets for the NC program (the PTP and CLS files).
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» Areference to each tool used in the NC program. Teamcenter lists the cutter time in the
Duration column of the Activity view. You can also see the tool number in a separate column.

* The time required for the postprocessing in the activity Duration column for each NC program
that is postprocessed. You can also see this time in the properties of the activity. Teamcenter
overwrites any previously existing time.

5. Open the Attachments view.

The NX CAM Integration shop document is attached as a dataset to the MENCMachining operation
revision. Double-click a shop document file to open and view or edit its contents. You can save
changes you make to the file for subsequent sessions, including CAM sessions.

Note:

If you had Part Planner open while working in NX, it may be necessary to close the
application and reopen it to see any changes made in NX.

Note:

To have a visual representation of an NX part available in Teamcenter, you must save the file as

a JT file in NX. To do this, choose File-»Save Options->Save JT Data. A JT file is attached as a
DirectModel dataset to the item revision and is available in the viewer. NX updates JT data only if
the part changes after the previous save.

Displaying CAM data in the NX Teamcenter Navigator

In NX, you can use the Teamcenter Navigator to locate documents stored with the CAM part in the
Teamcenter database. For example, you can open the shop floor documentation. The resulting NC
programs are organized under the Manufacturing Activities section. In this section, you can identify
the program groups that you selected for postprocessing. The related NC tape file and optionally the
CLS file is managed in this section. The manufacturing data includes the CAM setup showing the design
part to be machined together with the fixture and clamping devices. Additionally, you can identify

the resource list including the selected machine and the list of tools used for this CAM part. The NC
programmer can always look at this data inside NX without the need to search in Teamcenter.
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Displaying CAM data in the NX Teamcenter Navigator _

& Teamcenter Navigator |
Object Number Revis... | Description | Type Che
=4+ Teamcenter ~
£y Home beste Folder
'%'--Er Mailbox beste Mail Folder
Eé'--ﬁi Newstuff beste Newstuff F.__ L
& i@ Home infodba Folder E
Eﬁ'--% cam_et_housing_cover cam_et__.. ltem
Ej'--l% cam_et_housing_MNX6 cam_et_... cam_et_ho... ltem L
=Bk MachiningMx6 Machinin. .. Machining... MENCMac...
: --@Machiningmtﬁm Machinin... A Machining... MENCMac...
7 MachiningMX6-A Machinin... A Assembly |
Az MachininghX6-A-dwg 1 Machinin... A Machining... Drawing
'E;'--@cam_et_housing_NXEfA cam et . A cam_et_ho._. ltemRevision M
£ e — | [2]
Manufacturing Activities A
Object Number Revis... | Description | Type Chec...  Access | Statu... | Date Mc
EI--[g-' MachiningMX6/A MEACTivity Write 5-Feb-2
=B cavity_mill MENCProg. .. Write 4-Feb-Z
- b mill_3_axis CAM Data... Write 31-Jan-:
-z clsf_standard CAM Data... Write 4-Feb-z
'E;'-- milling MEMCProg... Write 4-Feb-Z
E;'--[;.' Unload Part MEACTivity Write 4-Feb-z
= B cavity_mill_copy MEMNCProg... Write 5-Feb-:
<] | B
Manufacturing Occurrences A
Object Number Revis... | Description | Type Chec... | Access | 5. | D
= EiE MachiningNXG/A Machinin... A Machining... MENCMac... Write
sim010101_001_mm/A sim0101... A MRM Reso... ltemRevision Write
tla_thread_mill/A tla_threa... A ltemRevision Write
tla_mill_7parameter/A tla_mil_7... A ltemRevision Write
tla_mill_7parameter_2/A tla_mill_7... A Milling tool ... ltemRevision Write
tla_ball_mill_16/A tla_ball_.. A [temReavision Write
tla_barrel_cutter_20/A tla_barrel... A ltemRevision Write M
[<_]. S — . = .. m
Search v
EBrowse Filter v
Assembly Load Options v
Preview v
Note:

The NX Teamcenter Navigator is available with NX 6 and later. You must activate the different
panes in the NX Customer Defaults. To do so, choose File=Utilities>Customer Defaults, and
then choose Teamcenter Integration for NX-»General->Teamcenter Navigator and select the
panes you want to display.
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_ 9. Collaboration and CAM integration

Creating resources

Depending on whether you are the process planner, who works primarily in Teamcenter, or the NC
programmer, who works primarily in NX, you assign tools, machine tools, or fixtures in different ways.

* Process planner

The process planner assigns resources in Part Planner. The Classification Search dialog & is

used to add resources from the Teamcenter database to the MENCMachining operation. All tools
must be assigned using the METool occurrence type. All machines must be assigned using the
MEMachineTool occurrence type.

Note:

Find the Occurrence Type box at the bottom of the Classification Search dialog.

* NC programmer

The NC programmer retrieves or loads tools in NX CAM using the NX Library mechanism. Generally,
these resources are stored in the Teamcenter database. In addition, the NC programmer can create
nonlibrary tools in NX Manufacturing by specifying tool parameters in the tool creation dialog boxes.
When the CAM part is saved in NX, the resource list is exposed to the corresponding MENCMachining
planning operation in Teamcenter. Teamcenter saves all tools using the METool occurrence type and
any machine using the MEMachineTool occurrence type.

Tip:

If you change a tool (cutter, component or tooling), you can use the Teamcenter Where Used
search to find all NX CAM part files that use this cutter.

Displaying NX CAM tool times

You can store NX CAM tools and their individual time values with their corresponding NC programs. The
tools are displayed in the Activities view. Cutting times are shown in seconds in the Duration column.

Part Planner Sctivities ¢ RPNy | G v | 28 Y 5 O
Line Descripkion Ackivity Descripkion I Start(Sec)., I Durati, . I Skark [Calc
A bIZIEISEl,l'.ﬁ. Activity Rook Ob, ., Ackivity Root Object 0 i 1]
EIEﬁ 1234 MNx CAM program,.. Me CAM program gr ] 3.6 0
ST MILLT Post 0 166 | 0
S MILL Post 0 185 | 0

These activities are stored in an operation of the MENCMachining type.




Create an NX machining setup template _

If you update an operation in NX, Teamcenter updates the CAM tools in Part Planner, including adding or
deleting tools.

To pass additional CAM-related time values to the Activities view from NX models, install the
PMOPartManufacturing BMIDE template that contains the time definitions with Teamcenter. Some
of the CAM-related time values you might want to pass to the Activities view are Positioning Time,
Designing Time, Delay Time, Wait Time, and Tool Change Time.

Note:

In the preference MPP_ToolActivity NXCamTime, you can define a single NX time to be passed as
a default table column time. You can also add any defined time values to the Activities view. Just
right-click the column header, select the preferred column names, and choose Insert column(s).

If MPP_ToolActivity_NXCamTime is not set, the default legacy value of 0 appears in the
Activities view table columns.

Create an NX machining setup template

You can create your own machining setup that gets copied into each new CAM part upon initialization.
The NX CAM Integration stores this template in the library class hierarchy along with the existing setup
templates and it is available for your reuse.

1. In NX, create a part file containing everything you want in the setup template. This could include:

Machine

Tools
* CAM operations
* Fixtures
2. Save this part as a template by choosing Export->Setup Template.

The Library Class Selection dialog box appears.

Note:

This menu command is only available from within the Manufacturing application.

3. Inthe setup template tree, select the class in which your new template should be stored and click
OK.

The Template Attributes dialog box appears.

4. Enter a descriptive name for the template and specify the unit for which the template is applicable.
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_ 9. Collaboration and CAM integration

5. If the Import Files for Part dialog box appears, click OK.
6. Click OK.

Teamcenter automatically saves the part file as a template. The template is listed in the
template_part_planner.dat file, which is a named reference in the UGCAMTemplateData dataset
in the database and is now available from the Library Class Selection dialog box the next time you
initialize a part.

Working with Integrated Simulation and Verification (ISV)

If you want to retrieve machine tools in NX CAM while storing your parts and machine tools in the
Teamcenter database, there are several points to consider:

* The resource kit provided with Teamcenter contains the same sample machines that are provided in
the MACH\resource\library\machine directory in NX. Teamcenter checks for the machine DAT file in
the MACH\resource\postprocessor directory. To run the machine tool simulation using these sample
machines, copy the machine DAT file ( listed in the PP config file attribute in the database) to the
postprocessor directory.

» Postprocessor and machine tool driver files can remain in the NX installation (in the MACH/resource/
postprocessor directory) or be stored in the Teamcenter database.

Create an in-process workpiece in Teamcenter

You can include an in-process workpiece (IPW) as part of the CAM setup. The workpiece can be created
automatically from within NX Manufacturing or you can use a designed workpiece such as a casting.

1. Create an IPW in the NX Manufacturing application by saving the workpiece as an IPW and using it
as input for the next machining operation.

2. Saveyour partin NX.

The IPW is stored as an NX part file in the Teamcenter database. It is now time to assign your
workpiece to the next machining operation in Part Planner.

3. Find the new item representing the IPW in the My Teamcenter application and copy it to the
clipboard.

4. In Part Planner, select the machining operation for which the copied part will be the workpiece.
5. Choose Edit->Paste Special.
The Paste dialog box appears.

6. Inthe Occurrence Type box, select MEWorkpiece.
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About using Multi-Site Collaboration in manufacturing _

7. Click OK.
The NX IPW is added as a workpiece for the manufacturing operation.

The next time you open the MENCMachining operation in NX Manufacturing, you are prompted to
position the workpiece into the machining session.

Using Multi-Site Collaboration

About using Multi-Site Collaboration in manufacturing

You can use Multi-Site Collaboration to share structures with other sites. If you use it to share
collaboration context objects, take the following into consideration:

» Export all revision rules at the original site using plmxml_export -xml_file=file_name -
class=revisionrule and use pImxml_import -xml_file=file_name at the importing site before using
Multi-Site Collaboration with collaboration or structure context objects.

* Export individual structures prior to exporting a collaboration or structure context in order to get the
proper revisions of the objects in the structures.

* The configuration context does not affect which revisions are exported if you export a BOM with a
collaboration or structure context.

* To be able to consume exported objects at the remote site when you do not have write access to the
product item, create a new item at the remote site that acts as the local product root, and copy the
product under it.

Sharing compositions

If you create a process in site B and import it to site A using the following procedure, the assigned
product/plant information is not displayed in the structure:

1. Create process in site B and assign a product/plant.

2. Close and restart Part Planner.

3. Create a top-level process in site A.

4. Open My Teamcenter and copy the process created in step 1.

5. Paste the process under top-level process created in step 3.
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_ 9. Collaboration and CAM integration

When you create a root process and paste in another process, the product and plant are not displayed.
Pasting the process does not automatically populate these structures. You can work around this problem
as follows:

* Load the old product and plant structures into Part Planner.
The assignments appear in the process structure.

* Ensure that the product and plant load automatically the next time you open the new process in Part
Planner. To do this:

¢ Use the Associate commands to link the roots.
Generating reports

Generating reports

You can generate reports for most aspects of a process plan including products, manufacturing
processes, and plant structures.

You can view image datasets of the Image type that represent target parts and are attached to the
operation. They are shown in the right-hand side of the report and can be viewed in the Viewer view.
You can also view images that were created by clicking the Image Capture button in the Viewer view in
this way.
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10. NX CAM to Teamcenter custom user
tooling data synchronization

Synchronize NX CAM to Teamcenter custom user tooling data

You can define custom attributes to be synchronized between NX CAM and Teamcenter, such as pocket
ID, tool description, technology data, and adjust register. You can synchronize up to fifteen custom
properties that are stored with the MENCToolActivity attribute of a CAM setup.

Before custom attributes can be synchronized, you must install the Part Manufacturing Shopfloor
Integration e.g., Presetter and Activity User Data feature, and must set and define the two
mandatory preferences.

The following is step-by-step example of how to create, process, and view custom attributes
synchronized between NX CAM and Teamcenter.

1. Perform the initial preparation (only needs to be done once).

a. Install the Part Manufacturing Shopfloor Integration e.g., Presetter and Activity User Data
feature.

b. Setthe MPP_ToolActivity EnableUserData preference to true.

L, A

~ Preferences List | Catego
Searc Manufacturing

MPP_ToolActivity_EnableUserData

Description
|Filter by category |"| Synchronize custo
- - Up to 15 custom ¢
|F|Iter by protection scope |V| These custam attr
Mame Location Value
MPP_ToolActivity_EnablelserData |5ite true

c.  Use the Teamcenter preference MPP_ToolActivity CustomUserData to define the custom
attributes.

For example, specify the mom variable to output the Tool Number:
pmOUserData02:mom_tool_number:Tool Number
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_ 10. NX CAM to Teamcenter custom user tooling data synchronization

L

MPP_ToolActivity_CustomUserData

[site

r~ Preferences List Category Environment Type Multiple

Search On Keywords |Manufacturing |I§| |Disabled || |Strir'|g || |Multiple ||

|MPP_TooIActivitv_CustomUserData | o
Description

|Filter by category || Define user customizable attributes that can be synchronized between NX-CAM and Teamcenter. *
Up to 15 custom properties can be defined that are stored with the MENCToolActivity of a CAM setup.

|Filter by protection scope || o

MName Location Values

pmOUserDatall:morn_tool_name:Tool Description
pmOUserDatal2:mom_tool_numberTool Number
pmOUserDatal3:mom_tool_type:Tool Type

KNI

pmOUserDatald:morm_cutter_libref:Library Reference
pm0UserDatal53:mom_tool_flute_length:Flute Length
pmOUserDatale:[MOM Variable]:User Data 06
pmOUserDatal7:[MOM Variable]:User Data 07
pmOUserDatal2:[MOM Variable]:User Data 08
pmOUserData0S:[MOM Variable]:User Data 09
pmOUserDatal0:[MOM Variable]:User Data 10
pmOUserDatal1:[MOM Variable]:User Data 11
pm0OUserDatal2:[MOM Variable]:User Data 12
pm0UserDatal3:[MOM Variable]:User Data 13
pmOUserDatal&[MOM Variable]:User Data 14

pmOUserDatal3:[MOM Variable]:User Data 13
pmOUserDatal2imom_tool_number: RN | IE‘

Preferences found: 1

2. Create CAM setup in NX and generate NC output data.

a. Opena CAD file in NX (CAD_geometry_4711 is used in this example).

to] Assembly Navigator O V- CAD_geometry 4711/4;1-CAD part file X
Ohbject Number
Iﬁg_ [ Sections
’ b (¢ CAD_geometry_4711/A;1-CAD part file |CAD_geometry 4711

(=
R

b. Create a CAM part file for the CAD model: File - New - Item (CAM_Setup_4711_004 is

used in this example).
10-2 Part Planner, Teamcenter 2412
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Synchronize NX CAM to Teamcenter custom user tooling data _

New Item
Manufacturing
Templates A Preview A
Units | Millimeters -
Name Type Units Relationship Owner H
= General Setup Setup Millimeters  master infodba (d... ~
B Die Mold (Essentials) Setup Millimeters master infodba (d...
ﬁTuming (Essentials) Setup Millimeters  master infodba (d...
=) Machinery (Essentials) Setup Millimeters master infodba (d...
E Multi-Axis (Essentials) Setup Millimeters  master infodba (d...
B Mill Turn (Essentials) Setup Millimeters master infodba (d... v
< >
Name and Attributes A
Name Value Other Parameters A
1o CAM_Setup_4711_004 o
2 |8 revision ¥ Double-dick fo assign -
3 E Name ¥ Double-dick fo assign Projects
Folder
Secondary Attributes | :Newstuff |
Reference Part A
Number | CAD_geometry_ 4711 | Revision | A | Name | CAD_geometry_4711-A |

0] Operation Navigator - Program Crder O < CAM Setup A711_004/A1 B X

Mame Tool... Path Tool
I.EJ_ NC_PROGRAM

c.  Make sure you use a CAM configuration that includes the Teamcenter connection, such as
cam_part_planner_mrl.dat.

{3} Manufacturing Preferences D X
User Interface Operation Geometry
Selection Vizualization Output Configuration
Configuration File A

Configuration File

MACH\resourceh\configuration' =gy W Ty« 1Ty = g K= Fis ||3’

Part Planner, Teamcenter 2412 10-3
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_ 10. NX CAM to Teamcenter custom user tooling data synchronization

d. Retrieve tools from the Manufacturing Resource Library.

Class te Search ”

Assemblhies
g '
+ End Mills

+ Face Mills
Eall End / Spherical Cutters

Milling

Legend

Slotting Cutters
Angle Mills

Round Profile Cutter
Thread Mills

Special Mills

D R

.

Drilling

Special Tools
Probing

*

Class Description

Search Pararmeters

Library Units

X
o
Matching Items A
A Libref (DES) Tool Description (NX) NX Tool Typ
mat_mill_01_00002/4 D100.0 FaceMill Indexabl... 01:01 ~
roct_mill_01_00003/4 D25.0:38 EndMill Indexab... 01:01
nat_mill_02_00001/A D80.0 FaceMill Indexable... 01,05
it mill 02 00002/A D160 EndMill’Sk 0301
rod_mill_02_00010/4 D1.0 BallMill/SK 01;04
rt_mill_02_00015/4 D40.0 FaceMill Indexable... 01;01
[mq_mu_oz_mmam ~ D40.0 FaceMill Indexable... 0101
> Zia i A AARARIA FAA A o R e ~ina
Millimeter =

e. Generate CAM operations using the tools.

10} Operation Navigator - Machine Tool
Name
GENERIC_MACHINE
@ Unused ltems
pid | - [ NXT_MILL_01_00003_A

g

Path Tool

] - CAM.Setup 4711004/AT B X |

Description

Generic Machine
mill_planar

D25.0x39 EndMill Indexabl...

= | AFACE MILUNG_AREA |

CAM _Setup_4711_004/A;1 B %

?_ f] NXT_MILL_02_00002_A D16.0 EndMill/SK
@ f NXT_MILL_02_00016_A D40.0 FaceMill Indexable/...
F_
&
o} Operation Navigator - Machine Tool O B
MName Path Tool | Description
Fa_ | GENERIC_MACHINE Generic Machine
7 [ Unused Items mill_planar
bl | - { NXT_MILL_01_00003_A D25.0x39 EndMill Indexabl...
Ch V3 FACE MILLING_ AREA |«  NX.. FACE_MILLING_AREA
8. - B NXT_MILL_02_00002_A D16.0 EndMill/SK
re 7 [ FINISH_WALLS NX.. FINISH_WALLS
f_ = [l NXT_MILL_02_00016_A D40.0 FaceMill Indexable/...
| e /% FACE MILUING AREA 1| *  NX.. FACE MILLING AREA
T

f.  Generate shop-floor documentation, such as a tool list or an operation report.

1} Shop Documentation X

Report Format A

Operation List Select (HTML/Excel)

Operation List Select (TEXT)

Tool List Select (HTML/Excel)

Tool List Select (TEXT) '

MILLING TOOLS

TOOL WAME DESCRIPTION DIAMETER  COR RAD FLUTE LEN AD] REG
IT_MILL_01 00003 A 025.0x33 Endiill Indexable/NSKion 25,0000  G.7oe0 | S.szse 1
NXT_MILL_O2_20992_A 016.0 Endnill/sk 16,0000  9,8000 32.0000 1
MXT_MILL 82 88als_ & 040.8 FaceMill Indewable/MSK100 40.0808 8, 8008 1. o 1
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—
Index Operation Name Type Program Machine Mode | Teol Hame m Path image
3 Shop Documentation x Minutes

Report Format A i FACE_MILLING AREA | VSt Based by pocker -] o H

:nion List | = 1 B FINISH WALLS | Planar Naing  MILL_POCKET| - e n] an H
|Tool List Select (HTML/Excel}

Ti i
ool Lt aelect (TET) 3 | FACE_MILLING AREA 1 “';“;g‘*u;"‘:' MILL_POCKET] " “fﬁa‘,'bm waz

g. Postprocess the NC file for the program group.

Name Tool.. Path  Tool E!|“|°§=i| &) % = e |§|| _|
NC_PROGRAM Ll = —
[g Unused ftems Information listing created by infodba
e — Date 24-May-2019 17:03:48
= v[g e | == Current work part CAM_Setup_4711_004/A1
7 %gg FACE MILLING_AREA | | NXT_MILL_01_00003 A e s S

¥ [ FINISH_WALLS

v
v NXT_MILL_02_00002_A
¥ g9 FACE_MILLING_AREA 1 v

NXT_MILL_02_00016_A =

Neale Gae G17 G99 GO
heazd 691 G28 8.9
Ne@ese Tee Mes

3 Postprocess

Postprocessor o NOB4e GOe G3@ X2.957 Y.8859 S8 ME3
Ne@se G43 72,3622 Hel
WIRE_EDM_4 AXIS : e T NeBse Z.6299
I o NO@7e GOl X3.8386 2.3937 FO.5 MES
AXI BO Nease X.8858
IMILL_4_AXIS Nease I.5118

Now that you have completed the tasks in NX CAM, you can save the results in Teamcenter.
3. Save CAM files and data in the database.

* Once you save the CAM part file, the system checks for any generated files (NC program and
shop-floor documentation) that should also be stored.

£} Import ME Datasets for Part

Following datasets for the part are unsaved during this session:

Click OK to import selected dataset(s) to database ...

» Additionally, the system generates the file cutter_tmp_file.txt in a temporary folder.

« 4 ||« AppData » Local + Temp » 2 » CAM Setup 47110041 » ptp » mill_pocket > mill_3_mis v & | Search mill_3_axis
~
| CAM_ Setup_4711.004_1 A Name Date modified Type Size
4 ptp | mill_pocket.ptp_ 5/24/20195:03PM  File folder
|| mill_pocket cutter_tmp file.bxt 5/24/20195:03PM  Text Document 2KB
. mill_3_axis ] mill_pocket.ptp 5/24/2019503PM  PTPFile 5K
| shop post_process_time.bd 5/24/20193:03PM  Text Document 1KB
Part Planner, Teamcenter 2412 10-5
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_ 10. NX CAM to Teamcenter custom user tooling data synchronization

This file includes the customized attribute values for each tool used in the NC program.

File Edit Format View Help

1 cutter tmp file.tt - Motepad - m] ®

# Machine: decgnsrv2

# Date: Fri May 24 17:21:23 2@18 UW. Europe Daylight Time

cutter_tag|62152| cutter_name|NXT_MILL_81_88803_A|spindle_number|@|tool_libref|nxt_mill_81_8@0@3/A|cutting_time_used|FACE_MILLING_AREA|mom_cutting_time|726.671163|pm@UserDatadl|
cutter_tag|62156 | AN e L AW NP P | spindle_number|@|tool libref|nxt_mill_82_88@@2/A|cutting_time_used|FINISH_WALLS|mom_cutting time|278.369476|pmBUserData®dl |NXT_V
cutter_tag|62182|cutter_name |NXT_MILL_82_@0016_A|spindle_number|@|tool_libref|nxt_mill_82_80616/A|cutting_time_used|FACE_MILLING_AREA_1|mom_cutting_time|823.889479|pmoUserDatat

< >

v

File Edit Format View Help

) cutter_tmp_file.txt - Notepad - m] X

_time|726.671163| pm@UserDataBl |NXT_MILL_61_086083_A|pmBUserDatad2|1|pmBUserDataB3|Milling Tool-5 Parameters|pm@UserData®4|nxt_mill_81_86@63/A|pm@UserDatad5|@.375
[PXE RISV | omeUserDatall | NXT_MILL_B2_0@0@2_A|pm@UserDatad2|2|pmBUserData@3|Milling Tool-5 Parameters|pm@UserData®4|nxt_mill @2 _60082/A|pm@UserData@5|1.2598425196850394)
1g_time|823.809479|pmdUserData@l|NXT_MILL_ 62 00016_A|pmeUserDataf?2|3|pmBUserData®3|Milling Tool-5 Parameters|pmBUserDatafd|nxt_mill_02_080016/A|pmdUserDataBs|6.39370078740157477

< >

v

4. Review the data in Teamcenter.

Open Part Planner and search for the CAM part file (CAM_Setup 4711_004).

Review the data stored for the NC program in the Part Planner Activities panel.

g ddddddddaddddddd-

%, Product ... | Bk CAM Set.. 22 | - Workarea Al Part Planner Activities 3

E'E % ﬂ'} ‘[:‘_] F:?a "i! o Qﬂ &7 f@' ?||_" = Line | Activity Description IStart(...I Duration (l Start (Cal...l Duratio...l T
BOM Line [l A7 CAM_Setup_4T Activity Root Object 0 0 0 1,828.85
.:‘.?; ClAM_Setup_"iTI 1_004/A:1 (View) B mill_pocket MX CAM program group 0 2,068.28 0 1,828.85
% CAD_geometry_4711/4;1-CAD part file

By default, the custom attributes columns are not part of the activity table.

To add the custom attributes columns to the activity table, right-click on the table header and
select + Insert column(s)....

U [ R | U S U |

Al Part Planner Activities 57

Line | Activity Description | Start (zec) | Duration (sec) | start rrate 1 tean | Durstion tralcy o ﬂ
Al CAM_Setup_4T Activity Root Object 0 0 fleblakapchonitiend
Elgj mill_pocket NX CAM program group 0 2,068.88 s E
B NXT_MIFACE_MILLING_AREA D 72667 navle Lelumn selecton
é NXT_MIIFINISH_WALLS 0 278.37 Copy Selected Data .
e g NXT_MIIFACE_MILLING_AREA_T O 823.81
== Remove this column
=+ Insert column(s] ... %

In the dialog box, search for the custom attributes and add them to the Displayed Columns
section.
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¥ Change Columns *
Use the navigation buttons to choose the columns to be displayed and either save the modified list as a new colurmn
configuration or apply to the current view,
Activity Line
Available Celumns Displayed Columns
|Flute | |
S End Item ~ S Line
i End ltem Assembly State S Activity Description
S External File Reference S Start
S Flute Length S Duration
i Force Configured S Start (Calc)
S Frequency S Duration (Calc.)
S GDELine Name S Flute Length
S GEOMETRY
S GPAHint
S Gateway Of E
S General Audit Logs IE' -
S General Audit Loos

e.  You can use the names you specified in the MPP_ToolActivity_CustomUserData preference
or you can use the option Show internal names of properties.

When you use the internal name, all custom attributes are listed in one block (search

UserData).

¥ Change Columns pd
Use the navigation buttons to choose the columns to be displayed and either save the modified list as a new column
configuration or apply te the current view.

Activity Line

orailable Columns Displayed Columns
UserData [
b GDEBOPLine.nxOlsBvrStructModified ~ S CfgActivityline.me_cl_display_string
S CfgActivityLine.object_string S CfglctivityLine.al_activity_long_description
S CfgActivityLine.pm0UserData01 § CrgActivityLine.al_activity_start_time
S CfgActivityLine. pm0UserDatad2 S CrgActivityLine.al_activity_time
§ CfgActivityLine.pm0UserData03 S CrgActivityLine.al_activity_cale_start_time
8 CfgActivityLine.pm0UserData04 8 CfghctivityLine.al_activity_cale_time
S CfgActivityLine.pm0UserData0s ¥ S CfgActivityLine.pm0UserData01l &
8 CfgActivityLine. pm0UserData08 : s CfgActnityLine.pm0UserData02
8 CrgActivityLine. pm0UserData07 = |8 CfgActivityLine.pm0UserData03 v
8 CrgActivityLine,pm0UserData08 S CfgActivityLine.pm0UserData0d
S Cfghctivityline.pm0UserData09 |8 CfoActivitylinepm0UserData05
S CfgActivityLine,pm0UserDatal0
S CfgActivityLine.pm0UserDatall
8 CfgActivityLine.pm0UserData12
§ CfgActivityLine.pm0UserData13
§ CfgActivityLine.pm0UserData14
§ CfgActivityLine.pm0UserData15 v
< >

Show internal names of properties ]

Save.. Apply Close
Part Planner, Teamcenter 2412 10-7
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& Change Columns e
IUise the navigation buttons to choose the columns to be displayed and either save the
modified fist as & new column configuration or apply to the current view,
Activity Line
Awailable Columns Displayed Columns
Taol Des
[§ Targetio ] [S line
S Target 1D Data Format |8 Actwity Description
S Template Action |8 St
3 Time |S Duration
8 Tool Center Point Frame Positi |8 Start {Calc))
|8 Tool Description |8 Duration (Cale.)
1 Tool Mumber ¥ |8 Tool Description =
8 Tool Number |8 Tool Number
S Tool Humber =!8 Teol Type -
5 Tool Type |8 Library Reference
I Trace Link |8 Fiute Length
b Tesce Links |
s Type
S UlLeeation
| b Unit Net - Effective Occurmrenc:
S Unit Net Effectivity
= Unit Of Measure v
|< 3
|:| Show internal narmes of properties
Save.. Apply Close

f.  You can now review the custom tool attribute values that were transferred from NX CAM.

Al Part Planner Activities ©3

W& -

Line Activity Description i0...| Start (C...| Duration ..| Tool Description | Tool Numbgr Library Reference Flute Length
[=- A CAM_Setup_4711_004/A Activity Root Object 0 0 0 1,828.85
=+ mill_pocket_2 NX CAM pregram gr... 0 206888 0 1,828.85
-7 NXT_MILL_01_00003_A FACE_MILLING_AREA 0 72667 0 72667  NXT_MILL_01_00003... 1 Milling Tool-5 Parameters nxt_mill 01_00003/4 0.375
:101 MAT_MILL_02_00002_A FINISH_WALLS ] 27837 726.67 27837 MNXT_MILL_02_00002... 2 Milling Tool-5 Parameters nxt_mill_02_00002/A 1.2598425196850394
T8 NXT_MILL_02_00016_A FACE_MILLING_AREA_1 0 82381 1,005.04 823.81 NXT_MILL_02_00016... 3 Milling Tool-5 Parameters nxt_mill 02_00016/4 0.39370078740157477
Note:
Teamcenter remembers the column settings for the activity panel, so it is necessary
to add the custom properties only once. When you restart Teamcenter, you see the
customized attributes directly.
& Part Planner - Teamcenter 12 - o X
File Edit View Tools Window Help
B | o Bl % B[O &R E P #| comtmenrncresquencerocess | [ ¢ [0 X | S B & S-S -ib i TEAMCENTER SIEMENS
@~ @~ Part Planner (TOOLAdmind1 ( tooledminG1) - Menufacturing / NCTooling_Admin - [ IMC--1875326671 ] [ 111[ ] [ ) w
# 5, Product... @k CAM Se.. 53 < Workarea® = O [/ Part Planner Activities 57 Y E e v =0
B-29E Yl ¥ YR ~ Line | Activity Description | start..| Duratio...] tart (C...| Duration ..| Tool Description | Toel Number| Tool Type. | Library Reference | FluteLength
a- = BOM Line B4 CAM Setup 4711 004/A AmwtyRoolOmpen [ 0 1,828.85 : * - ’
T QUIEKLINKS  Customize |5 CAN Setup 4711.004/A&1 (View) -5 mill_pocket 2 NXCAMprogram gr.. 0 206888 0 122835
AP Home » % CAD_geometry_4711/A;1-CAD part file +-7& NXT_MILL 07_00003 A FACE_MILLING AREA 0 66T O 72667 NXTMILL_01.00003... 1 Milling Toel-5 Parameters nxt_mill_01_00003/A 0375
G My Worklist » s iNXT,M\LLﬁZ,ODDﬂZ,A FINISH_WALLS 0 27837 T26.67 278.37 NXT_MILL_02_00002... 2 Milling Tool-5 Parameters nxt_mill_02_00002/A 1.2598425196850394
e e 5 NI G2 00168 FACEMILUNG AREA 10 82381 100508 82351 NXTMILO2000T. 3 Wiling TeokSPrameters il CLO0VE/A 0393107 E76017477
@ My Links »

Preferences for synchronizing NX CAM to Teamcenter
tooling data

Two preferences control the synchronization of NX CAM and Teamcenter user data.

* MPP_ToolActivity_EnableUserData

custom user
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Preferences for synchronizing NX CAM to Teamcenter custom user tooling data _

This preference allows you to activate or deactivate the synchronization of User Data fields defined by
the MPP_ToolActivity_CustomUserData preference. To synchronize data, it must be set to true. If set
to false (default), all entries in the User Data fields are ignored.

This is a Site preference. The Type is Logical with only one entry allowed (Single).
MPP_ToolActivity_CustomUserData

This preference allows you to define up to fifteen user customizable attributes that can
be synchronized between NX CAM and Teamcenter. These attributes are stored with the
MENCToolActivity attribute of a CAM setup.

Syntax: pmOUserData[Custom Property Number]:[MOM Variable]:[Display Name]
* [Custom Property Number] — A two-digit number in the range of 01 to 15.

* [MOM Variable] — The Manufacturing Output Manager (MOM) variable that is set in the NX CAM
TCL postprocessor.

» [Display Name] — The display name for the user-defined attribute in the Activities view table.
Two examples of user-defined tool activity attributes:

* pmOUserData01:mom_tool_name:Tool Description

* pmOUserData02:mom_magazine:Magazine Position Note

Key information for the MPP_ToolActivity_CustomUserData preference

* You should not change the definition of a custom attribute once it has been
used to store activity data in the database. For example, if you previously defined
pmOUserData03:mom_tool_num:Tool Number, it would not be good to change it to
pmOUserData03:mom_adj_reg:Adjust Register, as any existing tool numbers would now show
up under the Adjust Register column.

While you should not change the definition of a custom attribute, you can adjust

the name. For example, if you noticed later that you misspelled the word Description

in the name, you can adjust it — pmOUserData04:mom_tool_descr:Tool Deszription to
pmOUserData04:mom_tool_descr:Tool Description.

* [Custom Property Number] must be in the range pmOUserData01 to pmOUserData15 (01-15)
and can only be used once. If a number is listed twice, the first entry is used and the second
is ignored. Also, the settings must have two digits; single digit entries are ignored (for example,
pmOUserData7 is ignored).
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* [MOM Variable] cannot contain spaces. If spaces are used, the definition for the attribute is ignored,
for example, pmOUserData05:post ver:Post Version. Also, the identifiers must be unique for all
entries.

* By default, all property-unique identifiers in the OOTB preference are set to [MOM Variable], which
indicates the property is not in use. You must modify the OOTB definition to use this specific
custom property. Modifying only some of the properties allows you to use a subset of custom
attributes. For example, if you define properties 01-10 only, 11-15 are ignored.

* [Display Name] cannot contain a : (colon). For example, if you defined
pmOUserData05:post_ver:Post Version:Date, it is displayed as Post Version and not Post
Version:Date.

MPP_ToolActivity_CustomUserData is a Site preference. The Type is String with multiple entries
allowed (Multiple).

Installing NX CAM to Teamcenter custom user tooling data
synchronization

Before you can use NX CAM - Teamcenter user data synchronization, you must activate the Part
Manufacturing Shopfloor Integration, e.g., Presetter and Activity User Data feature in the Part
Manufacturing group in the Teamcenter Environment Manager.
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Features

Select the features to install.

scorcr: [N

=1i-1= - Mechatronics Process Management

#~ Model Management
& Part Manufacturing

il-ir - Platform Extensibility
#~ Portfolio, Program and Project Management
i Reporting and Analytics

#~ Reuse and Standardization

il-ir - Supplier Relationship Management
#~ Systems Driven Product Development

+— Systems Engineering and Reguirements Management
#~ Teamcenter Integration for I-deas

g Teamcenter Integration for NX

#~Teamcenter Quality platform
& Miscellaneous

Browse...

iew a feature's description, roll the mouse cursor over the feature's name in the list. Use the
horizontal bar to view more or less of the feature description and dependencies.

The feature is available only after the NX Foundation is installed. Then you can select the Part
Manufacturing Shopfloor Integration, e.g., Presetter and Activity User Data option.
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Features

Select the features to install.

searc: [

I -
| - Mechatronics Process Management

g~ Model Management
& Part Manufacturing

| . . .
| I: @ Part Manufacturing Shopfloor Integration, e.g., Presetter and-Acti
|

B NX Fixed Plane Additive Manufacturing Integration
L B NX Machining Line Pianner integration
= Platform Extensibility
&~ Portfolio, Program and Project Management
#~ Reporting and Analytics
#~ Reuse and Standardization
-Supplier Relationship Management
systems Driven Product Development
Systems Engineering and Reguirements Management
#~ Teamcenter Integration for I-deas
#- Teamcenter Integration for NX
‘ l— B N Part Family Classification Integration
| |~ NX Foundation
a
[
a

=
#= Teamcenter Quality platform
Miscellaneous

ew a feature's description, roll the mouse cursor over the feature's name in the list. Use the
horizontal bar to view more or less of the feature description and dependencies.
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Integration

Using NX fixed plane Additive Manufacturing Integration

The image below shows a fixed plane Additive Manufacturing operation with added geometry and
3D printer files, generated in the NX Additive Manufacturing application. When you save the NX part,
printer files are imported into the Teamcenter database as datasets under the fixed plane Additive

Manufacturing activity.

51 MetaDataStamp Templates
[ RequirementsManagement Templates
(71 MS Office Templates
8 Mailbox
&S Mewstuff
~ [ AM Test Parts
~ & 000302
[ 000302
{7 000302-View
> 59 000302/A;1
. 000221
& 000222
. 000301
L#, 000121-itemO1
5 000122-item02

A Home 52 Q | = a v 7 =0 & Details X ¥ Impact Analysis leewerT:ﬂ JTPrevlewT@ Proce;;Hl;torﬂ
v & Home

|51 NX Templates &« 000302/A,1

51 NX12 Fixed Plane Additive Manufacturing Templates - -

[ ClientCache Object Type Relation

(=1 CAM Machining Knowledge i m 000302/A Fixed Plane Operation Revision Master ltermn Masters

|5y CAM Express Tutorials i‘j 000302-4 UGMASTER Specifications
up Templates r ixed Plane itive Manufacturing Machine Output Files  Specifications

(=1 CAM Setup Templat 000302 Fixed Plane Add Manuf Machine O Fil Specif

nigraphics parts -View iew Revision iew Revisior
=u hics UDF part: 000302/A-V BOMView R BOM View R
[ Unigraphics seed parts [ﬁ View Collection

The fixed plane Additive Manufacturing operation can be sent to Manufacturing Process Planner or Part
Planner, where the operation structure can be seen.

[~ Product 21 |2 | Workarea] 5% D @ |Q"§i| 5V| '%'lc@ T
BOM Line Quantity | Occurrence Type Item Description | EQC - Effective Occ...|
9 |000302/A:1 (View) 000302 True
P 000122/ A 1-item02 METarget AMTarget1 True

When you open an operation revision in the Activities tab, the datasets under the fixed plane Additive
Manufacturing Activity can be seen. Every named reference contains an output file.
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Line I Description | Activity Description
1141 00D302/A Activity Root Object Activity Root Object 0
EI% TRUMPF_TruPrint_3000 TRUMPF_TruPrint_3000 TRUMPF_TruPrint_3000 0

[#) Preprocessinfo
i [#) allSlices.MatAMX

-

& Named References X
4. Check-out a dataset to update named references, ®
Reference Name Size Remote Type Last Modified Volume
MealAny [iob.WZAgz | 158 M| |imanFile  |17-May-2018 02:56 [volume |

When you import Additive Manufacturing printer files, all output files are imported into datasets under
a fixed plane Additive Manufacturing activity. There is one exception, in which the output file with
extension .3mf is attached to a revision object. You can see this when the revision object is opened in
the Named References dialog box.

¥ Impact Analysis | oo Viewer| 4 JT Preview [ Process History|

=il . 001602/A:1
Object Type Relation q
[ 0o1602/A Fixed Plane Operation Revision Master Irern Masters §
o 001602 Fixed Plane Additive Manufacturing Machine Output Files  Specifications §
i 001602-A UGMASTER Specifications §
o7 001602/ A-View BOMYiew Revision BOM View RS
g View Collection
I oy Mamed References B
. Check-out a datacet to update named references. Y
Reference Name Size Remate Type Last Modsf... '-.fnll.;
| MeaDAny 001602 3mf 71 K| [inanFile  |23-Mar-201... [publ

Note:

Before you can use NX fixed plane Additive Manufacturing Integration, it must be installed.

Installing NX Fixed Plane Additive Manufacturing Integration

Before you can use NX Additive Manufacturing Integration with Teamcenter, the NX Fixed Plane
Additive Manufacturing Integration application in the Part Manufacturing group must be activated
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in the Teamcenter Environment Manager. By default the NX Fixed Plane Additive Manufacturing
Integration feature is not selectable.

Features

Select the features to install.

searcr: | 3

=:i-:= - Mechatronics Process Management

#~ Model Management
& Part Manufacturing

#~ Platform Extensibility
- Portfolio, Program and Project Management
#~ Reporting and Analytics
= Reuse and Standardization
- Supplier Relationship Management
~ Systems Driven Product Development
#~ Systems Engineering and Reguirements Management
#~ Teamcenter Integration for |-deas
& Teamcenter Integration for NX

[
&~ Teamcenter Quality platform
=~ Miscellaneous

Browse.

To v a Teature's description, roll the mouse cursor over the feature's name in the li
horizontal bar to view more or less of the feature description and dependencies.

You select NX Foundation to enable the NX Fixed Plane Additive Manufacturing Integration option,
and can then select it.
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Features

Select the features to install.

searc: [

I -
| - Mechatronics Process Management

g~ Model Management
& Part Manufacturing

| . . .
| I: @ Part Manufacturing Shopfloor Integration, e.g., Presetter and-Acti
|

B NX Fixed Plane Additive Manufacturing Integration
L B NX Machining Line Pianner integration
= Platform Extensibility
&~ Portfolio, Program and Project Management
#~ Reporting and Analytics
#~ Reuse and Standardization
-Supplier Relationship Management
systems Driven Product Development
Systems Engineering and Reguirements Management
#~ Teamcenter Integration for I-deas
#- Teamcenter Integration for NX
‘ l— B N Part Family Classification Integration
| |~ NX Foundation
a
[
a

=
#= Teamcenter Quality platform
Miscellaneous

ew a feature's description, roll the mouse cursor over the feature's name in the list. Use the
horizontal bar to view more or less of the feature description and dependencies.
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